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Preface

4th Dimension is a powerful relational database for the Macintosh and 
Windows platforms. As an integrated database environment, 
4th Dimension offers a complete solution for your Web publishing and 
database needs.

About the Manuals
The manuals described below provide a guide to the features of both 
4th Dimension and 4D Server. The only exception is the 
4D Server Reference, which describes features exclusive to 4D Server.

4th Dimension QuickStart leads you through example lessons where you 
create and use a 4th Dimension database. These examples provide 
hands-on experience that helps you become familiar with the concepts 
and features of 4th Dimension and 4D Server.

The User Reference provides a description of the User environment — 
the environment in which you use databases and forms to enter and 
manipulate data.

The Design Reference is a guide to the Design environment and provides 
detailed descriptions of the operations that you can perform in this 
environment. You should use it in conjunction with the other volumes 
in your documentation package.

The Language Reference is a guide to using the 4th Dimension language 
as well as the Web Server. Use this manual to learn how to customize a 
database by incorporating 4th Dimension commands and functions.

The XML Keys-BuildApplication manual lists and describes the XML 
keys that can be used to configure the application builder of 
4th Dimension.
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The XML Keys-Backup manual lists and describes the XML keys that can 
be used to set the 4th Dimension backup preferences.

The 4D Server Reference is a guide to installing 4D Server and managing 
multi-user databases with 4D Server. 

Supplemental manuals are also available. These manuals are 
particularly in reference to utility programs packaged with 
4th Dimension and 4D Server (4D Chart Language, 4D Tools, etc.).

About this Manual
This manual serves as a reference to 4th Dimension’s User environment 
and provides detailed descriptions of the operations that you can 
perform in this environment. It should be used in conjunction with 
the other manuals in the 4th Dimension package.

To use this manual effectively, you should first work through the 
exercises in 4th Dimension QuickStart and start to create your own 
database, referring to the 4th Dimension Design Reference when you need 
to review a process or explanation.

You can then proceed to enter and manipulate data in your database, 
referring to this manual when you need to review a process. 

Windows/Mac OS 
Versions

This manual details use of 4th Dimension both on the Mac OS and 
Windows platforms. Although the concepts and functionality of both 
versions of 4th Dimension are nearly identical, the manual addresses 
any differences where necessary. Such differences include the graphical 
user interface and keyboard commands.

This manual contains graphics illustrating the Windows environment. 
If there is a substantial difference in the appearance of the Mac OS 
version of a window or dialog box, it is also presented.

Right-click and 
Control+click under 
Mac OS

Certain functions are activated (for instance, the display of contextual 
menus) by carrying out a right-click, i.e. a click with the right button of 
the mouse, under both Windows and Mac OS. 
Under Mac OS, the same result can be obtained by using a 
Control+click combination. This alternative is necessary when you are 
using a single-button mouse.
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About this Manual
Chapter 
Descriptions

This manual is divided into the following chapters and appendices.

■ Chapter 1, “Introduction to the User Environment” introduces you to 
some basic User environment concepts such as the current selection, 
using tables and forms, and processes. It also describes some basic 
operations, such as entering a password-protected database, and 
provides an overview of the User environment menus.

■ Chapter 2, “Managing Structure and Data Files” provides an overview 
of 4th Dimension desktop files.

■ Chapter 3, “Data Entry” describes how to use input and output forms
and how to access forms from different tables.

■ Chapter 4, “Selecting Records” explains how to create a selection of 
records using the commands in the Records menu and how to use the 
various search methods to select a specific record or group of records.

■ Chapter 5, “Working with Records” explains how to add, modify, and 
delete records. It also describes how to use the Formula editor to 
automatically update records based on a formula (for instance, adding 
two days to the vacation balance in each employee’s record).

■ Chapter 6, “Sorting Records” describes how to place a selection of 
records in order by sorting them based on the values in one or more 
fields.

■ Chapter 7, “Modifying User Forms” describes how to adapt certain 
forms to the specific needs of users.

■ Chapter 8, “Form Reports” explains how to print reports that use 
forms created in the Design environment.

■ Chapter 9, “Quick Reports” explains how to use the Quick Report 
editor to print data in a columnar report. The chapter describes how to 
design the report using fields from your database as columns in the 
report and how to enhance the report by dividing data into sorted 
groups and performing summary calculations for each group.

■ Chapter 10, “Labels” explains how to use the Label Wizard to design 
and print labels.

■ Chapter 11, “Graphs” explains how to create, modify and print various 
types of graphs using 4D Chart. It also describes how to add a variety 
of objects to your graphs, and how to add dynamic references to field 
values or to 4th Dimension expressions.
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■ Chapter 12, “Executing Methods” provides instructions on how to 
execute a project method in the User environment and how to start a 
new process for the method or run it on the server computer as a 
stored procedure.

■ Chapter 13, “Backup and Restoring of the Database” explains how to 
set up and schedule backups, as well as how to ensure data integrity 
using the log file and the automatic restore parameters.

■ Chapter 14, “Importing and Exporting Data” explains how to import 
and export records via files or ODBC data sources.

■ Chapter 15, “Web Server” provides an overview of 4th Dimension’s 
capabilities as a Web server and explains how to start and stop a 
Web service from the User environment.

Conventions All the manuals in your documentation package, including this one, 
use certain conventions to help you understand the material. 

The following explanatory notes are used:

Note Text emphasized like this provides annotations and shortcuts that will 
help you use 4th Dimension more productively.

4D Server Throughout the manual, 4th Dimension and 4D Server/4D Client are 
referred to simply as 4th Dimension. Differences between the operation 
of the two products are explained in 4D Server notes, which provide 
information about using 4D Server/4D Client. This information is 
provided only when the operation of 4D Server/4D Client differs from 
that of 4th Dimension.

Notes like this alert you to important pieces of information and situ-
ations where data might be lost.

In addition, all table names are shown in brackets in the text to help 
distinguish them from the names of fields, forms, and other items. For 
instance, the Employees table is written as the [Employees] table.
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About this Manual
Using Hypertext You can take advantage of the hypertext buttons that have been added 
to this manual. All hypertext buttons are printed in blue text. A 
hypertext button looks like this: “For information on using 
4th Dimension as a Web server, see Chapter 15, “Web Server”.

You can click a hypertext button to read additional information about 
the topic. You can then use the Adobe Acrobat Go Back button to 
retrace your steps.
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1 Introduction to the 
User Environment

This chapter provides an overview of the 4th Dimension User environ-
ment. It describes important User environment concepts and the User 
environment menus. 

In this chapter, you will learn about:

■ The 4th Dimension environment

■ The 4th Dimension plug-ins

■ The 4th Dimension components

■ 4D Server and 4th Dimension

■ The User environment

■ User environment concepts such as the current selection, tables and 
fields, and multi-tasking

■ Opening a database with another data file

■ Entering and using a password-protected database

■ The User environment menus.
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Chapter 1  Introduction to the User Environment
The 4th Dimension Environments
4th Dimension manages data, performs calculations on that data, and 
produces output such as summary reports and graphs. These types of 
operations are performed in 4th Dimension’s User environment.

The User environment is the environment in which you enter and man-
age data. You use the User environment to:

■ Add, modify, and delete records

■ Search for a specific record or group of records

■ Modify the forms used for entering, displaying or printing data

■ Create labels, reports, and graphs that use the information in your 
database

■ Import and export data between 4th Dimension and other applications

■ Execute methods

■ Launch database backups and analyze the log

■ Control the Web server of your application.

You perform these operations on databases that have been created in 
the Design environment. The Design environment is the environment in 
which you create a database. You design its structure by creating tables 
and fields to store data, forms for data entry and reports, and other fea-
tures such as a password access system.

You can also use the Design environment to create a custom applica-
tion. A custom application has its own menu bars, entry screens, and 
editors. By creating menus and menu bars in the Design environment, 
you can design an application that suits your needs exactly and 
includes only the features you want.

A custom application can be used in 4th Dimension’s Custom Menus 
environment or deployed on 4D Server and 4D Client.

Using the 4th Dimension language, you can include some or all of the 
functions of the User environment in a custom application. For exam-
ple, a custom application can include menu commands that display 
the User environment’s Quick Reports and Labels editors.

To create a stand-alone Windows or Macintosh application, you can 
compile your application and merge it with a 4D Runtime.
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The 4th Dimension Plug-ins
In addition to the built-in functionality of 4th Dimension, 4D offers 
several plug-ins that work with your database to enhance its capabili-
ties. These plug-ins include the following:

■ 4D Chart, a graphing application that is included with 4th Dimension,

■ 4D Write, a word processing plug-in,

■ 4D Draw, an object-oriented drawing plug-in,

■ 4D View, a spreadsheet and data presentation plug-in,

■ 4D ODBC Pro, a developer’s tool that allows you to communicate 
directly with an ODBC database,

■ 4D for OCI, a developer’s tool that allows you to communicate directly 
with an Oracle’s OCI8,

■ 4D Open for 4D, a developer’s tool that lets 4th Dimension (single-
user) databases access data in 4D Server.

These products are designed to be used within your 4th Dimension 
database. For example, 4D Write and 4D Draw plug-ins allow you to 
include such things as letters and drawings in special areas called plug-
in areas. These areas appear as part of your data, just like a name or any 
other piece of information. The 4D Chart plug-in is already built into 
4th Dimension to facilitate graphing of your database information.

You can also treat the 4D View, 4D Write, 4D Draw, and 4D Chart plug-
ins as if they were separate applications by using them in their own 
windows. Your work within these windows can be independent of your 
database or linked to information in your database or in other plug-
ins.
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The 4th Dimension Components
You can install 4D components within any 4th Dimension database. A 
component adds one or more additional functions to the database. For 
example, it is possible to develop, and install, an e-mail component 
within a 4th Dimension database. 
Unlike plug-ins, 4D components are composed uniquely of 4D objects 
(tables, methods, forms, menu bars, etc.)

4D components are managed and installed using 4D Insider. Each 
component object is defined as either “public,” “protected,” or “pri-
vate,” which determines whether it is visible or able to be modified 
once installed. Components allow developers to commercialize origi-
nal solutions in total security. For more information on components, 
please refer to the 4D Insider Reference manual.

4D Server and 4th Dimension
You can create single-user and multi-user databases with:

■ 4th Dimension (single-user)

■ 4D Server and 4D Client (multi-user).

4th Dimension is a single-user database application. In a single-user 
database, operations such as entering data into a record or searching 
for a specific record are performed by one user at a time, working on a 
single computer. Both 4th Dimension and the database on which the 
user is working are stored locally on the user’s machine.

4D Server and 4D Client together form a multi-user database applica-
tion in which database operations can be performed by several users at 
a time. The users connect to databases from client computers that are 
connected over a network to a dedicated computer (a server) running 
4D Server. 

To set up a multi-user database, you install 4D Server along with the 
database on a separate computer. A copy of 4D Client is then installed 
on each user’s computer. A user accesses the database by launching his 
or her copy of 4D Client. 
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Whenever a user performs an action such as entering data or generat-
ing a report, 4D Server updates the tables on the server computer and 
performs all necessary calculations. Changes made by one user are 
updated on the server so that all users view the most recent informa-
tion. For more information about 4D Server and 4D Client, refer to the 
4D Server Reference manual.

However, the single-user version of 4th Dimension is comparable to a 
multi-user environment when the database is published as a Web 
server. In this case, if custom menus or specific methods have been 
created, Web browsers that connect to the database via the Internet or 
Intranet will have access to the data, in the same way as client 
machines (creation, deletion and modification of records). However, 
unlike 4D Client, a Web browser cannot gain access to the structure of 
the database.

Of course, 4D Server can also publish your database as a Web server, 
which gives both 4D Client machines and browsers simultaneous 
access to it. Moreover, each 4D Client machine can also become a Web 
server. 
For more information about Internet or Intranet operation on your 
database, refer to chapter 15, “Web Server,” as well as the Language 
Reference manual of 4th Dimension. 

The User Environment
The User environment is where you work with your data. The menus 
and editors in this environment provide a complete set of tools for 
managing information. You can use the User environment to:

■ Import or export data

■ Enter, modify, or delete records

■ Search for records and sort lists of records

■ Create and print reports, labels, and graphs

■ Customize user forms

■ Run processes that enable you to perform more than one operation 
simultaneously, also known as multi-tasking

■ Launch backups and display the contents of the log file

■ Start and stop the built-in Web Server. 
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Multi-tasking is discussed later in this chapter. All other User environ-
ment features are explained in the remainder of this manual.

Tables and Forms In a 4th Dimension database, you store information in tables. Ideally, 
each table stores a different type of information. For example, a Con-
tacts database might have one table that stores information about peo-
ple and another table that stores information about companies. 

In the User environment and custom applications, you use forms to 
enter and manage data. Each table in your database has an input form 
and an output form.

An input form displays one record at a time. You use an input form 
to enter, view, and modify information in a single record. In the User 
environment and custom applications, the input form is sometimes 
called the Detail form.

An output form displays several records as a list. You use an output form 
to browse through records, select and sort records, and print a selec-
tion of records. You can also enter and modify records directly in an 
output form. In the User environment and custom applications, the 
output form is sometimes called the List form. When you are working 
with a List form, you can display an individual record in its Detail form 
by double-clicking it.

You can switch from one table to another and change the input and 
output forms with which you work. You will learn how to do this in 
Chapter 3.

The Current 
Selection

When managing data, you select the group of records with which you 
want to work. This group of records is called the current selection. The 
current selection can contain none, one, some, or all of the records in a 
table. Every table has a current selection of records.

The current selection is an important concept in 4th Dimension. The 
most common data management operations are performed on the 
records in the current selection. 
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These operations include:

■ Sorting records

■ Viewing and modifying individual records

■ Updating a group of records

■ Printing a report

■ Generating labels

■ Graphing data

■ Exporting records.

The current selection of records is always the set of records most 
recently selected. For instance, you might have a company database 
that uses an Employees table to keep track of employee records. Sup-
pose that you decide to search for the records of all engineers in the 
company. 

When this query begins, the current selection may contain the records 
of all employees in the company — salespeople, production personnel, 
engineers, and so on. When the query is completed, the current selec-
tion contains only the engineers’ records. 

If you were to print a list of records, the list would contain only the 
records in the current selection — in this case, the records for all of the 
engineers in the company. If you were to graph employee salaries, your 
graph would display the salaries for all of the engineers in the company.

The current selection remains the same until you perform an operation 
that changes it. You change the selection of records in a table when-
ever you select records manually or do a query that selects records. 
Search operations are performed by menu commands in the Records > 
Query sub-menu, such as Query by Example, which searches for 
records based on the entries you specify for fields in a form.

To restore the current selection to all of the records in the table, you 
choose Show All from the Records menu.

For more information about selecting records, refer to Chapter 4.
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Multi-tasking in 4th Dimension
When you are working with a database, you typically perform a single 
action at a time — one query, one sort, printing one report.

At times, you might like to be able to perform several actions at once. 
For example, you might want to enter data into an employee’s record 
while a large group of records is printing. You might also want to view 
two selections from the same table (such as engineers in one window 
and salespeople in another) simultaneously.

4th Dimension provides such multi-tasking capabilities by enabling 
you to perform operations in separate processes. A process is a 
4th Dimension task that executes actions specified by a method. 

Although you write methods in the Design environment, you can exe-
cute them in the User environment. When you do so, you can choose 
to start a new process for the method. The method then executes in a 
separate process, allowing you to continue working in another process.

You can start as many processes as you want. The number of processes 
open concurrently is limited only by the amount of memory on your 
computer.

For information about executing a method that starts a new process, 
refer to Chapter 12 of this manual. For complete information about 
creating and managing processes, refer to the 4th Dimension Design 
Reference manual.

4th Dimension Desktop Files
A 4th Dimension database consists of four disk files: a structure file 
(extension “.4DB”), a structure resource file (extension “.RSR”), a data 
file (extension “.4DD”), and a data resource file (extension “.4DR”).

Note If you use backup functions (active by default), additional elements 
will be present: the log file (extension “.4DR”), the backup journal and 
the Preferences folder. For more information, refer to Chapter 13, 
“Backup and Restoring of the Database,” on page 319. 
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When you create a new database, 4th Dimension places the structure 
and data files in the same folder. If you check the Create Database 
Folder check box in the Welcome dialog box, all the database files will 
be saved in a new folder having the same name as the database. 

■ The structure file contains all of your specifications for the design of 
the database.

■ The structure resource file contains resources used by the structure file. 
These resources might include pictures or strings.

■ The data file contains your data and any indexes you build.

■ The data resource file contains resources used by the data file.

Please refer to Chapter 2 for details on database files.

Database Backup and Use of the Log File
For most databases, it is essential that the data are protected against 
risks like file corruption or human error. When data have been erased 
or modified accidentally by a user, this can mean consequences 
ranging from the additional work needed to re-enter the data, up to 
the irremediable loss of information. 

In order to limit these risks, 4th Dimension includes a complete 
database backup and restore module, which lets you back up a 
database during its use, without it being necessary to exit the 
application. Each backup file can include the structure file, the data file 
(including any segments), as well as any additional files or folders. 

The backup module also allows the use of a log file. This file keeps 
track of each operation carried out on the data and thus ensures 
complete security between two backups. 
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The Backup... command of the 4th Dimension File menu displays a 
dialog box that can be used to launch a backup at any time (Backup 
button) or to display the backup preferences:

All the backup settings (files to be saved, location of archives, log file, 
etc.) are defined beforehand in the application Preferences and used 
when the backup is launched. Backups can also be scheduled to take 
place automatically at regular intervals, or launched by programming. 

The backup and restore functions of 4th Dimension databases are 
detailed in Chapter 13, “Backup and Restoring of the Database,” on 
page 319. 

Password Protection
4th Dimension’s Design environment includes a comprehensive pass-
word access system. This access system is used to selectively grant 
access to parts of a database. Access can be granted to tables, record 
operations (e.g., adding, modifying, deleting, and viewing records), 
forms, menu commands, methods, and plug-ins. 

The password access system is based on the notion of user groups. Each 
group has specific access rights and each user belongs to one or more 
groups. The users inherit the access rights of the groups to which they 
belong. 

Each user of the database is given a user name and a password. 
Depending on the type of access system implemented in your 
database, the user must do one of three things: 

■ Select a user name from a list and type a password, or

■ Type both a user name and password, or

■ Type a password only, or type nothing (if the database is in the 
“Default User” mode and no password has been assigned).
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The second option provides extra security for a database by requiring 
that users enter both a valid user name and password. For more infor-
mation about designing the password access system, refer to the 
4th Dimension Design Reference manual.

If a database is password-protected, you must identify yourself as a 
valid user before you are permitted access to the information in the 
database. 4th Dimension automatically displays an User Identification 
dialog box whenever you open a password-protected database. You will 
be required to either enter your password or enter both your name and 
password.

❿❿❿❿ To enter a database protected by a password access system:

1 Open or connect to the database as you normally would.

2 If 4th Dimension displays the following User Identification dialog 
box, select your user name from the user list and type your password 
in the Password entry area at the bottom of the dialog box.

OR

Select your name

Type your password
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If 4th Dimension displays the following User Identification dialog 
box, type both your user name and password in the entry areas.

OR

If 4th Dimension displays the following User Identification dialog 
box, the Default User mode1 is activated; type the password for the 
default user in the entry area.

Note that in the dialog boxes, an asterisk is displayed in place of each 
character you type in the password entry area. 

Note Because the password access system is case sensitive, be sure to type 
your password using the correct uppercase and lowercase characters.

If you type the password correctly, you are given the level of access 
to the database that was specified when the access system was 
designed. If you type the password incorrectly, the computer beeps and 
does not allow you to open the database.

1. In the Default User mode, the password access system may be configured 
so that no dialog box is displayed. 
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Using a Password-
protected 
Database

After you have entered a password-protected database, you can use any 
part of the database to which you have been granted access. Unless you 
are the designer of the database or part of a group of users that has 
been given access to the Design environment, you will be unable to 
enter the Design environment.

The access system grants access to tables, record operations, forms, 
menus, methods, and plug-ins. If you try to use part of the database to 
which you do not have access, 4th Dimension displays an alert dialog 
box.

Note When the database is published as a Web server, the password system 
can be applied to browsers that connect to the database. For more 
information about this, refer to the “Connection Security” section in 
the Language Reference manual.

4D Server The 4D Client User Identification dialog box also includes a Save 
button that lets you store the access parameters to the 4D Server 
database. This option is detailed in the 4D Server Reference manual. 

Modifying 
Passwords

The User Identification dialog box by default includes a Change 
button which lets the current user modify their own password. If the 
list of users is displayed, the current user is the selected user. If the list 
is not displayed, the name of the current user must be entered 
beforehand in the User Identification dialog box. 

When the user clicks the Change button, the following dialog box 
appears:

User name
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In order to modify their password, the user must indicate their old 
password. The new password is then entered and confirmed. 

Once the dialog box is validated, if the entry is correct, the new 
password of the user replaces the old one and is stored in the database. 
The user then needs to enter his or her new password and click the 
Connect button in order to open the database. 

Note It is possible to hide the Change button in order to prevent users from 
modifying their password. This option is found on the 
Application/Access page of the application Preferences (see the Design 
Reference manual). 

User Environment Menus
This section briefly describes the commands in the User environment 
menu bar.

Menu Bar The User environment menu bar contains the following menus:

Note Under Mac OS, the application menu (named 4th Dimension, 4D 
Server or 4D Client depending on the current application) is added to 
the left of the menu bar. It contains more particularly the Preferences 
and Quit commands, which are described below in the Edit and File 
menus. 

Toolbar The User environment also includes a toolbar of command buttons for 
easy access to frequently used menu commands. To choose a com-
mand from the toolbar, click its button.

The buttons with a triangle icon to their right have associated menus 
offering different possible actions:
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Clicking the button directly carries out the principal associated action. 
To display the menu and select a different action, click on the right-
hand part of the button.

The toolbar is contextual; in other words, it changes according to the 
mode you are using (Design, User, Custom Menus).
For instance, the same tools are not available in Design and User mode. 
As a result, some buttons take the place of others depending upon your 
navigation within the application. In addition, when functions are not 
available, the corresponding buttons are dimmed to indicate that they 
are not enabled.

Hiding the Toolbar You can stop the display of the toolbar in your 4th Dimension 
application, both in Design and User modes, and in the Custom 
Menus mode as well. 
These options are set on the Application/Options page of the 
application Preferences:

These settings will be applied to all your databases. For more 
information about this, refer to the Design Reference manual.

You can also remove or display the toolbars individually for each 
database using the language commands of the “Tool Bar” theme. For 
more information about this, refer to the 4th Dimension Language 
Reference manual.

Toolbar display 
options
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Custom Menus and 
Toolbars

In addition to the built-in User environment menus and command 
buttons, you can add custom menus and buttons that will appear in 
the menu bar and the toolbar when a form is displayed. You use these 
custom commands to simplify complex or time-consuming tasks. 

File Menu The File menu contains the following commands for performing stan-
dard file operations:

■ New > Database...: This command opens the Welcome dialog box of 
4th Dimension on the “Create” page, which is used to create a new 
database.

■ New > Data File...: This command displays the standard save file dia-
log box, which is used to create a new data file for the open database 
(see the “Opening a New Data File” paragraph on page 45). 

■ Open > Database: This command opens the Welcome dialog box of 
4th Dimension on the “Open” page, which is used to open an existing 
database. 

■ Open > Data File...: This command displays the standard open file 
dialog box, which is used to change the data file for the open database 
(see the “Opening a Different Data File” paragraph on page 45).

■ Import > From File...: This command displays a standard open file dia-
log box, which is used to specify a file containing data to be imported 
into the current table. For more information about importing data, 
refer to chapter 14, “Importing and Exporting Data,” on page 361.

■ Import > From ODBC Source...: This command displays the system 
dialog box for selecting a data source, which is used to specify the 
ODBC source containing the data to be imported into the current 
table. For more information about importing data, refer to chapter 14, 
“Importing and Exporting Data,” on page 361.
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■ Export > To File...: This command displays the standard export dialog 
box of 4th Dimension. For more information about exporting data, 
refer to chapter 14, “Importing and Exporting Data,” on page 361.

■ Export > To ODBC Source...: This command displays the system dia-
log box for selecting a data source, which is used to specify the ODBC 
source to which you want to export data from the database. For more 
information about exporting data, refer to chapter 14, “Importing and 
Exporting Data,” on page 361.

■ Flush Data Buffers: This command is used to “force” the writing of the 
data cache to disk. 
Before being written to disk, the operations carried out on the data are 
kept in the data cache for a certain period of time. This makes for faster 
data access. The cache is written to disk at regular intervals (every 15 
minutes by default) or when the database is exited. In certain cases, 
you may want the cache to be written immediately to the disk. If so, 
you can use this command. 

■ Data Segments...: This command displays the dialog box for manag-
ing data segments, which can be used to configure or add data seg-
ments (see the “Segmenting Data Files” paragraph on page 47). 

■ Backup...: This command displays a dialog box that is used to launch a 
manual backup of the database. For more information, refer to the 
“Performing a Backup” paragraph on page 320. 

■ Check Log File...: This command opens a window displaying the con-
tents of the current log file. For more information, refer to the “Manag-
ing the Log File” paragraph on page 339. 

■ Page Setup...: This command displays the configuration dialog box 
for the current printer selected in your operating system. 

■ Print: Displays the Choose Print Form dialog box so you can print 
reports using a form. For a discussion of printing reports using forms, 
refer to Chapter 8.

■ Exit: Closes and saves the current database, then exits the 
4th Dimension application.

Note Under Mac OS X, the Quit menu command is only available in the 4D 
application menu and not in the File menu. 
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4D Server In 4D Client, the operations found in the User environment File menu 
differ from those listed, due to the division of the application between 
4D Server and 4D Client. Only the Open > Database command is 
available in the File menu of 4D Client — you cannot create a new 
database or manage data files using 4D Client. 
Similarly, the Backup and Check Log File commands are found on the 
server machine.
When you want to exit the database that is currently open, you choose 
the 4D Client Exit menu command. This operation exits the database 
on your client machine but does not close the database on the server.

Edit Menu The Edit menu contains the following standard editing commands:

■ Undo/Redo
■ Cut
■ Copy
■ Paste
■ Clear
■ Select All
■ Show Clipboard.

Your system’s standard editing operations are covered in the user guide 
that came with your system. You can use these menu commands when 
managing data with 4th Dimension. 

■ Preferences...: This command opens the application Preferences dia-
log box. These preferences determine the behavior of various aspects of 
the application (interface, security, backup, Web parameters, etc.) in 
all the modes (User, Design and Custom Menus). Consequently, you 
must take care when modifying the preferences. 
For more information about application preferences, refer to the 
4th Dimension Design Reference manual. 

Note Under Mac OS X, the Preferences... command is found in the 
application menu and not the File menu. 
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Mode Menu The Mode menu lets you change between the different environments 
of 4th Dimension: Design, User, and Custom Menus. 

A checkmark is placed beside the current environment. Selecting a 
command that already has a checkmark has no effect.

■ Design: Switches to the Design environment. When you enter the 
Design environment, all of the Design environment menus and editors 
are available to help you design your database.

Note The Design menu command is dimmed if you do not have access 
privileges to this environment or if the database with which you are 
working has been compiled. 

■ User: Switches to the User environment.

■ Custom Menus: Switches to the Custom Menus environment. When 
you enter the Custom Menus environment, only the custom menus 
defined for the database are displayed in the menu bar. By default, 
4th Dimension creates a custom menu bar containing the File, Edit and 
Mode menus.

Run Menu The Run menu contains the command related to the execution mode 
of the database, as well as the launching of specific tasks in 
4th Dimension.

Note The Run menu is the same in both Design and User mode. 

The commands are as follows:

■ Compiled / Interpreted: This command lets you change between exe-
cution modes. It is enabled if the database has been compiled at least 
once; otherwise, it is dimmed and the database automatically operates 
in interpreted mode. 
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When the database operates in compiled mode, the Design environ-
ment is no longer accessible. For more information about execution in 
compiled mode, refer to the Design Reference manual. 

■ Method...: This command displays the Execute Method dialog box. 
Use it to execute a project method. When you execute a method from 
this dialog box, you can choose to execute the method in another 
process or (4D Server only) on another 4D Client, and to start it in 
debug mode. For more information about processes, refer to “Multi-
tasking in 4th Dimension” on page 24.
The Execute Method dialog box is discussed in Chapter 12.

■ Runtime Explorer...: This command displays the Runtime Explorer 
window. The Runtime Explorer is used to check the parameters of the 
database in real time and to check whether available resources are used 
correctly. This tool is particularly useful during development and 
analysis of a database. 

Note Only the Designer and Administrator have access to the Runtime 
Explorer.

Tip: The Runtime Explorer can be displayed in a floating window, so 
that it always stays in the foreground. To do this, hold down the Shift 
key when selecting the Runtime Explorer... command or use the 
Ctrl+Shift+F9 (Windows) or Command+Shift+F9 (Mac OS) shortcut. 

Note The Runtime Explorer is described in the 4th Dimension Design 
Reference manual. 

■ Start Web Server / Stop Web Server: These commands toggle between 
starting and stopping the integrated Web server of 4th Dimension. 

■ Test Web Server: This command is accessible when the Web server is 
launched. It displays the home page of the Web site published by the 
4D application in a window of your default Web browser. This com-
mand is used to check the operation of the integrated Web server. 

Note Web publication in 4th Dimension is described in Chapter 15.
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Records Menu The Records menu contains the following commands used for enter-
ing, modifying, selecting, searching and sorting data in records: 

■ New Record in List: Adds a blank line in the current output form and 
places the cursor in the first field to begin data entry. 

■ New Record: Displays a blank input form and places the cursor in the 
first field to begin data entry. 

■ Modify Record: Displays the selected (highlighted) record using the 
current input form. Modify Record is dimmed if no records are 
highlighted or if you are currently using an input form. 

■ Show All: Displays all the records in the table you are working with in 
the output form. Show All is dimmed if you are currently using an 
input form.

Note For more information about modifying, updating and entering data in 
records, refer to chapter 5, “Working with Records,” on page 107. 

■ Show Subset: Displays only the group of records that is highlighted in 
the output form. Show Subset is dimmed if no records are highlighted 
or if you are using an input form.

■ Query > Query: Displays the Query editor. The Query editor is a 
general purpose search editor that you can use to perform many types 
of queries.

■ Query > Query by Example: This menu command displays the current 
input form as a query-by-example window.

■ Query > Query and Modify: This menu command also displays the 
current input form as a query-by-example window. When you use 
Query and Modify, the first record located by the query is displayed in 
the input form. 
374th Dimension User Reference



Chapter 1  Introduction to the User Environment
■ Query > Query by Formula: This menu command displays the Formula 
editor. Use Query by Formula when you want to search for records 
based on the results of a formula.

Note For more information about selecting and searching for records, refer 
to chapter 4, “Selecting Records,” on page 81. 

■ Order By: This menu command displays the Order By editor. Use 
Order By to sort the current selection.

Note For more information about sorting records, refer to chapter 6, 
“Sorting Records,” on page 123.

■ Tables List: This command displays the List of tables window, which is 
used to move between the different tables and forms of the database. 
This window is described in the “Choosing Tables and Forms” para-
graph on page 77.

■ Apply Formula: Displays the Formula editor. Choose Apply Formula to 
make changes to the current selection of records using a formula.

Tools Menu The Tools menu contains the commands that call the Quick Report, 
Label and Chart editors of 4th Dimension and lists the plug-ins 
installed in your database.

■ Quick Report: Displays the Quick Report editor. Use it to create and 
print columnar reports.

■ Labels: Displays the Label editor. Use it to create and print labels.

■ Charts: Displays the Chart Wizard. Use it to graph data.

Note These editors are described respectively in chapters 8, 9 and 10. 
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The Tools menu also lists the different plug-ins installed in your 
database. When you select a plug-in from this menu, a new external 
window containing this plug-in is created. 
By default, this menu contains the integrated 4D Chart plug-in 
command, which is used to create and manipulate graphs, as well as 
the OLE tools command (under Windows only), which is used to insert 
OLE objects into your databases. 

Window Menu The Window menu is used to manage the various windows open in the 
application. The first four menu commands are standard: 

■ Minimize Window: Minimizes the window in the foreground.

■ Minimize All Windows: Minimizes all the open windows. 

■ Bring All To Front: Enlarges all minimized windows. 

■ Arrange in Front: Displays all the windows in a cascade. 

All the open windows are then listed in this menu, regardless of their 
environment (Design, User or Custom Menus). To move a window to 
the foreground, simply select it from this menu. 

Help Menu The Help menu gives you access to the on-line Help available for the 
application. 

It also contains the Update License... command, which lets you add or 
delete serial and/or expansion numbers. For more information about 
this dialog box, refer to the 4th Dimension Installation Guide manual. 
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Under Windows, the Help menu also contains the About 4th 
Dimension command; under Mac OS X, this command is found in the 
Application menu. The About dialog box provides various information 
about the 4th Dimension program being executed, the database, the 
system configuration and the 4D company. 

Custom Menus for 
Forms

The Form editor (available in the Design environment) lets you associ-
ate a menu bar with a form. Whenever the form is used as an input 
form or is displayed by programming, the menus on the custom menu 
bar are appended to the User environment’s menu bar. 

You use the menus and menu commands on the custom menu bar for 
specialized functions. For example, a custom menu might contain 
menu commands that display custom search dialog boxes, print 
reports, or import data using a special format. You use custom menu 
bars as you would use menus and menu commands in any application.

Refer to the 4th Dimension Design Reference manual for more informa-
tion about designing custom menu bars and associating menu bars 
with forms.

Custom menu
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2 Managing Structure and 
Data Files

This chapter provides an overview of 4th Dimension desktop files. 

4th Dimension Desktop Files
Under Windows, a 4th Dimension database consists of four desktop 
files: a structure file, a structure resource file, a data file, and a data 
resource file. When you create a new database, 4th Dimension places 
the structure, resource, and data files in the same folder. If you check 
the Create Database Folder check box in the Welcome dialog box, all 
the database files will be saved into a new folder.

■ The structure file (denoted by the file extension .4DB) contains all of 
your specifications for the design of the database.

■ The structure resource file (denoted by the file extension .RSR) 
contains resources used by the structure file. These resources might 
include pictures or strings. 

■ The data file (denoted by the file extension .4DD) contains your data 
and any indexes you build.

■ The data resource file (denoted by the file extension .4DR) contains 
resources used by the data file.
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On Macintosh, a 4th Dimension database consists of two desktop files, 
the structure file and the data file. The structure resource file is merged 
with the Macintosh structure file and the data resource file is merged 
with the Macintosh data file. The structure file has no suffix on Macin-
tosh, while the data file has the suffix .data.

Naming Directories If you check the Create Database Folder check box in the Welcome dia-
log box, the directory (folder on Macintosh) is given the name you 
assign to the database. For example, if you name a database Contacts, 
the directory will be named Contacts, the structure file will be named 
Contacts.4DB, the structure resource file will be named Contacts.RSR, 
the data file will be named Contacts.4DD, and the data resource file 
will be named Contacts.4DR. 

On Macintosh, the folder is given the name you assigned to the 
database, followed by an “ƒ”. The data file is also given the same name, 
followed by “.data”. For example, if you name a database “Contacts,” 
the folder will be named Contacts ƒ, the structure file will be named 
Contacts, and the data file will be named Contacts.data.

On Windows, the data resource file (denoted by the file 
extension .4DR) contains Macintosh resources pertaining only to the 
data file, such as the WEDD resource that links a data file with a partic-
ular structure file.

Structure and Data 
File Locations

4th Dimension does not require that the structure and data files have 
the same names, be in the same directory, or be on the same volume. 
You can move either the structure or data file to new locations on the 
same hard disk or to different hard disks. However, the structure and 
resource files must always be in the same location. In the same way, 
the data resource file must be kept in the same location as the data file. 
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When you open a structure file, you can choose to use a data file other 
than the one you initially created or you can create a new data file. 
This option gives you the ability to use more than one set of data with 
the same structure file. For example, a developer can use a “dummy” 
data file while working on the database off-line and then redeploy the 
improved structure file with the “real” data file when the development 
is finished.

If you separate the data file from the structure file by moving it, you 
will need to indicate the data file’s new location. By displaying the 
Open Data File dialog box, 4th Dimension asks for the location of the 
data file the first time you open the structure file.
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Opening a Database
You can open a database by double-clicking the 4th Dimension applica-
tion icon and using the Welcome dialog box to open the desired struc-
ture file. 

4th Dimension will then look in the directory that contains the struc-
ture file for a data file with the same name. If 4th Dimension finds the 
data file, it will open it automatically.

If the data file is not in the same directory or is missing, 4th Dimension 
displays the Select Data File dialog box. Open the data file by double-
clicking its filename or by selecting the filename and clicking Open. 

Names of 
recently used 
databases

Icon for 
choosing a 
different data 
file
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If you want to specify a different data file or create a new one, click the 
icon located beneath the Data file area. Clicking this icon opens 

the Open Data File dialog box. The data file chosen or created will 
become the default and will open automatically the next time you 
open the database.

Note For more information about this dialog box, refer to the 4th Dimension 
Design Reference manual. 

Opening a Different 
Data File

You can prevent 4th Dimension from opening the default data file 
automatically.

❿❿❿❿ To open a different data file:

1 Choose Open > Data File... in the File menu of 4th Dimension.
OR
Hold down the Alt key (Option key on Macintosh) while opening any 
structure file.
OR
In the Welcome dialog box, click the  icon under the Data File area.
4th Dimension displays the Open Data File dialog box.

2 Double-click the desired data file name or select the data file and click 
Open.

Opening a New 
Data File

You can also create a new data file by preventing 4th Dimension from 
opening the default data file automatically. 

❿❿❿❿ To create a new data file:

1 Choose New > Data File... in the File menu of 4th Dimension.
OR
Hold down the Alt key (Option key on Macintosh) while opening any 
database and click the New... button.
OR
In the Welcome dialog box, click the  icon under the Data File area.

2 In the Open Data File dialog box, click the New... button. 
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4th Dimension displays a create-file dialog box.

In the File name text area, 4th Dimension automatically enters a name 
for the new data file based on the name of the current structure file. 

3 If you wish to enter a new name for the data file, type the name in the 
File name area then click Save. 
The names of any other data files in the directory are displayed. If you 
enter the name of an existing data file, 4th Dimension displays a 
message asking you if you want to replace the existing data file with 
the new data file.

4th Dimension will “remember” where the data file is from then on 
(4th Dimension stores the pathname of the data file). The Open Data 
File dialog box will not be displayed again unless you call it intention-
ally (as described above), move the data file to a new location, or 
change its name. 
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Segmenting Data Files
If you are creating a data file that may become very large, you may 
need to segment the data file. You need to segment a data file if:

■ The data file will not fit on your hard disk,

■ The data file will become larger than 2 gigabytes.

Using data file segmentation, you can store a single data file on two or 
more volumes. Each segment can grow to a maximum of 2 gigabytes. 
The maximum size of a 4th Dimension data file is 128 gigabytes. You 
do not need to segment a data file when you first create it. You can 
wait until it becomes too large to manage on your hard disk.

For complete information on segmenting data files, see Appendix A of 
the 4th Dimension Design Reference manual.
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3 Data Entry

This chapter covers the basic skills required to manage information 
using input and output forms. These skills are used whenever you work 
with data — entering new records, modifying existing records, or 
working with a list of records.

Input and Output Forms
Input and output forms provide access to the information in your 
database. You use forms to enter, view, modify, and print information. 

Input forms display one record at a time. They have enterable areas for 
fields and buttons for working with records. For details, see the “Using 
Input Forms” section on page 54. Here is an input form that was 
created using a standard form template.
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Output forms display several records as a list. Each row is a record and 
each column is a field. Typically, only a few fields appear in the output 
form. Output forms are described in detail in the “Using Output 
Forms” section on page 51. Here is an output form that was created 
using a standard form template:

Although the above example shows the typical use of a form, any form 
can be designated as either an input or output form. For instance, a 
form that contains several fields set out vertically and one or more 
picture field(s) can be used perfectly well as an output form. 

You use an output form to do the following:

■ Scroll a list of records

■ Highlight a subset of records

■ Double-click a record to display it in the input form

■ Enter or modify records directly in the list.

Input forms display one record at a time. You can enter and modify 
information, move from one field in the form to another, and move 
from one record to another. 
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An input form usually has buttons that you use to:

■ Save a new record to disk or save modifications to an existing record

■ Cancel changes to a record

■ Navigate from one record to another

■ Delete a record.

Using Output Forms
An output form lists records. Although any form can be used as an 
output form, most output forms have these features:

■ Each row is a record

■ Each column is a field or a variable

■ Each column is labeled at the top of the window. The columns can be 
resized using the splitters between each title area. 

■ The header and/or footer of the form may contain buttons, pop-up 
menus, etc. 

The following is a typical output form.

Working with 
Output Forms

There are five basic ways to work with output forms:

■ Scrolling to locate records

■ Resizing columns

Table name

Number of records 
in current selection

Number of 
records in table

Scroll bars
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■ Highlighting to select records

■ Double-clicking to view a record

■ Entering and modifying data in fields.

Scrolling An output form has standard horizontal and vertical scroll bars. You 
can scroll records by clicking either of the scroll arrows, clicking the 
scroll bar, or dragging the scroll box. You can also use the PgUp and 
PgDn keys (to scroll through the list of records one screen “page” at a 
time) or the Start and End keys (to go directly to the start or end of the 
list). 

If the output form has more fields than can be displayed in the 
window, you can scroll horizontally using the scroll bar at the bottom 
of the window.

Resizing Columns You can resize the output form columns (except when this possibility 
has been removed in the form editor). To do so, place the mouse cursor 
over the title area of the columns; the cursor changes as follows  in 
order to indicate that the column can be resized. You can then click 
and move the edge of the column in order to reduce or enlarge it:

Highlighting You highlight (select) a record by clicking it. You can highlight a single 
record, two or more adjacent records, or two or more non-adjacent 
records. After highlighting records, you can perform operations such as 
displaying them as a subset or deleting them.

❿❿❿❿ To highlight a record:

■ Click a record displayed in the output form or press the ↑↑↑↑  or ↓↓↓↓    keys.
The record you clicked is highlighted. If you use the arrow keys, the 
first or last record of the list is highlighted.

❿❿❿❿ To highlight several adjacent records:

1 Click the first record you want to highlight.

2 Hold down the Shift key and click the last record you want 
to highlight (or press the ↑↑↑↑  or ↓↓↓↓    keys). 
All records between the first and last ones you clicked are highlighted.
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❿❿❿❿ To highlight several non-adjacent records:

1 Click the first record you want to highlight.

2 Hold down the Ctrl key (Windows) or Command key (Macintosh) and 
click another record.

3 Continue clicking records while holding down the Ctrl key (Windows) 
or Command key (Macintosh).
Each record you click is highlighted.

❿❿❿❿ To highlight the entire current selection of records in the output form:

■ Choose Select All from the Edit menu or use the standard Ctrl+A 
(Windows) or Command+A (Mac OS) shortcut.
All records displayed in the output form are highlighted. To highlight 
all the records in the table, choose Show All from the Records menu (or 
the corresponding icon in the toolbar) before choosing Select All from 
the Edit menu.

Double-clicking To view a record in the input form:

■ Double-click the record in the output form.
When you double-click a record, the input form replaces the output 
form in the frontmost window. The selected record is displayed in the 
input form, ready for modification.

Adding and Modifying 
Records

You can add and modify records directly in an output form. The out-
put form is especially useful for modifying a few adjacent records 
because several records are displayed on the screen simultaneously. 

You can only enter or modify fields in the current table. You cannot 
enter or modify data in variables, fields from other tables, or subforms.

In the output form, you can:

■ Select and edit fields by clicking on them (you have to click twice if the 
record is not already selected),

■ Move from field to field and record to record using the Tab, Enter or 
Return keys,
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■ Add a new record, using the Records > New Record in List menu 
command or by clicking on the corresponding button in the toolbar.

Hitting the Tab, Enter or Return keys, or clicking on another field saves 
your changes.

Using Input Forms
The input form is the primary tool for entering and modifying data. 
Most input forms have the following elements to manage information:

■ Enterable Areas: Input forms have enterable areas (fields or variables) 
in which data can be entered. You use enterable areas to enter values 
into the database.

■ Accept Button: A button for accepting the record. You use the Accept 
button to save a new record or to save changes to an existing record. 
When you accept a record, you request 4th Dimension to add the new 
record (or your changes to an existing record) to the database.

■ Cancel Button: A button for canceling the record. You use the Cancel 
button to discard changes you made to an existing record or to discard 
a new record. If you press the Cancel button while entering a new 
record, 4th Dimension does not add the record to the database. If you 
press the Cancel button while modifying an existing record, 
4th Dimension ignores any changes you have made. The record you 
were modifying is not affected by your changes. 

■ Navigation Buttons: Buttons to navigate from one record to another 
(e.g., First Record, Last Record, Next Record, Previous Record).

Field being modified
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When you press a record navigation button, 4th Dimension accepts the 
record you were adding or modifying before displaying a new record.

■ Delete Button: A button for deleting the record. You use the Delete 
button to permanently delete a record from the database. 

Buttons and Form 
Templates

The Design mode Form wizard lets you create forms quickly and easily 
based on the combination of a form type (detail form, list form, etc.) 
and a template (Mac OS, Windows, Web Aware, etc.). It is possible to 
create forms that are partly or entirely customized.
Depending on the type and template of the form, as well as any 
parameters that you may have set (number, location and family of 
buttons chosen, etc.), the accept, cancel and navigation functions will 
vary accordingly in their appearance. 

Here are examples of detail form types using the Windows and Web 
Aware templates:

Accept/Cancel buttons

Buttons for navigating 
between records

Buttons for navigating 
between records
Accept/Cancel buttons

Record number

Delete button

Delete 
button

Records in selection
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Help Tips in Input 
Forms

In the 4th Dimension Form editor (Design mode), it is possible to 
associate help tips with fields and variables of input forms. A help tip 
can contain the title of a picture button, a data entry hint or, more 
generally, any information which the developer wishes to provide to 
the user. The Form wizard associates help tips with each button of 
input forms created by default.

In User mode, when you place the mouse cursor over an object which 
has an associated help tip, this tip will be displayed after a few 
moments in a small label.

For more information about associating help tips with form fields and 
variables, refer to the Design Reference manual. 

Enterable Areas and 
the Data Entry 
Order

You enter data into enterable areas. An enterable area can be either a 
field or a variable.

When entering or modifying data, you move from one enterable area 
to another in a consistent order. This order is called the data entry order. 
Every enterable area into which you can type a value is included in 
the data entry order. Boolean fields (shown as radio buttons or check 
boxes), subforms, combo boxes, and areas that accept pictures are also 
included in the data entry order.

Thermometers, rulers, and dials can also be used to enter data. These 
objects, however, are not included in the data entry order. You select 
them by clicking on them. 

The data entry order can be changed in the Design environment’s 
Form editor. The data entry order for a particular form may not 
necessarily move from left to right or top to bottom. A form with a 
custom data entry order is shown below.
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Refer to the 4th Dimension Design Reference manual for information 
about changing the data entry order.

❿❿❿❿ To move forward in the data entry order:

■ Press the Tab key or the Enter key on the alphanumeric keyboard.

Note In a Text field, pressing the Enter key on the alphanumeric keyboard 
(Return key on Macintosh) ends the paragraph you are writing and 
moves the insertion point to the next line in the field. In this case, use 
the Tab key to move forward in the data entry order.

❿❿❿❿ To move backward in the data entry order:

■ Hold down the Shift key and press Tab or Enter.

❿❿❿❿ To select any enterable area:

■ Click in the area or tab into it using either Tab or Shift+Tab (or Enter). 

Accept Button When you are satisfied with your entry, you can accept the record. 
When you accept a record, you tell 4th Dimension to add the record 
to the database.

❿❿❿❿ To accept a record:

■ Click the Accept button. 
OR
Press the Enter key on the numeric keypad.

Note The default validation key can be modified in the application 
Preferences. Refer to the Design Reference manual for more information 
about this.

4th Dimension adds the record to the database.

Depending on the design of the input form, the Accept button may be 
represented in different ways. 

In multi-page forms, the fields on all the pages are part of the same 
record. In a multi-page form, clicking the Accept button on any page 
saves the entire record. Similarly, pressing the Enter key on the 
numeric keyboard while on any page saves the entire record.

Note 4th Dimension updates the data file stored on your hard disk at regular 
intervals. You can specify this interval using the application 
Preferences. See the 4th Dimension Design Reference manual for more 
information about setting Preferences.
574th Dimension User Reference



Chapter 3  Data Entry
Cancel Button If you decide you do not want to add a record to the database or save 
modifications to an existing record, you can cancel the entry. When 
you cancel an entry, the data you entered is not saved. If you were 
modifying an existing record when you canceled, 4th Dimension 
ignores the modifications. No changes are made to the record stored 
on disk.

❿❿❿❿ To cancel a record:

■ Click the Cancel button. 
OR
Press the Esc (Escape) key.

Note The default cancellation key can be modified in the application 
Preferences. Refer to the Design Reference manual for more information 
about this.

4th Dimension discards any data you have entered or modified for that 
record and displays the output form. 

Record Navigation 
Buttons

A form often contains buttons or icons for moving from one record to 
another. 4th Dimension automatically disables navigation buttons 
when appropriate. 

The four navigation buttons are: First Record, Last Record, Previous 
Record and Next Record.

Clicking any of these buttons accepts the current record and then 
moves to another record.

The following illustration shows record navigation buttons from one 
button style that is shipped with 4th Dimension.

First Record

Previous Record

Last Record

Next Record
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4D Server If a record to which you are attempting to move is being used by 
another user, 4D Client displays a message stating that the record is 
locked and you will be unable to modify it. The record remains locked 
while the other user is working with it. You will only be able to view 
the locked record until the other user frees it by clicking the Cancel or 
Accept button or by using the navigation buttons or icons to move to 
another record.

Page Navigation 
Buttons

An input form can consist of more than one page. Multi-page forms 
must provide some way for the user to move from one page to another. 
The database designer may use page navigation buttons. The four page 
navigation buttons are: First Page, Previous Page, Next Page and Last 
Page.

Clicking a page navigation button displays another page in the form 
but does not accept or cancel the record. 

Some forms contain the page navigation buttons shown below. You 
use these buttons to move to the previous or next page of the form.

Note Page navigation buttons are not added to all input forms automati-
cally. Your database may use other page navigation controls or not use 
multi-page input forms.

Delete Button An input form may have a Delete button. It is used to delete the record 
being displayed. Deleting a record cannot be undone. Before deleting 
the record, 4th Dimension displays a dialog box in which you can 
confirm or cancel the deletion. 

To delete the record, click the OK button.

Previous Page

Next Page
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Editing Data While you are entering or modifying data, you can edit the values you 
enter before accepting the record. Highlight the value you want to edit 
and use standard text editing techniques. You can use the Cut, Copy 
and Paste commands in the Edit menu to modify any entry. You can 
select text by double-clicking or dragging the insertion point over it.

If you make a typing error, you can press the Backspace key (Delete key 
on Macintosh keyboards) to backspace over the incorrect characters. 
You can also choose Undo from the Edit menu to undo your last 
action.

For more information about data entry, see the “Entering and 
Modifying Different Types of Data” section on page 60.

Interrupting Data 
Entry 

When you use an input or output form, you can choose any menu 
command that is not dimmed. For example, you can do a query, print 
a quick report or a set of labels, or graph data. 

If you choose a menu command while you are in the process of 
entering or modifying a record, 4th Dimension displays an alert box 
asking you whether you want to accept the record, discard the record, 
or cancel the menu selection and return to the record being entered.

Entering and Modifying Different Types of Data
Each field in a form has a field type that dictates the kind of data you 
can enter. Most fields are numeric or alphanumeric. You enter data in 
these fields simply by typing. Other types of fields accept data only in 
particular formats. 

Alpha, Numeric, Date and Time fields can have display formats 
associated with them. When you tab out of a field with a display 
format, 4th Dimension applies the format to the data you entered. For 
example, a salary field could have a format that displays a dollar sign 
($) and two decimal places. If you entered 100.500, tabbing out of the 
field would produce $100.50. 
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For more information about the available formats for each data type, 
refer to the 4th Dimension Design Reference manual.

Note The database designer can also use triggers, object methods, and form 
methods to process data as it is entered. These tools may be used to 
validate data, update the contents of other tables, or compute values of 
variables whenever data is saved or modified. The database designer 
may also use methods or triggers to provide customized feedback to 
the user. For more information about triggers, object methods, and 
form methods, see the 4th Dimension Design Reference manual.

Alpha Fields An Alpha field can contain alphanumeric characters (letters and num-
bers), punctuation marks, and special characters such as *, %, and {. 
The maximum length of an Alpha field is set in the Design environ-
ment. If you type more characters than the maximum allowed, the 
extra characters are truncated.

An entry filter can be associated with an Alpha field. An entry filter 
validates the entries that you type on a character-by-character basis. 
See the “Fields with an Entry Filter” section on page 71 for more 
information.

It is possible to automatically spell-check the text being entered in an 
Alpha field. For more information about this, please refer to the Design 
Reference manual. 

When an Alpha field contains a URL (string beginning with http:, ftp:, 
www. or mailto:), it is detected automatically; under Windows, it is 
displayed as blue and underlined:

You can Ctrl+click (Windows) or Command+clicK (Mac OS) the URL to 
execute it directly in your default Web browser. 

Numeric Fields 4th Dimension supports three types of numeric fields: 

■ Real: This type of field stores real numbers to ±1.7e±308 (15 digits).

■ Integer: This type of field stores integers from -32768 to 32767.

■ Long Integer: This type of field stores integers from -231 to 231 -1.

If you enter a decimal point and numbers to the right of the decimal in 
an Integer or Long Integer field, the number will be truncated. 
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Numeric fields do not store formatting characters such as the dollar 
sign or the comma. If you enter a formatting character, it is ignored. To 
format a numeric field, assign a display format to the field in the 
Design environment.

The only non-numeric characters which are taken into account when 
entered in a number field are the following:

Note In the United States, the decimal point (.) is used as the decimal 
separator in real numbers. Other countries use a different character 
such as the comma (,) as the decimal separator. When entering 
numbers in an international version of 4th Dimension, you should use 
the character specified by your operating system.

Text Fields A Text field functions like a text processor. It can hold up to 32,000 
characters. Text fields are used for entering long blocks of text such as 
notes or comments. A Text field can have a vertical scroll bar.

A Text field provides basic text editing features: scrolling, word wrap-
ping within the field, and double-clicking to select words. It also sup-
ports the use of the arrow keys and the standard cut, copy, and paste 
operations. Using the Enter key on the keyboard (or Return on Macin-
tosh), you can type a Carriage return into a Text field to form para-
graphs. If you press the Enter key (Return on Macintosh), the insertion 
point moves to the next line. You cannot insert Carriage returns in an 
Alpha field.

You cannot use tabs in a Text field. If you press the Tab key while in a 
Text field, the insertion point moves to the next enterable area in the 
data entry order.

4th Dimension lets you paste text into a text field. For example, you 
can paste the contents of a letter written in a word processor into a 
Text field. 

As an alternative, you can install the 4D Write word-processing plug-in 
in the database. 4D Write supports multiple fonts, font sizes, styles, 
text alignment, and integrated mail-merge. For more information 
about using 4D Write, refer to the documentation that comes with the 
4D Write plug-in.

Character Purpose Example
Decimal point (.) Used as the decimal separator 54.3321
“e” or “E” Used in scientific notation 1.1e5
Hyphen (-) Used for negative numbers -2090
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It is possible to automatically spell-check the text being entered in an 
Text field. For more information about this, please refer to the Design 
Reference manual. 

When a Text field contains a URL (string beginning with http:, ftp:, 
www. or mailto:), it is detected automatically; under Windows, it is 
displayed as blue and underlined. You can Ctrl+click (Windows) or 
Command+clicK (Mac OS) the URL to execute it directly in your 
default Web browser. 

Date Fields A Date field accepts any date entered in the format specified by your 
operating system — for example the month/day/year format 
(MM/DD/YYYY). 4th Dimension stores dates between the year 100 A.D. 
and the year 32,767. You can enter the year using either two or four 
digits. If you use two digits for the year:

■ 4th Dimension assumes the date is in the 20th century and adds “19” 
before the digits if the value is greater than or equal to 30. For 
example, for 01/25/97, 4D interprets the date as “January 25, 1997”. 
For 01/25/30, the date is interpreted as “January 25, 1930”.

■ 4th Dimension assumes the date is in the 21st century and adds “20” if 
the value is less than 30. For example, 4D interprets the date 01/25/07 
as “January 25, 2007”. The date 01/25/29 is interpreted as “January 25, 
2029”.

Note The default century can be changed programmatically using the SET 
DEFAULT CENTURY command.

The month, day, and year can be separated by any character except 
a number. Some example date entries are shown below. The results are 
shown in the format MM/DD/YYYY.

Note The United States specifies dates in the month/day/year 
(MM/DD/YYYY) format. Other countries use different formats, such as 
DD/MM/YYYY for British systems and YY/MM/DD for Swedish systems. 
When entering dates in 4th Dimension, you should use the format 
specified by your operating system.

Entry Result
6:23:95 6/23/1995
6/23/95 6/23/1995
6 23 1995 6/23/1995
6/23/1995 6/23/1995
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Time Fields A time can be entered in 12- or 24-hour format. The time is stored in 
hours/minutes/seconds format (HH:MM:SS). The entries can be 
separated by any character except a number. 

During data entry, 4th Dimension will attempt to interpret partial 
entries. For example, the entry “1 p” is interpreted as 1:00 PM or 
13:00:00. The “p” tells 4th Dimension to add 12 hours to the value you 
enter. The entry “6 a” is interpreted as 6:00 AM or 6:00:00. 

If you enter “36 3 7”, 4th Dimension interprets the entry as 
“36 hours 3 minutes 7 seconds.”

Some example time entries are as follows:

Boolean Fields A Boolean field takes on one of two values, TRUE or FALSE. A Boolean 
field is displayed as either a check box or a pair of radio buttons. 
Boolean fields can be in the data entry order. When a Boolean field is 
selected, it is outlined by a marquee on Windows (a border that 
surrounds the field).

4th Dimension interprets a check box that has been selected (checked) 
as a yes (TRUE) value and an empty box as a no (FALSE) value. If a 
Boolean field is displayed as a pair of radio buttons, the value of the 
Boolean field is TRUE if the first radio button is selected, and FALSE if 
the second is selected.

❿❿❿❿ To enter a value for a Boolean field displayed as a check box:

■ Click the check box to enter the value of TRUE for the field. 
If there is a marquee surrounding the check box, you can press the 
Space bar to toggle between checked and unchecked or type “Y”.

Entry Result
11 a 11:00:00
3 p 15:00:00
3h 11m 3:11:00
23:43 23:43:00
6:00:05 6:00:05
23 8 6 23:08:06
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❿❿❿❿ To enter a value for a Boolean field displayed as a pair of radio buttons:

■ Click on either radio button. 
If there is a marquee surrounding the radio button, you can press the 
Space bar to toggle between the two radio buttons or use the keyboard 
equivalents. 

The first letters of the labels for the radio buttons can be used as key-
board equivalents. For example, if the radio buttons are labeled “Male” 
and “Female,” you can use the “M” and “F” keys. Also, the “Y” and “N” 
keys can be used to enter values. Typing “Y” is equivalent to clicking 
the first radio button; typing “N” is equivalent to clicking the second 
radio button.

Picture Fields A Picture field accepts bitmapped or object-oriented graphics.

❿❿❿❿ To enter a picture into a Picture field:

1 Copy the picture to the Clipboard. 

2 Select the Picture field into which you want to paste the graphic. 
Select the field either by clicking or by using the Tab key.

3 Choose Paste from the Edit menu.
Graphics stored in a Picture field appear in one of the following display 
formats specified by the database designer:

■ Truncated (Centered and Non-centered): The boundaries of the 
Picture field act like a “cookie cutter” on the graphic that you paste 
into the field. If the format of the field is Truncated (Centered), the 
picture is centered in the field and any portions that do not fit in 
the field are cropped. If the format of the field is Truncated (Non-
centered), the upper-left corner of the picture is placed in the upper-
left corner of the field and any portions that do not fit in the field 
are cropped.

4th Dimension saves the entire picture, even if only a portion is 
shown on the input form. 

Truncated
(Centered)

Truncated
(Non-centered)
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If you print the form, only a portion of the picture will be printed 
unless the Print with Variable Frame check box has been selected for 
the Picture field. For more information about printing with a vari-
able frame, refer to the 4th Dimension Design Reference manual.

■ Scaled to Fit: In this display format, 4th Dimension resizes the 
graphic to fit the dimensions of the field area. Because 
4th Dimension may compress or elongate the graphic to fit the 
dimensions of the Picture field, the picture may appear distorted in 
the form.

■ Scaled to Fit (proportional and proportional centered): In this dis-
play format, the picture pasted into the form is reduced proportion-
ally on all sides to fit the area created for the picture. If the picture is 
smaller than the area defined in the form, the picture will not be 
modified. If you use Scaled to Fit Centered (Proportional) the image 
will be centered rather than occupying the top-left area. If the pic-
ture is bigger than the area defined in the form, the picture is pro-
portionally reduced, and will not appear distorted.

■ On Background: In this display format, the graphic pasted into 
the form is transparent — any object behind the pasted graphic is 
visible through the graphic. When a picture is displayed in this for-
mat, you can move the pasted picture around the inside of the pic-
ture field by dragging it. 

Scaled to fit centered (proportional)Scaled to fit (proportional)
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4th Dimension remembers the position of the picture after you save 
the record.

■ Replicated: When this format is applied, if the picture is smaller 
than the area, the picture pasted in the form is replicated as many 
times as necessary in order to fill the area entirely. 

Contrast of Background 
Pictures 

When the display format of the picture is On Background, you can 
modify the contrast between the picture and the background at any 
time.

❿❿❿❿ To change the contrast of a background picture:

1 Double-click the field.
The Choice of Mode palette appears.

2 Select one of the contrasts from the palette.
4th Dimension applies the new contrast to the picture.

The following illustration shows the effect of each Choice of Mode 
selection. The examples are arranged in the same position as the but-
tons in the Choice of Mode palette. Each illustration shows how the 
picture field appears when it is not selected for data entry.

Background picture

Replicated
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A variable that displays the name of the graphic is placed on top of the 
On Background picture. 

You can produce additional combinations by setting the foreground, 
background, and fill properties of the objects placed on top of or 
behind the On Background picture field.

QuickTime 
Compression 

Once you have placed a picture in a picture field, you may compress 
the field if Apple QuickTime® (version 4 minimum) is already installed 
on your machine. This option allows you to reduce the space used by 
images on your hard disk. 

In Design mode you can apply a “standard” compression to all images: 
simply check the Compression attribute for the picture field in the 
Design window of the database (for more information, refer to the 
4th Dimension Design Reference manual).

Additionally, you can apply specific compression settings to each 
image pasted within the Picture field, or just compress certain images.

❿❿❿❿ To apply specific compression settings to an image pasted in a picture 
field:

1 Copy the image to the Clipboard.

2 Press the Alt key (Windows) or Option key (Mac OS) and select the 
Paste command in the Edit menu.
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The QuickTime Compression Settings dialog box appears.

3 Select your settings and click OK.
The image will be saved using the settings you just selected regardless 
of the initial attributes of the picture field.

For more information on QuickTime compression, refer to the 
4th Dimension Design Reference manual.

Entering Data in Fields with Data Entry Controls
The database designer may have used certain standard data entry 
controls that restrict the values that can be entered into fields. The 
following standard data entry controls may be used:

■ Mandatory attribute,

■ Unique attribute,

■ Range of acceptable values,

■ Entry filters,

■ Choice lists.

These constraints affect the way in which 4th Dimension processes 
data and provides feedback to users. This section discusses how stan-
dard data entry controls affect data entry.

Note In addition, the database designer may enforce business rules program-
matically. In this case, the nature of the data entry constraint and the 
type of feedback provided to the user is under the control of the data-
base designer. For example, he or she can build in the same types of 
constraints but provide more specific user feedback or build highly cus-
tomized constraints. See your system administrator for information on 
custom data entry constraints.
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Mandatory Fields Mandatory fields contain data that is essential to the database such as a 
field that uniquely identifies each record in a table. Any field type can 
be given the Mandatory attribute. 

If a field is mandatory, you must enter a value for that field before 
the record can be accepted. If you do not enter a value into a manda-
tory field, 4th Dimension displays an alert box when you try to accept 
the record.

After you put away the alert box, you can enter a value into the manda-
tory field and accept the record. 4th Dimension will not let you accept 
the record until you have entered a value into the mandatory field.

Unique Fields A field with the Unique attribute accepts only entries that uniquely 
identify each record in the table. For example, the Unique attribute is 
usually assigned to the primary key field of a table such as a Social 
Security number or invoice number field.

When you enter a value into a unique field and press the Tab key, 
4th Dimension determines whether or not the entry is unique. If you 
enter a value that already exists, 4th Dimension displays an alert box 
that informs you that the key value has already been entered. 

You can then enter a new value.

Note You cannot enter more than one record with a null value in a unique 
field.
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Fields with a 
Validation Range

A validation range specifies the minimum and maximum values that 
may be entered in an area. If you enter a value above the maximum 
value or below the minimum value, 4th Dimension displays an alert 
box when you press the Tab key. The alert box will tell you the 
minimum or maximum value you have exceeded.

Fields with an Entry 
Filter

An entry filter is a data validation tool. It examines each character as it 
is typed. As you type, 4th Dimension compares each character you 
enter to the set of characters specified by the entry filter. If you type an 
invalid character, 4th Dimension rejects the character and does not 
display it on the screen. Invalid characters are disregarded and valid 
characters are displayed normally.

When a field with an entry filter is selected for data entry, the display 
format appears. In the following illustration, a telephone number field 
uses an entry filter and display format. The display format specifies 
parentheses surrounding the area code, a space after the closing paren-
thesis, and a dash between the third and fourth characters. The entry 
filter itself accepts only numeric characters.

When the field is selected, the first enterable position is highlighted. 
Notice that the parenthesis is for display only; it cannot be selected or 
edited.

As you type numbers, 4th Dimension accepts your entries. If you type 
an alphabetic character, the character is filtered out. As you type each 
number, the next enterable position is highlighted.
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If you want to delete a character, press Backspace (Delete on Macin-
tosh). An entry filter can also specify the maximum number of charac-
ters that can be entered in a particular field. When you enter the last 
character, the insertion point automatically moves to the next enter-
able area. You do not need to press the Tab key to move to the next 
field in the data entry order. For instance, entering a state abbreviation 
such as “CA” in a two-letter State field automatically moves the text 
insertion point to the next field in which you can enter data.

The cut, copy, and paste functions do not work normally if an entry 
filter is associated with an enterable area. You cannot cut or copy more 
than one character and you cannot paste into a field with an entry 
filter.

Fields with a Choice 
List

Moving the insertion point into a field with a choice list displays a list 
from which you can choose a value. The list is displayed in the 
choice list window. An example of a choice list window is shown 
below:

A choice list is often used to limit entries to specific values and prevent 
misspellings. For example, a Payment Type field in an Invoices database 
can be associated with a list of all the procedures used for payment. 

A list can also be used to exclude values from a field or require that only 
certain values be entered. Excluded lists contain values that are not 
acceptable. If you type a value that appears on an excluded list, an alert 
box will be displayed indicating that the value you typed is not allowed. 

❿❿❿❿ To enter data using a choice list:

1 Select the field for data entry by pressing Tab or clicking in the field.
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The choice list for the field appears.

2 Double-click the desired item to select and enter the item.
OR
Click the value you want to enter.
OR
If the list is sorted, type an entry.
OR
Use the Up and Down Arrow keys to highlight values on the list.
If you type an entry, the list scrolls to match the value you type. 

3 Press Enter on the alphanumeric keyboard (Return on Macintosh) to 
select a highlighted value. 
To cancel the entry, click Cancel or press the Tab or Esc key.

Modifying Choice 
Lists

A choice list can be designated as modifiable. In this case, the Modify 
button in the choice list window is enabled. If a list is modifiable, you 
can do the following: 

■ Add items to the list

■ Modify items on the list

■ Delete items

■ Sort the list alphabetically

❿❿❿❿ To modify a choice list:

1 Click the Modify button in the choice list window. 
The Items in List dialog box appears.
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The dialog box lists the items of the list. The buttons on the right side 
of the dialog box are used to modify the list.

Adding Items If the value you wish to enter is not in the list, you can add it to the 
list. You should do so if the item will be used again.

❿❿❿❿ To add items to the end of the list: 

1 Click the Append button.
4th Dimension adds an empty area below the last entry in the list and 
places the insertion point in it.

2 Type an item and press Tab or click outside the entry area to save your 
changes. 

Inserting Items If you insert an item rather than appending it, you can place it above a 
selected element.

❿❿❿❿ To insert an item in the list:

1 Click an item on the list.

2 Click the Insert button.
4th Dimension creates an entry area above the item you clicked on and 
places the insertion point in the entry area.

3 Type an item and press Tab or click outside the entry area to save your 
changes. 

Modifying Items You can also edit any item.

❿❿❿❿ To modify an item:

1 Alt+click (Option-click on Macintosh) the item you want to modify
OR 
Click twice on the item you want to modify.
The item becomes editable.

2 Edit the item as needed.

3 Press Tab or click outside the entry area to save your changes.

Deleting Items You can delete an item that is not appropriate for data entry.

❿❿❿❿ To delete an item:

1 Click the item in the list and click the Delete button.
4th Dimension deletes the item from the list and removes the space it 
occupied.
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Sorting the List You can sort the list to facilitate data entry.

❿❿❿❿ To sort the list:

1 Click the Order By button.
4th Dimension sorts the list alphabetically. Sorting the list allows you 
to select an item by typing.

Click OK to save the modified list, close the dialog box, and enter the 
selected item in the field. Or, click Cancel to discard any changes you 
made and close the dialog box.

Using Subforms
Some of your forms may contain subforms — forms from other tables 
or subtables that are nested within the current form. The current form 
in this context is sometimes called the parent form. 

Subforms provide a way for you to add data to a subtable or to a related 
table without switching tables or forms. Usually, subforms are shown 
as list areas included in the parent form. 

The commands for selecting, creating and modifying sub-records 
(records displayed in subforms) differ according to the property set for 
the subform in the Design mode. 

Subform

Current form

Selected subrecord
754th Dimension User Reference



Chapter 3  Data Entry
Selecting 
Subrecords

Three selection modes can be set for a subform in the Design mode:

■ None: In this case, it is not possible to select a subrecord. Clicking on 
the list has no effect unless the subform is “Enterable in List” (see 
below). Navigation keys will only allow you to scroll through the list. 

■ Single: In this case, only one record can be selected at a time. Clicking 
on a record highlights it. If you Ctrl+click (Windows) or Com-
mand+click (Mac OS) a record, it switches between a selected/dese-
lected state. The Up and Down arrow keys select the previous/next 
record in the list. The other navigation keys scroll through the list. 

■ Multiple: In this case, more than one record can be selected simulta-
neously. Clicking on a record highlights it. The Ctrl+click (Windows) 
or Command+click (Mac OS) and Shift+click combinations can be used 
to create multiple selections. The Up and Down arrow keys select the 
previous/next record in the list. The other navigation keys scroll 
through the list. 

Entering Data in 
Subforms

Data entry and modification can be carried out in different ways 
depending on the properties set for the subforms in the Design mode. 

Modification

■ If the Enterable in List property has been assigned to a subform, you 
can modify subrecord data directly in the list. To do this, just click on 
the field to be modified in order to switch to editing mode (click twice 
if the subrecord was not already highlighted). 
When you double-click a subrecord, you can display or modify its val-
ues in the detail form associated with the subform (unless double-click-
ing has been disabled, see below).

■ If the subform does not have the Enterable in List property, data entry 
must be carried out in the detail form associated with the subform. 
This form is automatically displayed when you double-click on a line 
of the subform (unless double-clicking has been disabled, see below).

Addition To add a subrecord, select the subform area then press the Ctrl+Shift+/ 
(Windows) or Command+Shift+/ (Mac OS) keys, or click on the add 
button of the subrecord (displayed as follows  by default). 

Note The shortcut used to add a subrecord can be modified in the 
application Preferences (for more information, refer to the Design 
Reference manual). 
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■ If the Enterable in List property has been assigned to a subform, a new 
blank line is added below the existing lines, ready for data entry. The 
subrecord is saved as soon as you tab out of the subform area, or when 
you click outside of this area. 

■ If the subform does not have the Enterable in List property, the detail 
form associated with the subform will be displayed blank. The sub-
record is saved as soon as you validate this detail form. 

Note If the subform belongs to a subtable, the new subrecord will only be 
saved when you have validated the parent record. 

Action in the Case of a 
Double-click

In the Design mode, it is possible to set the behavior of subforms in 
response to a double-click on a subrecord. The following behaviors can 
be set: 

■ Nothing happens: Double-clicking has been disabled (Do nothing 
option in the subform properties). 

■ The detail form associated with the subform is displayed, ready for data 
entry: Double-clicking causes the detail form to open with the page 
switched to editing mode (Edit Record option in the subform proper-
ties). 

■ You stay in the list form and the first field of the subrecord switches to edit-
ing mode: Double-clicking causes the list form to switch to editing 
mode (Edit Record and Enterable in List options in the subform proper-
ties). 

■ The detail form associated with the subform is displayed as read only: Dou-
ble-clicking lets you display the data in the detail form (Display Record 
option in the subform properties). 

Choosing Tables and Forms
In the User environment, you can switch between tables whenever you 
need to work with data in another table. For example, while entering 
data into a company table, you may need to look up a home telephone 
number stored in an employee table. 
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Each table can have many forms attached to it. You can create different 
forms to meet specific needs. For example, different report forms can 
be used for different types of reports and different forms can be used 
for different monitor sizes. In the User environment, you can switch 
between tables and forms at any time.

Each table has a current input form and a current output form. You 
specify a default input and output form in the Design environment for 
each table in the database. These forms are used unless you specify 
different forms in the User environment. 

To choose tables and forms in User mode, you must use the List of 
tables window. This window lets you change quickly from one table to 
another or from one form to another. 

You can choose a new table or a new form while you are using either 
an input or output form. Your choices are implemented immediately. 

Note The changes you make are temporary. The permanent selections are 
made using the Explorer in the Design environment.

❿❿❿❿ To choose a table using the List of Tables window:

1 If the List of Tables window is not visible, choose the Tables List 
command in the Records menu.

The List of Tables window moves to the front. 
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If necessary, use the scroll bar or the size box to view the names of 
additional tables.

Each table name in the List of Tables window is accompanied by two 
icons that represent input and output forms. The left icon represents 
input forms. The right icon represents output forms.

2 Click the name of the table in the List of Tables window.
4th Dimension displays the current selection for that table using 
the output form. 

❿❿❿❿ To change forms:

1 Click either the input or output icons next to a table name in the 
List of Tables window and hold down the mouse button.
A pop-up menu appears, listing the names of input or output forms 
belonging to that table. 

An underline in the pop-up menu indicates the current input or 
output form. 

2 Select the name of the form you want to specify as the current input 
or output form.
These settings will remain in effect until you replace them with others 
or until you exit the database.
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4 Selecting Records

You select records in your database to access information that you 
want to use. For example, you might search a database of contacts to 
look up the telephone number of a person you need to call or to select 
the people to whom you want to send product information.

In 4th Dimension, the group of records you have selected is called the 
current selection. The current selection can be any subset of records in a 
table — from no records up to all the records. For more information 
about the concept of the current selection, see “The Current Selection” 
section on page 22.

You can change the current selection by:

■ Selecting all records

■ Selecting a subset of records

■ Searching for records.

The current selection is the group of records on which operations are 
performed. For example, you can:

■ Sort the current selection

■ Perform a global update of records in the current selection

■ Print the records using a form or a quick report

■ Print labels

■ Graph data

■ Modify or delete records

■ Export records.

In other words, creating a current selection in a table is the first step in 
many other data management operations. 
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The title bar of the output form tells you how many records are in the 
current table and how many records from the table are in the current 
selection.

4D Server With 4D Client, only the number of records in the current selection is 
displayed.

Every table in a database has its own current selection. In a relational 
database, changing the current selection in one table can change the 
current selections in related tables. For example, in a database consisting 
of related [Employees] and [Departments] tables, a opening an input 
form in the [Departments] table changes the current selection in the 
[Employees] table. That is, the employees belonging to that department 
become the new current selection in the [Employees] table. For more 
information about relations, see the 4th Dimension Design Reference man-
ual.

If you are using several processes to perform database tasks, you can 
have several current selections for a table simultaneously. Each process 
acts like a separate 4th Dimension environment, allowing you to 
perform separate tasks. 

Table name

Number of records 
in current selection

Number of 
records in table
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The ability to have more than one current selection per table can be 
very useful, especially when comparing two or more subsets of records, 
such as the monthly invoices from several sales territories. For more 
information about processes, see the “Multi-tasking in 4th Dimension” 
section on page 24. For information about creating processes, refer to 
the 4th Dimension Design Reference manual.

Selecting All Records
When using an output form to display records, you can reset the 
current selection so that it contains all the records in the current table.

❿❿❿❿ To select all records:

1 Choose Show All from the Records menu or click the corresponding 
icon in the toolbar of the User mode.
All the records in the current table are placed in the current selection. 

Note Show All is dimmed if you are using an input form.

Selecting a Subset of Records 
You can create a new current selection directly in the output form by 
highlighting records and defining the highlighted records as the new 
current selection. 

❿❿❿❿ To create a subset:

1 Highlight one or more records.
Instructions for highlighting an adjacent or non-adjacent set of records 
is found in the “Highlighting” section on page 52.

2 Choose Show Subset from the Records menu or click the 
corresponding icon in the toolbar of the User mode.
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4th Dimension displays the new current selection in the output form.

Searching the Database
Searching is one of the most common database operations. It is often 
the most convenient way to select the records with which you want to 
work.

The term searching refers to finding a group of records in the database 
based on the contents of one or more fields. You perform a search by 
specifying a query. A query is the set of instructions that tells 
4th Dimension which records to include in the new current selection, 
such as “Company Name is equal to 4D.”

A query always has three elements: field name, comparison operator, and 
value. The field name is from the current table or a related table. The 
comparison operator tells 4th Dimension how to compare the contents 
of the field to the value you specify (equal to, greater than, less than, 
and so forth). The value specifies the number, string, or other value to 
which each record is compared. 
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Suppose you want to see all the records for employees with salaries 
greater than $30,000. The query you would use is “Salary is greater 
than 30000.” “Salary” is the field, “is greater than” is the comparison 
operator, and “30000” is the value.

When you search a database, 4th Dimension compares the contents of 
the field in the query to the value you specify. The new current selec-
tion is made up of records that satisfy the rules stated in the query. The 
new current selection can be no records, one record, a group of 
records, or all the records in the table.

You can perform a query while you are using either an input or an out-
put form. If you perform a query while you are using an input form, 
the first record in the new current selection is shown in the input 
form. You can view, modify, or print the record. If the new current 
selection consists of more than one record, you can move through the 
records using the navigation buttons (Previous Record, Next Record, 
First Record, Last Record). If you modify a record before pressing a nav-
igation button, 4th Dimension will save the modifications to disk.

In relational databases, you can search in fields from other tables, 
provided that a relation between the tables has been established. For 
more information about relations, see the 4th Dimension Design 
Reference manual.

If you do the query while using an output form, the new current selec-
tion is displayed in the output form. You can reset the current selection 
to all the records in the current table by choosing Show All from the 
Records menu.

Note If a field in the database structure is not used in the current database, 
the database designer can elect to hide the field by giving it the Invisi-
ble attribute. Only tables and fields which are visible appear in the 
Query editor. For information about making tables and fields invisible, 
refer to the 4th Dimension Design Reference manual.
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Indexed and 
Sequential Queries

4th Dimension can carry out queries very quickly if it has an ordered list of 
records to work from. An ordered list is called an index. An index is associated 
with a particular field and is stored on disk as part of the data file. 

A query that is performed without an index is slower than an indexed 
query because the program must start at the beginning of the table and 
examine each record until it finds the records that meet the criteria 
you have set. To be sure that it has found all the records you are 
looking for, it must examine every record in the table sequentially. 
This process is called a sequential search.

If an index is available, the program “knows” where the target records 
are located. If you are searching for everyone whose last name is Smith, 
the program will know where in the table the Smiths are located. Thus, 
it doesn’t need to examine every record in the table.

A good analogy for an index is a card catalog in a library. The card cat-
alog is an alphabetized list of all the books in the library. Each record 
in the catalog contains information about the book’s location. If you 
are looking for a particular book, it would be inefficient to conduct a 
sequential search of the library’s entire holdings. It is much faster to 
consult the card catalog, obtain the location of the book, and then 
search the particular shelf on which the book is stored.

When you are designing a database, you should index the fields that you 
are likely to use often for searching. As you enter or import records, 
4th Dimension automatically updates all indexes. When you do queries, 
4th Dimension automatically uses indexes if they are available.

Note 4th Dimension allows you to choose between two indexing modes, 
depending on how the index will be used. For more information, refer 
to the 4th Dimension Design Reference manual. 

Comparison 
Operators

When you write a query, you tell 4th Dimension how to compare the 
value you specify to the contents of the database. For example, the 
query, “Last Name equals ‘Smith’” uses the “is equal to” comparison 
operator. It tells 4th Dimension to compare the values in the Last Name 
field to the string “Smith.”

Comparisons involving alphanumeric values are not case-sensitive. A 
search on the last name “Smith” will find records containing “smith,” 
“SMITH,” “sMith,” and so on.
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The following comparison operators are available:

■ Is equal to - Is not equal to

■ Is greater than - Is greater than or equal to

■ Is less than - Is less than or equal to

■ Contains - Does not contain.

Note Queries using the Contains and Does Not Contain operators are always 
sequential queries.

Wildcard Character To make queries easier to specify, 4th Dimension has a wildcard 
character (@) that can replace one or more characters in a search 
involving an Alpha or Text field. For example, if you are looking for all 
occurrences of the name “Belmondo” in a field, you may specify the 
search value in several ways:

Simple and 
Compound Queries

You can search on one or more fields. A query on one field is called a 
simple query. For example, the search “Last name equals ‘Smith’” is a 
simple query. When you do a simple query, 4th Dimension examines 
the contents of one field when searching the database. 

A query on two or more fields is called a compound query. When you do 
a compound query, you combine separate queries using a conjunction 
operator. The conjunction operator tells 4th Dimension how to com-
bine the results of the individual queries. 

A search for: Finds
Bel@ All values beginning with “Bel”
@do All values ending with “do”
Bel@do1

1. In the Preferences dialog box, you can specify that 4th Dimension evalu-
ates the @ character (the “at” sign) as a literal character in searches or char-
acter string comparisons when it is found within a word (but not at the 
beginning or the end of a word). This option is particularly useful for data-
bases that store e-Mail addresses (which are usually “name@provider.com”). 
For more information, please refer to the 4th Dimension Design Reference 
manual. 

All values starting with “Bel” and ending with “do”
@elm@ All values containing “elm”
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There are three conjunction operators:

■ And: This operator finds all the records that meet the two conditions 
simultaneously. For example, the query “Find all the employees who 
work in the engineering department and who make over $50,000” will 
find the records of only those engineering employees who make over 
$50,000.

■ Or: This operator finds all the records that meet either of two simple 
queries. For example, the query “Find all the employees who work in 
the engineering department or who make over $50,000” will find the 
records of all the people in the engineering department, as well as all 
the people who make over $50,000 regardless of the department in 
which they work.

■ Except: This operator is the equivalent of “not.” The query “Find all 
the engineers except those who make over $50,000” will exclude the 
engineers making more than $50,000.

The conjunction operators let you create compound queries such as 
“Find the salespeople in New York or California and who have commis-
sion rates in excess of 30 per cent and who had sales volume less than 
$20,000.” 

The figure below shows this query being specified in the Query editor.
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When this query is executed, 4th Dimension finds all the New York 
and California salespeople who may be getting high commissions for 
low volume sales. Additional examples of the uses of comparison and 
conjunction operators are given for each search method.

Using the Query Commands
4th Dimension provides several powerful methods for searching a 
database. You can use any of the search methods to create a query. 
Records that meet the condition become the new current selection.

You can choose any search method when you are using either an input 
or output form.

The Records > Query menu provides four menu commands related to 
searching. Each menu command displays a different dialog box or win-
dow or provides different options. They differ in the types of queries 
they carry out and the way in which the current selection is displayed.

The four commands of this submenu represent four different search 
methods:

■ Query: This menu command displays the Query editor. It is a general-
purpose search dialog box that can be used to perform simple or 
compound queries. You can specify compound queries using the 
conjunctions. You can also save queries to disk and restrict the query 
to the current selection.

■ Query by Example: This menu command displays the current input 
form for use as a search window. You specify a query by typing the 
values for which you want to search in the areas corresponding to the 
fields to be searched. You can specify compound queries by typing 
values into more than one area. The results of your query are displayed 
in the current output form.

■ Query and Modify: This menu command is identical to the Query by 
Example menu command, the difference being that the first record of 
the selection from the query is loaded, ready to be modified. You can 
make changes and then browse among found records in order to 
modify them one by one.
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■ Query by Formula: This menu command displays the Formula editor. 
You use the Formula editor to construct a query that uses a formula as 
the query. For example, you can use Query by Formula to search on the 
last three digits of a six-digit part number. A valid formula returns a 
Boolean expression (TRUE or FALSE).

Query Editor The Query editor is a general-purpose editor that can be used to create 
simple or compound queries:

■ You can create compound searches linked with the And, Or, or Except 
conjunctions. For example, you can use the Query editor to perform a 
query for all employees who are over 60 years old or who have an 
income in excess of $45,000.

■ You have the choice of searching through the current selection of 
records or all the records in the table. The other three search methods 
always search the entire table. 

■ You can save queries to disk and open them when you want to repeat 
the query.

■ The Query editor remembers your last query. You can edit the query or 
clear it and enter a new query.

You can search in fields of the current table as well as fields of related 
tables. You can also search in subfields of the current table or subfields 
of related tables.

If your database includes subtables, you can use subfields in your que-
ries. A query on subrecords creates a new current selection of parent 
records, not subrecords. This group of parent records contains at least 
one subrecord that meets the query. 

However, the query does not remove the other subrecords from the 
parent record. All subrecords stay attached to their parent records.

Suppose a database for employees includes a subtable for information 
about employee children. The fields in the subtable, called subfields, 
are First Name, Middle Name, and Last Name. To find all the employ-
ees with a child named John involves searching the subrecords for 
John in the First Name subfield. 4th Dimension finds all the parent 
records with at least one subrecord with the name “John” in the first 
name subfield. In this case, the selection contains the parent records —
not just the subrecords themselves.
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If your database includes related tables, you can include fields from 
related tables in your query. A query on a field in a related Many table 
works like a search of subrecords. The new current selection in the One 
table consists of all records that are related to at least one record in the 
Many table that meets the query. Queries on related tables are always 
sequential, even if the field being searched in is indexed. 

For example, if employees are stored in the One table and children are 
stored in a related Many table instead of a subtable, a query for 
employees with children named John would produce the same current 
selection of employees.

The Query editor is shown below:

The Query editor contains the following areas:

■ Criteria area: This area displays the query as you create it or after you 
load it from a disk file.

■ Available Fields menu: This menu allows you to select the table or 
tables from which you want to display fields in the Fields list. You can 
display fields from the Master table, the Related tables, or All tables. 

■ Fields list: This area displays a hierarchical list of the fields in the 
selected table or tables. Indexed fields are shown in boldface.

Criteria area

Fields list

Conjunction buttons

Value area

Comparison 
Operator area

Available Fields menu
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■ Comparison Operator area: This area displays a list of comparison 
operators.

■ Conjunction buttons: This area contains three buttons that correspond 
to conjunction operators you can use to join the current simple query 
to the previous simple query.

■ Value area: You enter the value for which you want to search in this 
area.

■ Query in selection button: This button performs the query only on the 
records in the current selection.

■ Query editor buttons: You use this area to save your queries, load other 
queries from disk, cancel the query, or execute the query.

❿❿❿❿ To create a query:

1 Choose the subcommand Query > Query... from the Records menu or 
click the corresponding icon in the toolbar of the User mode.
4th Dimension displays the Query editor, highlighting the first row of 
the Criteria area. 

2 Click a field name in the Fields list1. 

1. If the desired field is in a related table, you need to display the fields of the 
related table. See the “Selecting a Field from Another Table” section on 
page 97.
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4th Dimension displays the field name in the Criteria area and adds the 
“is equal to” comparison operator, as shown below.

3 If you do not want to use the “is equal to” operator, click the desired 
comparison operator.

Your choices are:

■ Is equal to

■ Is not equal to

■ Is greater than

■ Is greater than or equal to

■ Is less than

■ Is less than or equal to

■ Contains (Alpha and Text fields only)

■ Does not contain (Alpha and Text fields only).

If you want to use the “starts with” comparison (on Alpha or Text 
fields only), see the “Using the “Begins With” Operator” section on 
page 97.

Field name
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4 Type the value you want to search for in the Value area.

In a Text or Alpha field you can use the wildcard character (@) at the 
end of the value to request a “Begins with” search.

If the field you selected is associated with a choice list, 4th Dimension 
displays the list and prompts you to select a value. If the field you 
selected is a Boolean field, 4th Dimension displays a pair of radio 
buttons. If the field you selected is a subtable, a window listing the 
subfields is displayed.

5 If you want to add another simple query, click Add Line.
4th Dimension adds a new line using the “And” conjunction operator.

6 If you want to use the “Or” or “Except” operator, click the desired 
conjunction operator button.

Value

Value area
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Repeat steps 2 through 4 to build the second simple query.

When you build a compound query, 4th Dimension evaluates the 
simple queries in the order in which they appear in the Query editor 
(i.e., from top to bottom). There is no precedence among the 
conjunctions. In other words, And does not have priority over Or. 
Therefore, if you use more than two simple queries when building the 
compound query, the order in which you enter the simple queries can 
affect the results of the query. 

If you need to add a third simple query, you can choose to either add 
the condition to the existing compound query or insert the new 
simple query between the first two simple queries. To add the new 
query to the end of the existing queries, click Add Line. To insert the 
new query, highlight the last query and click Insert Line. The new 
query is inserted above the line you highlighted.
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The following illustration shows the results of clicking Insert Line:

As you build the compound query, you can modify existing parts of 
the query by clicking the line you want to change and clicking a new 
field or operator, or typing a new value. For example, if you decided to 
replace the Salary search field with the Department field, you would 
select the second line and click the Department field.

You can remove a simple query by selecting the line and clicking 
Del Line. In a compound search condition, you can remove one line of 
the condition by clicking the Del Line button.

7 (Optional) To save the query to disk, click the Save button and enter a 
filename in the create-file dialog box.
You do not need to save your query to perform the search. 

8 Click Query to search the entire table. 
OR
Click Query in Selection to restrict the query to the current selection.

Click the Cancel button to put away the Query editor without doing a 
query.
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Selecting a Field from 
Another Table

You can use the Query editor to search in related tables and subtables. 
If the field you want to search is in a related table, choose Related 
Tables in the Available Fields menu, or select All Tables and expand the 
foreign key field in the master table to display fields from the related 
table. The illustration in the following set of instructions shows an 
expanded foreign key field. 

❿❿❿❿ To select a field from another table: 

1 Choose Related Tables from the Available Fields menu.

2 Expand the foreign key field by clicking the plus sign (on Windows) or 
arrow (on Macintosh) in the hierarchical list of fields.
The fields belonging to the related table appear in the hierarchical list.

3 Click the desired field in the related table.

4 Follow steps 3 through 7 at the beginning of this section for directions 
on creating the rest of the query.

Using the “Begins With” 
Operator

If you want to search for records that begin with a specified string, use 
the “is equal to” operator and enter the wildcard character (“@”) at the 
end of the value to search for. 

Foreign key field

Fields in related table

Available Fields menu
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For example, if you want to search for companies whose names begin 
with the string “Frame”, you would use the following query:

Saving a Query to Disk If you perform the same query often, you may want to save it to disk. 
When you save queries to disk, you only need to create them once. In 
subsequent uses of the Query editor, you can simply load the desired 
query from disk and click Query or Query in Selection to perform it.

❿❿❿❿ To save a query to disk:

1 Click the Save button.
4th Dimension displays a save-file dialog box where you can enter a 
filename. 

2 Click Save.
The query is saved to disk. The next time that you want to perform this 
query, you need only load the query into the Query editor.

Loading a Saved Query You can reuse a saved query at any time.

❿❿❿❿ To load a saved query:

1 Click the Load button.
4th Dimension displays an open-file dialog box.

2 Select and open the desired file.
4th Dimension loads your query into the Query editor. When you load 
a file, it replaces any query that previously appeared in the Query 
editor.
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Query by Example The Query by Example option is a convenient way to perform many 
queries. In this type of query, you use the current input form to enter 
values on which to base the search. You can only search in fields of the 
current table. Query by Example performs both indexed and sequential 
queries.

The Query by Example window shown is just an example. Your current 
input form is always used as the Query by Example window. The cursor 
changes to an eye  when it passes over a button, in order to indicate 
that the form is being used for a query. You can control the appearance 
of the Query by Example window by changing the current input form 
using either of the methods described in Chapter 3.

You can use comparison operators in Query by Example. For example, 
to use the “is equal to” comparison operator, enter the value to be 
searched for in the appropriate field. If you need a different compari-
son operator, precede the value with one of the following signs:

Comparison Operator Sign Example
is not equal to # #Marketing
is greater than > >30000
is greater than or equal to >= >=30000
is less than < <30000
is less than or equal to <= <=30000
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You can request a “Begins with” query by placing the wildcard 
character (@) after the value to be searched for. The following figure 
shows the Query by Example window being used to search for all com-
panies whose names begin with “S”.

You can create a compound query by typing values into more than one 
field. If you enter a compound query, the And conjunction is assumed 
(e.g., “Name starts with “S” and is in California”). The following Query 
by Example window illustrates a compound query:
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❿❿❿❿ To use Query by Example:

1 Choose Query > Query by Example from the Records menu.
4th Dimension displays the input form for the current table as a Query 
By Example window. Only the Accept and Cancel buttons are enabled.

2 Enter a value to search for in a field. 
For example, to find records for everyone with the last name “Smith,” 
you would enter “Smith” in the Last Name field.

To use a comparison operator, precede the value by the comparison 
operator. To do a “begins with” search, follow the value by the “@” 
symbol.

3 To perform a compound query, enter values in additional fields. 
4th Dimension uses the And conjunction if you enter values for more 
than one field. 

4 Click the Accept button or press the Enter key on the numeric keypad 
to do the query. 
To cancel the query, click the Cancel button or use the Escape key (or 
Esc key on Mac OS).

Query and Modify The Query and Modify command is intended for quickly finding and 
modifying records. Like Query by Example, it uses the current input 
form as a query window. You specify the query in exactly the same way 
as with Query by Example.

When a record or selection of records is found, 4th Dimension displays 
the first record in the input form for modification. When you accept 
the record, you are returned to the output form.

■ Using Query and Modify, found records are displayed in the current 
output form. All records within the new selection are simultaneously 
displayed.

■ Using Query and Modify, the current record of the new selection is also 
displayed in the current input form. Thus, you can directly replace the 
values as desired.

If the new selection contains several records, you can click on the 
navigation buttons in the import form to scroll through each record 
and modify the values one by one.
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❿❿❿❿ To use Query and Modify:

1 Choose Query > Query and Modify from the Records menu.
4th Dimension displays the current input form as a query window. 
Only the Accept and Cancel buttons are enabled.

2 Click the entry area for the first field in which you want to search. 

3 Enter a value in the criteria entry area. 
For example, to find records for everyone with the last name “Smith,” 
you would enter “Smith” in the Last Name field.

To use a comparison operator, precede the value by the comparison 
operator. To do a “begins with” query, follow the value by the “@” 
symbol.

4 To perform a compound query, enter values in additional fields. 
4th Dimension uses the And conjunction if you enter values for more 
than one field. For Alpha fields, you can also use the wildcard character 
(@) to perform a “Begins with” search. For example, entering 
“ACME@” in the Company area requests a search of all companies 
whose name begins with ACME.

5 Click the Accept button or press the Enter key on the numeric keypad 
to begin the search. 
4th Dimension performs the query, sets the current selection, and 
displays the first record that meets the search criteria in the input form. 

6 Modify the records using standard text editing methods.

7 Click the navigation icons to move to other records in the current 
selection. 
OR
Click the Accept button or press the Enter key on the numeric keypad 
to accept the modified record and return to the output form.
4th Dimension saves each record as you move to another record.

Click the Cancel button to end the editing session — you do not have 
to modify every record in the current selection. 

4th Dimension displays the output form.
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Query by Formula Use the Query by Formula editor to find records based on the results of a 
calculation or data manipulation. You use the Formula editor to write 
the expression based on which the query will be performed. The 
expression you write must equal either TRUE or FALSE for each record. 
You can use any function in the language as well as any project methods 
specifically designated by the developer.

The Query by Formula command is useful for writing queries that 
involve operations such as the following:

■ Performing operations or evaluations on alphanumeric strings

■ Searching in the results of date computations

■ Searching in the results of arithmetic computations.

Here are some examples of the uses of the Query by Formula editor.

▼ The following formula is used to search for records in which the last 
seven characters of the Phone number field are equal to “2524444.”

Substring ([Emp]Phone number;4;7) ="2524444"

▼ The following formula finds people born on the current date regardless 
of the year:

(Day of (Current date) = Day of ([Emp]Birthdate)) & 
(Month of (Current date) = Month of ([Emp]Birthdate))

▼ The following formula divides annual sales by the cost of living and 
finds records whose calculated value is greater than 1,000:

([Stats]Annual Sales / [Stats]CostOfLiving) > 1000

However, the formula

[Stats]Annual Sales / [Stats]CostOfLiving

is incorrect because it returns a numeric value, not TRUE or FALSE. 

Formula Length You can only write formulas that are one logical line long. That is, you 
cannot press the Enter key on the keyboard (Return key on Macintosh) 
and write a second line. The editing area, however, will wrap to the 
next line if the statement is too long.

If you need to use a formula that is more than one line, write it as a 
project method and use this method in the formula.
1034th Dimension User Reference



Chapter 4  Selecting Records
Using the Char Function If you are searching for a character using the Char function, you must 
use Macintosh ASCII codes. For a detailed discussion of the Char 
function, and a list of Macintosh and Windows ASCII codes, refer to 
the 4th Dimension Language Reference.

Saving Formulas You can save formulas to disk and load saved formulas into the 
Formula editor.

Using the Query by 
Formula Editor

The Query by Formula editor enables you to create and use formulas to 
retrieve records. The following figure shows a query (search) formula in 
the Formula editor. 

For a detailed description of the Formula editor, see the “Global 
Updates” section on page 113.

❿❿❿❿ To use the Query by Formula editor:

1 Choose Query > Query by Formula from the Records menu.

2 Use the Formula editor to build a formula. 
OR
Select the name of a user-written function from the Commands area.
OR
Click the Load button to retrieve an existing formula from disk.

The expression you write must equal either TRUE or FALSE for each 
record.

Note You can resize the Formula editor window by clicking on its lower 
right-hand corner.
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If you build a formula in the Formula editor, you can either type your 
function or use the list of operators and functions.
As you enter values, the editor checks the syntax used. If any syntax 
errors occur, a message describing the error will appear in the window.

If you click the Load button, 4th Dimension displays an open-file 
dialog box where you can select a file. When you load a file, it replaces 
any formula that appears in the Formula editor.

❿❿❿❿ To save a new formula to disk:

1 Click the Save button.
4th Dimension displays a dialog box and asks you to enter a filename 
for the new formula. 

Note On Windows, the file extension for a formula file is “.4FR.”

2 Click Save to save the formula.
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This chapter discusses the major operations you perform when 
working with data. This includes the following:

■ Adding records

■ Modifying records

■ Updating records

■ Deleting records.

After you create a database in the Design environment, you can switch 
to the User environment and begin adding records. To add records to 
the database, you need only to create a table and one or more fields. 
You can then switch to the User environment, begin entering data, and 
return to the Design environment to add tables, fields, forms, meth-
ods, or to make any other changes you like.

After adding records to your database, you will usually need to modify 
the information. If you need to modify one or more records, you can 
use one of the record selection methods described in Chapter 4 to 
display them. You can then modify them using either the input or 
output form.

Sometimes you need to make exactly the same change to a group of 
records in a table. This is called a global update. In 4th Dimension, you 
can update the current selection of a table automatically — without 
having to make the change to each record individually.

You may also find that you need to delete one or more records. You can 
delete a record if you discover it is outdated or irrelevant. If the record 
is needed but the values stored in it are no longer correct, you should 
modify the record rather than deleting it. You can delete the current 
record from an input form or you can delete a subset of records in the 
current selection using the output form.
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Adding New Records
You can add records using either an input or output form. For a 
description of the basic operations you use to work with input and 
output forms, see Chapter 3.

Input Forms To add a new record using an input form:

1 Choose New Record from the Records menu.
You can choose New Record while you are using either an input or 
output form.

4th Dimension displays a blank input form and places the insertion 
point in the first enterable area in the form.

2 Enter data into the first enterable area.

3 Press Tab.
4th Dimension moves the insertion point to the next enterable area.

4 Enter data into this area.

5 Press Tab.
Repeat the process of entering data into each enterable area until all 
data for that record has been entered.

When you have finished entering data and are satisfied with the values 
you have entered, you can accept the record. 
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6 Press the Enter key on the numeric keypad1 or click the OK button on 
the input form to accept the record. 

By accepting the record, you are requesting that 4th Dimension add 
the record to the database stored on disk.

After you press enter, a new blank input form is displayed.

7 Repeat the data entry process until you want to stop.

8 When you finish entering data, click the Cancel button on the form or 
use the Esc key when the next blank record is displayed. 
Either of these actions displays the output form.

Output Forms You can also add records directly in the Output form. Keep in mind 
that in this case you cannot enter data into variables, fields from other 
tables, or subforms.

❿❿❿❿ To add a new record using an output form:

1 Choose New Record in List from the Records menu.
An insertion point appears in the first field below the last record dis-
played in the output form. 

1. Keyboard assignments can be modified in the application Preferences.
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2 Type in the field and use the Tab or Enter key to move through the 
fields for that record. 

Note Use Shift+Tab or Shift+Enter to move in the reverse direction among 
the fields of the records. 

Any data validation controls that are attached to the fields of the 
output form will be used when you select those fields. For example, a 
field with a choice list will display the choice list when you tab into it.

3 Press the Enter key on the numeric keypad to save the new record and 
create a new blank record. 
OR
Click a field in another record.
4th Dimension accepts the entries in the record you added.

Modifying Records
You modify records when you need to update information or when 
you discover that the information originally entered is incorrect. 
Before modifying a group of records, select the records to modify as the 
current selection. You can search to select records for modification or 
select the records after highlighting them in the output form. 

For information about selecting records and searching the contents of 
a database, refer to Chapter 4. 

Firefly’s job title being 
entered in List mode
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You can modify records using either the input or output form. The 
output form is convenient for modifying a group of records because 
several records are displayed at the same time. However, the output 
form typically does not include all the fields of the input form and 
may not duplicate the input form’s data entry controls. 

If a record is being modified in another process, the record is said to be 
locked. Locked records can be viewed, but they cannot be modified. If you 
open a locked record, you will be able to view the entries in the fields, but 
you will not be able to change any data. For a general description of 
processes, see the “Multi-tasking in 4th Dimension” section on page 24. 
For a more detailed discussion of what processes are and how to create 
them, refer to the 4th Dimension Design Reference manual.

4D Server In 4D Server, record locking also occurs when a record is being modi-
fied by another user.

Input Forms You ordinarily enter and modify data using input forms. 

❿❿❿❿ To modify records using an input form:

1 Double-click the record on the output form.
OR
Highlight a record in the output form and choose Modify Record from 
the Records menu.
4th Dimension displays the record in the default input form.
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2 Select certain fields and edit, replace, or delete the values. 
See Chapter 3 for more information about editing data.

3 Click the OK button or press the Enter key on the numeric keypad to 
accept the modified record and return to the output form. 
OR
Click a navigation button (Previous Record, First Record, Next Record, 
Last Record) to accept the record and move to another record in the 
current selection.
Clicking a navigation button moves between records in the current 
selection. 

You can cancel your changes and return to the output form at any time 
by clicking the Cancel button or hitting the Esc key.

Output Forms You can modify the fields displayed directly in the output form. Keep 
in mind that in this case you cannot enter data into variables, fields 
from other tables, or subforms.

❿❿❿❿ To modify records using an output form:

1 Select a record then click on the field to be modified.

Middle initial is added 
to First Name field
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The field in the output form becomes enterable.

Note You can choose Modify Record from the Records menu at any time in 
order to modify the record in the input form.

2 Type the new text and press Tab or the Enter key on the keyboard. 
In the example shown above, typing will replace the job title with a 
new value. 4th Dimension saves your changes to a field when you press 
Tab or Enter (Return on Macintosh) and selects the next field.

3 Continue modifying fields as needed.

4 Click twice on a field in another record of the output form to modify 
it.

Global Updates
You do a global update when you want to make a specific change to a 
group of records. You perform a global update to automate changes to 
a group of records that would otherwise be tedious and time-
consuming. For example, you would perform a global update if you 
wanted to do the following:

■ Change all prices in an Inventory table by a certain percentage,

■ Format a numeric or Alpha field.

The global update is done by “applying” a formula to the current 
selection of records. In other words, the formula is used to make the 
change to each record in the current selection.

Job title field 
selected
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Here are some example formulas and explanations of the functions 
they perform. 

▼ The following formula multiplies the Salary field by 1.05. It could be 
used, for example, when a salary increase goes into effect.

[Emp]Salary := [Emp]Salary * 1.05

▼ The following uses a built-in function to make the contents of the 
State field uppercase. It ensures uniformity in the way State appears in 
labels and reports. 

[Customer]State := Uppercase ([Customer]State)

▼ This formula includes a user-written function that formats the 
Last Name field. It sets the first letter of the Last Name field to upper-
case and all the remaining letters to lowercase. 

[Emp]Last Name := Capitalize ([Emp]Last Name)

The ability to include user-written functions when carrying out global 
updates is a powerful feature of 4th Dimension. For security reasons, 
only project methods that are designated explicitly beforehand by the 
developer can be used in formulas. 

To perform a global update, you use the Formula editor to write a for-
mula that is applied to each record in the current selection.

You can use 4th Dimension’s built-in language as well as project meth-
ods (declared “usable” in formulas by the developer) to create formu-
las. For more information about creating methods, see the 
4th Dimension Design Reference manual. See the 4th Dimension Language 
Reference manual for detailed information about programming and the 
syntax to be applied to your formulas.
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Formula Editor The Formula editor provides many shortcuts for writing formulas. You 
can click field names, operators and commands, as well as any project 
methods, to add them to the formula. You can also drag and drop items 
into the editing area.

The Formula editor contains the following areas:

■ List of tables and fields: This area displays the fields of the table. The 
menu located above the list lets you set the fields to be displayed. You 
can use fields of the current table, those of related tables or those of all 
the tables.

Note Only visible tables and fields appear in the list. For information about 
making tables and fields invisible, refer to the 4th Dimension Design 
Reference manual.

■ Operators list: The operators list lets you choose the operators to be 
used in the formula. The operators are grouped into themes found in 
the menu located above the list:

Editing area

Operators list

Commands list

List of tables and 
fields
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Each theme displays all the available operators for the corresponding 
type of data or operation. For example, the assignment operator := is 
available for all data types. 
For a description of each operator, refer to the following paragraph. 

■ Commands list: The commands list contains the 4D functions that can 
be used in formulas, as well as any project methods allowed by the 
developer. The menu located above the list lets you display the com-
mands by theme or by alphabetical order. Refer to the 4th Dimension 
Language Reference manual for a description of the 4D commands that 
appear in this menu. 

Note In principle, project methods that can be used in formulas must be 
declared beforehand using the 4D SET ALLOWED METHODS command. 
However, by default, the Designer and Administrator of the database 
have complete access to the 4D commands and user methods in the 
Formula editor. It is also possible to completely disable access control 
for all users. These options are set via the Preferences of the application 
(for more information, please refer to the Design Reference manual). 

Formula Operators Here is a brief description of the different operators available in the 
Formula editor. For a more detailed description of the possibilities 
provided by these operators, refer to the “Operators” chapter of the 
4th Dimension Language Reference manual. 

String Operators A and B are character strings; N is a number. 

Operator Use Description

:= Assignment A:=B Assigns the value B to A
+ Concatenation A+B Returns AB
* Repetition A*N Repeats the value of A N times
[[ ]] Indexes [[A]]N Returns the Nth character of A
"" Empty string "" Inserts a pair of quotation marks
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Numeric Operators X and Y are numbers.

Note The modulo % operator returns significant values with numbers 
belonging to the long integer category (from -2^31 to +2^31 minus 1). 
To calculate the modulo of numbers outside of this interval, use the 
Mod command. 

Date Operators D1 and D2 are dates; N is a number.

Operator Use Description

:= Assignment X:=Y Assigns the value Y to X
+ Addition X+Y Returns X plus Y
- Subtraction X-Y Returns X minus Y
* Multiplication X*Y Returns X multiplied by Y
/ Division X/Y Returns X divided by Y
\ Integer Division X\Y Returns the integer division of X by Y 

(X and Y must be integers)
% Modulo X%Y Divides X by Y and returns the remainder
^ Exponentiation X^Y Returns X to the power of Y

Operator Use Description

:= Assignment D1:=D2 Assigns the value D2 to D1
+ Addition D1+N Returns D1 plus N days
- Difference D1-D2 or

D1-N
Returns the number of days between D1 and 
D2
Returns D1 minus N days

!//! Blank date !00/00/00! Inserts a blank date
1174th Dimension User Reference



Chapter 5  Working with Records
Time Operators H1 and H2 are times; N is a number.

Comparison Operators Z1 and Z2 can be of the string, numeric, date or time type. 

Logical Operators B1 and B2 must be Booleans (expressions that are TRUE or FALSE).

Operator Use Description

:= Assignment H1:=H2 Assigns the value H2 to H1
+ Addition H1+H2 or

H1+N
Returns H1 plus H2
Returns H1 plus N seconds, expressed in sec-
onds elapsed since midnight

- Subtraction H1-H2 or
H1-N

Returns H1 minus H2
Returns H1 minus N seconds, expressed in 
seconds elapsed since midnight

* Multiplication H1*N Returns H1 multiplied by N, expressed in 
seconds elapsed since midnight

/ Division H1/N Returns H1 divided by N, expressed in sec-
onds elapsed since midnight

\ Integer 
Division

H1\N Returns the integer division of H1 by N, 
expressed in seconds elapsed since midnight

% Modulo H1%N Divides H1 by N and returns the remainder
?::? Blank hour ?00:00:00? Inserts a blank hour

Operator Use Description

= Equal Z1=Z2 Returns True if Z1 equals Z2
# Not equal Z1#Z2 Returns True if Z1 does not equal Z2
> Greater than Z1>D Returns True if Z1 is greater than Z2
>= Greater 
than or equal 
to

Z1>=Z2 Returns True if Z1 is greater than or equal to 
Z2

< Less than Z1<Z2 Returns True if Z1 is less than Z2
<= Less than or 
equal to

Z1<=Z2 Returns True if Z1 is less than or equal to Z2

Operator Use Description

& AND B1 & B2 Returns True if B1 is True and B2 is True
| OR B1 | B2 Returns True if B1 is True or B2 is True
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Applying a Formula You can build a formula by clicking fields, operators and commands or 
methods that you wish to use. When you click an item, it automati-
cally appears in the Editing area, where you can modify it with stan-
dard cut, copy, and paste techniques. You can also type directly into 
the Editing area or add items using drag and drop.

A formula can be only one logical line long. You cannot press Return 
and type another line. However, methods declared usable in the 
Formula editor can be many lines long.

❿❿❿❿ To perform a global update by applying a formula:

1 Set the current selection to the records to be updated. 
For more information about setting the current selection, refer to 
Chapter 4.

2 Choose Apply Formula from the Records menu.

3 Use the Formula editor to build the formula. 
For more information, refer to “Formula Editor” paragraph on 
page 115. 

OR
Click the Load button to retrieve an existing formula from disk.

■ To add a field to the formula, double-click a field name or drag the 
field name from the Fields list to the editing area. If the field is in a 
related table, first expand the foreign key field to display the list of 
related fields. A foreign key field has a plus sign (on Windows) or 
arrow (on Macintosh) indicating that it can be expanded.

■ To add an operator to the formula, click an operator button.

■ To add a command or project method to the formula, click the 
command or method.

If you click the Load button, 4th Dimension displays an open-file 
dialog box so that you can select a file (“.4FR” file extension on 
Windows). When you load a file, it replaces any formula that currently 
appears in the Formula editor.

After you load a formula, you can modify it in the editing area.

4 (Optional) If you want to save a new formula to disk, click the Save 
button.
4th Dimension displays a create-file dialog box and asks you to name 
the file in order to store the new formula.

5 Click OK to apply the formula to the current selection.
1194th Dimension User Reference



Chapter 5  Working with Records
4th Dimension closes the editor and applies the formula to the records 
in the current selection.

Click the Cancel button to close the editor and return to the output 
form without applying the formula.

Deleting Records
You may want to delete a record that is outdated or no longer neces-
sary. If the record is needed but the values stored in the record are 
incorrect, you should modify the record rather than delete it. 

You can delete records in two ways:

■ Delete records individually from the input form,

■ Delete one or more record(s) from the output form.

Deleting records is permanent and cannot be undone. When you 
delete records, 4th Dimension displays a dialog box asking you to 
confirm the deletion.

Deleting Records 
Using the Input 
Form

Deleting records from the input form lets you verify the contents of 
each record before you delete it. 

❿❿❿❿ To delete records using the input form:

1 Use a query or a navigation button to select and then open the record 
you want to delete.

2 Click the Delete button to delete the record. 
Depending on the design of the input form, the Delete button may be 
represented in different ways.

When you click the Delete button, 4th Dimension asks you to confirm 
the deletion. You cannot undo the deletion after 4th Dimension 
removes the record.

3 Click the Yes button to complete the deletion. 
4th Dimension removes the current record from the database and 
returns to the output form.
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Deleting Records 
Using the Output 
Form

Using the output form, you can delete several records in one opera-
tion. The records to be deleted must be highlighted in the output form. 
You can select records that you want to delete by clicking them or by 
doing a query.

❿❿❿❿ To delete records using the output form:

1 Highlight the record or records that you want to delete. 

Note If you want to delete all the records in the table, choose Show All from 
the Records menu and Select All from the Edit menu.

Highlighting records is described in the “Highlighting” section on 
page 52.

2 Choose Clear from the Edit menu.
4th Dimension displays a dialog box asking you to confirm the 
deletion. You cannot undo a deletion.

3 Click the Yes button to complete the deletion. 
4th Dimension removes the highlighted record or records from the 
database.
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Deleting Locked 
Records

You cannot delete locked records. Records are locked when they are 
being used by another process. For instance, if a process opens a record 
for modification, 4th Dimension locks that record so that other pro-
cesses cannot modify it.

4D Server Records are also locked when they are being used by another user.

Before deleting records, you create a selection of the records you want 
to delete. If your selection includes any locked records, the deletion 
will proceed but the locked records will not be deleted and will remain 
in the current selection after the deletion. You must wait until these 
records are unlocked (i.e., no longer being used) to delete them.

Records Deleted in 
Another Process

The current selection may be altered by records being deleted in 
another process. For example, while you are working in your database, 
you might start another process that deletes certain records from a 
table. The records deleted in that process are permanently removed 
from the table. However, the records you see while working with the 
database in the User environment may not reflect those changes to the 
table until a new selection of records is created. 

To illustrate this point, suppose that a table contains fifty records and 
that all of the records are in the current selection. At this point, the 
title bar of the output form says that “50 of 50” records are selected. If 
one of the records is deleted in another process, the title bar changes to 
say that “50 of 49” records are selected. There now appears to be more 
records in the current selection than in the table! The title bar will be 
updated when you change your current selection.

If you attempt to modify or delete the deleted record, a dialog box will 
appear saying that the record has been deleted.

4D Server Records deleted by another user have the same effect on the current 
selection. The records are deleted from the table, but not from the cur-
rent selection. Thus, the current selection may appear to contain more 
records than actually exist in the table.
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A sort reorders records according to the values in the table. It is 
common to sort records:

■ To view records on screen in a particular order

■ Before printing a report or labels

■ Before graphing data.

As you enter data into a new database, 4th Dimension stores the 
records in the order in which they were entered or imported. When 
you list records in an output form or print records, they appear in this 
order. Often, you want to view records in another order. For example, 
you might want to alphabetize a list of names in a report — a sort on 
the Last Name field reorders the records alphabetically by Last Name.

A sort can be done while you are using an input or output form. If you 
sort from an input form, the first record in the new sort order is 
displayed in the input form. Otherwise, the sorted records are 
displayed in the output form. 

4th Dimension conducts indexed sorts very quickly. If you are sorting 
only one field and that field is indexed, 4th Dimension uses the index.
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Sort Levels
You can sort records in up to 30 different fields or formulas. Each field 
or formula you sort is referred to as a sort level. For example, the results 
of a two-level ascending sort of the last name and first name fields 
would produce a list such as this: 

Aardvark, Anthony
Aardvark, Artemis
Aardvark, Arthur
.
.
Zygote, Elena
Zymosian, Elmer

When sorting the contents of fields, 4th Dimension is not case 
sensitive (i.e., “Smith” = “smith”) or diacritical sensitive (i.e., “Aá” = 
“Aa”).

Note If you are using an international version of 4th Dimension and your 
operating system is diacritical sensitive (e.g., “Aá” ≠ “Aa”), sorting 
operations will also take diacritical marks into account. 

Ascending and Descending Order
You can specify either an ascending or descending order for each field or 
formula that you are sorting. Sorting from A to Z or smallest to largest is 
known as an ascending sort. Sorting in the reverse order is called 
a descending sort — largest to smallest, latest to earliest, and Z to A.

If you are sorting more than one level, you can freely mix ascending 
and descending sort orders. A multiple-level sort can mix fields and 
formulas, and ascending and descending sort orders.
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The Order By Editor
You can sort the records in the current selection by using the Order By 
command in the Records menu or by clicking on the corresponding 
button in the toolbar in User mode. Sorting the current selection 
changes the order in which records are displayed or printed. This is a 
temporary sort; it does not affect the order in which the records are 
stored on disk. 

When you choose Order By, the Order By editor enables you to specify 
the sort you want to perform.

The Order By editor contains the following areas:

■ Fields list: This area displays a hierarchical list of fields in the current 
table. Indexed fields are shown in boldface. You can sort on fields from 
subtables and related tables (provided the relation is automatic). To use 
a field from a related table or subtable, expand the foreign key field by 
clicking on the plus sign (on Windows) or arrow (on Macintosh) to dis-
play the fields from the related table. 

Note Only tables and fields that are visible appear in the Order By editor. For 
information about making tables or fields invisible, refer to the 
4th Dimension Design Reference manual.

■ Sort area: This area displays the sort fields or sort formulas and the 
direction of each sort. The arrows on the right of this area are used to 
specify an ascending or descending sort.

Fields list

Sort area

Indexed field 
shown in bold

Foreign key field
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■ Button panel: The Button panel has buttons for adding or removing 
fields from the Sort list.

■ Add Formula button: You use the Add Formula button to write a for-
mula as one of the sort criteria. You use a formula when you want to 
sort something that is not a field — such as a calculated value or a por-
tion of a field. For instance, you might sort a calculated failure rate for 
parts or the last four digits of a Part Number field.

■ Modify button: When you click the Modify button, it displays the 
selected sort criterion in the Formula editor. If the selected criterion is a 
formula, the formula is presented for editing. If the criterion is a field, 
the field name appears in the editing window of the Formula editor.

■ Cancel button: You use this button to cancel the sort and return to the 
form you were using.

■ Order By button: You use this button to perform the sort.

Note The Quick Report editor can sort records that appear in a quick report. 
For more information about the Quick Report editor, see Chapter 9. 

Sorting a Selection
Use the Order By menu command to sort the current selection of 
records. This sort is temporary and applies only to the current selec-
tion; it does not affect the order in which records are stored in the 
database. The Order By command is commonly used immediately after 
a query and before printing a report or labels.

Note You can carry out a permanent sort of table records using the 4D Tools 
utility, which is supplied with 4th Dimension and 4D Server. For more 
information about this point, refer to the documentation for 4D Tools. 

❿❿❿❿ To sort the current selection:

1 Choose Order by from the Records menu or click on the 
corresponding button of the toolbar in the User mode.

Adds selected field to Sort list

Removes all fields from Sort list

Removes selected field from Sort list
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4th Dimension displays the Order By editor.

2 Double-click the name of a field which you want to sort.
OR
Drag the field name from the Fields list to the Sort area.
OR
To sort based on a formula, click the Add Formula button.
When you open the Order By editor, the Fields list displays the fields 
from the master table. You can choose fields from related tables or sub-
tables by expanding the foreign key field or subtable field.

If you clicked the Add Formula button, 4th Dimension displays the 
Formula editor. For information on writing a formula, see the “Sorting 
Based on a Formula” section on page 128.

The field name or formula appears with a sort direction arrow in the 
Criteria area.

3 If necessary, click the sort direction arrow in the Sort area to switch 
between ascending and descending sort order. 
Up is ascending; down is descending. 

4 If necessary, repeat steps 2 and 3 to add secondary sort levels to the 
list.
For each sort level, you can specify ascending or descending order.

For example, the sort order shown requests a listing of musicians 
sorted by name. The albums of each musician are sorted by the year 
they were recorded, starting with the most recent.

Ascending sort

Descending sort
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5 Click the Order By button.
4th Dimension sorts the current selection. If you are using an input 
form, the first record in the sorted current selection is displayed. 

Sorting Based on a 
Formula

You can sort a field or sort based on a formula. For example, the 
following formula sorts the month of a birth date field: 

Month of (Birth Date)

❿❿❿❿ To create a sort formula:

1 In the Order By editor, click the Add Formula button.
4th Dimension displays the Formula editor. 

You use the Formula editor to create a formula that returns the values 
to be sorted. The formula can return values of any data type. For more 
information about how to use the Formula editor, see the “Global 
Updates” section on page 113.

2 Click OK when you are finished writing the formula. 
4th Dimension displays the formula in the Sort area.

The formula appears with a sort direction arrow in the Sort area.

Modifying a Sort 
Order

You can remove or reorder fields or formulas in the Sort area.

■ Removing a field or formula: To remove a field or formula, highlight 
the field or formula in the Sort area and click the Remove button  
or press Backspace (Delete on Macintosh). To remove all fields or for-
mulas, click the Remove All button .

■ Reordering the sort criteria: To reorder fields or formulas in the Sort 
area, drag the field or formula up or down.

Sorting While a Record is Being Modified
If a record in the current selection is being modified in another process 
at the same time that you are performing a sort, 4th Dimension uses 
the last saved value of the field in the sort. 

For example, if an employee’s job title is in the process of being 
changed from “Engineer” to “Staff Engineer” while you are sorting on 
Job Title, the employee record will still be listed as “Engineer” and 
sorted with the engineer records. 
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If you were to perform the sort again, after the record has been 
modified and saved, the new job title would be used and the employee 
record would be sorted as a staff engineer.

4D Server The last saved value of a field is also used if a record in the current 
selection is being modified by another user. If the sort is performed 
again, after the other user has finished modifying the record, the newly 
saved value of the field is used.

Sorting While an Index is Being Built
Sorting an indexed field is extremely rapid, since the values of the field 
have already been organized by 4th Dimension. However, if the index 
for a field is being built or rebuilt at the same time that you are 
performing a sort on the field, 4th Dimension will be unable to use the 
index and the sort will be sequential.
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7 Modifying User Forms

In 4th Dimension, the developer can let users modify certain forms of 
the database in order, for example, to create custom reports, add a 
specific logo or, more generally, adapt the forms to their own specific 
needs. Once saved, a “user form” is substituted for the original form on 
the user machine and can be used like any other 4th Dimension form. 

The possible modifications mainly concern graphic aspects. For 
example, the user cannot add object methods, variables or fields. They 
can, however, change the entry order or add active objects from an 
object library. The various possibilities are set up beforehand by the 
developer in the Form editor of the Design mode. 

The mechanisms for setting up this system on the developer side 
(Design mode) are described in the “User forms” section of the 
4th Dimension Language Reference manual. 
The current chapter describes the operation of the user form editor in 
User or Custom Menus mode.

User Form Editor
The User form editor is displayed for a form when the EDIT FORM 
command is executed, if the Editable by user property was checked for 
the form. Generally, this editor is called from a database configuration 
or customizing command.
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The editor window appears as follows: 

This editor uses the standard 4th Dimension Form editor interface, in 
particular the two integrated toolbar concept (tools and objects). It also 
has its own specific functions.

When the editor is displayed, only the Edit menu of the menu bar is 
available. It is still possible to display a simplified Property List as well 
as a contextual menu.

The selection and move object mechanisms (when allowed) are 
identical to those in the standard 4th Dimension Form editor.

Toolbar The toolbar contains the following items:

Revert to factory settings: Returns to the original form as defined in 
the Design environment (deletes all changes made in the user form). 
When you click this button, an alert dialog box appears, allowing you 
to cancel or confirm the operation. 

Save: Saves changes made in the user form.

Print settings and Print: These two commands allow setting and 
starting the printing of the user form.

Toolbar

Object bar
132 4th Dimension User Reference



User Form Editor
Display: Allows selecting items to display and hide in the editor using a 
pop-up menu:

■ Page 0: Shows or hides the objects from page 0 in the form’s current 
page. This option allows you to distinguish between the objects on 
the form’s current page and those on page 0. In a multi-page form, 
page 0 contains objects that are displayed on all the pages. 

■ Paper: Shows or hides the borders of the printing page, which are 
shown as gray lines. This option can have no apparent effect when 
the Limits (see below) option is selected. If the size of the form is 
smaller than the printing page, the page’s borders are shown out-
side of the form’s viewing area and therefore do not appear. 

■ Rulers: Shows or hides the rulers in the form editor’s window. 

■ Markers: Shows or hides the output control lines and associated 
markers that show the limits of the form’s different areas (header, 
body, footer). Markers are mainly used in output forms. 

■ Limits: Shows or hides the form’s limits. When this option is 
selected, the form is displayed in the editor with its final dimen-
sions. 

Library: Allows loading the object library that can be used with the 
form (if any) (see the “Using an Object Library” paragraph on 
page 142). 

Selection tool: Allows selecting, moving and resizing form objects. 

Entry order: Switches to “Entry order” mode, where it is possible to 
view and change the current entry order of the form (see the “Data 
Entry Order” paragraph on page 139). 

Moving: Passes into “Move” mode, where it is possible to quickly reach 
any part of the form by using drag and drop in the window. The cursor 
takes the shape of a hand. This navigation mode is particularly useful 
when zooming in the form.
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Zoom: Allows modifying the form display percentage (100% by 
default). You can pass into “Zoom” mode by clicking on the 
magnifying glass or by clicking directly on the desired bar. 
When you click on this button, the cursor takes the shape of a 
magnifying glass . To increase the zoom percentage one level, click 
inside the form. To reduce the zoom percentage a level, press Shift (the 
cursor is changed to ) and click inside the form.

Alignment: This button is linked to a menu that allows aligning objects 
in the form. For this menu to be enabled, at least two objects must be 
selected in the form. 

Distribution button: This button is linked to a menu that allows 
distributing objects in the form. For this menu to be enabled, at least 
three objects must be selected in the form. 

Level button: This button is linked to a menu that allows changing the 
level of objects in the form. 

Display of pages: This area allows passing from one form page to 
another. To do so, click the arrow buttons or click the central area and 
choose the page to display from the menu that appears:

It is not possible to add pages in the user form editor.
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Object Bar The object bar of the user form editor lets you add various graphic 
objects to the form:

To create an object in the form, select the corresponding button and 
then trace the object in the form. 

Viewing and Editing Objects
The user can view and edit the properties of objects present in the form 
using a simplified Property List. To display the list, simply double-click 
the object or choose the Property List command in the contextual 
menu of the editor (right-click). 

Only user-editable properties are displayed in the Property List.

Text (this object must be selected in order to modify the contents of 
static text objects)
Group Box

Rectangle

Line

Rounded Rectangle

Oval

Matrix
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■ For graphic type objects added by the user using the object bar, all 
properties linked to the object type are available. 

■ For objects coming from the original form, two conditions must be 
met in order for a property to be editable in the User form editor:

■ The property must belong to a set of properties that can be declared 
editable for the object or form. For example, the properties related 
to managing form events or drag and drop are never editable by the 
user. 
In the Form editor of the Design environment, the editable prop-
erty themes are distinguished with a padlock icon in the Property 
List (see the Design Reference manual). 

■ The property theme must have been explicitly declared as editable 
by the developer for the object or form. To do that, the developer 
must have clicked on the padlock in the Property List in the Design 
environment to unlock it:

The unlocked properties then become accessible by the user in the 
User form editor:

Unlocked 
theme

Property List in the 
Design environment

Editable 
themes
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This also works for other possible actions in the user form: for 
example, if the “Coordinates & Sizing” theme is unlocked, the user 
could move the object using the mouse or the keyboard.

Edit Menu 
Commands

Only the Edit menu is active when the User form editor window is 
displayed in the User environment. When using customized interfaces 
(Custom Menus), the Edit menu is accessible if the commands it 
contains are managed using standard actions.

All editing commands (Cut, Copy, Paste, Clear, Select all) work 
without restrictions for objects added by the user.

On the other hand, for reasons of consistency, the user is never 
allowed to remove an object from the original form. The use of the 
Cut, Clear commands or the Del or Backspace keys cause the display of 
an alert dialog box telling the user that this action is not allowed.

Contextual Menu Several commands are accessible using the User form editor contextual 
menu. It is not possible to control the contents of this menu.

Clicking Outside of Any 
Objects

When the user clicks outside of any object, the standard display and 
editing commands of the form editor are available: display of the 
Property List, Magnetic grid activation and display of the editor tools:

■ Turn Magnetic Grid On: The magnetic grid offers you a visual aid for 
aligning and distributing objects in the form.
The magnetic grid works as follows: when you drag and drop an object 
in the form, 4th Dimension indicates the possible locations for this 
object based on alignments relative to other form objects:

■ Horizontally possible locations are suggested when the edges or 
centers of two objects coincide,

■ Vertically possible locations are suggested when the edges of two 
objects coincide. 
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At this moment, 4th Dimension places the object at the location and 
displays a red line indicating the noticeable alignment taken into 
account:

Concerning the distribution of objects, 4th Dimension proposes a 
distance based on interface standards. Like with magnetic alignment, 
red lines indicate the noticeable differences once they are reached. 

Note You can manually activate or deactivate the magnetic grid when an 
object is selected by pressing the Ctrl (Windows) or Control (Mac OS) 
key.

■ Display: This menu has the same items as the Display button in the 
editor toolbar (see the “Toolbar” paragraph on page 132).

Clicking on an Object When the user clicks on an object, graphical commands are available 
(color, alignment, etc.). 

Access to these commands can be restricted for objects that belong to 
the original form, depending on the type of object clicked as well as 
the settings made by the developer in the Design environment. 

■ Color: Displays two palettes for modifying the foreground and back-
ground colors of the object. 

Alignment on the top edges

Center alignment
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■ Align: Provides access to commands for aligning and distributing 
objects. The alignment commands are only enabled if at least two 
“movable” objects are selected. The distribution commands are only 
enabled if at least three “movable” objects are selected. 

■ Border Line Style: Used to modify the border line style of the selected 
objects. Here are examples of the styles available:

■ Automatic Size: This option is used to resize text objects and pictures 
in order to obtain optimal display in keeping with their current 
graphic characteristics (font size, style, etc.) or to display them in their 
original size (pictures). 
You can obtain the same result by pressing Ctrl (Windows) or Com-
mand (Mac OS) + clicking on the lower right-hand corner of the 
object. 

■ Level: Used to change the level of objects. 

■ Select Similar Objects: Used to select all the objects that are the same 
type as the selected object. 

Data Entry Order
The data entry order is the order in which fields, subforms, and other 
tabable objects are selected as you tab through a form. 

Note For more information about default data entry order in forms, please 
refer to the Design Reference manual. 

In some cases, it may be necessary to modify the data entry order of a 
form, for example when you have added one or more objects and want 
to include them in a more logical order. 

Viewing and 
Changing the Data 
Entry Order

To view the current data entry order of a form, click the Entry order 
button in the toolbar of the user form editor:

Transparent Plain Dotted Raised Sunken Double
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The current data entry order appears as follows:

■ To change the data entry order, position the pointer on an object in 
the form and, while holding down the mouse button, drag the pointer 
to the object you want to follow in the data entry order. 
4th Dimension will adjust the data entry order accordingly.

■ When you are satisfied with the data entry order, click the Entry order 
button in the toolbar.

Setting the First 
Object in the Data 
Entry Order

All enterable objects are part of the data entry order. To define the first 
object of the entry order, the Entry Order mode must be disabled.

❿❿❿❿ To establish one of the objects as the first in the data entry order:

1 Select the object you want to be first in the entry order and move it to 
the back.
You can use the Level > Move to Back command in the contextual 
menu or the corresponding command of the button in the editor tool-
bar. 

The object will be placed in back of any other form element. This is 
temporary.

2 Click the Entry order button of the toolbar.
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The selected object becomes the first object in the entry order and the 
object that was first becomes second. You can now drag from object to 
object in order to create the data entry order you want.

3 When you have finished setting the entry order, click on the Entry 
order button of the toolbar again.
4th Dimension returns to normal operation of the form editor.

The object you selected to make first in the entry order has returned to 
its previous location (it is no longer moved to the back of the form).

Using a Data Entry 
Group

While you are changing the data entry order, you can select a group of 
objects in a form so that the standard data entry order applies to the 
objects within the group. This allows you to easily set the data entry 
order on forms in which fields are separated into groups or columns.

❿❿❿❿ To create a data entry group:

1 Click the Entry order button of the toolbar.

2 Draw a marquee around the objects you want to group for data entry.
When you release the mouse button, the objects enclosed or touched 
by the rectangle follow the standard data entry order. The data entry 
order for the remaining objects adjusts as necessary.

Restoring the 
Standard Data Entry 
Order

You can restore the standard data entry order (based on the layering of 
the objects) at any time.

1 Click the Entry order button of the toolbar.

2 Draw a marquee around all the objects on the form.
When you release the mouse button, 4th Dimension re-establishes the 
standard data entry order for all the objects enclosed or touched by the 
rectangle.
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Using an Object Library
It is possible to use an object library with each user form being 
modified. 

An object library is an external file created by 4th Dimension in the 
Design environment. It allows storing all types of objects that can be 
used in forms: buttons, texts, pictures, hierarchical lists, etc. Libraries 
are put together and used by a simple drag and drop or copy-paste 
from 4D forms. They are somewhat like a permanent clipboard. 

Note For more information about object libraries, please refer to the Design 
Reference manual. 

Objects are stored with all their properties and standard actions. It is 
not possible to use objects with associated object methods in the user 
form editor. Only objects that do not have associated object methods 
will be visible in the library from the user form editor. 

The developer sets the library associated with the form using the last 
parameter of the EDIT FORM command which displays the user form. If 
this parameter is valid, the library can be displayed and used with the 
user form. To open the library, the user must click on the 
corresponding icon in the toolbar of the editor:

The library window is then displayed:

Note An object library can contain up to 32,000 items.
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The user can add objects to the form by drag and drop or copy-paste 
from the library.
All the properties of objects inserted from the library are automatically 
accessible to users (coordinates, dimensions, appearance, etc.).

Each object library has a contextual menu that allows accessing basic 
editing commands. In the user form editor, only the Copy command is 
available. Moreover, it is not possible for the user to remove, rename or 
add objects in the library. 
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8 Form Reports

One of the major functions of a database is to produce reports. 
In 4th Dimension, you can produce a report using either a form or 
using the Quick Report editor. This chapter explains how to print 
a report using a form.

There are several advantages to using a form for a report: you can use 
graphic elements on the form, you can control the placement of report 
elements precisely, you can use methods to perform calculations, and 
you can use headers to identify each subsection of a break report. Form 
reports can also be customized by each user with the help of the user 
form editor (see Chapter 7, “Modifying User Forms,” on page 131).

You can use a form to create reports that:

■ Require a non-columnar format

■ Display subforms

■ Contain embedded graphics

■ Require special graphic elements, such as hairlines.

Chapter 9 discusses designing and printing reports using the 
Quick Report editor. The Quick Report editor is excellent for printing 
tabular reports that use a standard columnar format.

This chapter assumes that you have already created a form for the 
report. For information about designing output forms for reports, 
see the 4th Dimension Design Reference manual.
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Standard Reports and Reports with Breaks
There are two kinds of reports that can be printed using output forms, 
standard reports and reports with breaks. When you create a standard 
report, you simply print the current selection using a form. Reports 
with breaks separate records into groups. To create a report with breaks, 
you must sort the current selection before printing.

Printing Standard 
Reports

4th Dimension prints the records in the current selection. Set the cur-
rent selection to the subset of records you want to print. If you want 
the report to list the records in a particular order, sort the current selec-
tion before printing the report.

❿❿❿❿ To print a standard report:

1 Select the records to be included in the report. If desired, sort the 
records.
Selecting records is discussed in Chapter 4 and sorting records is 
discussed in Chapter 6.

2 Choose Print from the File menu or click on the corresponding button 
in the toolbar.
The Print Form dialog box appears.

3 Choose the form you want to use.

You can choose a form by clicking on it, using the arrow keys, or by 
typing the first letter of a form name.

When you click on a form, a preview appears in the preview area. 

4 Click OK or press Enter.
4th Dimension displays the Page Setup dialog box for your selected 
printer. Choose any desired options and click OK.
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4th Dimension displays the Print dialog box for the printer you 
selected in the Print Manager. To preview the report on the screen, 
check the Preview on Screen check box.

If you checked the Preview on Screen check box, the report will be dis-
played on screen, one page at a time. The figure below shows a report 
previewed on screen.

When a page of the report is being previewed, you can do the follow-
ing:

■ View a close-up of the report by clicking the Zoom button. When you 
use Zoom, you can move around the page by dragging the hand 
pointer.

■ View the next page of the report by clicking the Next Page button.

■ Print the page being previewed by clicking the Print button.

If you did not check the Preview on Screen check box, the report will 
be sent to the printer you selected in the Print Manager (Chooser on 
Macintosh).

Zoom button

Next and previous 
page buttons

Print button Stop 
button
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Printing Reports 
with Break Levels

Break levels are used to separate records into groups and print sum-
mary calculations for each group. The output form used to print a 
report with break levels must contain at least one break area. For infor-
mation about designing output forms with break levels, see the 
4th Dimension Design Reference manual.

If your report includes break levels, you must sort the current selection 
before printing. When sorting records for a report with break levels, 
you normally sort on at least one more sort level than the number of 
break levels in your output form. If your report has one break level, use 
at least two sort levels. For example, if your report lists employees by 
department, the report has one break level (Departments). 

You can sort your break field (Department Name) and one more field 
— Last Name. Employees will be listed alphabetically by last name 
within each department.

When you print a report with break levels, you must turn on break 
processing. Break processing causes 4th Dimension to break the records 
into groups and compute summary calculations.

Header area

Detail area

Break area

Total area

Footer area

Break Header area
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There are two ways to turn on break processing. If an object on the 
form uses the Subtotal function, break processing is turned on auto-
matically. Break processing can also be turned on by executing a 
method when the report is printed. The method must contain two 
commands, ACCUMULATE and BREAK LEVEL. For more information 
about using these commands in a method, refer to them in the 
4th Dimension Language Reference manual.

For information about how to use the Subtotal function in output 
forms, see the 4th Dimension Design Reference manual.

❿❿❿❿ To print a report with breaks:

1 Select the records to be included in the report. 
Selecting records is discussed in Chapter 4.

2 Sort the records by at least one more level than the number of breaks 
in the report.
Sorting records is discussed in Chapter 6.

3 Execute the method that turns on break processing.

Note This step can be skipped if the output form turns on break processing 
automatically by using the Subtotal function.

4 Choose Print from the File menu or click on the corresponding button 
in the toolbar.
The Print Form dialog box appears.

5 Choose the form you want to use.

6 Click OK.
4th Dimension displays the Page Setup dialog box for your selected 
printer. Choose any desired options and click OK.

4th Dimension displays the Print dialog box for your selected printer. 
To preview the report on the screen, check the Preview on Screen 
check box.

If you checked the Preview on Screen check box, the report will be dis-
played on screen, one page at a time. See a description of the options 
available for previewing a report in the “Printing Standard Reports” 
paragraph on page 146.

If you did not check the Preview on Screen check box, the report will 
be sent to the printer you selected in the Print Manager (Chooser on 
Macintosh). A dialog box keeps you informed of the progress of the 
operation.
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9 Quick Reports

Introduction
One of the most important tasks in data management is report genera-
tion. The Quick Report editor is one of two tools made available by 
4th Dimension for the purpose of designing reports. You use the Quick 
Report editor to create ad-hoc reports in the User environment. The 
other tool is the Form editor, which you can use to design reports in 
the Design environment (which can be altered subsequently in User or 
Custom Menus mode). You should use an output form to design 
reports that require complex designs or programmatic processing.

Using the Quick Report editor, you can:

■ Produce lists of records.

■ Create break areas.

■ Produce cross-table reports.

■ Compute summary calculations.

■ Modify fonts and styles in the report.

■ Define borders and background colors on a cell basis.

■ Save and open quick report designs to disk.

■ Select different output types such as HTML or text file, 4D View or 4D 
Chart area, printing or saving to disk.

The Quick Report editor produces reports from the current selection of 
records. Before generating a report, set the current selection of records 
that you want to include in your report.
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Overview of the Editor

In the user environment, the Quick Report editor appears as follows:

It consists of two main areas:

■ The Quick Report data area that is used to specify the type of report to 
be built and the data to be integrated; it also can be used to access the 
Quick Report Wizard:
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■ The actual Quick Report area:

This shows the area as it appears when a Quick Report area is inserted 
in a form. This is where actual column and row contents are created, 
where sort orders are defined, etc. Also, this area includes various 
toolbars, its own menu bar and contextual menus.

For example, this area could be placed in a form as depicted below:
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List Mode and 
Cross-table Mode

In the Quick Report editor there are two operation modes available 
which generate two specific types of reports: List and Cross table.

■ List mode
This is the default mode. In this mode, reports would typically display 
records as a list with break levels where sums would be performed. The 
following is a typical List quick report. 

■ Cross-table mode
This mode allows you to display your report as a two-dimensional 
table. This is useful when you want to display data from a data source 
broken down into categories that are actually a function of two other 
data sources. 
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For example, a cross-table form would let you display in a table how 
many of each product type was sold in each quarter. The following is a 
typical Cross-table Quick Report.

Quick Report Basics
This section describes basic operations used when working with the 
Quick Report editor to design a report.

Creating a New 
Quick Report

By default, the Quick Report editor lets you create reports in the User 
environment. 
It is also possible to create reports from the Custom Menus mode, in 
particular by inserting a Quick Report area into a form.

❿❿❿❿ To design a quick report:

1 Choose Quick Report... from the Tools menu or click on the 
corresponding button in the toolbar.
4th Dimension displays the Quick Report editor. If a previous report 
has been defined, it appears in the window. To erase the contents of 
the window, choose New from the File menu or click the New icon in 
the standard toolbar of the editor  to begin a new Quick Report 
design.
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2 Choose the type of report to be generated by clicking on either the 
List or Cross table button, located at the bottom left corner of the 
Quick Report editor:

The List type is generally selected by default. The Quick Report area is 
modified according to the type selected. 

Loading and Saving 
a Quick Report 
Design

You can save a quick report design as a file that you can open from the 
Quick Report editor. The quick report design includes all of your speci-
fications for the report, but not the data. By saving report designs, you 
can maintain a library of quick report designs that you can use accord-
ing to your needs.

Note If you do not save your design, it is displayed the next time you open 
the Quick Report editor but only during the same work-session. 

Saving a Quick Report 
Design

❿❿❿❿ To save a quick report design:

1 Choose Save as from the File menu.
OR
Click the Save as icon in the file management toolbar .
4th Dimension displays a create-file dialog box in which you can name 
the quick report design.

Note Quick report files in 4th Dimension for Windows are denoted by the file 
extension .4QR.

2 Enter a filename for the quick report and click OK. 
4th Dimension saves the report as a file that you can open with the 
Quick Report editor. You can save the file on your hard disk. If you 
modify the parameters of the report subsequently and want to save 
them again, you just need to choose the Save command in the File 
menu. 
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The new file will replace the previous one on the disk, without the 
standard save file dialog box appearing. 

Loading a Quick Report 
Design

When the Quick Report editor is open, you can load a saved design 
and use it to print a new report. You can use the same quick report 
design repeatedly to print different selections of records.

❿❿❿❿ To load a report design:

1 Choose Open from the File menu.
OR
Click the Open icon in the file management toolbar .
4th Dimension displays an open-file dialog box displaying a list of 
available quick report designs. 

2 Double-click a filename or select a filename from the list and click OK.

4th Dimension replaces the current design with the design you opened.

The Quick Report Wizard
When creating a manual Quick report in User mode, you can use the 
Wizard to guide you through the creation of the report.

To start the wizard, click the Open wizard button in the Quick Report 
editor:
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The pages of the wizard then replace the data area in the window of 
the Quick Report editor:

The construction of the report is then carried out through detailed 
steps with comments appearing in the right-hand part of the window. 
To create a Quick Report using the wizard, follow the instructions 
displayed on the screen. 

When you have finished constructing the report, the wizard offers you 
the possibility of generating the corresponding 4D code. For more 
information about this, refer to the“Generating 4D Code” paragraph 
on page 206. 

To exit the wizard, click on the button to return to Manual mode:

List of steps

Information
area
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Using the Quick Report Editor

Interface When you create a quick report, you can specify the following:

■ Columns that display fields or formulas, either from the current table 
or from related tables,

■ Sort levels and order (list mode),

■ Summary calculations,

■ Display format,

■ Text for labels,

■ Formats for numeric and Boolean data,

■ Font, font size, style, and justification for labels, summary calculations, 
and data,

■ Background colors on a cell column or row basis,

■ Borders,

■ Page headers and footers.

List mode:

Fields list

Sort list

Toolbars 
and menu bars

Report type
selection buttons

Master Table
drop-down list

Break row

Title and detail rows
Column divider

Field

Cell
selection list
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Cross-table mode:

The Quick Report editor contains the following elements: 

■ Master Table drop-down list: This menu is used to specify the master 
table that will be used as a basis for generating the report. The fields of 
this table are displayed in the Fields list and the related fields will be 
displayed in relation to this table. 

■ Fields list: This list lets you select the fields to be inserted into the 
report by double-clicking or by drag and drop. It displays either the list 
of fields found in the master table, the hierarchical list of tables and 
related fields, or the hierarchical list of all the tables and fields of the 
database. You choose the type of display in the Field selection list 
located just above the area. 
Indexed fields appear in bold. You can also display and select the fields 
of related tables.

Note Only tables and fields which are not hidden appear in the Fields list of 
the Quick Report editor. For information about hiding tables and 
fields, refer to the 4th Dimension Design Reference manual.

Fields list
Sort orders

Toolbars 
and menu bars

Report type
selection buttons

Master Table
drop-down list

Title and detail rows

Column divider

Field

Cell
selection list
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■ All relations in automatic: This option is used to specify the way in 
which the Quick Report editor will make use of the relations between 
the different tables of the database. 
On principle, the editor can only use automatic relations. By default, 
the option is not checked and only automatic relations can be used by 
the editor. 
If the All relations in automatic option is checked, the Quick Report 
editor considers the manual relations of the database as automatic 
relations and will thus enable access to all the data related to the 
database. 

Note to developers • The All relations in automatic option causes all the relations to pass 
into automatic for the current process, even after the Quick Report 
editor has been closed. If you want to make sure that all the relations 
will be manual after using the Quick Report editor, execute the 
statement AUTOMATIC RELATIONS(False;False). 
• When the editor is called using the QR REPORT command, this 
option does not appear in order to allow the developer to manage the 
status of relations directly. 

■ Column dividers: These lines indicate the boundaries between columns 
of the report. They can be moved manually in order to enlarge or 
reduce the size of each column. Manual resizing deselects the Auto-
matic Width option if it has been activated for the column concerned.

■ Cells: A cell is the intersection of a row and a column.

■ Scroll bars: You use the scroll bars to view parts of the quick report 
design that extend beyond the area of the quick report form. 

■ Sort list/Sort order display area: 

■ In List mode, this list displays the fields of the report on which the 
sort will be carried out, as well as the sort order and whether it will 
be ascending or descending. Each field inserted into this list causes 
a sub-total row to be added in the Quick Report area. 

■ In Cross-table mode, this area displays the sort order for each data 
source.
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■ Quick Report area: This area lets you build your report by inserting 
fields using drag and drop, double-clicking or via the contextual menu; 
you can also adjust the width of the columns added, or delete breaks or 
formulas, define the colors and borders of cells, etc.

■ Title row: This row displays the names of fields or formulas that 
have been inserted into the report. It is repeated for each page of 
the report. The Quick Report editor inserts field names by default, 
but you can modify the contents.

■ Detail row: This row contains information drawn from each record 
and is repeated in the report for each record. You can associate a dis-
play format with it, depending on the type of data represented.

■ Subtotal rows: These rows display intermediate calculations as well 
as the wording that is associated with them. A row is created for 
each sort order.

■ Column data sources: These titles indicate the source of the data for 
each column.

■ Data Sources: These two cells will house fields that will be used for 
the two categories of the array. The center cell can also accept fields 
sources and calculations at the same time.

■ Total cells: These cells are designed to house calculations on the col-
umn’s contents.

■ Title cells: These cells house the titles for the last column or the last 
row. Their contents can be modified.

Title row
Detail row

Column data source

Grand total row

Subtotal rows

Data Sources

Last Column Title

Last row title

Total cells
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The following figures shows completed quick report designs and the 
relationship between the specifications in the design and the printed 
output:

List Report

Cross-table 
Report
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Contextual Menus The Quick Report editor has contextual menus that make it easy to 
access certain row, column, and cell operations. Instead of making 
menu selections or working with the Cell or Column properties areas, 
you can perform certain operations by displaying a Quick Report 
contextual menu.

There are separate contextual menus for row, column, and cell 
operations.

❿❿❿❿ To use a contextual menu:

1 Click with the right mouse button on a cell, a row title, or a column 
heading.
A contextual menu appears. The commands in the contextual menu 
depend on where you click (column heading, cell, row or subtotal row 
title). In addition, menu commands that are not appropriate for the 
specific row, column, or cell are disabled.

2 Choose the desired menu command:

As with any contextual menu, this menu’s contents vary depending on 
which cell type is highlighted. Items available break down into five 
main types:

■ Font attributes,

■ Display formats,

■ Standard calculations,

■ Column or row management items, and

■ Cell borders.

Cell

Row

Column

Subtotal
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Font Attributes These items appear in the contextual menu when a cell, column or row 
is selected. Selecting a font attribute will apply it to the current 
selection (cell, row or column). The Font attribute items appear as 
follows:

■ Font
Selecting this item displays the list of fonts installed on your machine 
from which you can select the font that will be applied to the items 
selected in the report area.

Once an item in the list is selected, a check mark is displayed next to it.

■ Size
Selecting this item displays the list of font sizes from which you can 
select the font size that will be applied to the items selected in the 
report area.

Once an item in the list is selected, a check mark is displayed next to it.

■ Style
Selecting this item displays the font styles (Plain, Bold, Italic, and 
Underline) from which you can select the font style that will be 
applied to the items selected in the report area.

Once an item in the list is selected, a check mark is displayed next to it.
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■ Justification
Selecting this item displays the list of justification attributes (Default, 
Left justified, Centered and Right justified).

Note Default is the default justification for this data type (left for numbers 
or, otherwise, right).

Once an item in the list is selected, a check mark is displayed next to it.

■ Font color
Selecting this item displays a palette of colors.

Display Formats These items appear in the contextual menu when either a cell or a 
column is highlighted. From the menu, you can select one of the 4D 
default formats that match the data type of the column. Once selected, 
the format applies to the entire column, regardless of whether the 
current selection is a cell or a column. 

Summary Calculations These commands appear in the contextual menu when the current 
highlighted cell belongs to either the Grand total row or to a Subtotal 
row.
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Selecting an item will insert the corresponding calculation in the 
highlighted cell (see the “Adding Summary Calculations” paragraph 
on page 189). Once an item in the list is selected for a cell, a check 
mark is placed next to it. It is possible to select several calculations 
successively. 

Column and Row 
Management Items

There are several items that are dedicated to column or row 
management:

■ Hide
Selecting this item hides the current column or row. Once it is hidden, 
a check mark is displayed next to the item, and the row or column is 
crossed out.

■ Add...
This item is displayed when a row is highlighted or nothing is high-
lighted. Selecting this item displays the formula editor to allow you to 
define the data source for a new column. Once this is done, the new 
column is added to the right of the right-most existing column.

■ Totals Spacing...
This item is displayed when you click on the title area of a subtotal 
row. It displays the Subtotals Properties dialog box. The options found 
in this dialog box are described in the “Subtotal Spacing” paragraph on 
page 188. 

■ Insert...
This item is displayed only when a column is highlighted in list mode. 
Selecting this item displays the formula editor to allow you to define 
the data source for a new column. Once this is done, the new column 
is added to the left of the current highlighted column.

■ Delete
This item is displayed only when a column is highlighted in list mode. 
Selecting this item deletes the current highlighted column.

■ Edit...
This item is displayed only when a column is highlighted in list mode 
or when a cell is highlighted in cross-table mode. Selecting this item 
displays the formula editor to allow you to edit the data source for the 
current column (list mode) or for the current cell (cross-table mode).
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■ Automatic Width
This item is displayed only when a column is highlighted in list mode, 
or when any cell is highlighted in cross-table mode. You can use this 
item to select or deselect the automatic width. When Automatic Width 
is selected, 4D will try to match the column size to the data so that the 
data fits on one line.

Borders These items appear in the contextual menu when a cell, column or row 
is selected. Selecting Borders... displays the Borders dialog box:

For more information about this dialog box, refer to the “Setting 
Borders” paragraph on page 179. 

Once defined, the border format is applied to the current selection 
(cell, row or column).

Selecting Rows, 
Columns, and Cells

When designing a List quick report, you need to select rows, columns, 
and cells in the quick report form. A cell is the intersection of a row 
and a column.

❿❿❿❿ To select a row:

■ Click on the Title, Detail, Subtotal, or Grand total cells in the row label 
area. 
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❿❿❿❿ To select a column:

■ Click the Header row of a column. 

❿❿❿❿ To select a cell:

■ Click on the cell.

Adding and 
Modifying Text

You can add or modify text in the quick report form to label parts of the 
report. For example, if you requested summary calculations, you can 
label them by adding text to other cells in the Subtotal and Grand total 
rows.

You can add and modify text as follows:

■ Edit the text that 4th Dimension automatically adds to the Title row of 
the report,

■ Insert text in empty cells of the Subtotal and Totals rows,

■ Insert the value of a Subtotal field in the Subtotal rows,

■ Specify the font, font size, justification, and style for any text that 
appears in the report.

Adding Text

❿❿❿❿ To add text in a report cell:

1 Click twice on an empty cell in the quick report form.
A text insertion point appears in the cell.

If you are entering a label for a summary calculation, select a cell in the 
same row as the cell containing the calculation icons. You cannot enter 
text into the same cell that contains summary calculations.

2 Type the text in the cell. 

Modifying Text

❿❿❿❿ To modify text in a cell:

1 Double-click in a cell to get an insertion point and drag across the text 
in the cell you want to modify.
4th Dimension highlights the selected text.

2 Type the new text in the cell.
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Adding Columns In List mode, you create columns by dragging field names from the 
Fields list into the quick report area. If you want to add a field from a 
related table, expand the foreign key field in the hierarchical list of 
fields to display the fields in the related tables (if you have selected 
Related Tables or All Tables in the drop-down menu located just above 
the list). 
You can add fields from related tables, provided that the relationship is 
automatic. If you want to be able to use manual relations, check the All 
relations in automatic option: in this case, the editor changes all the 
relations of the database to automatic (see the “Interface” paragraph 
on page 159). 

Note You cannot add or edit a column in cross-table mode, since the report 
comes with all the columns needed.

❿❿❿❿ To add a field:

■ Drag the name of a field to the right of existing columns in the Quick 
Report area and release the mouse button.

OR
Double-click on the name of a field in the Fields list.

Note If you drag and drop a field onto an existing column, it will be replaced 
by the new column. 

4th Dimension creates a column for the field and places the field name 
in both the column header and the cell in the Header row. 

By default, 4th Dimension prints the field names as column heads at 
the top of each page in the quick report.

❿❿❿❿ To add a column using a menu command:

1 Select the Add... command in the Columns menu of the editor.
OR
Right-click over an unused area of the Quick Report area, then select 
the Add... command.

The standard 4th Dimension formula editor is displayed, allowing you 
to specify the data source of the new column (field or formula).
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Inserting Columns In List mode, you can insert an empty column into a quick report. 
After you insert the column, you can assign a field or a formula to it.

❿❿❿❿ To insert a column:

1 Select a column.

2 Choose Insert... from the Columns menu.

OR
Right-click to display the Quick Report contextual menu and choose 
Insert.

The standard 4th Dimension formula editor is displayed, allowing you 
to specify the data source of the new column (field or formula).

Deleting Columns In List mode, as you specify fields for your quick report, you may want 
to remove some columns to place them elsewhere. Or, you might want 
to delete the column from the report.

❿❿❿❿ To delete a column using the Quick Report menu bar.

1 Select the column you want to delete. 
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2 Choose Delete from the Columns menu.

OR

Right-click on the header of the column to be deleted, then select the 
Delete command from the contextual menu.

4th Dimension removes the selected column of the report. 

Replacing Columns In List mode, you can replace a column in the quick report by dragging 
another field over it. You can also replace a field with a formula and 
vice versa.

❿❿❿❿ To replace a column by a field:

1 Drag a field from the Fields list to the column you want to replace.
The replacement is instantaneous. If the previous field was designated 
as the sort level, the field that replaces it will also be substituted in the 
sort order list.

❿❿❿❿ To replace a column using the formula editor:

1 Select the column you want to replace and choose Edit... from the 
Columns menu.
OR
Right-click on the header of the column to be replaced, then select the 
Edit... command in the contextual menu.
The standard Formula editor of 4th Dimension appears, allowing you 
to designate the new data source of the column (field or formula).

When you print the quick report, 4th Dimension will print the results 
of the formula for each record that appears in the Detail row. See the 
“Associating Formulas with a Quick Report” section on page 174 for 
information about adding a formula to a quick report.
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Sizing Columns By default, the Quick Report editor sizes columns automatically, as 
reflected in the Automatic Width button. It sizes each column based on 
the maximum length of data displayed in the column and any labels 
typed into the column. The Quick Report editor sizes the columns 
when the report is printed. 
This operation is enabled for a column when the Automatic Width 
attribute has been associated with it. You can set and view the 
activation of this option in the Columns menu, in the contextual 
menu of the columns or using the corresponding button in the 
Columns toolbar:

To view the widths of each column, preview the report on the screen. 
See the “Generating a Quick Report” section on page 200 for more 
information about previewing a report. 

Because selecting the Automatic Width button or contextual menu 
item changes the width of a column based on the maximum width of 
data in the records being printed, selecting different records can 
change the size of the columns. 

You can resize a column manually, which automatically causes the 
deselection of the Automatic Width option (where applicable). 
When a column is set manually, text in the column wraps within the 
specified area.

❿❿❿❿ To manually resize a column:

1 Select the column you want to resize.

2 Move the pointer over the column divider in the quick report to 
change the pointer into a column width cursor . 

3 Drag the column divider to the left or right to resize the column. 

Moving Columns In List mode, as you specify fields for your quick report, you may want 
to move some columns to place them elsewhere.

❿❿❿❿ To move a column using the Quick Report toolbar:

1 Select the column you want to move. 
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2 Click the move icon to move it to the right or to the left: 

OR

3 Select Move right or Move left from the Columns menu to move the 
column as desired.
4th Dimension moves the selected column.

Associating 
Formulas with a 
Quick Report

You can add a formula to a column in a quick report. For example, you 
can add a formula that computes employees’ monthly salaries from an 
Annual Salary field.

❿❿❿❿ To associate a formula with a column:

1 Insert an empty column 
OR
Click an existing column and choose Edit... from the Columns menu.
OR
Double-click an existing column’s header. 
OR
Right-click on an existing column header to display the Quick Report 
contextual menu and choose Edit.
4th Dimension displays the Formula editor, which you can use to build 
a formula. If you selected an existing column, the formula you create 
will replace the previous contents of the column.

Note Make sure that the formula you create does not change the current 
selection. Changing the current selection will cause problems when 
you print the quick report since the report is based on the current 
selection. For information about commands and functions that change 
the current selection, refer to the 4th Dimension Language Reference.

2 Build the formula by selecting the fields, operators, commands and/or 
4D methods, then enter the desired values in the editing area. 
OR
Click the Load... button to retrieve an existing formula from disk.
For more information about the formula editor, refer to the “Global 
Updates” paragraph on page 113.

If you click the Load... button, 4th Dimension displays an open-file dia-
log box and asks you to select a file. When you load a file, it replaces 
any formula that currently appears in the Formula editor. After you 
load a formula, you can modify it in the editing area.
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To save the formula as a file that you can retrieve and use in another 
column or in another report, click the Save... button and enter a file-
name in the dialog box.

3 Click OK to assign the formula to the column.
4th Dimension adds a new label to the column that identifies it as a 
formula. You can relabel the column by typing a label into the header 
cell for that column. The formulas are labelled C1 to Cn. These labels 
are the name of the variables containing the current value of the col-
umn. You can use these variables in other formulas.

Modifying the Graphic Attributes of a Report
You can modify the graphic appearance of a quick report. The Quick 
Report editor lets you set the following attributes:

■ the character font, as well as its size, justification, style and color,

■ the background color of the cells,

■ the cell borders.

In addition, 4th Dimension provides a set of predefined report 
templates that you can modify as desired. 

Note Appearance specifications are only taken into account for the “Printer” 
and “HTML File” output destinations (colors only). With other types of 
output, the formatting of reports must be carried out after the report is 
generated, using the receiving applications (4D View, 4D Chart or a 
text editor). For more information about report destinations, refer to 
the “Generating a Quick Report” paragraph on page 200. 

Specifying 
Character Font, Size, 
Justification, Style, 
and Color Attributes

While designing your quick report, you can specify different fonts, 
font sizes, justification, styles and colors. You can then apply these 
specifications to text, data, and summary calculations within rows, col-
umns, or cells in the quick report.

If you assign specifications to the Detail row of the report, you will not 
see the results until you preview or print the report.

You can specify font attributes using either the Quick Report menu 
commands or the Quick Report contextual menu.
1754th Dimension User Reference



Chapter 9  Quick Reports
❿❿❿❿ To specify a character font, font size, style, justification or color:

1 Right-click on the row label, column header, or cell to which you want 
to apply the font attributes.
A contextual menu appears.

2 Use the Font, Size, Style, Justification or Font Color submenus to 
change the font attributes as desired.
OR

1 In the report, select the column, row or cell that you want to 
configure.

2 Choose a font in the drop-down font list and a size in the drop-down 
size list; then choose a style, justification and color in the Style toolbar:

Note You can also assign a style and justification using the Style menu. 

4th Dimension applies the parameters to the text, data or calculations 
included in the selected area.

Specifying the 
Background Color of 
Cells

The Quick Report editor allows you to set a background color for each 
cell. You can set either a single color or two alternating colors, which 
provides better readability for tables. 

It is possible to set background colors for both List and Cross-table 
reports. 

Background colors are used with the “Print” and “HTML File” output 
destinations. 
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❿❿❿❿ To set a background color:

1 Select a cell, column or row, then choose the main color in the 
“Background Color” palette of the toolbar:

You can assign any color combination that you want to the rows, cells 
and columns. 

2 (Optional) If you want to use an alternating background color, choose 
it using the “Alt. Background Color” palette:

The cells which have been assigned two alternating background colors 
will display both of them in the Quick Report editor. 

Background 
Color palette

Alt. Background 
Color palette

Cell with an 
alternating back-
ground color
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Here is an example of a generated report in List mode (preview) that 
has alternating background colors:

Background colors are also taken into account in reports generated in 
HTML format:
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Setting Borders You can set the borders for cells in both cross-table and list reports.

❿❿❿❿ To set the borders for a cell, a column or a row:

1 Highlight a cell, column or row, and either select Borders... in the 
contextual menu or from the Style menu.
The “Borders” dialog box is displayed:

The preview area varies dynamically depending on the type of the 
selection: cell, column or row, but also whether a cell is in a list or 
cross-table type report. For example, the behavior of the center cell in a 
cross-table report is different from the behavior of a detail cell in a list 
report. The center cell is repeated both horizontally and vertically for a 
cross-table report, whereas the detail cell in a list report is going to be 
repeated only vertically. Also, other cells may not be repeated at all 
(titles, for instance).

■ If the selected cell is a title cell (which is not repeated), the outer 
lines represent the outer lines of the cell:

Preview area

Shortcut buttons

Line thickness
selection area
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■ If the selected cell is a detail cell in a List report (which is repeated 
vertically), the outer lines represent the outer lines of the cell repeti-
tion, and the inner horizontal line represents the border between 
two cells in the sequence:

■ If the selected cell is the center cell in a cross-table report (which is 
therefore repeated both horizontally and vertically), the outer lines 
represent the outer lines of the repetition of cells, and the inner 
lines represent the borders between each cell generated from the 
center cell:

2 Select the line thickness and color to use:

You can use different colors for different borders.
180 4th Dimension User Reference



Modifying the Graphic Attributes of a Report
3 Select the borders using either the arrows or the shortcut buttons.
You will notice that some shortcut buttons are disabled to match the 
type of the cell you are editing.

4 Repeat steps 2 and 3 for each border to be configured. 

5 Click OK to validate the changes.
OR
Click Revert to revert to the original border settings.
OR
Click Cancel to discard the changes and close the dialog box.

Using a Predefined 
Report Template

The Quick Report editor contains a set of predefined templates 
providing various graphic approaches for the production of printed or 
HTML reports. You can use all of the template as is or you can use it as 
a basis for constructing your own reports. A template can be applied at 
any time. 

A report template combines a set of graphic characters: font, colors, 
style, borders and justification. You can use either all or part of the 
template characteristics.

❿❿❿❿ To use a predefined template:

1 Choose the Presentation... command in the Style menu. 
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The template selection dialog box appears:

2 In the list of predefined templates, click on the one that you want to 
use. 
You can preview each template in the right-hand area of the dialog 
box. Choose the template that best corresponds to your needs, keeping 
in mind that you can always modify your report subsequently. 

3 If you do not want to use all the graphic options set by the template, 
you can uncheck each option that you do not want to be taken into 
account. 
By default, all the options are selected. If, for example, you uncheck 
the “Border” option, the borders defined by the template will not be 
applied to your report. 

Note Only the “Color” option will be taken into account for reports whose 
output destination is an HTML file. 

4 Click on Apply. 
The selected characteristics are immediately applied to your report. If 
any graphic attributes were set previously, they will be replaced. 

Keep in mind that certain characteristics will be only visible once the 
report has been generated. 

List of predefined 
templates

Preview area for the 
selected template

Graphic options to be 
used or excluded
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Sorting Records
An important feature of the Quick Report editor is the ability to sort 
the records in your report. You sort records for two reasons:

■ To view records in a particular order,

■ To create groups of records and subtotal areas in the report for the pur-
pose of reporting summary calculations for groups.

Specifying a Sort 
Order for a List 
Report

You can specify a sort order at any time; simply drag and drop a column 
into the Sort order list. 
For example, if you wanted to sort the records of salespeople by the 
Sales Region field, you would drag and drop the Sales Region column 
into the Sort order area.

You can also sort based on a formula by selecting the column that 
contains the formula and placing it in the Sort order list. See the 
“Associating Formulas with a Quick Report” section on page 174 for 
more information about adding formulas to quick reports.

You can sort a report on several levels. The order in which the fields 
and formulas appear in the Sort order list indicates the sort level. 

❿❿❿❿ To specify the sort order using the field list:

1 Drag the Field you want to set as the sort level from the Fields list to 
the Sort order list.
OR
Highlight the field from the Field lists and click on the field insertion 
button:

The field is then added to the Sort order list.
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By default, sorts are carried out in increasing order (A -> Z). You can 
reverse the direction of the sort by clicking on the triangle next to the 
field in the Sort order list. 

Note If the sorted field has not already been inserted into a report column, 
an additional column is automatically created in the Quick Report 
area. 

❿❿❿❿ To specify a sort for a column (field or formula):

1 Select Report Columns from the table selection drop-down list.

The list then displays the headers of the columns present in the report:

2 Drag the column that you want to set as the sort level and drop it in 
the “Sort order” list.
OR
Highlight the field from the Field lists and click on the field insertion 
button:
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4th Dimension then displays the name of the column in the Sort order 
list:

Changing the Sort Level

❿❿❿❿ To change the level of a sort:

1 Right-click on the field in the Sort order list in order to display the 
contextual menu:

2 Select Up or Down to move the field up or down (respectively) in the 
sort levels.

Deleting a Field or 
Formula from the Sort 
List

You can delete any field or formula from the Sort list.
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❿❿❿❿ To remove a field or formula from the Sort order:

1 Select the field or formula to be deleted in the sort list and display the 
contextual menu using a right-click:

2 Select Delete.
The level is then removed.
Note that the associated column is not removed from the report. On 
the other hand, the associated subtotal row disappears.

Sorting the Cross-
table Values

In a Cross-table report, the only values that can be sorted are the 
horizontal and vertical data sources (the two data sources that are used 
as categories in the final table).

❿❿❿❿ To sort the categories in a cross-table report:

1 Click the sort indicators in the Sort order area.
An arrow indicates the sort order specified:

To modify or delete the sort order of a data source, click on it again. 
The different possible reports appear successively. 

When no arrow is displayed, no sort order is selected. In this case, 
values will be displayed in the order they appear in the selection. 
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Subtotal Levels In a quick report, you set break levels to separate or “break” records 
into groups according to values in one or more sort fields. A break area 
is printed at each break level. You can print summary calculations in 
the break area. The summary calculations — sum, average, minimum, 
maximum, count and standard deviation — are calculated for each 
group of records. 

Break levels are determined by the sort levels and Break rows. For 
example, if you sort records by Sales Region, 4th Dimension inserts a 
break between each group of records that have the same sales region. 
These rows are automatically inserted when a sort is defined.

After you add a subtotal row to the quick report, you can request sum-
mary calculations on each break. For example, you can insert a sum-
mary calculation in a subtotal row to display subtotals for sales from 
each state in a marketing region. Refer to the “Adding Summary Calcu-
lations” section on page 189 for more information about adding sum-
mary calculations to Subtotal and Total rows.

The label of a subtotal row indicates which change in value triggers the 
break.

Using the Values of 
Break Fields in 
Labels

You can improve the appearance and clarity of your reports by labeling 
each Subtotal row using the value of the Break field.

To request that the value of a Break field be printed in a label placed in 
the Break area, use the number sign (#) in the label. For example, the 
text “Total salaries for # department” will insert the department name 
(in this case, the value of the Department field) in place of the number 
sign when the report is printed.

The number sign does not need to be placed in the same column as the 
Break field. It will display the value of the Break field in any cell in the 
Subtotal row.

Subtotal rows
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The following figure illustrates the use of the number sign in a label in 
the Subtotal row:

Subtotal Spacing It is possible to configure subtotal rows in order to control the page 
layout and appearance of the quick report. For example, you can 
generate a page break after each subtotal. 

The subtotal page layout options can be used to visually set apart the 
different parts of the report. 

❿❿❿❿ To set the spacing for a subtotal row:

1 Select a subtotal row and choose the Totals Spacing command from 
the File menu of the editor.
OR
Right-click on the subtotal row title and choose the Totals Spacing 
command:

Number sign 
used in label
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The “Subtotals Properties” dialog box appears:

2 Choose one of the three following options:

■ Do nothing (option selected by default): No specific property is applied 
to the subtotal row; it has the same spacing characteristics as the other 
rows of the report. 

■ Generate a page break: A page break is generated after each subtotal 
row in the report.

■ Generate extra space: A specific amount of space is added below each 
subtotal row in the report. 
An additional option can be used to set the spacing mode:

■ Extra points: You set a specific height of extra space in points.

■ Extra % of height: You set the amount of extra space to be added as 
a percentage of the standard row height of the report. For example, 
to generate extra space corresponding to two empty rows, pass the 
value 200. 

Adding Summary Calculations
You can add summary calculations on the contents of fields and 
formulas to each Subtotal row and to the Totals row. In a cross-table 
report, calculations can be inserted in the center row.

The calculation buttons in the toolbars of the Quick Report editor 
identify the summary calculation options available for quick reports.
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The following summary calculations are available:

■ Sum: Totals the values in the report or break.

■ Average: Calculates the average of the values in the report or break.

■ Minimum: Displays the lowest value in the report or break.

■ Maximum: Displays the highest value in the report or break.

■ Count: Calculates the number of records in the report or break.

■ Standard deviation: Displays the square root of the variance of the 
report or break (the variance is a dispersion value around the average).

These options also appear in the Quick Report contextual menu for 
cells in the Subtotal and Total rows or, for a cross-table report, in the 
total cells and the center cell.

■ List Reports
When you place a summary calculation in the Totals row, the calcu-
lation is done for all records in the report. If you place the summary 
calculation in a subtotal row, separate calculations are done for the 
records in each break.

■ Cross-table reports
Summary calculations will apply as follows

Applies to values Applies to values
in each column in both the last column

and last row

Applies to values 
in each rowApplies to each 

cell of the table
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Adding Summary Calculations
❿❿❿❿ To add a summary calculation:

1 Select a cell where you want to insert the summary calculation.
The Sum, Minimum, Maximum, and Average calculations work only 
on a numeric field or formula. 

2 Click as many summary calculation buttons as you like. 
OR
From the contextual menu, choose the desired summary calculations.
4th Dimension displays a calculation icon in the selected cell for each 
type of summary calculation you request. The following figure shows a 
Sum calculation icon in a Subtotal row:

If you add more than one summary calculation to a cell, 
4th Dimension stacks the calculation icons on top of each other.

Using Calculations 
and Column Values 
in Labels

You can insert summary calculations using the following codes. 

■ ##S will be replaced by the sum in the sub-total or total row.

■ ##A will be replaced by the average.

■ ##C will be replaced by the count.

■ ##X will be replaced by the max.

■ ##N will be replaced by the min.

■ ##D will be replaced by the standard deviation. 

■ ##xx, where xx is a column number. This will be replaced by that 
column’s value, using its formatting. If this column does not exist, 
then it will not be replaced

These codes can be useful when you want to mix labels and data in a 
cell.

Calculation icon
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Displaying Repeated 
Values for Break 
Columns

In a report with subtotals, the columns which are used to group 
records so that summary calculations can be done are called Break 
columns. In the report shown below, the Department field is a Break 
column since the records in the report are grouped by department.

When a report like this is printed, the values for the Break column are 
printed only once per break. In other words, a department name is 
printed only for the first record in the group and is not repeated until 
the department changes.

In some cases, you may want to repeat the values for the Break col-
umns so that they appear for every record in the Break area. You do so 
by selecting the Repeated Values column property. This can be done 
either by clicking the Repeated Values button in the toolbars , by 
choosing the Repeated Values menu command in the Quick Reports 
contextual menu for that column, or by selecting Repeated Values 
from the Columns menu.

❿❿❿❿ To display repeated values for fields in a column:

1 Select the column by clicking the header row for that column and 
choosing the Repeated Values command in the Columns menu or 
clicking the Repeated Values button  in the “Columns” toolbar.
OR
From the contextual menu for that column, choose Repeated Values.

Non-repeating 
break values
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Setting Display Formats
The following figure shows the previous report after the Repeated 
Values check box has been checked for the Department Name column.

Setting Display Formats
You can specify display formats for columns that contain numeric 
(integer, longint, real), alphanumeric (alpha), date, time and picture 
data. 

For example, if you are displaying prices in a column, you can add a 
numeric format to the Detail cell for the Price field. The $###,##0.00;-
$###,##0.00 format places a dollar sign ($) to the left of the number 
and can display dollar amounts from -$999,999.99 to $999,999.99:

If your report includes Alpha fields such as a telephone number or 
Social Security number, you can use an Alpha format. If your report 
displays dates, times or pictures, you can also assign display formats to 
them.

4th Dimension provides different default display formats. However, 
you can create your own display styles for numeric and alphanumeric 
formats. For more information about this point, refer to the 
4th Dimension Design Reference manual.

Break values 
(repeated)

Numeric format
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Chapter 9  Quick Reports
Assigning the 
Display Format

You can associate a display format with a cell by selecting it in the 
contextual menu or by entering it directly in the cell. 

❿❿❿❿ To assign a display format to a numeric, alpha, date, time or picture 
field:

1 Right-click on a cell of the column with which you want to associate a 
style.

The contextual menu of the editor appears.

2 Select the desired display format from the Format submenu:

The contents of the submenu vary according to the type of data 
contained in the column: numeric, alphanumeric, date, time or 
picture. If the report column contains data that cannot be formatted, 
the Format command does not appear in the contextual menu.

Note For more information about display formats, refer to the Design 
Reference manual of 4th Dimension. 

The format is entered in the Detail cell. If you have also requested sum-
mary calculations for the column, the format specified in the Detail 
cell will automatically be applied to the summary calculations. The 
only exception is the “Count” calculation which is always displayed as 
an integer and does not accept any formatting symbols such as the dol-
lar sign.
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Hiding and Showing Rows and Columns
You can also enter the formats to be applied manually by clicking 
twice in the cell and entering the elements of the format using the 
keyboard. 

Different formats can be applied to different columns in the report.

Hiding and Showing Rows and Columns
4th Dimension lets you hide rows or columns in a quick report in List 
mode. If desired, you can show a hidden column or row.

Hiding rows is useful when you want the report to include only sum-
mary calculations. For example, hide the Detail row if you want to dis-
play only the summary calculations that appear in the Totals and 
Subtotal rows. You can also use this feature to hide a Subtotal row or the 
Totals row.

You can hide a column if you need to use the column as a sort column, 
but do not want the report to display it. 

You can hide/display a row or column using either the Quick Report 
contextual menu, the Columns menu or the “Columns” toolbar.

Note You cannot hide a row or column in a cross-table report.

❿❿❿❿ To hide a row or column:

1 Select the row or column you want to hide by clicking on its header.
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2 Right-click on the header of the row or column to be hidden, then 
choose Hide in the contextual menu:

OR
Choose the Hide command in the Columns menu of the Quick Report 
editor. 

OR
Click on the  button of the “Columns” toolbar. 
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Adding Page Headers and Footers
4th Dimension displays the column in gray to remind you that the row 
will not appear when you print or preview the quick report.

Showing a Hidden 
Row or Column

When a row or column is hidden, a check mark (√) is displayed next to 
the Hide menu command in the Columns or contextual menu. In 
addition, the corresponding button of the “Columns” toolbar is 
pressed in.

You can display a hidden row or column by choosing Hide again from 
either the Columns or contextual menu, or by pressing the 
corresponding button in the “Columns” toolbar again. When you do 
so, the row or column is displayed normally in the Quick Report area.

Adding Page Headers and Footers
Before printing a quick report, you can add page headers and footers. 
You specify page headers and footers in the Headers and Footers dialog 
box. Use this dialog box to do the following:

■ Add page header and footer text or pictures,

■ Specify the size of the page header and footer areas,

■ Use separate text for left, center and right parts of the header and 
footer, 

■ Specify fonts, font sizes, and font styles for page header and footer text,

■ Insert codes that add page numbers and the date and time to your 
reports.

You can only specify page headers and footers when printing to a 
printer. However, once they are defined, they are kept with the report, 
even if the destination is modified. See the “Generating a Quick 
Report” section on page 200 for more information about alternate 
output destinations.

Hidden row

Hidden column
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❿❿❿❿ To add page headers and footers:

1 Choose Header and Footer... from the File menu.
The Headers and Footers dialog box appears.

Note The preview area takes the print format configuration into account. 

The Headers and Footers dialog box lets you specify both headers and 
footers using the same screen. Use the Headers/Footers drop-down list 
to indicate the one you currently want to define.

2 Choose Headers or Footers from the selection menu.

3 Enter the header or footer height in the Height area. 
When you first enter the dialog box, the header and footer heights are 
set to 25 points each. You can not only change these values, but can 
change the measurement scale to enter values in inches or centimeters 
as well.

Picture 
insertion 
area

Headers/Footers
drop-down list

Text insertion 
area

Page preview 
area
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Adding Page Headers and Footers
As you enter the header and footer height, the lines on the page 
preview area change to indicate the size of the header and footer as 
they will appear in the printed report.

4 If you want to use a picture, paste it in the picture area (using 
standard copy-paste commands):

5 Select its alignment by clicking on the alignment icons:

6 If you want the height of the picture to become the height of the 
header/footer, click the Apply button:

7 Select an entry area and type the header or footer text.
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To the right of each entry area, there are three buttons that let you 
enter variables into the entry area. 

You can insert the current page number, time of execution, or date of 
execution.

You can also use the code for the variables directly: #H for the time, #D 
for the date and #P for the page number.

8 Assign the font attributes for the header/footer.

9 Click OK to validate the changes.

Generating a Quick Report
After you have completed your report design, you can “print” the 
quick report. You can print a quick report to a variety of output types:

■ On the standard printer selected,

■ To disk, in a Text file,

■ To a graph,

■ To a 4D View document,

■ To an HTML document.

❿❿❿❿ To select an output destination:

■ Choose Destination from the File menu. 

Inserts the current time

Inserts the current date

Inserts the current page
number
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Generating a Quick Report
The Destination submenu contains five items.

Printer This option uses the printer you have chosen in your current print set-
tings. If you are printing to a printer, you can preview the report before 
printing it. 

❿❿❿❿ To print to a printer:

1 In the File menu, choose Printer from the Destination submenu.
This option is selected by default.

2 If necessary, select Page Setup from the File menu and specify your 
print parameters. 

Note This command is only available when the Printer destination is 
selected. 

3 If you want to preview your report, select Print Preview... in the File 
menu. 

Note This command is only available when the Printer destination is 
selected. 

The print preview dialog box appears, containing the report that you 
have defined with the current data of the database. 

4 Select Generate... in the File menu. 

5 Choose the settings that are appropriate for your report and click the 
OK button. 
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Disk File This option sends your quick report to a disk file that you can open 
and modify with other applications, including text editors and spread-
sheets. This option exports the records in the quick report to a text file.

When you use this option, 4th Dimension automatically uses the 
column headings as the first “record” that is exported.

❿❿❿❿ To generate the report in a Text file:

1 In the File menu, choose Disk File from the Destination submenu.

2 Choose Generate... from the File menu. 
4th Dimension displays a standard create-file dialog box and asks you 
to enter a filename. 

3 Enter a filename and click OK.
4th Dimension displays a dialog box that keeps you informed of the 
progress of the operation.

After the report is printed to a file, 4th Dimension returns you to the 
Quick Report editor. Remember to change the output device if you 
want to resume sending a quick report to a standard printer.

Print to Graph This option directs the report to 4D Chart, 4th Dimension’s plug-in for 
plotting data. When you choose the Graph item in the Destination 
submenu, your report is presented as a graph rather than in table form. 
Your graph can then be printed using 4D Chart.

■ In list mode, 4D Chart uses only the summary calculations and labels 
in the Subtotal row. It uses the leftmost non-numeric column for the 
Categories axis (the horizontal axis). To use the Graph feature, your 
report should:

■ Include from one to five numeric fields or formulas. These columns 
will be assigned to the values axis in the graph.

■ Use one type of summary calculation per numeric field.
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Generating a Quick Report
For example, if you want to graph the average salary by department, 
you should create a quick report with two columns, Department Name 
and Salary as well as a Subtotal row consisting of the Average summary 
calculation for Salary:

■ In cross-table mode, 4D Chart uses two data sources and the value cell. 
The last row and column are ignored.
For example, if you want to show the amount of sales per country for a 
set of products, you can define the following report:

❿❿❿❿ To print to a graph:

1 In the File menu, choose Graph from the Destination submenu.

2 Choose Generate... from the File menu. 

Value to be
represented graphically

Value to be represented 
graphically (Z-axis)

Series (Y-axis)

Elements (X-axis)
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Chapter 9  Quick Reports
■ For list reports, 4th Dimension graphs your data as a 2D column 
graph.

■ For cross-table reports, 4th Dimension graphs the data as a 3D 
column graph:

You can use 4D Chart to select another graph type or print the graph. 
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Generating a Quick Report
Printing to a 
4D View Document

This option directs the report to 4D View, 4th Dimension’s plug-in for 
displaying data. When you choose the 4D View item in the 
Destination submenu, your report is presented as a 4D View window 
rather than in table form. 4D View uses all the data in the report.

Note The 4D View destination is only available if this plug-in is installed in 
your 4th Dimension environment, and if you have the appropriate 
licenses. 

❿❿❿❿ To generate a report in a 4D View document:

1 In the File menu, choose 4D View from the Destination submenu.

2 Choose Generate... from the File menu. 
4th Dimension creates a 4D View window containing the data. You can 
modify its contents, print it or save it using the 4D View menu com-
mands. 

Printing to an HTML 
Document

This option sends your quick report to an HTML file. When you 
choose this option, it uses the default HTML template unless it was 
changed programmatically.

When you use this option, 4th Dimension automatically uses the 
column headings as the first “record” that is exported.

❿❿❿❿ To print to an HTML file:

1 In the File menu, choose HTML File from the Destination submenu.

2 Choose Generate... from the File menu. 
4th Dimension displays a standard create-file dialog box and asks you 
to enter a filename. 

3 Enter a filename and click OK.
4th Dimension displays a dialog box that keeps you informed of the 
progress of the operation.

After the report is printed to an HTML file, 4th Dimension returns you 
to the Quick Report editor. Remember to change the output device if 
you want to resume sending a quick report to a standard printer.
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Generating 4D Code
The Quick Report editor allows you to automatically generate the 
4th Dimension code corresponding to a defined report and paste it in 
the Clipboard. This function allows manual building of quick report 
outlines that can be customized using 4th Dimension language. 

This feature is only available in User mode. 

The button for code generation is located on the last page of the Quick 
Report Wizard:

Even if you built the quick report manually, you can use this feature by 
displaying the “Finalization” step of the wizard. 

When you click on this button, a dialog box appears that allows you to 
set the parameters related to code generation:

Build 4D code

Last page of 
Wizard
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Generating 4D Code
The following options are available:

■ Borders: Check this option to specify that you want to include the cell 
border properties in the generated 4D code.

■ Palettes visibility: Check this option to specify that you want to 
include the current palettes display status (Standard, Styles, Col-
umns...) in the generated 4D code. 
It is advisable to deselect this option if the code is intended for use in 
an offscreen area. 

■ Text properties: Use this option to specify that you want to include the 
font style definition of the report (font, style, etc.) in the 4D code. 
If this option is not checked, the three following options have no 
effect. 

■ Font, Size, Justification: When this option is checked, the generated 
4D code includes information regarding font, font size and font jus-
tification in the quick report template. 

■ Style (Bold, Italic, Underline): When this option is checked, the 
generated 4D code includes information regarding text styles in the 
quick report template.

■ Color (Text, Background): When this option is checked, the gener-
ated 4D code includes information regarding the text colors in the 
quick report template.

Once you have defined the options, click on the Build code button to 
generate the 4D code; the code is then displayed in the Preview area of 
the dialog box: 
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You can modify the code options and click again on the Build code 
button in order to update the preview area. 

If you are satisfied with the code generated, click on the Paste in 
Clipboard button, then click on the Close button to close the dialog 
box. 

You can then paste the code in a method or a text file using the 
standard shortcut Ctrl+V (Windows) or Command+V (Mac OS), or the 
Paste command in the Edit menu. 
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10 Labels

4th Dimension’s Label editor provides a convenient way to print a wide 
variety of labels. 

With the Label editor, you can do the following:

■ Design labels for mailings, file folders and file cards, and for many 
other needs

■ Specify the font, font size, and style to be used for the labels

■ Specify the number of labels across and down on each page

■ Specify the label page margins

■ Load and save label designs

■ Print labels.

Labels can also be created using the Form editor in the Design 
environment. Use the Form editor to design specialized labels that 
include variables or take advantage of the drawing tools available in 
the Form editor. For more information about using the Form editor to 
create labels, refer to the 4th Dimension Design Reference manual.

The Label Wizard
You use the Label Wizard to create, format, and print labels in the User 
environment. The Label Wizard contains settings for designing labels 
and positioning the labels on label paper. For example, when produc-
ing mailing labels, you might want a label design that includes the per-
son’s first and last name on the first line, the street address on the 
second line, and so on.
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As part of the design, the Label Wizard enables you to specify the num-
ber of labels on the page and the margins of the label paper so that the 
label text is centered within the labels.

The Label Wizard consists of two pages, the Label page and the Layout 
page, each identified by a tab at the top of the dialog box. You use the 
Label page to specify the contents of the label and the Layout page to 
define the size and position of the labels on the page. When you create a 
satisfactory label design, you can save it to disk so that you can reuse it.

Opening the 
Label Wizard

To open the Label Wizard:
Choose Labels from the Tools menu or click on the corresponding icon 
in the toolbar of the User mode.
4th Dimension displays the Label page of the Label Wizard. 

Label Page The Label page contains settings for designing and formatting labels.

It contains the following elements:

■ Fields list: This area displays the names of the fields in the current table 
in a hierarchical list. If this table is related to other tables, the foreign 
key fields have a plus sign (on Windows) or an arrow (on Macintosh). 

Toolbar

Text attributes 
areas

Label preview 
area

Fields list

Object Look 
area

Form to Use 
drop-down list

Static text 
entry area

Default Look button
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The Label Wizard
You can display fields from the related table by expanding the related 
fields. The fields in the related table are indented. 

Note Only tables and fields which are visible appear in the Label Wizard. For 
information about making tables and fields invisible, refer to the 
4th Dimension Design Reference manual.

■ Label preview area: You use this area to design your label.

■ Toolbar: The Label Wizard toolbar contains tools for drawing, select-
ing, aligning, distributing, layering, and duplicating objects. For com-
plete information on the toolbar, see “The Label Wizard Toolbar” 
section on page 212.

■ Object Look area: These controls let you specify foreground and 
background colors, fill patterns, and borders for individual objects on 
the label.

■ Default Look button: This button applies the default set of Object Look 
attributes to the selected object.

■ Static Text entry area: This area allows you to add static text objects to 
the label.

■ Text attributes areas: These controls allow you to specify the font, font 
size, display format, and style of the text. 

■ Form to Use drop-down list: This drop-down list lets you bypass the 
Label Wizard and use a form to print the labels. If you are using the 
Label Wizard to create the label, choose No Form (default) from this 
list. If you want to use a form, choose it from this list. 4th Dimension 
will then ignore any other label specifications in the Label Wizard and 
print the labels according to the design of the specified form. As with 
any print job, it executes any form or object methods associated with 
the form. See the 4th Dimension Design Reference manual for more 
information about designing forms for labels.

Layout Page The Layout page contains controls for printing labels based on the 
requirements of the printer you selected in the Print Manager (Chooser 
on Macintosh), so that it can format the page accurately.

For complete information on the Layout page, see the “Specifying the 
Label Layout” section on page 223.
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The Label Wizard 
Toolbar

The Label Wizard toolbar contains the following tools.

Creating a Label Design
You create a label by dragging field names to the Label Preview area, 
adding static text, drawing graphic objects using the graphics tools in 
the toolbar, and pasting graphics from the Clipboard. You can edit the 
label by distributing, moving, resizing, layering, and aligning objects. 
With the Object Look and Text attribute areas, you can control the 
font attributes, foreground and background colors, fill patterns, and 
borders of individual objects.

The Label Preview area shows the approximate size and shape of the 
selected label. Before adding elements to the label, you may want to 
specify your label paper and label dimensions using the Layout page. 
For information, see the “Specifying the Label Layout” section on 
page 223.

Note You cannot add a formula (a variable) to a label with the Label Wizard. 
If you need to use a variable on a label, use the Form editor.

❿❿❿❿ To create a label:

1 Drag the first field you want to display in the label from the Fields list 
to the Label Preview area.
If the field is in a related table, expand the related field to display the 
fields in the related table.

Drawing tools

Rectangle
Rounded Rectangle
Oval
LIne

Alignment Tools

Move to Front
Move to Back

DuplicateArrow tool

Align Right
Align Left
Align Bottom
Align Top
Align Horizontal Center
Align Vertical Center

Distribute Vertically
Distribute Horizontally
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Creating a Label Design
Your field is added to the Label Preview area. Selection handles indicate 
that it is selected. 

2 If you want to concatenate a field to this field, drag the new field from 
the Field list to the existing field.
OR
If you want to concatenate two fields using the Carriage return as the 
separator, drag the new field by holding down the Shift key.
OR
Otherwise, continue dragging fields to the Label Preview area.

■ When you concatenate two fields by simply dragging and dropping 
them, the separator used is the one defined in 4th Dimension’s 
resources. By default, the Space character is used. A “+” between 
field names in a field object indicates that the fields are concatenated on 
a single line. When 4th Dimension prints the label, it will insert a space 
between the fields on the same line. The following illustration shows the 
concatenation of the First Name and Last Name fields.

■ If you concatenate two fields by dragging and dropping the second 
field while holding down the Shift key, the Carriage return is used 
as the separator. When the labels are being printed, if the second 
field is empty, its position is deleted and is replaced by the next 
field. If a field contains some text with Carriage returns, they are 
taken into account. 
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For example, this feature allows you to create address labels by 
using many concatenated fields ([Clients]Address1, [Cli-
ents]Address2, etc.) without generating an empty line when a field 
is blank.
You can automatically resize a group of concatenated fields so that 
it corresponds to the number of lines that it contains. To do so, 
Ctrl+click (Windows) or Command+click (Mac OS) on the lower 
right handle of the group.

As you add fields, you can reposition them by dragging or using the 
alignment tools in the toolbar. 

3 To add a text element to the label, enter the text in the Static Text 
area and click the arrow . 
The static text object is added to the Label Preview area. The following 
illustration shows a static text element being added to the label: 

After you add the element to the label, you can reposition it by drag-
ging and aligning it with other objects.

4 (Optional) Using a drawing tool, draw any graphic objects that you 
want to add to the label.
For example, you could add different backgrounds to the “TO:” and 
“FROM:” sections of the label.

5 (Optional) Paste a graphic from the Clipboard into the Label Preview 
area.
For information on adding a graphic to the label, see the “Adding a 
Graphic to the Label” section on page 222.

After you add all required elements to the Label Preview area, you can 
use any of the editing tools to modify the label design. For complete 
information, see the “Working with Label Wizard Objects” section on 
page 215.

How the Label Wizard 
Handles Blank Fields

Some records in your database may not contain entries for every field. 
When printing labels, the Label Wizard handles blank fields intelli-
gently. Instead of leaving gaps where the data should be, the Label 
Wizard concatenates the data.

If a field in a line contains no data for a particular record, 4th Dimension 
concatenates the remaining fields in the line without leaving a blank 
space for the missing data.
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If an entire line contains no data for a particular record, 4th Dimension 
vertically concatenates the remaining lines in the label without leaving 
a blank line.

4th Dimension automatically centers the text of the label inside the 
label area.

Clearing Fields If you make a mistake, you can remove one or more fields from the 
label. 

❿❿❿❿ To remove an object:

1 Select the object and press Backspace (Delete on Macintosh).

The selected object is removed. If the object is a row of concatenated 
fields, pressing Backspace removes only the last field in the row. Con-
tinue pressing Backspace to remove more fields from the row.

Working with Label Wizard Objects
This section discusses the techniques for editing objects placed on the 
label. It includes:

■ Creating graphic objects,

■ Aligning objects,

■ Distributing objects,

■ Layering objects,

■ Duplicating objects,

■ Moving objects,

■ Resizing objects,

■ Adding a border to an object,

■ Adding foreground or background fill colors, patterns, and borders,

■ Pasting a graphic into the label,

■ Deleting objects.
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Creating Graphic 
Objects 

You can create a graphic object by drawing.

❿❿❿❿ To create an object:

1 Select the type of object you want to draw by clicking its tool in the 
toolbar.
The pointer becomes a crosshair when it is over the Label Preview area. 

2 Drag to create an area for the object.
For two-dimensional objects (ovals, rectangles, and rounded rectan-
gles), drag diagonally. 

Note Hold down the Shift key as you draw to constrain the object to a regu-
lar shape. Lines are constrained to horizontal or vertical, rectangles are 
constrained to squares, and ovals are constrained to circles.

3 When you have finished drawing the object, release the mouse 
button.
4th Dimension creates the object and makes it the currently selected 
object. The Arrow tool is automatically selected and the pointer 
becomes an arrow.

Aligning Objects The alignment tools let you align objects to each other. When you 
align one object to another, you can align it to the top, bottom, side, 
or horizontal or vertical center of the other object. 

The following illustration shows the Label Wizard’s alignment tools.

1) Select the 
drawing tool 
you want to use

2) Drag to draw 
the object

Align Right

Align Bottom

Align Left

Align Top

Align Center Vertical

Align Center Horizontal
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The arrangement of lines represents the function of each tool. For 
example, the Align Right icon shows the lines aligned vertically on the 
right side of the box. The Align Center Vertical icon shows the lines 
aligned vertically in the middle.

❿❿❿❿ To align a set of objects:

1 Select the objects that you want to align.
Shift-click to select several objects.

2 Click the alignment tool that corresponds to the alignment you want.
4th Dimension aligns the selected objects according to the alignment 
you selected.

Distributing Objects The toolbar includes two tools that let you distribute three or more 
objects evenly.

When you use either tool, you can modify its action by holding down 
the Shift or Alt keys when you click either tool. 

■ Clicking: Distributes the objects from their adjacent sides,

■ Shift+Clicking: Distributes the objects from their left sides (horizontal) 
or tops (vertical),

■ Alt+Clicking: Distributes the objects from their right sides (horizontal) 
or bottoms (vertical),

■ Shift+Alt Clicking: Distributes the objects from their centers.

Distribute vertically Distribute horizontally
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These rules are illustrated in the following diagram. 

❿❿❿❿ To distribute a set of objects:

1 Select the objects that you want to distribute.
You must select at least three objects. Hold down Shift and click to 
select several objects.

2 If desired, hold down a modification key or key combination and click 
the Distribute Horizontally or Distribute Vertically tool.
4th Dimension distributes the selected objects according to the rules 
you selected.

Layering Objects You may want to create a design that uses objects in different layers. 
For example, you may want to place a shaded rectangle behind the 
fields on a label. The Label Wizard provides the Move to Back and 
Move to Front tools that let you layer objects on the label. 

Click Shift+Click Alt+Click (Windows)
Option+Click (Mac OS)

Shift+Alt+Click (Windows)
Shift+Option+Click (Mac OS)

Distribute 
Vertically

Standard Tops Bottoms Centers

Action 

Standard Left Sides Right Sides CentersDistribute 
Horizontally 
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The following illustration shows objects in front of other objects:

Clicking the Move to Front or Move to Back tools moves the selected 
objects to the top or bottom layer. If you want to move the object only 
one layer toward the front or back, hold down the Shift key when you 
click Move to Front or Move to Back.

❿❿❿❿ To move an object to the front or back:

1 Select the object or objects that you want to move to the back.
Hold down Shift and click to select several objects.

2 Click the Move to Front or Move to Back tool in the toolbar.
4th Dimension moves the selected object or objects to the front or 
behind all the other objects.

Note When you move an object to the back, it may be hidden by objects in 
front of it. To see the object, select the object in front and send it to the 
back.

Duplicating Objects You can duplicate any object in the label. Copies of active objects 
retain all the properties of the original, including foreground and back-
ground colors and fill patterns, text attributes, and display format.

❿❿❿❿ To duplicate an object:

1 Select one or more objects.
Hold down Shift and click to select several objects.

2 Click the Duplicate tool in the toolbar.
4th Dimension duplicates the selected object or objects.

Moving Objects You can move objects by selecting them and dragging with the mouse. 
You can also use the arrow keys to move the object either one or ten 
pixels at a time.

■ To move an object one pixel at a time, select the object and press an 
arrow key.

■ To move an object ten pixels at a time, select the object, hold down the 
Ctrl key (on Windows) or Command key (on Macintosh), and press an 
arrow key.

Fields in front of 
shaded rectangle
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Resizing Objects You can resize any object on the label by selecting it and dragging a 
selection handle. 

❿❿❿❿ To resize an object by dragging:

1 Select the object you want to resize.

2 Move the pointer over one of the four handles that appear on the 
selected object.
The pointer changes into a multi-directional arrow  and the handles 
disappear.

3 Drag the handle toward the center of the object to shrink it. 
OR
Drag the handle away from the object’s center to enlarge it.
4th Dimension resizes the object.

Adding a Border to 
an Object 

You can add a one-pixel border to an object. The border can be from 
one to nine pixels from the object.

❿❿❿❿ To add a border:

1 Select the object.
The selected object is indicated by selection handles.

2 Hold down the Ctrl key (Command key on Macintosh) and press a 
number from 1 to 9 on the numeric keypad.
A border is added to the object. The distance from the object (in pixels) 
is controlled by the number you pressed. The following illustration 
shows the results of pressing Ctrl+1.
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Adding Foreground 
or Background 
Colors

4th Dimension lets you add colors to objects for display on a color 
monitor or (if your printer supports color) for color printing. By com-
bining selected colors with fill patterns, you can display thousands of 
different color shadings.

Note Colors appear black and white on a black and white monitor. They 
appear as shades of gray on a gray-scale monitor. The color palettes 
display shades on a gray-scale monitor.

You can specify different colors for foreground pixels (pixels that appear 
black on a black-and-white monitor) and background pixels (pixels that 
appear white on a black-and-white monitor). If the object is a field or 
static text, the foreground color controls the color of the text and the 
background color controls the color of the object’s rectangle.

You set foreground and background colors using the Background and 
Foreground picture menus in the Object Look area of the Label Wizard.

If your monitor supports 16 colors, choose the colors from the first 16 
colors on each palette. If your monitor supports 256 colors (or more), 
any colors you choose will display properly.

Setting Fill Patterns You can apply a fill pattern to any two-dimensional graphic object in 
the form such as an oval, a rectangle, a line, the enclosed area of a field 
or static text object, and a two-dimensional object’s border. 

The Fill picture menu controls the fill pattern for the selected object. 
The Border picture menu controls the fill pattern for the border.

Setting Border 
Patterns

You can set patterns for the borders of any object in the form that has a 
border such as an oval, a rectangle, and a grid object. The border 
patterns available are the same as the fill patterns. The appearance of 
the border also depends on the line width you have specified for the 
border.

The following illustration shows a fill pattern applied to the upper 
rectangle and a border fill pattern applied to the bottom rectangle.
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Setting Line Width The Line Width pop-up menu controls the width of a line or the width 
of the border of a two-dimensional object.

To set a line width, select the object and choose a line width from the 
Line Width pop-up menu.

Restoring the 
Default Look

When you add an object to the label, it takes on the Object Look 
attributes of the most recently created object. If you want to assign the 
default Object Look attributes to this object (or any object), select the 
object and click Default Look. The foreground and background colors, 
fill patterns, and border width are reset to the default settings.

Adding a Graphic to 
the Label

In addition to the drawing tools in the toolbar, you can paste a graphic 
from the Clipboard into the label. 

❿❿❿❿ To paste a graphic into the label:

1 Place the graphic on the Clipboard.

2 Choose Paste from the 4th Dimension Edit menu or press Ctrl+V 
(Command–V on Macintosh).
The graphic appears in the Label Preview area with selection handles. 

You can then move, align, distribute, or resize the object like any other 
object.

Deleting Objects You can delete the selected object by pressing the Backspace key 
(Delete key on Macintosh). If the selected object contains concate-
nated fields, the last field is removed from the object. If you want to 
delete the entire object, continue pressing the Backspace or Delete key.
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Specifying the Label Layout
You specify the label layout with the Layout page of the Label Wizard. 
You can display the Layout page at any time by clicking its tab.

The Layout page contains the following elements:

■ Orientation and Labels Order buttons: These buttons enable you to 
specify the page orientation and the order in which information is 
assigned to labels. Keep in mind that the orientation of the sheet is 
independent from that of the page. If you modify this parameter, be 
sure to change the configuration of the page accordingly in the 
standard print setup dialog box.

■ Labels across and down boxes: These boxes are used to control the size 
of labels by specifying the number of labels that appear on your label 
paper.
2234th Dimension User Reference



Chapter 10  Labels
■ Layout preview area: This area provides a reduced view of how an 
entire page of labels will look, based on the dimensions you enter in 
the Label Wizard. The page preview also reflects the paper size selected 
in the Print Setup dialog box. You can also select the first label on the 
page to be printed. The red border indicates the size of the physical 
page and the blue border indicates the size of the printable area.

■ Label Size and Page Size radio buttons: These buttons are used to 
select the label or the page for setting label and page dimensions. If 
you click Label Size, you can enter the label width and label height in 
the appropriate areas. If you click Page Size, you can enter values for 
right margin and bottom margin, as shown below.

■ Margin boxes: These boxes are used to specify the dimensions of the 
label and the page size, depending on the radio button you select. After 
you have entered the margins of your label paper, you may need to 
make some additional adjustments so that the label text is centered in 
the labels. You can use both positive and negative numbers in the 
Margin boxes to increase and decrease the margins.

■ Automatic Resizing: If Automatic Resizing is checked, the values in the 
Label Width and Label Height entry areas are set automatically.

■ Horizontal Gap: This area controls the amount of space between label 
columns.

■ Vertical Gap: This area controls the amount of space between label 
rows.

■ Unit drop-down list: This drop-down list allows you to change the 
units in which you specify your label and label page measurements. 
You can use pixels, millimeters, centimeters, or inches. 
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■ Labels per record drop-down list: This control lets you print more than 
one copy of each label. If you print more than one copy, 
4th Dimension prints the copies consecutively rather than making 
copies of the label pages.

■ Standard Code drop-down list: This control lets you specify the label, 
page dimensions, and margins by choosing a standard commercial 
label paper from the drop-down list.

■ Method to apply: This control lets you choose a method that will be 
run at print time. For example, you can execute a method that posts 
the date and time that each label was printed.

■ Apply Once radio buttons: These radio buttons are used to specify 
whether to run the method once per label or once per record. This 
control has meaning only if you are printing more than one copy of 
each label and you are also executing a method at print time.

■ File buttons: These buttons provide options for page setup, printing, 
saving, and loading label designs.

❿❿❿❿ To specify the layout of the label sheet you are using:

1 Click the Layout page tab.
The Layout page of the Label Wizard appears.
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You can specify the design of the label sheet using the entry areas on 
the Layout page or choose a standard design from the Standard Code 
drop-down list. This drop-down list contains specifications for a wide 
variety of standard commercial label sheets.

2 Click the Print Setup button.
The Print Setup dialog box for your operating system appears. 

3 Choose the desired printer and click OK.
If necessary, the Label Preview area changes to reflect your selection.

4 If appropriate, choose the type of label paper you are using from the 
Standard Code drop-down list.
The remaining entry areas on the page change to reflect the selected 
label paper’s characteristics. If necessary, you can modify these specifi-
cations.

5 Click the appropriate Orientation and Labels Order radio pictures.
You can choose between portrait and landscape orientation and 
horizontal or vertical order. Remember that the orientation of the sheet 
is independent from that of the page. If you modify this parameter, be 
sure to change the configuration of the page in the standard print 
setup dialog box.

6 Enter the number of labels in each row of your label sheet in the 
Labels Across box and the number of labels in each column in the 
Labels Down box.
The Label Preview area adjusts to display the appearance of the labels 
on a printed page.

7 If the first sheet of label paper is partially used, click on the first blank 
label in the Label Preview area.
226 4th Dimension User Reference



Specifying the Label Layout
4th Dimension will begin printing labels on the label you indicated. 
The following illustration shows the Preview area after clicking on the 
second label area.

8 If desired, choose a unit of measurement from the Unit drop-down list 
to use for entering margin sizes.

9 Enter values to reflect the margins on your label paper.

Use the Label Size and Page Size radio buttons to control whether you 
use the entry area for the size of the label or the size of the page.

The size of the individual labels in the label page preview will adjust to 
accommodate the margins. For example, if you increase the size of 
your margins to two inches, top and bottom, the size of the individual 
labels will shrink to maintain the same number of labels that you 
specified earlier.

Because some printers use portions of the margin to hold the label 
sheet in place, the printer may not take the full margins into account 
when printing your labels. In this case, you may need to adjust the 
margin settings so the label text is properly centered in each label. 
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Since the printer uses part of the margins, the printer begins measuring 
the margins from a point that is not precisely at the edge of the label 
paper. When the labels are printed, the label text may appear skewed 
to the right or to the bottom of the label paper.

To compensate for this lost margin space, you can use negative num-
bers in some of the margin boxes. When placed in the Right margin 
box, negative numbers pull the label text to the right. When entered in 
the Top margin box, negative numbers pull the label text toward the 
top of the page. 

Note As a rule, using a negative number in a margin box moves the label 
text toward the margin you are setting.

10 (Optional) If you want to print more than one copy of each label, use 
the Labels per Record drop-down list to choose the number of copies 
to print.
The copies are printed consecutively on the label paper. 4th Dimension 
does not duplicate the entire label page.

11 (Optional) If you want to run a method when the labels are printed, 
choose the method from the Method to Apply drop-down list.

12 (Optional) If you are running a method and printing more than one 
copy of each label, click either the Once Per Record or Once Per Label 
radio button in the Apply Once area.
This control has no effect unless you are using both the multiple 
copies and method features.

Saving and Loading Label Designs
4th Dimension lets you save each label design as a file that you can 
open from the Label Wizard. By saving label designs, you can maintain 
a library of labels that you can use according to your needs. 
Label designs store the parameters set on the Label and Layout pages. 

Saving a Label Design To save a label design:

1 Click the Save button. 
4th Dimension displays a dialog box where you can enter a file name 
for the label design. 

Note Label files on Windows are denoted by the file extension .4LB. 

2 Enter a filename for the label design and click the Save button.
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Loading a Label Design You can load the label design whenever the Label Wizard is active.

❿❿❿❿ To load a label design:

1 Click the Load button.
4th Dimension displays an open-file dialog box where you can select 
the filename of a label design. Double-click the filename or select the 
filename and click Open. 

4th Dimension replaces the current label design with the design you 
selected.

Printing Labels
After you have completed your label design, you can preview or print 
the labels. You may want to print first on regular paper so that you can 
check the placement of text before you use the more expensive label 
paper.

❿❿❿❿ To print your labels:

1 Click the Print button.
The Print dialog box appears for the printer you selected in the Print 
Manager. If you check the Print Preview check box before clicking OK, 
the labels are previewed on screen.

If you are printing using a form, 4th Dimension will use the selected 
form to print the labels. 4th Dimension assumes that the form was 
designed to print labels.

After the labels are printed, 4th Dimension closes the Label Wizard and 
returns you to the form you were using when you opened the Label 
Wizard.
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4th Dimension allows you to create a wide variety of two- and three-
dimensional plots without having to export the data to a graphics 
package. You can create graphs from the data in your database or from 
data that has been copied to the Clipboard from another application. 
You can graph data directly from fields or you can graph the results of 
calculations on data. You create graphs in 4th Dimension using the 
built-in 4D Chart plug-in. 

Because graphing capability is fully integrated into 4th Dimension, you 
can graph data in your database and update your graphs when the 
information in the database changes. You can print your graphs or 
copy them to the Clipboard and paste them into other applications.

Finally, 4D Chart adds over 100 commands to the 4th Dimension 
language which enable you to control tasks that you normally perform 
manually. For example, you can use 4D Chart commands to create new 
graphs, modify graph features, open and save documents, and execute 
any 4D Chart menu command. For information on these commands, 
please refer to the 4D Chart Language Reference manual.

Managing 4D Chart Documents and Windows
4D Chart documents can be created in plug-in areas on forms or in 
separate plug-in windows. This section explains how to create, open, 
and save 4D Chart documents in both types of areas.

This section explains the basics of managing 4D Chart documents, 
including:

■ Using 4D Chart in a plug-in window

■ Using 4D Chart in a 4th Dimension form
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■ Hiding and showing 4D Chart features

■ Creating a new document

■ Opening an existing document

■ Saving a document

■ Setting the document size.

Using 4D Chart in a 
Plug-in Window

You can use 4D Chart in its own window. When used in its own win-
dow, 4D Chart operates as if it were a separate application.

When you open 4D Chart in a plug-in window, the window has its own 
menu bar. 4th Dimension’s menu bar remains at the top of the screen.

When you expand the window to full screen size by clicking the win-
dow’s zoom box, 4th Dimension’s menu bar remains at the top of the 
screen and 4D Chart’s menu bar remains within the 4D Chart window.

To generate and modify a graph in an external 4D Chart window, you 
have two possibilities:

■ Call the Chart Wizard directly from the User mode of 4th Dimension. 
After it has been set up, the graph is displayed in a new external win-
dow,

■ Open a blank 4D Chart window then use the menus and functions of 
the plug-in to create your graph.

Close box

4D  Chart window

Zoom box

4

 

th

 

 Dimension menu bar

4D  Chart menu bar

4

 

th

 

 Dimension toolbar

4D  Chart tool palette
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Opening an External 
Window Displaying the 
Graph Directly

 

When you create a graph from the User mode of 4

 

th

 

 Dimension, an 
external window is automatically opened to display it.

����

❿❿❿❿

 

To create an external window displaying the graph directly:

 

1 Make sure that the current selection contains the records that you 
want to represent graphically.

2 Choose Charts... from the Tools menu of 4

 

th

 

 Dimension or click on the 
corresponding icon in the 4

 

th

 

 Dimension toolbar.

 

The Chart Wizard appears. The use of this wizard is described in the 
“Creating a Graph” paragraph on page 254. 

 

3 Set the parameters of your graph and click on OK.

 

An external 4D Chart window is created to display the graph.

 

Opening a Blank 
4D Chart External 
Window

 

You work with external windows in the User mode of 4

 

th

 

 Dimension.

����

❿❿❿❿

 

To open 4D Chart in an external window:

 1 In the User environment, choose 4D Chart from the Tools menu. 

A new 4D Chart

 

 

 

document opens in an external window. 

You can open additional 4D Chart windows by choosing

 

 

 

4D Chart 
again from the 

 

Tools

 

 menu. Opening several 4D Chart documents at 
the same time allows you to compare documents, copy and paste 
between documents, and move from one document to another simply 
by clicking on the appropriate window.

The titles of all 4D Chart windows appear at the bottom of the 
Window menu. You can bring any document to the front by choosing 
it from this menu.

When you save a document, its title bar displays the document name, 
plus the suffix “(CT)”, which distinguishes 4D Chart

 

 

 

documents from 
documents created by other plug-ins. 

You can close a plug-in window at any time by clicking the window’s 
control-menu box (on Windows) or the close box (on Macintosh).

 

Using 4D Chart in a 
Form

 

You can place a 4D Chart area in any form. When you use 4D Chart in 
an input form, you can display a graph for each record in the table. 
You can also use a 4D Chart area in an output form.
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When 4D Chart is used in a form, the 4D Chart menu bar appears at 
the top of the 4D Chart area. You can choose menu commands from 
either the 4

 

th

 

 Dimension menu bar or the 4D Chart menu bar. 

����

❿❿❿❿

 

To expand a 4D Chart area: 

 

1 Choose Go to Full Window from the 4D Chart File menu. 
OR
Click the 4D Chart area’s zoom box. 

 

The document expands to fill the entire screen, and 4D Chart’s menu 
bar temporarily replaces 4

 

th

 

 Dimension’s menu bar.

The expanded window has a size box and close box. 

When the document window is expanded, the 

 

Go to Full Window

 

 
menu item in the File menu changes to 

 

Return to Form

 

.

����

❿❿❿❿

 

To reduce the window and return to the form:

 

1 Choose Return to Form from the File menu.
OR
Click the close box.

Creating a 4D Chart 
Area in a Form

 

You can add a chart area in an input form and save a graph with each 
record in the table.

For more information about inserting a plug-in area into a form, refer 
to the 

 

4th Dimension

 

 

 

Design Reference 

 

manual.

 

4D Chart area

4D  Chart menu bar

4D  Chart zoom box

4D form
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Minimum Size of the 
4D Chart Area

 

By default, if the size of the 4D Chart area included in the form is less 
than the minimum size (width 300 pixels, height 150 pixels), it will 
appear as a button. The button title is the name of the variable 
associated with the plug-in area. 

When the user clicks on this button, the area is displayed in full-page 
mode. 

It is possible to disable this operation using the 
 

CT SET ENTERABLE 
 

language command (the area is then never displayed as a button). 

 

Hiding and 
Displaying 4D Chart 
Features

 

You can choose to hide or display several of 4D Chart’s features, 
including:

 

■

 

The 4D Chart menu bar

 

■

 

The Object Tool palette

 

■

 

The Chart Tool palette

 

■

 

Scroll bars

 

■

 

Rulers.

Use the 

 

Display

 

 submenu of the 

 

Edit

 

 menu of the plug-in area to hide 
or display these items. Items that are checked in the Display submenu 
are displayed in 4D Chart.

 

Note

 

If you have hidden the 4D Chart menu bar, you can display it by 

 

pressing 

 

Ctrl-Shift-M

 

 on Windows or

 

 Command-Shift-M

 

 on Macintosh.

 

Creating a New 
4D Chart Document

 

You can create a new, blank 4D Chart document at any time. The new 
document replaces the current document. If you have made changes to 
the current document, you will be prompted to save them before open-
ing a new document.
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❿❿❿❿

 

To create a new document:

 

1 Choose New from the 4D Chart File menu.

 
An empty document appears in which you can create a new graph.

 

Opening a 4D Chart 
Document

 

You can open any previously saved 4D Chart document in a 4D Chart 
area. The newly opened document replaces any current document. 

����

❿❿❿❿

 

To open a

 

 

 

4D Chart document:

 

1 Choose Open from the 4D Chart File menu.

 

A standard open-file dialog box appears. 

 

2 Select a document.

3 Click Open.

 

The document opens in the current

 

 

 

4D Chart window.

 

Note

 

You can also open a PICT file in your graph. This point is covered in 
the “Importing a PICT Document in a 4D Chart Window” paragraph 

 

on page 239.
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Saving a 4D Chart 
Document

 

You can save the contents of a 4D Chart document regardless of 
whether the document was created in a plug-in window or in a form. 
4D Chart offers several ways to save documents:

 

■

 

As a file

 

■

 

As part of a record

 

■

 

As a template for a 4D Chart area.

You can also save a selection of objects, for instance a graph, as a PICT 
document (Macintosh format). In this case, the document saved is a 
picture that can no longer be modified. This point is covered in the 
“Exporting a 4D Chart Document in PICT Form” paragraph on 
page 240.

 

Saving a 4D Chart 
Document as a File

 

Any document that you create using 4D Chart can be saved as a sepa-
rate document for use in another place — either in the same database, 
in another database that uses 4D Chart, or in an entirely different 
application. You use the standard 

 

Save

 

 and 

 

Save As

 

 menu items in the 
4D Chart 

 

File

 

 menu to save and update individual documents. 

Documents you save can be opened with the 

 

Open

 

 menu item in the 
4D Chart 

 

File

 

 menu. It makes no difference whether a document is 
created in a plug-in window or in a form; a document can be saved and 
opened in either place.

If you save a 4D Chart document as a file, when you reload the file, the 
document appears exactly as it was when you saved it. To update the 
information in any graphs in the document, you must use the 

 

Update

 

 
menu item in the 

 

Chart

 

 menu, which is described in more detail in the 
“Updating the Data in a Graph from the Database” section on 
page 262.

����

❿❿❿❿

 

To save a 4D Chart document:

 

1 Choose Save As from the 4D Chart File menu.

 

Notice that you choose 

 

Save As

 

 from the 4D Chart 

 

File

 

 menu, not the 
4

 

th

 

 Dimension 

 

File

 

 menu.

 

 

 

4D Chart displays a save-file dialog box.

 

2 Enter a filename for the document.

3 Click Save.

 

4D Chart saves the document with the filename you entered.
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Saving a 4D Chart 
Document as Part of a 
Record

 

If you have created a 4D Chart area in a form and want its contents to 
be saved with each record, you need to create a BLOB or Picture field in 
the table to which the form belongs in order to store the contents of 
the area. The contents of the area are then saved automatically with 
each record when it is validated.

For more information about creating 4D Chart areas on forms, refer to 
the 

 

4th Dimension

 

 

 

Design Reference 

 

manual.

����

❿❿❿❿

 

To save a 4D Chart document as part of a record:

 
1 Add a BLOB or Picture field to the table whose form contains the 

4D Chart area.  

For more information about creating a field, refer to the 

 

4th Dimension

 

 

 

Design Reference 

 

manual.

 

2 Give the field the same name as the external area that you have 
created on the form and add an underline (_) to it.

 

For example, if your external area is named 

 

MyArea

 

, the field must be 
named 

 

MyArea_.

 

Each graph is thus saved as a part of the record. 

If you save a 4D Chart document as part of a record, when you reload 
the record, the document appears exactly as it was when you saved it. 
To update the information in any graphs in the document, you must 
use the 

 

Update

 

 menu item, which is described in more detail in the 
“Updating the Data in a Graph from the Database” section on 
page 262.

 

Saving a 4D Chart 
Document as a Template

 

If you have inserted a 4D Chart area into a form, you can create a 
standard document that is the same for every record by saving the 
document as a template. You can only create templates for 4D Chart 
on forms. 

When you save a document as a template, the template is used for 
every new record that is opened in the form. 

Each document starts with the same template, but any unique modifi-
cations you make to it are saved with the record. There can be only one 
template for each 4D Chart area on a form.

If there is a graph in the document that is saved as a template, the 
graph is updated automatically for each record, if possible. 4D Chart 
can update a graph only if it was created from data stored in records in 
the database. 
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❿❿❿❿

 

To save a document as a template:

 

1 Choose Save as Template from the 4D Chart File menu.

 

4D Chart saves the document with a special filename. The filename is 
the name of the 4D Chart area on the form, plus an underscore. 

For example, an area named “Document” will have a template file 
named “Document_”.

Because 4D Chart automatically names the file and places it in the 
database directory; no save-file dialog box is displayed.

 
4D Server

 
By default, 4D Chart templates are read from and saved to the client 
machines. You can use the 4D Chart language to specify that templates  

be read from and saved to the server machine. 

If you make changes to the document and want to incorporate those 
changes in the template, choose 

 

Save as Template

 

 again.

You can create a template for a 4D Chart area without using the 

 

Save as Template

 

 menu item simply by saving the document with a 
filename that is the same as the name of the 4D Chart area, plus an 
underscore, and placing the file in the database directory. This feature 
allows you, for example, to create a document in one database and use 
it as a template in another database. You can also create a document in 
one document area and use it as a template in another document area.

You can temporarily disable the use of a particular template file by 
changing the template filename or moving the file out of the database 
directory.

 

Importing a PICT 
Document in a 
4D Chart Window

 

You can open documents of the PICT type in a 4D Chart window. 
These documents can come from different sources (export of a 
4D Chart graph in PICT form, design software, etc.). The imported 
document behaves like a simple object; you cannot modify its 
attributes.

����

❿❿❿❿

 

To import a PICT document:

 

1 Choose the Import... command in the File menu of 4D Chart.

 

A standard open file dialog box appears. 

 

2 Select the PICT file you want to open (*.PCT extension under 
Windows) and click Open.

 

If the imported file is valid, its contents are displayed in the 4D Chart 
window.
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Exporting a 
4D Chart Document 
in PICT Form

You can export a 4D Chart document or a selection of objects in it as a 
PICT file. In both cases, the objects do not keep their unique 4D Chart 
properties; the exported document is a static picture of the objects in 
the 4D Chart area or in the external window. You can import it as a 
PICT in 4D Chart or any other application that opens PICT files.

❿❿❿❿ To export a 4D Chart document in PICT form:

1 Choose the Export as... command in the File menu of 4D Chart.

2 Select a name and location for your file in the standard dialog box 
then click Save.

❿❿❿❿ To export a selection of 4D Chart objects in PICT form:

1 Select the object(s) that you want to export in PICT form.

2 Choose the Export Selection as... command in the File menu of 
4D Chart.
A standard save file dialog box appears. 

3 Select a name and location for the file and click Save. 
Whether you export a 4D Chart document or a selection of objects, a 
PICT file (*.PCT extension under Windows) is created on the disk.

Setting the 
Document Size

You can change the document size by changing the number of pages 
in the document or by specifying a new document size in points. The 
maximum drawing size is 3500 x 3500 points. You can add pages to the 
right of the first page, below it, or both.

❿❿❿❿ To change the document size:

1 Choose Properties from the 4D Chart Edit menu.
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The following dialog box appears.

The document size is indicated by the point values to the right of the 
model document area and by the white rectangles in the model 
document area. 

2 Click in the Document size area to adjust the number of pages in the 
drawing.
OR
Enter the exact size of the document (in points) in the Width and 
Height text areas.

Choosing a Graph Type
4D Chart allows you to create two-dimensional and three-dimensional 
graphs from within your database. Once you decide what data you 
want to graph, you should think about what type of graph will best 
display that data.

The nature of the data that you are graphing will help indicate the type 
of graph you should choose. For example, a line graph is best suited for 
showing how values (such as “number of units sold”) change over time. 

Don’t be afraid to experiment with different graph types. Once you 
have created a graph, you can easily convert it to another graph type. 
Creating graphs and changing their types are discussed in the 
“Creating a Graph” section on page 254.

Click here to add or 
remove pages Enter values to set the 

size of the design area 
here
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This section discusses the types of two- and three-dimensional graphs 
that you can create using 4D Chart. The features of each type of graph 
are described, along with the type of data that the graph is best suited 
to show.

Choosing a Two-
dimensional Graph 
Type

This section briefly describes the parts of a two-dimensional graph and 
then presents each two-dimensional graph type. 

The following diagram shows a two-dimensional (two-axis) graph:

The X-axis is also called the Category axis. The X-axis displays the 
categories into which the information is divided. For instance, if you 
are graphing the number of computers sold per year, you would place 
the years on the X-axis.

The Z-axis is also called the Values axis. You use the Z-axis to display the 
values calculated for each category. In the computer sales example, the 
Z-axis would contain the values for the numbers of computers sold per 
year. For instance, if there were 500 computers sold in 1991, the Z-axis 
value corresponding to the X-axis category “1991” would be 500.

Another concept in graphing is the data series (or simply, series). Each 
category is composed of one or more series that further breaks down 
the information displayed in the graph. In this example, there was 
only one series, “computers sold.” Therefore, the series is not 
represented by a separate field or formula.

Sales History: Widget Computers

Graph values
on the Z-axis

Graph categories
on the X-axis
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However, suppose you want to compare the sales volumes from 1989 
to 1992 for three models of computers. In this case, each computer 
model becomes a distinct series on the graph. All series share the same 
categories (in this case, the years 1989 through 1992), but have their 
own values.

Another way to graph this data would be to create a three-dimensional 
graph of the data. This type of graph is discussed in the “Choosing a 
Three-dimensional Graph Type” section on page 249.

Area Graphs Area graphs are commonly used to show the magnitude of values over 
time, but can show values over any continuous category. 

Widget 100

Widget 350

Widget Pro

Sales History: Widget Computers (by model)
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The categories on the X-axis should be continuous, such as times or 
temperatures. Discrete categories, such as salespeople or products, are 
better suited to column graphs.

Options
The following options are available for Area graphs:

■ Stacked: When graphing multiple series, stack the areas for the series.

■ Stacked, proportional: When graphing multiple, stacked series, show 
the series as proportions of a 100% whole.

■ Horizontal: Make the X-axis the vertical axis and the Z-axis the 
horizontal axis.

Column Graphs Column and bar graphs are the most frequently used graph types for 
business data. They are usually used to compare one item to another, 
or one or more items over a period of time.

The following column graph uses the Depth feature, which makes each 
column look three-dimensional. 

Note The Depth feature is discussed in more detail in the “Modifying Depth 
in a Two-dimensional Graph” section on page 284.

Stacked Stacked, proportional Horizontal

Ticket Sale Profits in 2003

$0
$200
$400
$600
$800

$1000
$1200
$1400
$1600

King LearMacbeth
HamletTwelfth Night
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Options
The following options are available for Column graphs:

■ Stacked: When graphing multiple series, stack the columns for the 
series in each category.

■ Stacked, proportional: When graphing multiple, stacked series, show 
the series as proportions of a 100% whole.

■ Horizontal: Make the X-axis the vertical axis and the Z-axis the 
horizontal axis. This option creates a bar graph. Bar graphs show the 
categories on the vertical axis, with the values expressed by the length 
of the bars. Bar graphs are often a useful alternative to column graphs, 
especially when the category labels are long.

■ Overlap: When graphing multiple series, use this option to specify the 
percentage by which the series columns within each category overlap 
each other.

■ Gap Width: Use this option to specify the spacial gap between the 
columns from one category to the next. The larger the gap, the 
narrower the columns for each category.

Line and/or Scatter 
Graphs

Line graphs are often used to show the rate of change of values over 
time. Scatter graphs can show relationships and trends in your data. 
Such graphs are most often used when there are a large number of 
different values of the X-axis field, as in a scientific study. 
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The values on the X-axis should be continuous or ordered, such as 
times or temperatures. Discrete categories or categories that do not 
have an order — such as salespeople or products — are better suited to 
column graphs.

Options
The following options are available for Line and/or Scatter graphs:

■ Stacked: When graphing multiple series, stack the lines for the series in 
each category.

■ Horizontal: Make the X-axis the vertical axis and the Z-axis the 
horizontal axis. 

■ Displaying lines and/or points
You can:

■ Show Points: Each value appears as a dot in the graph.

■ Show Lines: Only lines appear in the graph.

■ Show Both: Lines and Points appear in the graph.

Pie Charts Pie charts show data as a percentage of a whole. Your data does not 
need to be expressed as percentages; 4D Chart automatically converts 
the data into percentages when it creates the pie chart.

Each pie chart can have only one series. Categories are displayed in the 
legend.

France Leads Widget Market

France

England

USA40.0%

30.9%

29.1%
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Options
The following option is available for pie charts: 

■ Start Angle: Use this option to specify the rotation of the chart. The 
specified angle determines the placement of the first edge of the first 
category in the chart.

Picture Graphs Picture graphs are similar to column graphs, except that you can 
substitute a picture for the column.

Options
The following options are available for Picture graphs in 4D Chart: 

■ Stacked: When graphing multiple series, stack the pictures for the 
series in each category.

■ Stacked, proportional: When graphing multiple, stacked series, show 
the series as proportions of a 100% whole.

■ Horizontal: Make the X-axis the vertical axis and the Z-axis the 
horizontal axis. This option creates a bar picture graph.

■ Overlap: When graphing multiple series, use this option to specify the 
percentage by which the series within each category overlap.
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■ Gap Width: Use this option to specify the spacial gap between the 
picture columns from one category to the next. The larger the gap, the 
narrower the picture columns.

Additional options for aligning and adjusting the pictures are discussed 
in the “Adding Pictures to a Picture Chart” section on page 291.

2D XY Graphs 
(Scatterplots)

Each data point in a scatterplot represents a pair of values. The X-axis 
is also a value axis.

When the 2D XY type is selected, the option Category is replaced with 
Values (X) in the Chart>Axis, Chart>Grid Lines and Chart>Titles 
menus. 

Options
The following options are available for 2D XY graphs in 4D Chart: 

■ Plots shape: You can display None, Circles, Squares, or Star plots.

■ Lines appearance: You can display None, Straight, or Arrows lines.

■ Show Regression Line (y = ax+b): Allows viewing the predictive 
relation between the X- and Y-axis values (if appropriate). 
There is one regression line for each series of points. Using Ctrl+click 
(Windows) or Command+click (Mac OS), you can select the points 
associated with the regression line.

■ 2D XY variant: Polar charts
Polar charts are used to show the distribution of data around a central 
point. In a polar chart, each point is plotted in terms of degrees from 
the zero point and distance from the center. 
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Each data point on a polar chart is plotted using one Z-axis field to 
specify the angle in degrees and a second Z-axis field to specify the 
distance from the center.

Choosing a Three-
dimensional Graph 
Type

This section briefly describes the parts of a three-dimensional graph 
and then presents each three-dimensional graph type. 

The following diagram shows a three-dimensional (three-axis) graph:

Distribution of Dairies Around 

Distance in Miles

Acme Milk Processing Plant

Graph values
on the Z- axis

Graph categories
on the X-axis

Graph series
on the Y-axis

 

Widget Pro
Widget 350

Widget 100

 

Sales History: Widget Computers (by model)
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As with a two-dimensional graph, the X-axis (or Category axis) dis-
plays the categories into which the information is divided. For 
instance, if you are graphing the number of computers sold per year, 
you would place the years on the X-axis.

In a three-dimensional graph, the Y-axis is also called the Series axis. 
Each category is composed of one or more series that further breaks 
down the information for each value of the X-axis field. Each data 
point in the graph is the intersection of one category and one series. In 
the example illustrated above, each computer model is a series. 

In a two-dimensional graph, the series remain on the X-axis. The col-
umns representing each series are distinguished by their patterns. In a 
three-dimensional graph, the series are displayed on their own axis. 
Each series still has its own pattern, but now the series are also sepa-
rated from each other in space.

The Z-axis displays the values calculated for each combination of 
category and series. 

In the computer sales example, the Z-axis would contain the values for 
the numbers of each type of computer sold per year. For instance, if 
there were 725 Widget Pro computers sold in 1991, the Z-axis value 
corresponding to the X-axis category “1991” and the Y-axis series 
“Widget Pro” would be 725.

 

3D Column Graphs

 

3D Column graphs, like 2D Column graphs, compare one item to 
another, or one or more items over a period of time.

 

Improvement in Test Scores

 

Seniors
Juniors

1990
2000
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Options

 

The following options are available for 3D Column graphs:

 

■

 

Category Gap/Width

 

: The gap between or width of the categories in 
the graph. The larger the category gap, the smaller the category width.

 

■

 

Series Gap/Width

 

: The gap between or width of the series in the graph. 
The larger the series gap, the smaller the series width.

 

■

 

Tops only

 

: Show only the top side of each column.

 

3D Line Graphs

 

3D Line graphs show trends in your data. They should be used for 
continuous categories, such as time.

 

Option

 

The following option is available for 3D Line graphs:

 

■

 

Series Gap/Width

 

: The gap between or width of the series in the graph. 
The larger the series gap, the smaller the series width.

1990 1995 2000 2005
Imports

Exports

Trends in Widget Imports and Exports
2514th Dimension User Reference



Chapter 11  Graphs
    

3D Area Graphs

 

3D Area graphs emphasize the volume or size of the series over a 
continuous category, such as time.

 

Option

 

The following option is available for 3D Area graphs:

 

■

 

Series Gap/Width

 

: The gap between or width of the series in the graph. 
The larger the series gap, the smaller the series width.

 

3D Surface Graphs

 

Surface graphs show three-dimensional data where the Z-axis value 
varies depending on the X- and Y-axis values. Surface graphs are 
commonly used to graph the results of mathematical formulas.

The following graph was created using a mathematical formula:
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z = (1 - x)

 

2  + y 2   
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Option

 

The following option is available for 3D Surface graphs:

 

■

 

Tops only

 

: Show only the top side of the surface, not the sides. This 
option is used in the previous example graph.

Here is an example of a surface graph with sides:

 

3D Triangle Graphs

 

3D Triangle graphs compare one item to another, or one or more items 
over a period of time. 3D Triangle graphs are an alternative to 
3D Column graphs.

 

Options

 

The following options are available for 3D Triangle graphs:

 

■

 

Series Gap/Width

 

: The gap between or width of the series in the graph. 
The larger the series gap, the smaller the series width.

 

■

 

Flipped

 

: The triangles appear flipped vertically.

 

■

 

Plot Zero Values

 

: If this option is not selected, zero values will be 
omitted from the graph.
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Rockies
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3D Spike Graphs

 

3D Spike graphs show the intersection of three values. Each data point 
is connected to the Category plane with a drop line.

 

Option

 

The following option is available for 3D Spike graphs:

 

■

 

Oval/Square Heads

 

: Use this option to specify whether the spike heads 
are oval or square.

 

Creating a Graph

 

This section includes the basic steps for creating a graph. After reading 
this section, you will be able to:

 

■

 

Create a two-dimensional or three-dimensional graph from data stored 
in the database or copied to the Clipboard

 

■

 

Update a graph created from data in the database

 

■

 

Change a graph’s type

 

■

 

Change the options specific to each graph type.

4D Chart allows you to create two-dimensional and three-dimensional 
graphs based on the data in fields in your database. You can graph the 
values in the fields themselves, or you can graph the values that result 
from formulas that use the fields.
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Whatever the case, when you create a graph, you select the data that 
you want to graph on each axis. For each axis, there are certain restric-
tions on the data types that can be graphed. If a data type cannot be 
graphed on a certain axis, fields of that type cannot be selected in the 
Chart Wizard. The following table provides information on the types 
of data that can be assigned to the Categories or Series axis and the Val-
ues axis.

 

Creating a Selection 
of Records to Graph

 

Before you begin the process of creating a graph, you must create a 
selection of records to graph.

4D Chart can operate in its own window or in 4D Chart areas on forms. 
The following sections explain how to generate the selection of records 
to be graphed, depending on the 4D Chart location. 

 

Creating a Selection of 
Records in a Plug-in 
Window

 

4D Chart graphs the records in the current selection. Before you create 
a graph in a plug-in window, select the records you want to graph. 

4D Chart will not create a graph unless there is at least one record in 
the current selection of the table whose data you want to graph. 

 

Creating a Selection of 
Records in an Input 
Form

 

A 4D Chart area in an input form can be used to graph data in other 
tables. 

The table whose records you want to graph must have at least one record 
in its current selection. If the table that contains the form is automati-
cally related to the table you wish to graph, the current record in the 
input form determines the selection of records in the related table.

 

Data Type
Category or 
Series Axis?

Values
Axis?

Compatible Types
on Values Axis

 

Alphanumeric Yes No -------

Text Yes No -------

Real Yes Yes Integer, Long integer

Integer Yes Yes Real, Long integer

Long integer Yes Yes Real, Integer

Date Yes Yes -------

Time Yes No -------

Boolean Yes No -------

Picture No No -------

Blob No No -------
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Because you have a record loaded in an input form, you should avoid 
creating graphs from data in the current table. If you want to graph 
data from the same table as the input form, you must use 

 

PUSH RECORD

 

 and 

 

POP RECORD

 

 or create a new process with the 

 

New process

 

 function. For more information, see the descriptions of 
these commands in the 

 

4

 

th

 

 

 

Dimension Language Reference 

 

manual.

For more information about adding a 4D Chart area to a form, see the 

 

4

 

th

 

 

 

Dimension Design Reference manual.

Creating a Graph 
from Data in the 
Database

For a two-dimensional graph, you specify a field for the horizontal axis 
(X-axis) and one or more fields or formulas for the vertical axis 
(referred to in 4D Chart as the Z-axis). 

For a three-dimensional graph, you will specify one field (or formula) 
each for the X-, Y-, and Z-axes.

The following example graph shows how 4D Chart uses the informa-
tion in the database to create a 2D graph. The graph plots the scores on 
two tests for each of 11 students. The X-axis field is Student ID, and the 
Z-axis fields are AOC Score and TUC Score.

Name of 1st
Z-axis field

Name of 2nd
Z-axis field

Value stored in
AOC Score field
for Student #6

Categories stored 
in X-axis field

Scale values
generated by
4D  Chart from
Z-axis values

Test Scores for Fifth Grade
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The following example graph shows how 4D Chart uses the informa-
tion in the database to create a graph. The graph shows the average 
monthly stock value for two companies. The X-, Y-, and Z-axis fields 
are, respectively: Month, Company Name, and Average Price.

����

❿❿❿❿

 

To create a graph from data stored in the database:

 

1 Make sure that no graph is currently selected in the 4D Chart area.

 
To deselect a selected graph, click anywhere in the 4D Chart area 
outside the graph. 

2 Choose the Charts... command in the Tools menu of 4

 

th

 

 Dimension or 
click the Chart icon  in the 4

 

th

 

 Dimension toolbar.
OR
If you are in a 4D Chart area, choose New Chart from the Chart menu 
or click the chart creation icon  in the 4D Chart tool palette.

Series stored in
the Y-axis field

Z-axis field 
for Ink, Inc. in

Categories stored 
in the X-axis field

Scale values
generated by
4D  Chart from
Z-axis values February

Value stored in
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The Chart Wizard appears.

You can choose between 12 types of charts. Types 1-6 are two-
dimensional and 7-12 are three-dimensional. By default, the first chart 
type is selected. 

The Chart Wizard has two pages:

 

■

 

Chart Type

 

/

 

Chart Style

 

: Displays the 12 chart types and the varia-
tions on the type of graph that you selected in the Chart Type sec-
tion. The Chart Style section changes depending on your choice of 
chart type.

 

■

 

Data Selection

 

: Lets you select the table that contains the data you 
wish to graph and a field list. Use the Data Selection page to assign 
fields or formulas to the graph axes. The Data Selection page 
changes depending on the graph type you chose.

You must choose a chart type and use the Data Selection page to assign 
appropriate fields or formulas to each axis that the chart type requires.

 

3 Click a chart type.

 

When you click on a chart type, the Chart Style section and Data Selec-
tion page change to match the requirements of the selected type. For 
complete information on the types of charts available in 4D Chart, see 
the “Choosing a Graph Type” section on page 241. 

 

Area for selecting 
chart type

Area for 
selecting 
style of the 
selected 
chart type
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4 Click on a chart style (Optional).

 

Note

 

Some chart types allow for only one style.

 

5 Click the Next > button.

 

The Data Selection page appears, displaying the appropriate options 
for the selected chart type. The names of database tables are placed in 
the “Source Table” drop-down list and the field names of the selected 
table are displayed in the “Select Fields from the Table” area.

 

Style variations 
for 2D area 
graphs

Table drop-down list

Fields list
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Note

 

If you are creating a graph in a 4D Chart area in an input form, the 
current table is not listed in the Tables list because you cannot graph 

 

data from the current table.

 

6 Choose the desired table from the Source Table drop-down list.

 

The Fields list changes to show the fields from the selected table.

 

Note

 

Picture, subtable and BLOB fields cannot be included in a graphic 

 

representation.

 

7 Drag the field that you want to assign to the Category axis to the 
Category box or double-click the field.

 
Note

 
If you make a mistake when choosing the X-axis field, replace the field 

 by dragging the desired field to the Category box. 

■

 

If you want to create a three-dimensional graph, you must fill the 
“Second Category (Y-axis)” area. Go to the following step.

 

■

 

If you want to create a two-dimensional graph, you only need to fill 
the “Values (Z-axis)” area. Go to step 9.

 

8 If you are creating a 3D graph, drag the Series field to the Y-axis 
(Second Category) box or double-click the field.

 

The name of the field appears in the Y-axis box.

 

Note

 

If you make a mistake when choosing the Y-axis field, replace it by 

 

dragging the correct field to the Second Category box.

 

9 Drag the field containing the values to be graphed to the Values (Z-
axis) box or double-click the field

 

1

 

.
OR
Click the Formula button (2D graphs only).

 

1. With 2D graphs, you can add more than one field or formula to the Z-axis. 
Each field or formula becomes a series. For more information, please refer to 
the “Choosing a Graph Type” section on page 241. 
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The name of the field or the formula appears in the Z-axis (Values) box.
For instructions on creating a formula, see the “Adding a Formula” sec-
tion on page 267.

For two-dimensional graphs, you can add an unlimited number of 
fields and/or formulas on the Z-axis (Values). Each item placed in the 

 

Values (Z-axis)

 

 area becomes a series. For more information on series, 
refer to the “Choosing a Graph Type” paragraph on page 241.

 

Notes

 

• For three-dimensional graphs, to modify the field placed in the Z-axis 
area, you just need to drag and drop the name of another field onto 
the area.
• For two-dimensional graphs, you can delete a series, i.e., a field or 
formula placed in the Z-axis area: just select the series then click on the 

 

Delete

 

 button or press 

 

Backspace

 

.

 

10 If you want to have the Z-axis values summed for each X-axis category, 
click the Group check box.

 

This option is used when the X-axis categories are not unique and you 
want each category to appear only once, with the values for each 
instance summed. For more information about this option, see the 
“Grouping Non-unique Categories and Series” section on page 266.

 
Button for add-
ing a formula 
(2D graphs)
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11 If you want to have the Z-axis values summed for each Y-axis series, 
click the Group check box (3D graphs only).

 

This option is used when the Y-axis series are not unique and you want 
each series to appear only once, with the values for each instance 
summed. For more information about this option, see the “Grouping 
Non-unique Categories and Series” section on page 266.

 

12 When you have finished designing your graph, click OK.

 

4D Chart creates the graph and displays it in the 4D Chart area.

 

Updating the Data in a 
Graph from the 
Database

 

When you create a graph from data stored in the database, the data in 
the graph is static. Although the data in the database may change, the 
data in the graph remains the same until you update it. 

You can tell 4D Chart to update a graph by choosing 
 

Update
 

 from the 
 

Chart

 

 menu. When you choose Update, 4D Chart regenerates the 
selected graph using the data in the current selection for the table 
whose fields you are graphing. 

You will want to update a graph in the following situations:

 

■

 

When you want to include more records in the selection

 

■

 

When you want to include fewer records in the selection

 

■

 

When you want to include different records in the selection

 

■

 

When the data in the selection has been modified.

When you use 

 

Update

 

, 4D Chart recreates the graph using the new 
current selection and the settings you chose for the original graph. 

 

Note

 

The 

 

Update

 

 menu item is available only for graphs created from data 

 

in the database.

 

Creating a Graph 
from Data on the 
Clipboard

 

You can graph data from any application if it is correctly formatted and 
then copied to the Clipboard. This section describes how to format 
data in order to use it in a graph, and how to create a 4D Chart graph 
from this information.

 

Formatting Data and 
Copying it to the 
Clipboard

 

You can graph data that is formatted in the Tab-Tab-Return (TTR) 
format. If you copy cells from any spreadsheet application, they will be 
in TTR format. You can also use data from a word-processing 
application if it is formatted with tabs between the fields and carriage 
returns between the records.
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Following are examples of correctly formatted data:

 

Note

 

The and symbols represent the invisible symbols used by many 
word-processing applications to indicate tabs and carriage returns, 

 

respectively.

The first row of data is used as the field names. Each column contains 
the data for one field.  

Note

 

If you want to use dates copied to the Clipboard, the dates must be in 

 

the same format as the System-level date format.

When you have prepared the data in your application, select the 
desired rows and columns and copy them to the Clipboard. 

 

Creating the Graph from 
Data on the Clipboard

 

For a two-dimensional graph, you will specify a field for the X-axis and 
one or more fields or formulas for the Z-axis. The following illustration 
shows how 4D Chart interprets the information from the Clipboard.

TTR data (word-processing) Spreadsheet data

Names
Helen 25

Todd 27

Norm 22

Michele 23

Ages Names
Helen

Todd
Norm

Michele

25

27
22

23

Ages

Names
Helen

Mike

Norm
Michele

25

27

22
23

AgesField names

Records

Clipboard

Name of the
Z-axis field

Norm’s age

Values stored in 
the X-axis field

Scale values
generated by
4D  Chart from
Z-axis values

 

2D Graph
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For a three-dimensional graph, you specify one field each for the X-,
Y-, and Z-axes. The following illustration shows the spreadsheet data 
used for the example graph. The information details the total sales by 
two different stores to three types of customers. 

����

❿❿❿❿

 

To create a graph from data stored on the Clipboard:

 

1 Copy the data to be graphed to the Clipboard, using the format 
described in this section.

2 Follow the instructions provided in steps 1 to 5 in the “Creating a 
Graph from Data in the Database” section on page 256.

 

The Data Selection page appears, configured for the selected chart type.

 

3 Click the Use Data From Clipboard check box.

 Clicking Use Data From Clipboard disables the Source Table drop-
down list and populates the Fields list with the field names from the 
Clipboard.

 

4 Assign fields to the axes by dragging to the appropriate areas or by 
double-clicking the fields.

Field names

Records

Categories
Series
Values

Clipboard

Series

Categories 

Total value of
sales to retail stores
at the Sunny Valley
store location

3D Graph
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When all areas have been assigned fields, the 

 

OK

 

 button is enabled.

 

Note

 

With 2D graphs, you can add as many fields and formulas to the Z-axis 
as you like. However, be sure to choose only numeric fields. Do not 
mix date fields and formulas with number fields and formulas. Each 

 

item in the Z-axis (Values) box is plotted in the graph.

 

5 If you want to have the Z-axis values summed for each X-axis category, 
click the Group check box.

 

This option is used when the X-axis categories are not unique and you 
want each category to appear only once, with the values for each 
instance summed. For more information about this option, see the 
“Grouping Non-unique Categories and Series” section on page 266.

 

6 When you have finished designing your graph, click OK.

 

4D Chart creates your graph and displays it in the 4D Chart area.

 

Updating Graph 
Data from the 
Database

 

When you create a graph using the contents of the database, the data it 
contains are static. Even when the contents of the database change, 
the data of the graph can only be modified by an update. 

����

❿❿❿❿

 

To update a 4D Chart graph:

 

1 Choose the Update command in the Chart menu of 4D Chart. 

 

This way 4D Chart regenerates the selected graph using the data found 
in the current selection of the table whose fields are being graphed. 

You should update a graph in the following cases:

 

■

 

To add records to the selection,

 

■

 

To remove records from the selection,

 

■

 

To put different records in the selection,

 

■

 

When the data of the selection has been modified.

When you use the update, the graph remains the same with all the 
previously chosen options, but with a new selection of data. 

 
Note

 
The 

 
Update

 
 menu command is only enabled for graphs created using 

 the contents of the database.
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Grouping Non-
unique Categories 
and Series

 

Some categories or series may appear more than once in your data. For 
instance, suppose that you want to graph the total purchases made by 
each of your customers. Each customer may have made several 
purchases.

When you create a two-dimensional graph, you can choose to sum the 
values for non-unique categories, so that each category appears only 
once on the graph. When you create a three-dimensional graph, you 
can choose to sum the values for non-unique categories, non-unique 
series, or both.

To create the graph described in the example above, you might graph 
from the [Invoices] table, using [Invoices]Customer for the X-axis 
categories and [Invoices]SalesTotal for the Z-axis values. Because some 
customers may have more than one invoice, you would want 4D Chart 
to sum the values in the [Invoices]SalesTotal field so that there would 
be only one value (the total) for each customer.

The illustrations below show the same basic graph with and without 
the Group

 

 

 

option:

To group data on the Category or Series axis, check the corresponding 

 

Group

 

 

 

check box in the Data Selection page of the Chart Wizard.

 

Graph without
Group option

Graph with
Group option
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Adding a Formula 

 

You can graph values that are not represented in your data but are 
obtained by performing calculations on the data or on other values in 
your database. For example, you can graph your profits by graphing the 
results of a formula that subtracts your unit cost from your retail price.

You can refer to any function or valid 4

 

th

 

 Dimension method 
“allowed” in the formula editor and graph the result on the Values 
axis. The method must return a value to 4D Chart. If the categories are 
grouped, 4D Chart sums the values returned.

If there are fields or other formulas also being graphed on the Values 
axis, the data types of all the values must be compatible. For instance, 
if you are graphing a Date field and a formula on the Values axis, the 
formula must return a date. 

 

Formulas are available only for two-dimensional graphs.

����

❿❿❿❿

 

To use a formula to calculate values for a graph:

 

1 When you are ready to specify the Values field in the Data Selection 
page, click the Formula button.

 

The 4D Formula dialog box appears.

 

2 Type the formula.

 

For more information about the Formula editor dialog box, please refer 
to “Formula Editor” section on page 115. Following are some examples 
of formulas:

 3 Click OK.

4 When you have finished designing the graph, click OK in the Chart 
Wizard to create the graph.

Formula Syntax

 

Month of (Current date) 4D function (4D function)

Day of ([Invoices]Invoice date) 4D function (field)

Sin (vX) 4D function (variable)

NumVisits Method that returns a value in $0 
This method must have been 
“allowed” in the Formula editor using 
the SET ALLOWED METHODS com-
mand
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Changing the Chart 
Type

 

You can switch between chart types at any time. You can change from 
one two-dimensional graph type to another, or from one 
three-dimensional graph type to another. When creating a graph, feel 
free to experiment with chart types to find the best way to present your 
data.

����

❿❿❿❿

 

To change the chart type:

 

1 Make sure that the graph is selected.

 

You select a graph by clicking it. When a graph is selected, selection 
handles appear around it.

 

2 Click the Chart  button in the 4D Chart Tool palette.

 

A pop-up menu appears, which lets you select another type of chart. 
This menu does not allow a preview of the chart types. 

 

OR
Choose the Chart Type item in the Chart menu of 4D Chart.

 

The “Choose a Chart Type” window is then displayed. 

You can select another chart type and click 

 

OK

 

. 

The graph is redrawn using the new chart type. Both the Chart drop-
down list and the Choose a Chart Type window display only the chart 
types that are appropriate for the selection of data. You cannot, for 
example, plot 3D data using a 2D chart type. For information on the 
graph types available in 4D Chart, see the “Choosing a Graph Type” 
section on page 241.
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Setting the Chart Type 
Change Alert 

 

You can have 4D Chart display an alert dialog box when the user 
attempts to change the type of a graph. The user then has the option 
to cancel or continue with the change.

����

❿❿❿❿

 

To display an alert dialog box when a new chart type is selected:

 

1 Choose Properties from the 4D Chart Edit menu.

 

The Properties dialog box appears. 

 

2 Check or uncheck the Chart Type Change Alert check box.

3 Click OK to close the Properties dialog box.

 

Changing the 
Options for a Chart 
Type

 

Each chart type has a particular set of options that you can change 
using the Options dialog box. By changing the chart options, you can, 
for example, change a column graph to a bar graph, or show the series 
in an area graph as proportions of a whole.

����

❿❿❿❿

 

To open the Options dialog box for a graph:

 

■

 

Double-click the graph.
OR
Select the graph and choose Options from the Chart menu.

 

For more information about the options for each chart type, see the 
“Choosing a Graph Type” section on page 241.

Chart Type Change 
Alert check box
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Modifying Graph Features

 

This section explains how to modify graph features. After reading this 
section, you will know how to:

 

■

 

Resize a graph

 

■

 

Customize graph axes

 

■

 

Show and hide grid lines

 

■

 

Display the series values

 

■

 

Customize legends

 

■

 

Add depth to a two-dimensional graph

 

■

 

Change the perspective of a three-dimensional graph

 

■

 

Customize the tips of a graph

 

■

 

Change the graphic attributes of graph objects

 

■

 

“Explode” a wedge from a pie chart

 

■

 

Add a picture to a picture chart.

 

Resizing a Graph

 

When you create a graph, its initial size corresponds to the size of the 
window in which it is created.
If the graph is created using the 

 

Tools>Chart

 

...

 

 menu command of 
4

 

th

 

 Dimension, its size corresponds to the default size of a 4D Chart 
external window .
If the graph is created from a 4D Chart window, its size corresponds to 
that of the window.

You can resize a graph in two ways: 

 

■

 

By resizing the window in which it is displayed.
A graph is “unified” with the window where it was created as long as 
its own dimensions have not been modified using the selection han-
dles (see below).

 ■  By directly resizing the graph in the window using the selection han-
dles (black squares that appear around the object when it is selected). 
Once you have done so, the graph is no longer “unified” with the win-
dow (see above).
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You can resize the height and width at the same time, maintaining the 
sizing proportion between the two. 

����

❿❿❿❿

 

To resize a graph:

 

1 Select the graph.

2 Hold down the mouse button on a selection handle and drag it up, 
down, or diagonally.

 

If you drag a corner, the height and width change. If you drag a side, 
either the height or the width changes.

To resize the object so that the height and width retain the same 
proportion to each other, hold down the 

 

Shift key while you are 
resizing.

3 Release the mouse button when you have finished.
The graph is resized.

Customizing the 
Axes

You can customize many aspects of each axis of a graph. This section 
contains information about:

■ Customizing the axis labels

■ Customizing the tick marks

■ Changing the scale of the Values axis

■ Reversing the order of data points on an axis

■ Positioning the origin

■ Adding axis titles.z

The following table explains the axes available in two-dimensional 
(2D) and three-dimensional (3D) graphs:

Number of Axes Axis Name Axis 
Two (2D Graph) Category X

Series N/A
Values Z

Three (3D Graph) Category X
Series Y
Values Z
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You can display the Axis dialog box for any axis by choosing the 
appropriate axis from the Axis submenu of the Chart menu.

Using the Axis dialog box, you can change the location of the axis 
labels, tick marks, and origin. You can also change the scale used for 
the Values axis and reverse the order of the items graphed on each axis.

This section presents the dialog boxes that you use to customize the 
axes of your graph. It then provides details about each of the options.

The Category Axis dialog box enables you to customize the Category and 
Series axes:

Note The Tick Marks drop-down list, Reverse Order check box, and Cross 
Axis At text box are not available in the Category or Series Axis dialog 
box for three-dimensional graphs.

Labels area

Tick marks drop-down list

Reverse order check box

Cross Axis at box

Show One Label out of box
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The following dialog box enables you to customize the Values axis:

Note Only the Labels and Scale areas are available in the Axis dialog box for 
three-dimensional graphs. The Date Increment drop-down lists are 
available only when dates are being graphed on the Values axis.

Customizing the Axis 
Labels

4D Chart automatically labels the axes when it generates a graph. You 
can change the position, orientation, and format of the labels, or you 
can decide not to display them with your graph.

■ Label Positions
You can choose one of the following label positions from the Position 
drop-down list:

■ None

■ Top

■ Bottom

■ Left

■ Right.

Depending on the orientation of the axis, either Top and Bottom or 
Left and Right will be unavailable.

When the position is None, the label does not appear on the graph. 

Tick Marks area

Labels area
Scale

Z-axis Crosses at 
Category box

Logarithmic 
check box

Reverse Value 
Order check box

area
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■ Label Orientation
The following label orientations are available for each axis:

■ Label Formats
You can change the way data in your labels is displayed by using 
display formats. For instance, you can use a display format to display 
dollar amounts using the dollar sign ($), commas, and decimals. 

The following table shows some examples of the effects of display 
formats:

When you select one of the formats from the Format drop-down list, it is 
entered into the Format text box, located to the right of the drop-down 
list. If you want to use a custom format, you can enter it in that area.

You can use one of 4th Dimension’s built-in formats, edit a format, or 
create one of your own. For more information, see the 4th Dimension 
Design Reference manual.

■ Labeling Data from Boolean Fields
If you create graphs using Boolean fields from the database, the default 
axis labels are “0” and “1”, corresponding to FALSE and TRUE. You can 
label your graph more informatively by changing the label format. 

To create more meaningful labels for Boolean fields, change the label 
format to the following:

TrueLabel;;FalseLabel

For example, you might change the format to “Female;;Male” or 
“Experimental;;Control”.

Orientation

Normal Vertical Rotated 
Left

Rotated 
Right Staggered Wrap

R
e
s
u
l
t

Label L
a
b
e
l

La
be

l Label

Label1 Label3
Label2

Lab
el

Data in Default Format Display Format Data in Display Format
3400 $###,###.00 $3,400.00
3/4/99 Month Date, Year March 4, 1999
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Reducing the Number of 
Labels

You can reduce the number of labels displayed on the X-axis or Y-axis 
of a graph. This feature is useful when you create graphs with a large 
number of categories (more than 100).

When this option is used, 4D Chart displays only one label per N labels 
on the selected axis. To use this option, enter a value between 2 and 
255 in the “Show One Label out of” box. For example, if you enter 10, 
4D Chart will display one label per 10 categories. The value 1 is the 
standard setting (all labels are displayed).

■ Auto: If you check the Auto box, 4D Chart will calculate the appropri-
ate number of labels to display, according to the amount of room.

Customizing the Tick 
Marks

Tick marks show the increments of the axes. You can choose among 
different styles of tick marks, or you can decide not to show the tick 
marks. You can customize this option for each axis in a two-
dimensional graph.

Note You cannot customize the tick marks for a three-dimensional graph.

The following tick mark styles are available:

■ Cross ( )

■ Inside ( )

■ Outside ( ).

Changing the Values 
Axis Scale

You can change the minimum and maximum values. By default, 4D 
Chart uses the minimum and maximum value of the set of data being 
graphed. You can change these values, for example, to start the Z-axis 
at zero. 
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You can also modify the major and minor units for tick marks. By 
default, 4D Chart calculates these parameters based on the number of 
values to be shown and the size of the graph. If the values are dates, 
you can specify whether the major and minor units are measured in 
days, weeks, months or years.

For each scale display option, there is an Auto option which lets you 
enable the default operation of 4D Chart. 
If you want to use custom values, remember to uncheck the Auto 
option, otherwise your parameters will not be taken into account. 

Note The major and minor unit grid lines can be either hidden or displayed 
(see the “Showing and Hiding Grid Lines” paragraph on page 278). 

■ Using a Logarithmic Scale
You can change the scale from normal to logarithmic by checking the 
Logarithmic check box, located in the Values axis dialog box.

Reversing the Order of 
the Data 

You can reverse the order of the data on an axis by checking the 
Reverse Order check box. This can only be done in a two-dimensional 
graph.

Positioning the Origin You can change the position of the origin — the place where one axis 
crosses another — for each axis in a two-dimensional graph.

■ Changing the Origin of the Values (Y) Axis
The origin of the Z-axis is the value at which the Category (X) axis 
crosses the Z-axis. Usually, the origin is the minimum value on the 
graph or zero. Sometimes you will want to change the position of the 
origin.

❿❿❿❿ To change the origin of the Values axis:

1 Choose Category (X) from the Axis submenu of the Chart menu.
The Category (X) dialog box appears.

2 Enter a value in the “Cross Axis At” area.
The value you enter is the numerical value of the desired origin 
position.

3 Click OK to close the dialog box.

■ Changing the Origin of the Category (X) Axis
The origin of the X-axis is the category at which the Values axis crosses 
the X-axis. Usually, the origin is placed to the left of the first category. 
Sometimes you will want to move the origin.
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❿❿❿❿ To change the origin of the Category (X) axis:

1 Choose Values (Z) from the Axis submenu of the Chart menu.
The Values (Z) dialog box appears.

2 Enter a number in the “Z Axis Crosses at Category” area.
The number you enter is the number of the category at which the 
origin should cross. The categories are numbered from left to right, (or 
from bottom to top in a horizontal graph). The Z-axis crosses to the left 
of the specified category.

To move the origin to the right of the last category on the graph, 
specify the number of categories plus 1. 

If the specified number is higher than the number of categories plus 1, 
the value is ignored and the origin is reset to the left of the first 
category.

3 Click OK to close the dialog box.

Adding Axis Titles You can add a title for each axis. Usually, the titles describe the data 
graphed on the axis.

❿❿❿❿ To add a title to any axis:

1 Choose the appropriate axis from the Titles submenu of the Chart 
menu.
The Titles dialog box appears.

2 Type the title into the “Title” text box.

3 Choose a position for the title from the “Position” drop-down list.
This specifies the position of the title relative to the graph. 

Title text box
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You can choose one of the following title positions:

■ None

■ Top

■ Bottom

■ Left

■ Right.

The default position is None. When the position is None, the title does 
not appear on the graph. 

Depending on the orientation of the axis, either Top and Bottom or 
Left and Right will be unavailable.

4 Choose an orientation for the title from the “Orientation” drop-down 
list.
The following orientations are available for each axis:

■ Normal

■ Vertical

■ Rotated Left

■ Rotated Right.

5 Click OK.

Showing and Hiding 
Grid Lines

You can display grid lines for the major and minor increments of each 
axis. Grid lines can make a graph easier to read.

The major and minor increments are set in the Axis dialog box for the 
Values axis.

❿❿❿❿ To display the grid lines for any axis:

1 Choose the appropriate axis from the Grid Lines submenu of the Chart 
menu
The Grid Lines dialog box appears.

2 Click the desired check boxes and click OK.
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Displaying the 
Series Values

You can display information for each series directly in the graph. You 
can display the following information:

■ Values: The actual number or date, in Arabic numerals. You can show 
the values on the graph instead of using labels on the Values axis, or 
use them to supplement the axis labels.

■ Percentages: The value of the data point divided by the sum of all the 
values in the category, as a percentage.

■ Categories: The name of the category, identical to the axis label for the 
category.

The following graph shows the values at the tops of the columns:

You can select the location at which the values, percentages, or 
category labels should appear, as well as their orientation and format. 

This feature is not available for three-dimensional graphs.
❿❿❿❿ To display information about the data in a series:

1 Choose Values from the Chart menu.
The Values dialog box appears.
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2 Select the location at which the information should appear. 
You can select one of the following options from the Position drop-
down list:

3 Select the type of information you wish to display.
You can select one of the following options from the Display drop-
down list:

■ Values

■ Percentage

■ Category

■ Value & Percent

■ Categories & Percent.

4 If you wish, select a format from the “Format” drop-down list.
You can change the way values are displayed by using display formats. 
For instance, you can use a display format to display dollar amounts 
using the dollar sign ($), commas, and decimals. 

The following table shows some examples of the effects of display 
formats:

When you select one of the formats from the Format drop-down list, it 
is entered into the Format text box, located below the drop-down list.

You can use one of 4th Dimension’s built-in formats, edit a format, or 
create one of your own. For more information, see the 4th Dimension 
Design Reference manual.

Pie Charts All Other Graph Types 
None None
Inside Outside Top
Outside Outside Bottom

Inside Top
Inside Centered
Inside Bottom
At Axis

Data in Default Format Display Format Data in Display Format

3400 $###,##.00 $3,400.00

3/4/99 Month Date, Year March 4, 1999
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5 Select an orientation from the “Orientation” drop-down list.
You can select one of the following options:

■ Normal

■ Vertical

■ Rotated Left

■ Rotated Right.

6 When you are finished making your selections, click OK.

Customizing the 
Legend

4D Chart automatically creates a legend for you when it generates the 
graph. By default, the legend is based on value labels. You can 
customize the legend’s location, order, and text.

Displaying and Hiding 
the Legend

To display or hide the legend for the selected graph:

1 Choose Legend from the Chart menu.
The Legend dialog box appears.

2 Click the Display Legend check box.
If this check box is checked, the legend is displayed as part of the graph 
object. If this check box is unchecked, the legend is hidden.

3 Click OK to close the dialog box.

The next section explains how to position the legend in the graph 
object.

Display Legend 
check box
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Positioning the Legend The legend is part of the graph object. You can position the legend 
using the eight built-in legend locations, or you can move it using the 
mouse. You can move the legend anywhere in the document, includ-
ing placing it inside the graph itself. 

In addition, you can display the legend vertically or horizontally. In 
other words, the series in the legend can be placed left-to-right or 
top-to-bottom.

Positioning the Legend 
Using the Built-in 
Locations

To use the built-in locations for the legend:

1 Choose Legend from the Chart menu.
The Legend dialog box appears.

2 Select a legend position by clicking one of the model legends in the 
Location area.
The location you choose will determines whether the orientation is 
horizontal or vertical.

3 Click OK to close the dialog box.

Positioning the Legend 
with the Mouse

You can position the legend anywhere in the 4D Chart document by 
moving it with the mouse.

❿❿❿❿ To position the legend with the mouse:

1 Hold down the Ctrl key (Command key on Macintosh) and click the 
legend to select it.

Horizontal orientation

Vertical orientation
282 4th Dimension User Reference



Modifying Graph Features
2 While continuing to hold down the Ctrl or Command key, click and 
drag the legend to the desired location.

3 Release the mouse button and the Ctrl or Command key.

Maintaining the Legend 
Location

When you use the Legend dialog box, click the User Specified button 
to maintain the legend location. If you select one of the built-in 
locations, the User Specified option is automatically deselected.

Setting the Legend 
Order

You can reverse the order of the series in the legend. In addition, you 
can reverse the order of the legend key and legend text.

❿❿❿❿ To change these options:

1 Choose Legend from the Chart menu.
The Legend dialog box appears. The following options are available:

■ Reverse Legend Order: Reverses the order of the series in the leg-
end.

■ Reverse Key and Text: If this check box is checked, the square con-
taining the color or pattern code for each series is displayed after 
the series name.

2 Check or uncheck the check boxes as desired.

3 Click OK to close the dialog box.

Customizing the Legend 
Text

You can customize the text of any or all of the series in a legend. 

❿❿❿❿ To customize legend text:

1 Choose Legend from the Chart menu.
The Legend dialog box appears.

2 Click the Legend Titles tab.
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The Legend Titles page appears.

The series labels for the legend are displayed in a list. 

3 Choose the series label to edit by clicking its name in the list.
The series label is highlighted in the list and the text of the label 
appears in the Text Editing box.

4 Edit the text in the Text Editing box.

5 Click the Set button.
You must click Set in order for the changes to take effect.

6 Repeat the previous steps until you have made all the changes you 
want.

7 Click OK.
The Edit Legend dialog box closes. If you are displaying the legend, 
you will see your changes in the legend text.

Modifying Depth in 
a Two-dimensional 
Graph

A three-dimensional graph plots three fields or variables in three 
dimensions. However, you can add the appearance of a third dimen-
sion to a two-dimensional graph by adding “depth.” The third dimen-
sion does not represent the values of any of the fields or formulas 
plotted in the graph.

By default, 4D Chart adds the illusion of depth to two-dimensional 
graphs. You can remove it to make the values in the graph easier to 
read, or modify the three-dimensional illusion.

Text Editing box
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❿❿❿❿ To modify or remove the depth illusion in a two-dimensional graph:

1 Choose View from the Chart menu.
This menu item is enabled only when the currently selected object is a 
graph. 
The Depth dialog box appears.

2 Modify the horizontal and vertical depth, measured in points, by 
typing values in the appropriate text boxes.
To remove the depth illusion, enter zeros in both entry areas. You can 
also enter negative values to invert the axis of the three-dimensional 
illusion. 

When you press Tab or click outside a text box, the value you have 
entered is reflected in the Depth preview area.

3 Click OK.
Your Depth specifications are applied to the graph.

Changing the 
Perspective of a 
Three-dimensional 
Graph

You can change the perspective from which a three-dimensional graph is 
viewed. You can change both the rotation and the elevation of a graph.

❿❿❿❿ To change the perspective from which a three-dimensional graph is 
viewed:

1 Choose View from the Chart menu.
The View menu item is enabled only when the currently selected 
object is a graph.

Depth preview 
area
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The 3D View dialog box appears.

2 If you wish, you can change the rotation by entering a new value 
(from 0 to 90) in the Rotation text box or by moving the Rotation 
slider to the left or right.
Rotation is the rotation of the graph around the Values axis.

The model graph reflects the changes you have made.

3 If you wish, you can change the elevation by entering a new value 
(from 0 to 90) in the Elevation text box or by moving the Elevation 
slider up or down.
Elevation is the rotation of the graph around a horizontal line 
perpendicular to the Values axis.

The model graph reflects the change you have made.

4 Click OK.
Your graph is redrawn from the new perspective.

Rotation slider

Elevation slider
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Customize Tips in 
Graphs

Tips — information about a graph and its data — are available for both 
XY and non-XY graphs. The user can display tips from any position of 
the pointer in the graph. 

Tips display the following types of information:

■ Value (on which the pointer is located).

■ Ratio between a value (on which the pointer is located) and the total of 
values in that category. This ratio is expressed as a percentage.

■ Category.

The following table lists the graph types and the information that can 
be displayed in the associated tips:

Tip

Type of Graph Tips
2D Column Values and percentages
2D Line None
2D Pie Values and percentages
2D Area None
2D XY Values only
2D Picture Values and percentages
2D Polar Values only
3D Column Values only
3D Line None
3D Area None
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The values in the tips are based on the data as displayed in the graph 
and thus may be approximations based on the screen resolution.

Tip attributes are accessed manually in the Tips dialog box (from the 
Tips item in the Chart menu) or programmatically using the CT GET 
TIPS ATTRIBUTES and CT SET TIPS ATTRIBUTES commands.

The Tips dialog box appears as follows:

Note In the case of XY type graphs, the dialog box contains a second Format 
drop-down list and an additional entry area for the Y-axis.

In the Tips dialog box, you can change the properties of the tips 
displayed for any graph.

The Tips list box enables you to select when to display tips. The 
choices are Never, Always, and On Request.

■ If you select Always, tips appear when the user places the mouse 
cursor over part of the graph.

■ If you select Never, tips are disabled.

■ If you select On Request, tips will appear when the user places the 
mouse cursor over part of the graph while holding down the Ctrl 
(Windows) or Command (Mac OS) key. 

By default, the Never option is selected.

3D Surface None
3D Triangle Values only
3D Spike Values only

Type of Graph Tips
2D Column Values and percentages
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Selecting the Show Second Category displays the value of the second 
Category axis in the tips. The default is to not show the second 
category. In the case of a 2D graph, selecting this option displays the 
field name of the Category axis value.

Selecting the Show Category option displays the value of the Category 
axis in the tips. The default is to display the Category axis value.

Selecting the Show Value option displays the value of the Values axis 
in the tips. The default is to display the Values axis value.

The Format list box enables you to select the display format for values 
displayed. The default is General. If the Format selected is General, the 
text box below the Format list box allows you to enter text for the 
Values axis. In the case of XY graphs, there are two Format list boxes 
and text boxes, to accommodate the X- and Y-Values axes.

The Display list box enables you to choose to display the category 
value, percentage (the ratio between the value on which the pointer is 
located and the total of values in that category), or both.

Changing the 
Attributes of Graph 
Objects

This section describes how to select individual graph objects (axis 
lines, grid lines, series elements, etc.) and change their graphic 
attributes, such as color, pattern, and line width. You can also change 
the font attributes of graph text objects (such as axis labels and titles).

❿❿❿❿ To select an individual graph object:

■ Hold down the Ctrl key (Windows) or Command key (Macintosh) and 
click the object.
The following graph objects can be selected:

■ Each series in a two-dimensional graph

■ Each of the three visible sides of a series in a 3D graph

Note To select all sides of a series in a three-dimensional graph at once, hold 
down the Shift and Ctrl keys (Windows) or Command key (Macintosh) 
and click an object in the series.

■ Each axis (includes the tick marks)

■ Axis labels for each axis

■ Major grid lines for each axis

■ Minor grid lines for each axis
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■ Titles for each axis

■ The legend

■ Values displayed for the series.

Changing Object 
Attributes

After you have selected an object, you can modify its graphic attributes 
using items in the Object menu.

Each of the following object attributes can be changed in the Object 
menu.

■ Fill Pattern: The pattern displayed inside the border of an object. All 
objects except lines have fill patterns. 

■ Fill Color: The color displayed inside the border of an object.

■ Line Pattern: The pattern of a line or border. The default line pattern is 
solid.

■ Line Color: The color of a line or border. The default line color is black. 
The color palette used for Fill Color is also used for Line Color.

■ Line Width: The width of a line or border measured in points. The 
default line width is 0.25 points (also called a hairline).

Changing Text 
Attributes

Text attributes apply only to axis labels, axis titles, legend text, and 
series values. Each of the following text attributes can be changed in 
the Text menu:

■ Font: The typeface of the text.

■ Size: Font size is measured in points. 

■ Style: Styles include plain, bold, and italic. The default style is plain.

■ Color: The default color is black.

You cannot change the justification of graph text. You can only change 
the justification of text added with the Text tool. For more information 
about adding text with the Text tool, see the “Adding Text” section on 
page 297.
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Exploding Wedges 
from a Pie Chart

You can “explode” a pie chart by pulling one or more wedges away 
from the center of the pie. 

❿❿❿❿ To explode a wedge from a pie chart:

1 Hold down the Ctrl key (Windows) or Command key (Macintosh) and 
click a wedge of the pie chart to select it.
Selection handles appear around the wedge.

2 While holding down the Ctrl key (Command key on Macintosh), click 
and drag the wedge away from the center of the pie.

3 When the wedge is where you want it, release the mouse button and 
the Ctrl key (Command key on Macintosh).

Adding Pictures to a 
Picture Chart

When you create a picture chart, the columns are filled with a default 
picture. You can add your own picture for each series by pasting it from 
the Clipboard.

❿❿❿❿ To paste a picture into the columns for a series:

1 Make sure that the picture you want to paste into the column is on the 
Clipboard.

2 Hold down the Ctrl key (Windows) or Command key (Macintosh) and 
click a column of the desired series.
All the columns are then selected. By default, the picture for each series 
shows a building.

3 Choose Paste from the 4th Dimension or 4D Chart Edit menu.
OR
Press Ctrl+V under Windows or Command+V under Mac OS.

The picture is pasted into each column for the series.

You can repeat this process for each series. 

Note To recover the standard picture, apply a different chart type then re-
apply the 2D Picture type.

Exploded 
wedge
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Adjusting the 
Pictures within the 
Columns of Picture 
Charts

To customize the proportions of the pictures within the series 
columns:

1 Double-click the graph to display the Options dialog box for picture 
graphs. 
OR
Select the graph and choose Options from the Chart menu.
The Picture Chart Options dialog box appears.

In addition to the chart options, which are discussed in the “Choosing 
a Graph Type” section on page 241, you will find the following options 
for aligning and adjusting the pictures:

■ Alignment: This option specifies the horizontal alignment of the 
picture: center, left, or right.

■ Vertical: This option specifies how the picture uses the vertical space 
of the column. The options are: clipped, stretched, and stacked. For 
more information about these options, see the table at the end of 
this section.

■ Horizontal: This option specifies how the picture uses the horizon-
tal space of the column. The options are: clipped, stretched, and 
stacked. For more information about these options, see the table at 
the end of this section.
292 4th Dimension User Reference



Adding Objects and Text
The following table explains the Vertical and Horizontal options.

2 Choose the desired options from the drop-down lists and click OK.

Adding Objects and Text
With 4D Chart you can add a variety of objects to your documents, 
including lines, rectangles, ovals, polygons, and text. You can also add 
dynamic references to fields or to 4th Dimension expressions by 
inserting expressions in text objects.

The following graph uses objects and text to identify the series.

Topics covered in this section include:

■ Drawing objects

■ Modifying object attributes

■ Adding text

Option Description

Clipped If the picture is too tall or too wide to be displayed in its 
entirety, it is truncated at the edges of the column. The 
proportions of the picture remain unchanged.

Stretched The picture is stretched or shrunk so that its dimensions 
match those of the column.

Stacked If the picture is either too short or too narrow to fill the 
column, the picture is repeated until the column’s height or 
width is reached. When the edge of the column is reached, 
the picture is truncated.

JBC

Industrial
Average
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■ Modifying text attributes

■ Adding a dynamic reference to a 4th Dimension field or expression

■ Resizing objects

■ Arranging objects in a document.

Drawing Graphic 
Objects

You can draw the following objects:

■ Lines  

■ Rectangles  

■ Rounded rectangles  

■ Ovals  

■ Polygons  .

Selecting a Drawing Tool To draw an object, you must first select a tool from the Object Tool 
palette. You make a tool active for drawing when you select it.

The mouse pointer changes depending upon its use. If the Arrow tool 
is selected, then the pointer is an arrow . You use the Arrow tool to 
select menu items and objects.

When you select any of the graphic object tools, the pointer changes 
to a crosshair . You use the crosshair to draw graphic objects.

Locking a Drawing Tool When you select a tool, it is in effect only while you draw one object, 
after which the Arrow tool is selected. However, you can lock a tool so 
that you can continue to use it as long as you need it, by double-
clicking it. When you lock a tool, it remains in use until you select 
another tool.

Drawing an Object

❿❿❿❿ To draw all objects except polygons:

1 Select a tool in the 4D Chart toolbar. 

1 Hold down the mouse button in the document area and drag the 
mouse to draw the object.

2 Release the mouse button to finish drawing the object.
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❿❿❿❿ To draw a polygon:

1 Click to anchor the first vertex.

2 Drag the mouse to draw a side and then click to anchor the next 
vertex.

3 Continue anchoring vertices and drawing sides as necessary.

4 Close the polygon by clicking the first vertex to close the polygon, or 
by pressing Alt+Ctrl+Enter (Windows) or Option+Command+Enter 
(Mac OS).
OR
Leave an open side to the polygon by double-clicking the mouse 
button to anchor the last vertex or by pressing Enter.

Constraining Graphic 
Objects As You Draw

By constraining graphic objects as you draw, you can control the 
drawing process — in particular, the height and width of objects. For 
example, a square is really just a constrained rectangle. 

The following table lists the effects of constraining each object:

Open polygonClosed polygon

Object Key Constraint
Lines Shift Constrain line to 45° angles

Rectangles

Shift Draw a square

V (for vertical) Constrain height

H (for horizontal) Constrain width

Rounded 
Rectangles

Shift Draw a rounded square

V Constrain height

H Constrain width
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Changing Object 
Attributes

Each of the following object attributes can be changed using 
commands in the Object menu:

■ Fill Pattern: The pattern displayed inside the border of an object. All 
objects except lines have fill patterns. The default fill pattern is solid 
white.

■ Fill Color: The color displayed inside the border of an object. All objects 
except lines have fill color. The default fill color is black.

■ Line Pattern: The pattern of a line or border. The default line pattern is 
solid.

■ Line Color: The color of a line or border. The default line color is black.

■ Line Width: The width of a line or border measured in points. The 
default line width is 0.25 points (also called a hairline).

■ Arrowhead: The arrows that appear on one or both ends of a line; only 
lines have arrowheads. The default is to have no arrowheads. If the 
selected object is a line, the Arrowhead menu item is enabled. The 
Arrowhead submenu has the following items.

■ Round Corners: The amount of rounding of the corner of a rounded 
rectangle. The default rounding is 1/4 inch. If the selected object is a 
rectangle that you created with a rectangle tool, the Round Corners 
menu item is enabled. When you choose Round Corners, the following 
dialog box appears:

Ovals

Shift Draw a circle

V Constrain height

H Constrain width

Polygons Shift Constrain sides to 45° angles

Object Key Constraint
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When you enter a value in the entry area, the preview area shows the 
effect of the value:

Adding Text Most of the text that you want to add to a graph — such as axis labels, 
titles, legends — can be added using menu items in the Chart menu.

To add extra text to a graph, you must first create a text object and 
then enter the text. A text object is a container for text. 

❿❿❿❿ To create a text object:

1 Select the Text tool .
The pointer changes to an I-beam .

2 Hold down the mouse button and drag the mouse to create a 
rectangular text area.

3 Release the mouse button.
You can also simply click in the window after you have selected the 
Text tool to create a text object of default size (three inches in width). 
The default height is determined by the font and font size you have 
selected.

4 If you have not already done so, click inside the text object to insert 
the pointer.
When you place the pointer in the text object, it becomes an insertion 
point  .

5 Type your text.

6 When you have finished typing the text, select any other tool.
Unlike other objects, text objects are not selected after you create 
them. 
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Once you have created a text object and added text, you can change 
the text by editing it — for example, copying, cutting, or pasting it. 
You can also change its attributes, such as its font, size, style, and 
justification. For more information about changing text attributes, 
refer to the next section, “Changing Text Attributes”. 

Changing Text 
Attributes

Text attributes are applied only to text inside a text object. Each of the 
following text attributes can be changed in the Text menu:

■ Font: The typeface of the text. 

■ Size: Font size is measured in points. The default size is 12 point.

■ Style: Styles include plain, bold, and italic. The default style is plain.

■ Color: The default color is black.

■ Alignment: Text can be left, right, or center aligned. The default align-
ment left.

Adding Dynamic 
References

Using field references and 4th Dimension expressions, you can create 
4D Chart documents that incorporate information from your database. 
For example, you can use field information from the records to make 
graph titles. You can use 4th Dimension expressions to perform tasks 
such as computing numeric values or concatenating text information.

In this section, you will find information about the following topics:

■ Inserting field values into a 4D Chart document,

■ Inserting a 4th Dimension expression into a 4D Chart document,

■ Displaying field and expression values,

■ Formatting field and expression values,

■ Changing a dynamic reference to static text.

Understanding Values 
and References

You can display the information from 4th Dimension as either values or 
references. A value is the actual information stored in a field or calcu-
lated from an expression. A reference is the name of the field or the 
text of the expression.

When expressions and fields are displayed as references, they are 
surrounded by the following symbols: « and ». 
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For example, a reference to the First Name field in the [Stationery 
Order] table would appear as:

«[Stationery Order]First Name»

4D Chart inserts these symbols when a field is inserted into a text 
object. When you insert any other type of reference, such as a 
4th Dimension function or variable, you must indicate that it is a 
reference. 4D Chart will then add the « and » symbols to differentiate 
the reference from normal text. For more information on referencing 
expressions, see the “Inserting 4th Dimension Expressions” section on 
page 302.

When references are displayed as values, the « and » symbols do not 
appear; for example, a field value for First Name might be:

James

The field value appears as standard text.

Field references and 4th Dimension expressions always refer to the 
current record and are updated whenever the current record changes. 
If there is no current record, no value is displayed. 

Inserting Field 
References

By inserting a field reference in a 4D Chart document, you add 
dynamic information to the document. As the field is updated, so is 
the value in 4D Chart. You can use fields from any table in the data-
base, except subtables.

The field reference or value appears in a text object, except for refer-
ences to picture fields. The text object containing a reference acts as 
any other text object; you can change its attributes, move it, and so on.

■ Using Field References in a Plug-in Window
When you insert a field reference in a 4D Chart plug-in window, the 
value that is displayed when you choose Show Values from the 
Database menu is the field’s value for the current record. If no record is 
currently loaded there will be no value displayed in the 4D Chart plug-
in window. 
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In order to show the value stored in a field for a particular record, make 
sure that the record is loaded — by displaying the record in an input 
form, for instance. If the current record changes, the value displayed in 
the field changes.

■ Using Field References in a 4D Chart Area on a Form
When you insert a field reference in a 4D Chart area on an input form, 
the value that is displayed when you choose Show Values from the 
Database menu is the field’s value for the current record.

You can use the Paste Field dialog box to paste a field reference into a 
document.

❿❿❿❿ To paste a field reference into a 4D Chart document using the Paste 
Field dialog box:

1 Click the mouse button where you want to insert the reference.
If you click inside a text object, you cannot insert a Picture field.

2 Choose Paste Field from the Database menu.
The Paste Field dialog box appears. All tables in the database are listed 
in the Tables drop-down list. The fields for the selected table are 
displayed in the Fields list.

3 Select the table from which you wish to paste a field reference from 
the Tables drop-down list.
The fields in the selected table are displayed in the Fields list.

4 Select the field you wish to paste from the Fields list and click OK.
A reference to the field is pasted into the document in a text object.

Tables drop-down list

Fields list
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You can select fields from a drop-down list containing all available 
tables and fields. You cannot paste references to Picture fields when 
you select a field from a drop-down list.

When you are working in a form, you can choose fields from a drop-
down list that displays the fields in the current table, or from a drop-
down list of fields for all tables in the database. 

When you use 4D Chart in a plug-in window, the drop-down list 
always contains both tables and fields. 

❿❿❿❿ To insert a field into a 4D Chart document using the Tables and Field 
pop-up menu:

1 Create a text object where you want to paste the field.
If you need information about creating text objects, see the “Adding 
Text” section on page 297.

2 Position the I-beam pointer  over the text object.
Make sure that the insertion point is in the text object.

3 To choose a field from the same table as the form, hold down the Alt 
key (Windows) or Option key (Macintosh) as you press the mouse 
button.
A pop-up menu of fields for the table in which you are working 
appears. If you are working in a plug-in window, the pop-up menu 
contains both tables and fields.

4 To choose a field from another table, hold down the Shift and Alt 
(Windows) or Option (Macintosh) keys while you press the mouse 
button. 
If you are working in a plug-in window, you do not need to hold down 
the Shift key.

4D Chart displays a hierarchical pop-up menu of the tables in the 
database. Each table has a submenu containing its fields. 

5 Select a field.
A reference to the selected field is pasted into a text object in the 
4D Chart document at the insertion point location.
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Inserting 4th Dimension 
Expressions

You can insert any valid 4th Dimension expression into a document. 
The expression can be a 4th Dimension variable, a 4th Dimension func-
tion, a plug-in function, or a method that returns a value.

With expressions you can use the power of 4th Dimension’s language 
within 4D Chart documents. You can perform calculations, concate-
nate information from several fields, and so on. 

The following table contains some examples of expressions:

An expression is evaluated only when you perform one of the 
following actions:

■ Open the document

■ Choose Show Values from the Database menu

■ Print the document.

For more information about expressions, refer to the 4th Dimension 
Language Reference manual. 

❿❿❿❿ To insert a 4th Dimension expression into a 4D Chart document:

1 Create a text object where you want to place the expression.
Since the expression is created from text, you must first create the text 
object.

2 Enter the expression text and then select it.

3 Choose Reference from the Database menu.
The text is now enclosed in the « and » symbols, which indicate that it 
is an expression:

«Current date»

4 When you have finished, select the Arrow tool.
To display the value of the reference, choose Show Values from the 
Database menu.

Expression Comment
vDate A variable containing a date
Current date A 4th Dimension function
Current date–vDate A statement that performs a calculation
DateCalc A method that returns a value
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Displaying Values or 
References

When you display values, you show the actual values stored in refer-
enced fields and the values calculated by referenced 4th Dimension 
expressions. For example, if the reference is «Current date», today’s date 
is displayed. 

❿❿❿❿ To display values:

■ Choose Show Values from the Database menu.
The value of each reference is displayed.

Note The values of all references are displayed, regardless of the selected 
reference.

❿❿❿❿ To display references:

■ Choose Show References from the Database menu.
The reference for each value is displayed.

Changing the Value in a 
Reference to Text

You can change the value in a dynamic reference into static text that 
will not be updated when the value changes. 

For instance, you can use the 4th Dimension expression «Current date» 
to display the date you created a graph, and then change that date to a 
static text object. No matter what the current date is, the text object 
will always display the creation date of the graph.

Changing a value to text is called unreferencing the value, because the 
value no longer has a dynamic reference to the database. Once you 
have unreferenced a value, you cannot change it back to a reference. 

❿❿❿❿ To change a value in a field reference or expression to text:

1 Choose Show Values from the Database menu to display all values.

2 Select the text block containing the value you want to unreference.
If the text block contains more than one field or expression, select only 
the value you want to change.

3 Choose Unreference from the Database menu.
The value becomes text.
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Changing a Reference to 
Text

You can change a reference into text by unreferencing it. When you 
change a reference to text, you change the words of the reference, not 
the value to which the reference refers. 

For instance, if you change the reference «Current date» to text, the text 
object displays the following:

Current date

When you choose Show Values from the Database menu, this text does 
not change, and the current date is not displayed, because the text no 
longer refers to a 4th Dimension expression.

You may want to edit a reference or permanently change it to standard 
text. If you want to edit a reference, you must unreference it, edit it, and 
then reference it again. 

❿❿❿❿ To unreference a field reference or expression:

1 Choose Show References from the Database menu to display all 
references.

2 Select the text block containing the reference you want to 
unreference.
If the text block contains more than one field or expression, select only 
the reference you want to change.

3 Choose Unreference from the Database menu.
The « and » symbols are removed, and the reference becomes text.

Formatting References You can use a display format for the value of any numeric, date, or 
time field, or expression in 4D Chart. For instance, you can use a 
display format to display dollar amounts using the dollar sign ($), 
commas, and decimals. 

The following table shows some examples of display formats:

❿❿❿❿ To format a reference:

1 Select the reference.
Since the entire expression is a single value, you can select it by 
clicking it with the Text tool.

2 Choose Format from the Database menu.

Data in Default Format Display Format Data in Display Format
3400 $###,##.00 $3,400.00
3/4/03 Month Date, Year March 4, 2003
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The Field Format dialog box appears.

3 Select an appropriate format from the list.
The format appears in the text box below the list of formats.

If you want, you can edit a number format or enter a new number 
format in the Format text box. You cannot edit date or time formats.

For more information about display formats, refer to the 
4th Dimension Design Reference manual.

4 Click OK.
The format is listed after the reference. For instance:

«Current date; Abbr.: Month Day, Year»

When you choose Show Values, the value of the reference is displayed 
using the format.

Resizing Objects You can make an object larger or smaller by resizing it. You can select 
one or more objects to resize. If you select more than one object, all 
selected objects are resized by the same amount. 

You can resize the height and width at the same time, maintaining the 
sizing proportion between the two. 

❿❿❿❿ To resize an object:

1 Select the object.

2 Hold the mouse button down on a selection handle and drag it up, 
down, or diagonally to change the object’s size.

Format list

Edit format area
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If you drag a corner, the height and width change. If you drag a side, 
either the height or the width changes.

To display the object’s outline — rather than its rectangular frame —
hold down the Alt key (Option key on Macintosh) while resizing. 

To resize the object so that the height and width retain the same 
proportion to each other, hold down the Shift key while you are 
resizing.

3 Release the mouse button when you have finished.
The object is resized.

Arranging Objects When you have two or more objects in a 4D Chart document, you can 
use the items in the Arrange submenu of the Object menu to arrange 
them. The Arrange submenu is shown below.

You can choose from the following actions in the Arrange submenu:

■ Bringing an item to the front 

■ Sending an item to the back 

■ Moving an item forward one level

■ Moving an item backward one level

Object’s frame

Object
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■ Aligning objects in relation to each other

■ Grouping a set of objects

■ Ungrouping a set of objects.

The following sections describe these actions in more detail.

Changing the Stacking 
Order

When you draw objects, they can partially or entirely overlap one 
another. The order in which objects are placed when they overlap one 
another is called the stacking order. The example below displays several 
objects and their stacking order:

As you work with objects, you may want to change the stacking order 
of objects; to do so, you can move one or more objects in front of or 
behind other objects.

■ Moving an Object in Front of All Others: By moving an object in front 
of all others, you move it to the top layer.

■ Moving an Object Behind All Others: By moving an object behind all 
other objects, you move it to the bottom layer.

■ Moving One Object in Front of Another: Moving an object in front of 
another object allows you to move the selected object one layer higher 
— that is, place it closer to the top layer.

■ Moving One Object Behind Another: Moving an object behind 
another object allows you to move the selected object one layer lower 
— that is, place it closer to the bottom layer.

Middle object

Top object

Bottom object
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❿❿❿❿ To modify the stacking order:

1 Use the arrow pointer to select an object.

2 Choose a command in the Arrange submenu of the Object menu. 
The Arrange submenu is shown below:

Aligning Objects When you align objects, you position them in relation to each other. 
Aligning objects ensures that they are placed precisely in relation to 
each other. You can align objects both horizontally and vertically. 

The object that is farthest in the selected alignment direction is the 
reference for object alignment. For example, if you want to align the 
left sides of several selected objects, the selected object that is furthest 
to the left remains fixed, and the other objects are aligned with it.

When you select Align Objects from the Arrange submenu, the 
Align Objects dialog box appears:

Vertical alignment buttons

Model objects

Horizontal alignment buttons
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Use the following icons to align the selected objects with each other:

Select a maximum of one vertical and one horizontal alignment. The 
model objects move to indicate the effects of the alignment.

Note To deselect an icon, click it again.

❿❿❿❿ To align objects:

1 Select the objects to be aligned.
Shift-click to select several objects.

2 Choose Align Objects from the Arrange submenu of the Objects menu.
The Align Objects dialog box appears.

3 Click the desired alignment icons and click the Align button.

Grouping and 
Ungrouping Objects

By grouping objects, you can combine several objects into one. A 
grouped object acts like a single object when you manipulate or edit it. 
You can work with a grouped object as you would any other object; 
you can change its attributes, resize it, and so on.

When you group several objects, all attributes of the individual objects 
are retained. However, if you change any attribute of the group, that 
change affects all objects in the group. For example, if you select a new 
fill pattern for the group, it is applied to each object in the group. 

Ungrouping an object breaks it into its component objects. When an 
object is ungrouped, each piece becomes a separate object again. 
Ungrouped objects retain any changes made to them while part of a 
group.

Icon Meaning

 Align the left edges of selected objects.

 Align the centers of selected objects along a vertical axis.

 Align the right edges of selected objects.

 Align the top edges of selected objects.

 Align the centers of selected objects along a horizontal axis.

 Align the bottom edges of selected objects.
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❿❿❿❿ To group objects:

1 Select all objects to group.

2 Choose Group from the Arrange submenu of the Object menu.
The objects become one object.

You can break a grouped object into its separate objects by ungrouping it.

❿❿❿❿ To ungroup objects:

1 Select an object to ungroup.

2 Choose Ungroup from the Arrange submenu of the Object menu.
The object is ungrouped and each object is selected.

Printing 4D Chart Documents
You can print any 4D Chart document. This section discusses printing 
4D Chart documents in the following ways:

■ As a single 4D Chart document

■ As part of a 4th Dimension form

■ As a part of a print merge, in which you print a 4D Chart document for 
each record in a selection of records.

Setting the Print 
Order

The order in which a multi-page document is printed (either horizon-
tally or vertically) is determined by the print order selected in the Prop-
erties dialog box. You can select printing by row , or printing by 
column . The print order affects only the order in which the docu-
ment prints; it does not affect the page orientation. The default is to 
print pages by row.

❿❿❿❿ To set the order in which a multi-page document is printed:

1 Choose Properties from the 4D Chart Edit menu.
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The Properties dialog box appears:

2 Click the desired Print Order icon.

3 Click OK.

Printing the 
Document

You can print 4D Chart documents from a plug-in window or from a 
4D Chart area in a form. If the document is more than one page in 
length, you can select the pages you want to print.

❿❿❿❿ To print a document:

1 Choose Print from the 4D Chart File menu.

The Print dialog box appears.

2 Select options as necessary.

3 Click the Print button to begin printing.

Print Order icons
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Printing a 4D Chart 
Area as Part of a 
Form

If a 4D Chart area is on a 4th Dimension form, you can print it with 
the record. In this case, you print from 4th Dimension, rather than 
from 4D Chart. 

Before printing, be sure to select the records you want to print. For 
more information about selecting records in 4th Dimension, see 
Chapter 4, “Selecting Records,” on page 81.

❿❿❿❿ To print a 4D Chart document as part of a record:

1 Choose Print from the 4th Dimension File menu.
A dialog box appears so that you can choose the print form.

2 Choose the print form.

3 Click OK.
The Page Setup dialog box appears.

4 Select options from the Page Setup dialog box as necessary.

5 Click OK.
The Print dialog box appears.

6 Select options as necessary.

7 Click the Print button when you want to begin printing.
The selected records are printed, including the 4D Chart documents.

Creating a Print 
Merge

You can perform a print merge of a 4D Chart document. Performing a 
print merge allows you to print a 4D Chart document for each record 
in a selection of records.

Note The values in any graphs in the document are not updated for each 
record.

Print merges are most useful when performed from 4D Chart plug-in 
windows. 

You can only perform print merges for documents that contain 
references to 4th Dimension fields. The value in a field reference is 
determined by the current record being printed. The advantage to 
performing a print merge is that you can print a document for an entire 
selection of records without having to load and print for each record 
separately. 

Note For information on adding field references, see the “Inserting Field 
References” section on page 299.
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❿❿❿❿ To perform a print merge:

1 Choose Print Merge from the 4D Chart File menu.

The Create Merge Selection dialog box appears. 

2 Choose the table whose records should be included in the print merge. 
The dialog box displays the number of records currently selected for 
that table. 

4D Chart will only print the document for the selected records. 

3 If you want to change the selection of records, click the Query button. 
The 4th Dimension Query editor appears. After you perform the query 
in the Query editor, you will return to the Create Merge Selection 
dialog box. For more information about the 4th Dimension Query 
editor, see the “Query Editor” section on page 90.
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4 If you want the selected records to be sorted, click the Order by 
button. 
The 4th Dimension Order By editor appears. After you sort the records, 
you will return to the Create Merge Selection dialog box. For more 
information about the Order By editor, see “The Order By Editor” 
section on page 125.

When you have selected the appropriate records, you can print them.

5 Click OK in the Create Merge Selection dialog box.
The Print dialog box appears.

6 Select the appropriate options and click OK.
4D Chart prints the document for each record in the selection.
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The Method command in the Run menu, as well as the corresponding 
button on the far right of the toolbar, are used to execute a method 
from the User environment. Once you have written project methods in 
the Design mode, you can execute them directly in User mode, for 
example to test them.

It is possible to execute methods directly in Trace mode, in order to 
debug them.

You can execute a method in a new process or, with 4D Server, indicate 
for it to execute this method on the server machine or on other clients’ 
machines.

Note A project method can also be executed from the Custom Menus 
environment by assigning it to a menu command on the custom menu 
bar. When you choose a menu command on a menu bar, the 
associated method is automatically executed. For more information 
about form menu bars, see the 4th Dimension Design Reference manual.

Executing Methods
Use the Method command in the Run menu to select and execute a 
method created with the 4th Dimension language.

For more information about writing methods, see the 4th Dimension 
Design Reference and the 4th Dimension Language Reference manuals.

❿❿❿❿ To execute a method:

1 Choose Method from the Run menu.
OR
Click the “Execute” button in the toolbar of the User mode.
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4th Dimension displays the Execute Method dialog box, as shown 
below:

2 Select the name of a method in the list.
3 If you want to start a new process for the method, check the “New 

Process” check box.
If you check the New Process check box, the method you selected exe-
cutes in another process. If the method is performing a time-consum-
ing task such as printing a large set of records, you can continue to 
work with your database, adding records to a table, creating a graph to 
display data, and so on. 

For a definition of processes, see the “Multi-tasking in 4th Dimension” 
section on page 24. For a detailed description of processes, including 
how to create, use, and manage processes, refer to the 4th Dimension 
Design Reference manual.

4D Server • If you are using the database on 4D Client, you can choose to run the 
method on the server machine. To do so, select the On 4D Server 
option in the To be executed menu. Most methods can be executed on 
the server machine, unless the method must create or modify interface 
elements on a client workstation.
• You can also choose to run the method on another client 
workstation. Other client workstations will not appear in the menu, 
unless they have been previously “registered” (for more information, 
please refer to the description of the REGISTER CLIENT routine in the 
4th Dimension Language Reference manual, as well as the “Registering 
4D Client” paragraph in the 4D Server Reference manual.
By default, the locally option is selected. With 4D single-user version, 
this is the only option available.
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4 Click the Execute button (or double-click the method name).
OR
If you want to trace the method, click the Debug button.

4D Server The Debug option is not available if you execute the method on the 
server.

4th Dimension executes the method. What happens next depends on 
what the method does. A method can perform calculations, change the 
current selection, print reports, and even exit the application and 
return to the Program Manager or Finder.

If you click Debug, the debug window appears in the foreground and 
you can execute the method step by step. For more information on the 
4th Dimension debugger, refer to 4th Dimension Language Reference 
manual. 
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13 Backup and Restoring of 
the Database

Introduction
4th Dimension includes a full database backup and restore module. 

This module works with 4th Dimension single-user and 4D Server. It 
allows backing up a database currently in use without having to exit it. 
Each backup can include the structure file, the data file (as well as any 
segments) and any additional files or folders. These parameters are first 
set in the application Preferences.

Backups can be started manually or automatically at regular intervals 
without any user intervention. Specific language commands, as well as 
specific database methods, allow integrating backup functions into a 
customized interface. 

Databases can be restored automatically when a damaged database is 
opened.

Also, the integrated backup module can take advantage of the log file. 
This file keeps a record of all operations performed on the data and 
also ensures total security between two backups. In case of problems 
with a database in use, any operations missing in the data file are 
automatically reintegrated the next time the database is opened. A 
specific window allows you to view the log file contents at any time.

The integrated backup module allows you to:

■ Start a complete backup of database files at any time (structure file, 
data file, log file, attached files, etc.),
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■ Set up automatic backups at regular intervals — on a hourly, daily, 
weekly or monthly basis,

■ Set advanced parameters for backups (number of sets, file compression, 
options for startup after a restore, etc.),

■ Automatically restore a database and its attached files in case of inci-
dent,

■ Automatically integrate missing operations stored in the log file into a 
restored database,

■ Roll back operations performed on database data.

Managing Backups
Backing up the database consists of generating a copy of the database 
and all its necessary files at a given moment. This copy is placed in one 
or more backup file(s). 

Any backup file can later be opened using 4th Dimension in case of any 
incidents that damage the current database; the database will then be 
restored to its previous state (at the time it was copied).

Performing a 
Backup

Each backup is performed while taking into account the parameters set 
in the application Preferences.

The Preferences can be used to define every aspect of the backup:

■ Files to include in the backup (data / log, structure, user structure 
and attached files),

■ Location of backup files (main backup file and log backup file).

■ Management of log file,

■ Backup scheduling,

■ Backup options: number and rotation of backup sets; handling of 
active transactions or index operations; handling of failures; seg-
mentation, compression and integrity of backup files,

■ Setting automatic restore options.
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These parameters are set at default values corresponding to standard 
use; changing these values is optional. For more information on these 
parameters, please refer to the “Configuration of Backup Files” 
paragraph on page 325 and the “Backup Settings” paragraph on 
page 330. 

Starting a Backup In 4th Dimension, a backup can be started in three ways:

■ Manually, using the Backup... command in the 4th Dimension (User 
environment) and 4D Server File menu.

■ Automatically, using the scheduler that can be set in the application 
Preferences.

■ Programmatically, using the BACKUP command.

The choice will depend on your use of the database and your backup 
strategy. 

4D Server A backup can be started manually from 4D Client using a method that 
calls the BACKUP command. The command will be executed, in all 
cases, on the server.

❿❿❿❿ To perform a manual backup:

1 Select the Backup... command in the 4th Dimension (User 
environment) or 4D Server File menu:
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The backup window appears:

The Preferences button causes the general backup preferences to be 
displayed (see the “Configuration of Backup Files” paragraph on 
page 325). The Cancel button cancels the backup. 

2 Click Backup to start the backup using current parameters.

❿❿❿❿ To perform a scheduled automatic backup:

1 In the Scheduler page of the “Backup” Preferences, set the backup 
frequency:

Backups are automatically performed at the times defined on this page 
without any type of user intervention.

Note For more information on using this dialog box, please refer to the 
“Scheduled Backup Settings” paragraph on page 336. 
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❿❿❿❿ To perform a scheduled backup using 4th Dimension language:

1 Execute the BACKUP command in a method. 
The backup starts using the current parameters.

You can use the On Backup Startup and On Backup Shutdown database 
methods for handling the backup process. 
For more information on this, please refer to the 4th Dimension 
Language Reference manual.

Executing a Backup Once the backup is started, 4th Dimension displays a dialog box 
indicating the progress of the backup:

The Stop button lets the user interrupt the backup at any time (please 
refer to the “If Backup Fails” paragraph on page 334). 

The result of the last backup (successful or failed) is stored in the “Last 
Backup Information” area of the Backup/Configuration page of the 
Preferences or in the main window of 4D Server (please refer to the 
“Last Backup Information” paragraph on page 329). It is also recorded 
in the database Backup journal (please refer to the “Backup Journal” 
paragraph on page 358). 

Accessing the Database 
During Backup

During a backup, access to the database is restricted by 4D according to 
the context.

4D locks any processes related to the types of files included in the 
backup: if only the structure file is being backed up, access to the 
structure is not possible but access to the data will be allowed. 

Conversely, if only the data file is being backed up, access to the 
structure is still allowed. In this case, the database access possibilities 
are as follows:

■ With the 4th Dimension single-user version, the database is locked for 
both read and write; all processes are frozen. No actions can be per-
formed.
3234th Dimension User Reference



Chapter 13  Backup and Restoring of the Database
■ With 4D Server, the database is only write locked; client machines can 
view data. If a client machine sends an add, remove or change request 
to the server, a window appears asking the user to wait until the end of 
the backup.
Once the database is saved, the window disappears and the action is 
performed. To cancel the request in process and not wait for the end of 
the backup, simply click the Cancel operation button.

However, if the action waiting to be executed comes from a method 
launched prior to the backup, you should not cancel it because only 
operations remaining to be performed are cancelled. Also, a partially 
executed method can cause logical inconsistencies in the database. 

Note When the action waiting to be executed comes from a method and the 
user clicks the Cancel operation button, 4D Server returns error -9976 
(This command cannot be executed because the database backup is in 
progress).

Encountering Problems 
During a Backup

It may happen that a backup is not executed properly. There may be 
several causes of a failed backup: user interruption, attached file not 
found, destination disk problems, incomplete transaction, etc. 
4th Dimension processes the incident according to the cause.

In all cases, the status of the last backup (successful or failed) is 
displayed on the Configuration page in the Backup preferences, in the 
4D Server window and in the Backup journal (please refer to the “Last 
Backup Information” paragraph on page 329). 

■ User interruption: The Stop button in the progress dialog box allows 
users to interrupt the backup at any time. In this case, the copying of 
elements is stopped and an error is generated. You can intercept this 
error in the On Backup Shutdown database method.

■ Attached file not found: When an attached file cannot be found, 
4th Dimension performs a partial backup (backup of database files and 
accessible attached files) and returns an error.
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■ Backup impossible (disk is full or write-protected, missing disk, disk 
failure, incomplete transaction, database not launched at time of 
scheduled automatic backup, etc.):

■ If this is a first-time error, 4th Dimension will then make a second 
attempt to perform the backup. The wait between the two attempts 
is defined on the Backup page of the Preferences (please refer to the 
“If Backup Fails” paragraph on page 334).

■ If the second attempt fails, a system alert dialog box is displayed 
and an error is generated. You can intercept this error in the On 
Backup Shutdown database method.

■ Backups blocked due to an incomplete transaction or index opera-
tion are handled using a specific mechanism (please refer to the “If 
Active Transactions or Index Operations” paragraph on page 333). 

Configuration of 
Backup Files

The Configuration page of the application Preferences lets you set the 
backup files and their location, as well as that of the log file. It also 
provides information on the last backup:

Note You can display the application Preferences dialog box:
• by clicking on the Preferences... button in the backup dialog box,
• by choosing the Preferences... command in the Edit menu of 
4th Dimension. 
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These parameters are specific to each database opened by the 
4th Dimension application.

4D Server These parameters can only be set from the 4D Server machine.

Backup Contents This area allows you to define which files and/or folders to copy during 
the next backup.

The upper portion of the area lists the 4th Dimension database files 
and indicates their current size. You must set each file to include in the 
backup by checking the corresponding option. A dimmed option 
means that the corresponding file is not available in the database. You 
can select the 4th Dimension files that you want, depending on how 
often they are updated, their strategic interest, their size, etc. No file is 
required.
The lower portion lists the file access paths of any attached files in the 
backup.

■ Data File: Database data file. 
If the database contains several segments, only the name and size of 
the first segment are displayed. Of course, all segments are backed up.
When this option is checked, the current log file of the database, if 
any, is backed up at the same time as the data. The backup causes the 
closing and backup of the current log file, then the creation of a new 
log file. This prevents the size of the log file from becoming excessively 
large.
For more information on the log file, please refer to the “Managing the 
Log File” paragraph on page 339.

■ Structure File: Database structure file. 
In cases where databases are compiled and merged with 4D Runtime 
Volume License, this option allows you to backup the .exe file (Win-
dows) and the package (Mac OS). 

■ User Structure File (optional): Database User structure file that con-
tains customized user forms (if any). 
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■ Attachments: This area allows you to specify a set of files and/or folders 
to be backed up at the same time as the database. These files can be of 
any type (documents or plug-in templates, labels, reports, pictures, 
etc.).
You can set either individual files or folders whose contents will be 
fully backed up. Each attached element is listed with its full access path 
in the “Attachments” area.

■ Add Folder: When you click this button, 4th Dimension displays a 
dialog box that allows selecting a folder to add to the backup. In 
case of a restore, the folder will be recuperated with its internal 
structure. You can select any folder or volume connected to the 
machine, with the exception of the folder containing the database 
files.

■ Add: When you click this button, 4th Dimension displays a dialog 
box that allows selecting a file to add to the backup.
You cannot select a database file as an attached file.

■ Remove: This button allows you to remove the selected file from the 
list of attached files.

Note It is possible that one or more attached files are not accessible when 
the backup is executed (modified name or access path, disk 
disconnected, etc.). In this case, the backup is executed without the 
missing file(s) and an error is generated. You can intercept this error in 
the On Backup Shutdown Database Method. The error is also indicated 
in the Backup journal. 

Backup File Destination 
Folder

This area allows defining the location where backup files and log files 
(if any) are stored.

4th Dimension generates two types of backup files: backup files and 
backup log files. Backup files are special for two reasons:

■ They can contain several files (structure, data, attached files, etc.).

■ They are secured using internal verification mechanisms (which can 
be set on the “Backup” page of the Preferences). 

By default, 4th Dimension stores these files next to the database data 
file. It is strongly advised to set a location on another disk volume to 
reduce the risk of data loss in case of disk failure on the drive 
containing the database. 
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To modify the location where these files are stored, click the [...] 
button:

A selection dialog box appears, which allows selecting a folder or disk 
where the backups will be placed. The “Used Space” and “Free Space” 
areas are updated automatically and indicate the remaining disk space 
on the disk of the selected folder.
You should make sure that the free space is sufficient for all of your 
backups. If a backup fails due to a lack of disk space, an error is 
generated. You can intercept this error in the On Backup Shutdown 
Database Method. The error is also indicated in the information area 
and in the Backup journal. 

Backup File Names 4th Dimension names backup files using a specific naming system on 
which the automatic restore functions are based. This naming system 
cannot be changed.

Standard backups are named Databasename[xxxx].4BK, where data-
basename is the name of the database data file and xxxx is the number 
of the backup. For example, the 26th backup of the Invoices database is 
named Invoices[0026].4BK.
If the backup is segmented, 4th Dimension adds the segment number 
as -xxxx. For example, the 3rd segment of the 26th backup of the 
Invoices database is named Invoices[0026-0003].4BK.
For more information on segments, please refer to the “Archive” para-
graph on page 335. 

■ Backups of log files are named Logname[xxxx].4BL, where logname is 
the name of the log file of the database and xxxx is the number of the 
backup (starting at 0). For example, the 13th backup of the Log log file 
is named Log[0012].4BL.
If the backup of the log file is segmented, 4th Dimension adds the seg-
ment number as -xxxx. For example, the 2nd segment of the 13th 
backup of the log file Log is named Log[0012-0002].4BL. 
For more information on segments, please refer to the “Archive” para-
graph on page 335. 
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Please note that log file backups start at 0 while database file backups 
start at 1. For the first database file backup (backup[0001].4BK for 
example), the log file backup is named log[0000]: it represents the 
changes made in the data file starting at its “empty” state and can only 
be integrated into an empty data file. Consequently, a log backup 
named, for example, log[0025].4BL must be interpreted as the “26th 
backup of the log file, corresponding to operations performed between 
the 25th and 26th database backup”. log[0025].4BL thus corresponds to 
the backup[0025].4BK backup.

Note The backup numbering ranges are as follows:
• backup: 1 to 9999
• log file backup: 0 to 9998
• segment: 1 to 9999.

Last Backup Information The “Last Backup Information” area provides information on the last 
database backup. Information is provided if at least one backup has 
taken place.

■ Last backup: Date and time of the last backup.

■ Next scheduled backup: Date and time of the next backup; informa-
tion is provided in this area if a backup schedule has been put into 
place.

■ Backup file name: Access path and file name of the last main backup.
If the backup is segmented, the name of the first segment is displayed.

■ Log backup file name: Access path and file name of the last log file 
backup (if any).

■ Status: This area displays the error code of the last backup, as well as a 
description of this code. If the backup was executed properly, the area 
remains blank.
For scheduled backups, you can use this area to verify that the last 
backup occurred as scheduled.
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With 4D Server, this information is also displayed in the main server 
window: 

Note The parameters related to log file management are covered in the 
“Managing the Log File” paragraph on page 339. 

Backup Settings Like the configuration settings, backup settings are used for each 
backup. Moreover, any changes to these settings are optional. Their 
default values correspond to the standard use of the backup function.

Information on the 
last backup
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The backup settings are defined on the Backup page of the application 
Preferences:

4D Server The backup settings can only be set from the 4D Server machine.

These settings are specific to each database opened with the 
4th Dimension application.

Keep Only the Last X 
Backup Files

This parameter allows activating and configuring the mechanism used 
to delete the oldest backup files. It lets you keep a specific number of 
the last backup files on the backup disk — the oldest file is then 
deleted at each new backup— and thus avoids the risk of saturating the 
disk drive.

This feature works as follows: once the current backup is complete, 
4th Dimension deletes the oldest archive if it is found in the same 
location as the archive to back up and has the same name (you can 
request that the oldest archive be deleted before the backup in order to 
save space).
If, for example, the number of sets is set to 3, the first three backups 
create the archives MyBase-0001, MyBase-0002, and MyBase-0003 
respectively. During the fourth backup, the archive MyBase-0004 is 
created and MyBase-0001 is deleted.
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Based on the space on the disk that you set aside for your backups, you 
can determine the maximum possible number of backup sets using the 
following equation:

You must reduce the maximum number of sets by 1 because 
4th Dimension, by default, first performs the current backup, then 
deletes the oldest archive from the disk. This behavior can be changed 
(please see the “Delete Oldest Backup File Before/After Backup” 
paragraph on page 333). 

By default, the mechanism for deleting sets is enabled and 
4th Dimension keeps 3 backup sets.

To disable the mechanism, simply deselect the option.

Note This parameter concerns both the database backup sets and the log file 
backup sets.

Backup Only if the Data 
File has been Modified

When this option is checked, 4th Dimension starts scheduled backups 
only if data has been added, changed or deleted in the database since 
the last backup. If not, the scheduled backup is cancelled and carried 
over until the next scheduled backup. No error is generated; however 
the backup journal notes that the backup has been postponed.
This option also allows saving machine time for the backup of 
databases mainly used for viewing purposes. Please note that enabling 
this option does not take into account any modifications made to the 
structure file or attached files.

Notes • For more information on scheduled backups, please refer to the 
“Scheduled Backup Settings” paragraph on page 336. 
• When this option is checked and backup starts manually, 
4th Dimension displays a dialog box indicating that the data file has 
not been modified and lets the user confirm or cancel the operation.
• This parameter concerns both database and log file backups. 

Maximum number of sets =
Space available for backups

Maximum backup size
- 1 set
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Delete Oldest Backup 
File Before/After Backup

This option is only used if the “Keep only the last X backup files” 
option is checked. It allows you to specify whether 4th Dimension 
should start by deleting the oldest archive before starting the backup 
(before option) or if the deletion should occur once the backup is 
completed (after option). In order for this mechanism to work, the 
oldest archive must not have been renamed or moved.

The before option allows you to save space. It is not necessary to 
reduce the number of backups allowed by 1, which lets you, for 
example, store two 2-GB archives on a 5-GB disk. Please also note that 
in cases of interruption during a backup, you can access neither the old 
backup (since it was previously deleted), nor the current backup, which 
is not yet completed. Since the database could not be modified during 
the backup, you can be sure that your data file is intact, even if you do 
not have a valid backup. Once the system restarts and the incomplete 
archive is destroyed, proceed immediately with a new backup.

The after option is an additional security measure but requires more 
space on the backup hard disk.

If Active Transactions or 
Index Operations

Transactions and index operations are critical operations that prevent 
the backup of a database as long as the operations are not yet 
completed. Before starting a backup (regardless of how it is started), 
4th Dimension or 4D Server examines the database; if the program 
detects a critical operation in progress it suspends the backup 
procedure.

This parameter allows you to define the waiting period:

■ Always wait for the end of operations: The backup is suspended as 
long as the operation is not completed; it is then started immediately. 
This guarantees that the backup is executed but does not allow precise 
verification of when the backup occurs.
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■ Abort backup after waiting X (seconds or minutes): The backup is sus-
pended for a limited time (3 minutes by default) to give the transaction 
or index operation time to finish. You can set a wait time in seconds or 
minutes using the corresponding menu. If, after this wait, the critical 
operation is still in progress, the backup is considered as failed and an 
error is noted in the backup journal. The mechanism defined for han-
dling failed backups then takes over (see paragraph below).

Note It is important to avoid opening a transaction that is only validated or 
cancelled when quitting the database, at the moment a database is 
launched. You should also avoid presenting users with input or 
validation dialog boxes during a transaction. If the user happens to be 
absent when the time comes to validate the dialog box, and the 
backup starts at that moment, the database can no longer execute new 
transactions until the dialog box is validated.

If Backup Fails This option allows defining the mechanism used to handle failed 
backups (backup impossible). 

Notes • Not all incidents result in a failed backup (please refer to the “If 
Backup Fails” paragraph on page 334). 
• 4th Dimension considers a backup as failed if the database was not 
launched at the time when the scheduled automatic backup was set to 
be carried out (please refer to the “Scheduled Backup Settings” 
paragraph on page 336). 

When a backup cannot be performed, 4th Dimension allows making a 
new attempt. Two options are available:

■ Retry at the next scheduled date and time: This option only makes 
sense when working with scheduled automatic backups (please refer to 
the “Scheduled Backup Settings” paragraph on page 336). It cancels 
the failed backup and an error is generated. 

■ Retry after X hour(s) or minute(s): When this option is checked, a new 
backup attempt is executed after the wait period. This mechanism 
allows anticipating certain circumstances that block the backup. You 
can set a wait period in hours or in minutes using the corresponding 
menu. If the new attempt also fails, an error is generated and the fail-
ure is noted in the status area of the last backup and in the backup 
journal file.

■ Cancel the operation after X attempts: This parameter is used to set 
the maximum number of failed backup attempts. 
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If the backup has not be carried out successfully after the maximum 
number of attempts set has been reached, it is cancelled and the error 
1401 is generated (“The maximum number of backup attempts has 
been reached; automatic backup is temporarily disabled”). In this case, 
no new automatic backup will be attempted as long as the application 
has not been restarted, or a manual backup has not been carried out 
successfully. 
This parameter is useful in order to avoid a case where an extended 
problem (requiring human intervention) that prevented a backup from 
being carried out would have led to the application repeatedly 
attempting the backup to the detriment of its overall performance. 
By default, this parameter is not checked.

Archive This area allows setting archive generation options. These options 
apply to main backup files and to log file backup files.

■ Segment Size (MB):
4th Dimension allows you to segment archives, which is to cut an 
archive up into smaller sizes. This behavior allows you, for example, to 
store a backup on several different disks (CDs, ZIPs, etc.). During a 
restore process, 4th Dimension will automatically fuse the segments. 
Each segment is called MyDatabase[xxxx-yyyy].4BK, where xxxx is the 
backup number and yyyy is the segment number. For example, the 
three segments of the sixth MyDatabase database backup will be called 
MyDatabase[0006-0001].4BK, MyDatabase[0006-0002].4BK and MyData-
base[0006-0003].4BK.
The Segment Size menu is a combo box that allows you to set the size 
in MB for each segment of the backup. You can choose one of the pre-
set sizes or enter a specific size between 0 and 2048. If you pass 0, no 
segmentation occurs (this is the equivalent of passing None).

■ Compression Rate
By default, 4th Dimension compresses backups to help save disk space. 
However, the file compression phase can noticeably slow down back-
ups when dealing with large volumes of data.
The Compression Rate option allows you to adjust file compression:

■ None: No file compression is applied. The backup is faster but the 
archive files are considerably larger.

■ Fast (default): This option is a compromise between backup speed 
and archive size.
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■ Compact: The maximum compression rate is applied to archives. 
The archive files take up the least amount of space possible on the 
disk, but the backup is noticeable slowed.

■ Interlacing Rate and Redundancy Rate
4th Dimension generates archives using specific algorithms that are 
based on optimization (interlacing) and security (redundancy) mecha-
nisms. You can set these mechanisms according to your needs. For 
these two options, 4th Dimension provides a default rate Medium. The 
menus for these options also contain rates of Low, High and None.

■ Interlacing Rate: Interlacing consists of storing data in non-adjacent 
sectors in order to speed up their read time. However, the storage 
phase is slower.

■ Redundancy Rate: Redundancy allows securing data present in a file 
by repeating the same information several times. The higher the 
redundancy rate, the better the file security; however, storage is 
slow and the file size is large.

Scheduled Backup 
Settings

You can automate the backup of databases opened with 4th Dimension 
or 4D Server (even when no client machines are connected). This 
involves setting a backup frequency (in hours, days, weeks or months); 
for each session, 4th Dimension automatically starts a backup using the 
backup settings defined in the Preferences.

If this application was not launched at the theoretical moment of the 
backup, the next time 4th Dimension is launched, it considers the 
backup as having failed and applies the appropriate configuration, set 
in the database Preferences (refer to the “If Backup Fails” paragraph on 
page 334). 
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The scheduler backup settings are defined on the Scheduler page of the 
application Preferences:

First select a frequency scale (days, weeks, etc.) by clicking on the 
corresponding radio button. You must then specify when to perform 
the backup.

■ No automatic backup: The scheduled backup feature is disabled.

■ Every X hour(s): This option allows programming backups on an 
hourly basis. You can enter a value between 1 and 24.

■ starting at: Sets the time at which the first hourly backup will 
begin. 

■ Every X day(s) at x: This option allows programming backups on a 
daily basis. Enter 1 if you want to perform a daily backup. When this 
option is checked, you must enter the time when the backup should 
start.
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■ Every X week(s) day at x: This option allows programming backups on 
a weekly basis. Enter 1 if you want to perform a weekly backup. When 
this option is checked, you must enter the day(s) of the week and the 
time when the backup should start. You can select several days of the 
week, if desired. For example, you can use this option to set two weekly 
backups: one on Wednesday and one on Friday.

■ Every X month(s), Xth Day at x: This option allows programming back-
ups on a monthly basis. Enter 1 if you want to perform a monthly 
backup. When this option is checked, you must indicate which day of 
the month and the time when the backup should start.

Automatic Backup 4th Dimension provides a default backup strategy when a database is 
created. This strategy puts into place a set of backup parameters that 
assure minimum database security.

These settings can be changed once the database is created.

The backup strategy is enabled, by default, when a new database is 
created. To disable it, simply deselect the Automatic Backup option in 
the Welcome dialog box: 

Option to use the 
default backup 
strategy
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The default backup strategy includes the following settings:

■ Creation and use of a log file (named DataFileName.4dl).

■ Backup of all database files (data, log, structure and user structure) next 
to the database structure file.

■ Automatic backup every Sunday at 00:00:00.

■ Default backup settings (keeping last 3 backups, medium rates, etc.).

■ All the automatic restore options.

Managing the Log File
A continuously-used database is always recording changes, and record 
additions or deletions. Performing regular backups of data is important 
but does not allow (in case of incident) restoring data entered since the 
last backup. To respond to this need, 4th Dimension now offers a 
specific tool: the log file. This file allows ensuring permanent security 
of database data.

In addition, 4th Dimension works continuously with a data cache in 
memory. Any changes made to the data of the database are stored 
temporarily in the cache before being written to the hard disk. This 
accelerates the operation of applications; in fact, accessing memory is 
faster than accessing the hard disk. If an incident occurs in the 
database before the data stored in the cache could be written to the 
disk, you must include the current log file in order to restore the 
database entirely. 

Introduction The log file generated by 4D contains all operations performed on a 
database, which are logged sequentially. As such, each operation 
performed by a user causes two simultaneous actions: the first one in 
the database (instruction is executed normally) and the second one in 
the log file (the description of the operation is recorded). The log file is 
created independently without disturbing or slowing down the work 
of the user. A database can only work with one log file at a time.

The log file records four types of operations:

■ Added records

■ Modified records
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■ Deleted records

■ Transactions.

Note on transactions A transaction is a set of operations executed all at once. For example, 
during a bank wire performed as part of a transaction, you must make 
sure that you debit one account and credit the second account in the 
same operation, without running the risk of interrupting the operation 
in progress. Either the entire operation is performed, or none of it, but 
it can never be partially done. The first account cannot be debited 
without the second account being credited. 4th Dimension considers 
transactions as single operations, just like an addition, update or 
deletion.

4th Dimension handles the log file. It takes into account all operations 
that affect the data file equally, regardless of any manipulations 
performed by a user (using 4th Dimension single-user or 4D Client), 4D 
methods, 4D plug-ins (4D Write, 4D View, 4D Draw, etc.), a Web 
browser or even 4D Open when using 4D Server.

The following illustration sums up how the log file works:

Data file Log fileOperations
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b

b
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The current log file is automatically saved with the current data file. 
This mechanism has two distinct advantages:

 

■

 

Its avoids saturating the disk volume where the log file is stored. With-
out a backup, the log file would get bigger and bigger with use, and 
would eventually use all available disk space. For each data file backup, 
4

 

th

 

 Dimension or 4D Server closes the current log file and immediately 
starts a new, empty file, thereby avoiding the risk of saturation. The 
old log file is then archived and eventually destroyed depending on 
the mechanism for managing the backup sets.

 

■

 

It keeps log files corresponding to backups in order to be able to parse 
or repair a database at a later point in time. The integration of a log file 
can only be done in the database to which it corresponds. It is impor-
tant, in order to be able to properly integrate a log file into a backup, to 
have backups and log files archived simultaneously.

 

Creating the Log File

 

By default, any database created with 4

 

th

 

 Dimension uses a log file: the 
creation of this file is linked to the 

 

Automatic Backup

 

 option in the 
database creation dialog box (please refer to the “Automatic Backup” 
paragraph on page 338).
The log file is named 

 

DataFileName.4DL

 

 and is placed in the folder 
containing the database structure.

You can find out if your database uses a log file at any time: just verify 
whether the 

 

Use Log File

 

 option is checked on the 

 

Configuration

 

 page 
of the Preferences (please refer to the “Configuration of Backup Files” 
paragraph on page 325).
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With 4D Server, the name of the log file is also listed in the server 
machine window:

If you deselected this option, or if you use a database without a log file 
and wish to set up a backup strategy with a log file, you will have to 
create one.

����

❿❿❿❿

 

To create a log file:

 

1 On the Configuration page (“Backup” theme) of the application 
Preferences, check the Use Log File option. 

Use Log File option
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The program displays a standard open file or new log file dialog box:

 

2 Click New...

 

A standard save file dialog box appears. By default, the log file is named 

 

DataFileName.4DL

 

.

 

3 Keep the default name or rename it, and then select the file location.

 

If you have at least two hard drives, it is recommended that you place 
the log file on a disk other than the one containing the database. If the 
database hard drive is lost, you can still recall your log file.

 

4 Click Save.

 

The access path and the name of the open log file are now displayed in 
the “Use Log File” area of the Preferences dialog box.

 

5 Validate the Preferences dialog box.

 

In order for you to be able to create a log file directly, the database 
must be in one of the following situations:

 

■

 

The data file is blank,

 

■

 

You just performed a backup of the database and no changes have yet 
been made to the data.
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In all other cases, when you validate the Preferences dialog box, an 
alert dialog box will appear to inform you that it is necessary to 
perform a backup.

If you click 

 

OK

 

, the backup begins immediately, then the log file is 
activated. If you click Cancel, the request is saved but the creation of 
the log file is postponed and it will actually be created only after the 
next backup of the database. 
This precaution is indispensable because, in order to restore a database 
after any incidents, you will need a copy of the database into which 
the operations recorded in the log file will be integrated. 

Without having to do anything else, all operations performed on the 
data are logged in this file and it will be used in the future when the 
database is opened.

■ You must create another log file if you create a new data file.

■ You must set or create another log file if you open another data file 
that is not linked to a log file (or if the log file is missing). To open 
another log file, click the [...] button to the right of the log file access 
path display area.

Stopping a Log File If you would like to stop logging operations to the current log file, 
simply deselect the Use Log File option on the Configuration page 
(“Backup” theme) of the application Preferences.
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4th Dimension then displays an alert message to remind you that this 
action prevents you from taking advantage of the security that the log 
file provides:

If you click Stop, the current log file is immediate closed (the 
Preferences dialog box does not need to be validated afterwards).

If you wish to close the current log file because it is too large, you must 
perform a data file backup, which will cause the log file to be backed 
up as well. Note that there is an automatic mechanism that prevents 
the log file from becoming too large (see the following paragraph). 

Automatic Backup of 
Log File When 
Critical Size is 
Reached

When the log file approaches the critical size of 2 GB, 4D 
automatically triggers a backup of the database, in order to close the 
current log file and open a new one. This avoids a situation where the 
size of this file could alter application performance. 

In this case, the backup carried out uses the current backup parameters 
and is the same as a manual backup. 

Parsing a Log File 4th Dimension includes a function that allows viewing the contents of 
the current log file. This function is useful for parsing the use of a 
database or detecting the operation(s) that caused errors or 
malfunctions. In the case of a database in client-server mode, it allows 
verifying operations performed by each client machine.

This function also lets you undo the operations performed on the 
database data. This possibility is detailed in the “Undoing Operations” 
paragraph on page 357. 
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To view the current log file, select the Check Log File... command in 
the File menu in 4th Dimension or 4D Server (this function is not 
available on the 4D Client machine):

Note Only the Administrator and Designer of the database have access to 
check the log file. 

The following window appears:

Every operation recorded in the log file appears as a row. The columns 
provide various information on the operation. You can modify the 
default column display — for example, you can display field values — 
using the contextual menu of the window (see the “Setting the 
Column Display” paragraph on page 347).

List of operations
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This information allows you to identify the source and context of each 
operation:

■ Action: Type of operation performed on the data. This column can 
contain one of the following four operations: Addition, Deletion, Mod-
ification, and Transaction. For more information, please refer to the 
“Introduction” paragraph on page 319. 

■ Table: Table to which the added/deleted/modified record belongs.

■ User: Name of the user that performed the operation. In client-server 
mode, the name of the client-side machine is displayed; in single-user 
mode, the ID of the user is displayed.
If the 4th Dimension passwords are not enabled, this column uses 
Designer.
If the operation was performed using 4D Open, the “4D Open” label is 
displayed.

■ Date and Hour: Date and hour when the operation was performed.

Setting the Column 
Display

You can customize the column display using the contextual menu of 
the Log file window. You can add or remove columns, or replace the 
contents of a column for the current window session (the customized 
window contents are reset when the window is closed). 

To display the contextual menu of the window, click on a column 
header:

The following commands are available:

■ Add: allows adding a column to the right of the existing columns. By 
default, the column is empty and is named “Field.” It can then be 
assigned to a field of the database (see the next paragraph). 

■ Remove: allows removing the column from the window. 

■ Change: allows replacing the contents of the current column. You can 
either select one of the standard information fields (Action, Table, 
etc.), or select Field to add a column displaying the values of a database 
field.
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Viewing Field Values You can assign a database field to a column of the Log file window, so 
that the current value of the field is displayed for each logged 
operation. This feature is very useful, for example, to identify the 
moment when a specific record has been added. 

To do this, add an empty Field column in the Log file window using 
the Add or Replace command of the contextual menu (see previous 
paragraph). 
Click on the header of the Field column. A hierarchical menu 
containing the database tables and fields appears: 

Select the field whose values you want to display. The values then 
appear for each added or modified record:
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Viewing Panes You can create viewing panes in the log window. To do this, click on 
the splitter located at the top of the window and slide it toward the 
bottom. 

To create several panes, simply repeat the operation as many times as 
necessary. You can create a pane below an existing pane by dragging 
its splitter.
To remove a pane, drag its bottom splitter toward the top or double-
click on the splitter.

Restoring Data
The built-in 4th Dimension backup module allows you to restore entire 
sets of database data in case of any incidents, regardless of the cause of 
the incident.

Incidents and 
Diagnostic

Two primary categories of incidents can occur:

■ The unplanned stoppage of a database while in use.
This incident can occur because of a power outage, system element 
failure, etc. In this case, depending on the current state of the data 
cache at the moment of the incident, the restore of the database can 
require different operations:

■ If the cache was empty, the database opens normally. Any changes 
made in the database were recorded. This case does not require any 
particular operation.

■ If the cache contains operations, the data file is intact but it requires 
integrating the current log file.

Splitter

Viewing pane
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■ If the cache was in the process of being written, the data file is prob-
ably damaged. The last backup must be restored and the current log 
file must be integrated.

■ The loss of database file(s).
This incident can occur because of defective sectors on the disk con-
taining the database, a virus, manipulation error, etc.
The last backup must be restored and then the current log file must be 
integrated.

To find out if a database was damaged following an incident, simply 
relaunch the database using 4th Dimension. The program performs a 
self-check and details the necessary restore operations to perform.
In automatic mode, these operations are performed directly without 
any intervention on the part of the user (please refer to the “Automatic 
Restore” paragraph on page 350). 

If a regular backup strategy was put into place, the 4th Dimension 
restore tools will allow you to recover (in most cases) the database in 
the exact state it was in before the incident. Two main tools are at your 
disposal:

■ Backup restore — which consists in extracting files contained in one or 
more backup file(s) and making them readable again for the applica-
tion that created them. 

■ Log file integration.

These two functions can be combined and automated.

Automatic Restore By default, 4th Dimension automatically launches the database restore 
procedures after an incident. Three types of automatic features are 
used:

■ Automatic restore

■ Automatic log file integration

■ Automatic restart of restored database.
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These mechanisms can be disabled using the options available on the 
Restore page (“Backup” theme) in the application Preferences:

Restore Last Backup if 
Database is Damaged

When this option is checked, the program automatically starts the 
restore of the data file of the last valid backup of the database, if an 
anomaly is detected during database launch. No intervention is 
required on the part of the user; the operation is logged in the backup 
journal (please refer to the “Backup Journal” paragraph on page 358). 

Note In the case of an automatic restore, only the data file is restored. If you 
wish to recover the attached files or the structure file, you must 
perform a manual restore. 

The steps of the automatic restore are as follows:

■ First, 4th Dimension renames the damaged data file.

■ 4th Dimension extracts the data file of the last backup and stores it in 
place of the previous one.

Automatic Restore 
features
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■ If the “Integrate last log if database is incomplete” option is checked, 
4th Dimension integrates the log file, if necessary (please refer to the 
“Integrate Last Log File if Database is Incomplete” paragraph on 
page 352). 

■ If the “Start database after automatic restore” option is checked, 
4th Dimension relaunches the restored database (please refer to the 
“Start Database After Automatic Restore” paragraph on page 352). 

Integrate Last Log File if 
Database is Incomplete

When this option is checked, the program automatically integrates the 
log file when a restored database is opened. No intervention on the 
part of the user is required.

■ When opening a database, the current log file is automatically inte-
grated if 4th Dimension detects that the operations stored in the log 
file are not present in the data. This situation occurs, for example, 
when a power outage occurs when there are operations in the data 
cache that have not yet been written to the log.

■ When restoring a database, if the current log file or backup log file hav-
ing the same number as the backup file is stored in the same folder, 
4th Dimension examines its contents. If it contains operations not 
found in the data file, the program automatically integrates it.

The user does not see any dialog box; the operation is completely 
automatic. The goal is to make use as easy as possible. The operation is 
logged in the backup journal (please refer to the “Backup Journal” 
paragraph on page 358).

Start Database After 
Automatic Restore

When this option is checked, 4th Dimension automatically opens a 
database that was just restored once the procedure is complete.

Note that when this option is used, it is important that all elements 
necessary for the database to work are accessible after the restore. If, for 
example, the database requires specific files next to the database 
structure file, they must be included in the backups so that they can be 
restored at the same time as the database. If the database uses plug-ins, 
it is better that they be installed next to the 4th Dimension application.
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The combination of the three restore options (associated with the 
backup options) allows putting into place a semi-automatic or 
automatic system to get back on track after an incident.

■ Semi-automatic: The administrator simply has to relaunch the data-
base, the 4th Dimension application automatically performs the 
necessary restore and relaunches a trustworthy version of the appli-
cation.

■ Automatic (4D Server only): If you save the database as a service 
launched at system startup, it will be relaunched automatically by 
the machine when it is restarted. The application automatically per-
forms the necessary restore. 

This type of system is particularly well adapted to 4D Server databases. 
Note that each operation executed automatically is logged in the 
database backup journal (please refer to the “Backup Journal” 
paragraph on page 358). 

Manually Restoring 
a Backup

You can restore the contents of an archive generated by the backup 
module manually. A manual restore may be necessary, for instance, in 
order to reproduce the contents of an archive in full (structure files 
and/or enclosed attached files), or for the purpose of carrying out 
searches among the archives.

The manual restore can also be performed along with the integration 
of the current log file.

Note You can set 4th Dimension so that the database data are automatically 
restored in case of any incidents. For more information on this, please 
refer to the “Automatic Restore” paragraph on page 350. 

The 4D application (4th Dimension, 4D Server, application merged 
with 4D Runtime Volume License, etc.) performs the backup restore 
itself using the Restore page of the Welcome dialog box.

Note An alternative solution consists in using the Open data file dialog box 
(see the “Manual Restoring via the Open Data File Dialog Box” 
paragraph on page 356). 
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❿❿❿❿ To restore a database manually:

1 In the Welcome dialog box, click the Restore Database icon 
(4th Dimension and 4D Server only).

OR
Execute the RESTORE command from a 4th Dimension method (all 4D 
applications).
OR
Drag and drop the backup file to restore on the application icon (all 
4D applications).
In the latter case, a standard save file dialog box appears, which allows 
you to indicate the location where files will be restored. Go directly to 
step 3.

2 Select the database, then the backup to restore, and click the Restore 
button:

The right-hand area of the dialog box indicates the access path and the 
contents of the selected archive. You can view the location of the 
backup file on the disk by clicking the  button. If the backup was 
segmented, the access path of the first segment is displayed.

Database to restore

Backup to restore
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OR
To restore another archive, click Browse..., then set the backup file to 
restore in the standard open document dialog box.

A dialog box appears, which allows you to specify the location where 
files will be restored:

By default, 4th Dimension restores the files in a folder named 
“Archivename-Restore” located next to the archive. You can click on the 
[...] button to specify a different location. 

3 If necessary, modify the location of the restored files and click on the 
Restore button.
4th Dimension extracts all backup files from the specified location.

If the current log file or a backup log file with the same number as the 
backup file is stored in the same folder, 4th Dimension examines its 
contents. If it contains operations not present in the data file, the 
program asks you if you want to integrate these operations.

Note Integration is done automatically if the “Integrate last log file...” 
option is checked (please refer to the “Integrate Last Log File if 
Database is Incomplete” paragraph on page 352). 

4 (Optional) Click OK to integrate the log file into the restored 
database.
If the restore and integration were carried out correctly, 4th Dimension 
displays a dialog box indicating that the operation was successful.

5 Click OK . 

The destination folder is displayed. During the restore, 4th Dimension 
places all backup files in this folder, regardless of the position of the 
original files on the disk when the backup starts. This way your files 
will be easier to find.
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Manual Restoring via 
the Open Data File 
Dialog Box

It is possible to restore an archive in 4D application by holding down 
the Alt (Windows) or Option (Mac OS) key while launching the 
database. This displays the Open data file dialog box. The file type 
selection menu now contains two new options that can be used to 
access backup files (.4BK) and log archive files (.4BL):

If you select an archive and click on Open, the restore process begins 
immediately. 

This function, which is available for all 4D applications, is intended 
more particularly for those configurations that do not have a welcome 
dialog box, i.e. applications based on 4D Runtime, 4D Runtime 
Volume License and client-server applications. 

Manually 
Integrating the Log

If you have not checked the option for the automatic integration of 
the log file (see the “Integrate Last Log File if Database is Incomplete” 
paragraph on page 352), a warning dialog box appears during the 
opening of the database when 4th Dimension notices that the log file 
contains more operations than have been carried out in the database. 

Selection of file type
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In order for this mechanism to work, 4th Dimension must be able to 
access the log file in its current location. 

You can choose whether or not to integrate the current log file. Not 
integrating the current log file allows you to avoid reproducing errors 
made in the data.

Successive 
Integration of 
Several Log Files

It is possible to integrate several log files successively into a database. 
If, for example, you have 4 log archives (corresponding to 4 database 
backups), you can restore the first backup then integrate the log 
archives one by one. 

To carry out this operation, simply open the restored database into 
which you want to integrate the log files. 4th Dimension then displays 
the Open file dialog box which can be used to select the current log file 
(.4DL) or an archived log file (.4BL). If you select a valid .4BL file, 
4th Dimension integrates it then displays the dialog box again so that 
you can select another .4BL file, and so on. This operation will be 
repeated until a valid .4DL file is selected, which will then lead to the 
database being opened. 

Undoing Operations 4th Dimension features a function that allows undoing operations 
performed on the log file. This function is similar to a multi-level 
cancel. It is especially useful when a record was deleted by error from a 
database.

In order for this function to be available, the database must have a log 
file.

❿❿❿❿ To restore a database to a previous state:

1 Select the Check Log File... command in the 4th Dimension or 
4D Server File menu (this function is not available on client machines).
The log file operations dialog box appears. This window is detailed in 
the “Parsing a Log File” paragraph on page 345.

Note Only the Administrator and Designer of the database have access to 
check the log file. 
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2 Select the row after which all operations must be cancelled.
The operation of the selected row will be the last kept. If, for example, 
you wish to cancel a deletion, select the operation located just before 
it. The deletion operation, as well as all subsequent operations, will be 
cancelled:

3 Click Roll back.
4th Dimension asks you to confirm the operation.

4 Click OK.
The data is then restored to the exact state it was in at the moment of 
the selected action.

How it Works When the user clicks the Roll back button, 4th Dimension shuts the 
current database and restores the last backup of the database data. The 
restored database is then opened and 4th Dimension integrates the 
operations of the log file up through to the selected operation.
If the database has not yet been saved, 4th Dimension starts with a 
blank data file.

Backup Journal
To make following up and verifying database backups easier, the 
backup module writes a summary of each operation performed in a 
special file, which is similar to an activity journal. Like an on-board 
manual, all database operations (backups, restores, log file 
integrations) are logged in this file whether they were scheduled or 
performed manually. The date and time that these operations occurred 
are also noted in the journal.

Selected operation

Operations 
kept

Cancelled 
operations
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When a backup takes place, the journal notes the following 
information:

For each archive:
Access path (for the archive, or the created or deleted log) 
Size

Archive contents (data file, structure file, user structure file, index files, log
file)

For each item in the archive:
File type
Original file size
Date/Time (starting time, scheduled time, ending time)

The backup journal is named “Backup Journal.txt” and is placed next 
to the database data file.

The backup journal can be opened with any text editor. To make 
parsing easier, information in the journal is separated with tabs and 
each line of information ends with a carriage return.

Management of 
Backup Journal Size

In certain backup strategies (for example, in the case where numerous 
attached files are being backed up), the backup journal can quickly 
grow to a large size.
Two mechanisms can be used to control this size:

■ Automatic backup,

■ Possibility of reducing the amount of information recorded.

Automatic Backup An automatic mechanism can be used to limit the size of the backup 
journal: before each backup, the application examines the size of the 
current backup journal file. If it is greater than 10 MB, the current file 
is archived and a new file is created. The archived files are renamed 
“Backup Journal[xxx].txt”, where xxx is a number from 1 to 999. Once 
file number 999 is reached, the numbering begins at 1 again and the 
existing files will be replaced. 
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Reduce Amount of 
Information Stored

It is possible to reduce the amount of information recorded in the 
backup journal. To do this, simply modify the value of the 
VerboseMode key in the Backup.xml file of the database. By default, this 
key is set to True. 
If you change the value of this key to False, only the main information 
will be stored in the backup journal: date and time of start of operation 
and any errors encountered. 

The XML keys concerning backup configuration are described in the 
XML Keys-Backup manual. 
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14 Importing and Exporting 
Data

4th Dimension’s data importing and exporting capabilities provide a 
fast and reliable way to transfer information to and from your data-
base. If you are upgrading to 4th Dimension from another database or a 
spreadsheet, you can avoid the work of re-entering the data from the 
keyboard by importing your data. You can import data from Windows 
data management applications, or any non-Windows application 
whose data has been transferred to Windows.

You can also export data from 4th Dimension so that it can be used in 
other types of programs that process information. For example, you 
can export data to a specialized graphics or statistics program. You can 
also transfer the exported data to another type of computer.

You can import or export data using the settings in the appropriate dia-
log boxes or using a form. Importing or exporting using the dialog 
boxes is faster than using a form. However, if you use a form you can 
use object and form methods to process data. When you import or 
export data using a form, the form and object methods are executed 
for every record that is processed.

When importing or exporting data via a file, you specify the file 
format, the field and record delimiters, and the fields to be imported or 
exported. Once you have defined your import or export settings, you 
can save or load them into or from Import/Export Settings files.

Finally, 4th Dimension lets you import and export data from and to an 
ODBC data source, without passing by an intermediary file. This point 
is covered in the “Importing and Exporting Data via an ODBC Data 
Source” paragraph on page 385. 

Note You can also use the Quick Report editor to export records. See the 
“Disk File” section on page 202 for more information.
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File Formats
The file format describes the way in which fields and records are 
arranged in the import or export file. Some file formats also include 
formatting information. 4th Dimension supports the following file 
formats:

■ Text (ASCII): This format separates fields within a record with the end-
of-field delimiter and records with the end-of-record delimiter. The 
default field and record delimiters are the Tab and Return, respectively. 
You can also include field names as the first row of an export Text file. 
If you include field names as the first row of an import Text file, you 
can tell 4th Dimension to use those names when it imports the file; 
otherwise, you can instruct 4th Dimension to ignore the row of field 
names. 

■ Fixed Length Text Format: The Fixed Length Text format allocates a 
specific number of characters per field. No end-of-field delimiter is 
used. All records have the same number of characters even if a the 
record’s values can fit into fewer characters. When this happens, a fill 
character — usually a space — is used to pad fields. You can specify the 
fill character for each data type or use default characters (see the “Fill-
ing Page” sections on page 373 and page 384). However, if a value has 
more characters than the number of characters allocated to the field, 
the value will be truncated. 

■ SYLK: This stands for SYmbolic LinK format. 

■ DIFF: This stands for Data Interchange Format. 

■ DBF (dBase): dBase is a file format commonly used in DOS and Win-
dows database applications.

■ XML: XML (eXtensible Markup Language) is a data exchange standard. 
This language is based on the use of tags that enable precise 
description of the exchanged data as well as its structure. XML files are 
Text format files; their content is parsed by the applications importing 
the data. Many applications support this format. 
For more information about XML terminology, refer to the 
4th Dimension Design Reference manual.

■ 4th Dimension Format: This format, which is specific to 
4th Dimension, makes it easy to exchange records between different 
4th Dimension databases. This format supports all of 4th Dimension’s 
data types, including Picture and Blob. The 4D export file extension is 
“.4IE.” 
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Macintosh and 
Windows Files

When you import or export data, you can specify whether the 
import/export file will be for either the Macintosh or Windows 
environments. This option affects the choice of field and record 
delimiters1 for Text files and whether an ASCII map is used: 

■ Macintosh file: The delimiters will be the standard ones used on 
Mac OS (End of field= Tab, End of record= Return, End of file= 
<None>).

■ Windows file: The delimiters will be the standard ones used on Win-
dows (End of field = Tab, End of record= Return+Line feed, End of file = 
<None>). In this case 4th Dimension’s Mac OS/Windows conversion 
filter is used (remember that an internal filter ensures multi-platform 
compatibility of 4th Dimension databases by storing the data in Macin-
tosh ASCII format). 

For example, if you choose Macintosh file, the Carriage return (ASCII 
code 13) will be used as the record delimiter. When importing a Text 
file, 4th Dimension automatically converts any instances of Return 
plus Line Feed to Return only.

Note ASCII codes in 4th Dimension are given in decimal (base 10) numbers. 
A table of ASCII codes is included in the 4th Dimension Language 
Reference manual.

Field, Record, and File Delimiters
End-of-field delimiters are placed between fields in a record and the 
end-of-record delimiter is placed after each record. End-of-file 
delimiters are placed at the end of the import or export file. They may 
be necessary when exchanging files with certain applications. 
Delimiters are used only with the Text and Fixed Length Text formats. 
The Fixed Length Text format does not use Field delimiters and, 
generally, neither text format uses an explicit File delimiter.

The following figure shows a text file as displayed in a word processor. 
The file is in Text format. This word processor displays the Tab 
character as an arrow  and the Carriage return as a paragraph 
symbol .

1. This option allows you to pre-enter values in the Delimiters Page of the 
Import or Export editor. You can also modify them directly on this page. 
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This is a Text format file:

When importing data using the Text format, 4th Dimension uses the 
delimiters embedded in the file to determine where fields and records 
end. When exporting data, 4th Dimension automatically places these 
delimiters in the file for you.

Be certain that fields do not contain embedded characters that are also 
used as field or record delimiters. For example, if the Carriage return is 
used as the record delimiter, no field should contain a Carriage return. 
When importing data, 4th Dimension will interpret any Carriage 
return as a record delimiter. Thus, a Carriage return inside a field will 
be erroneously interpreted as the end of that record. An improperly 
placed Carriage return will disrupt the importing process.

When you export data that includes a Text field, a Carriage return 
might be embedded within the Text field. If this is a possibility, choose 
another record delimiter or remove the embedded Carriage returns 
prior to exporting the data.
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Importing Data from Files
You can import data from files in XML, 4th Dimension, SYLK, DIFF, 
DBF, Text, or Fixed Length Text formats. If you are importing data that 
has been exported from another application, see that application’s doc-
umentation for information about exporting the data in one of these 
formats. If the other application uses a different format for exporting 
data, you may need to modify the file in advance using a text editor or 
word processor.

If you are importing data from another application running on the 
same platform as your database, first export the data using the other 
application. 

Note the order in which the fields were exported, the format the 
application uses to save the data, and, if the Text format was used, the 
delimiters used by the application. When importing the data, you 
must match these settings.

You do not need to build your entire table structure before you import 
data. You can create the required tables directly from the Import dialog 
box.

You have the option of selecting the fields for which data will be 
imported in the Import dialog box or specifying an input form that 
contains the fields for which data will be imported. 

❿❿❿❿ To import data:

1 Choose Import > From File... from the File menu of 4th Dimension.
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4th Dimension displays an open-file dialog box.

2 Select the type of file to be imported: XML, Text, DIFF, DBF, SYLK, or 
4IE (optional).
For more information about file types, please refer to the “File For-
mats” section on page 362. 

3 Select the file to import and click Open.
The Import Editor appears:

Table and Field 
Selection Area 

Command Area

Preview Area

Options Area

File Area

Format Area
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The File area shows the pathname of the file to be imported. If you 
want to import another file, click the Browse button to choose the file.

4 In the Format area, select the type of the import file and its format 
(Macintosh or Windows).
For more information on these choices, please refer to the “File For-
mats” section on page 362 and the “Macintosh and Windows Files” 
section on page 363. 

5 In the Table and Field Selection Area, choose the table and the fields 
into which you want to import the data. 
You can choose one of the following options:

■ Import data into an existing table and fields: Select a table from the 
Import Table drop-down list (by default the first table is selected). 
The hierarchical list allows you to view and select the fields into 
which you want to import data.

■ Create a new table for the data import: Check the Create Table 
check box. 4th Dimension will then create a new table into which it 
will import the data. 4th Dimension determines the number of 
fields and the type of each field according to the data being 
imported.

If you want to change the name of the new table or a field, double-
click on it in the Table and Field Selection area so that it becomes 
editable1. You can also change the data type for the new fields by 
clicking on the field’s title bar in the Preview Area. 
A pop-up menu displays the different types available. 

1. If the Text file contains a row of field names, you can instruct 
4th Dimension to use those names. For more information, please refer to the 
“Header Page” section on page 371. 
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The table is created only during the import. If you cancel the import 
or deselect the option, the database structure remains unmodified.

Note With the Password Access System, you can deactivate the Create Table 
option to prevent users from creating a new table in the database from 
the Import Data dialog box. To do so, use the Preferences dialog box to 
create an access group that has access to the Design environment (of 
course, the 4th Dimension password access system must first be 
activated). Users not included in this access group are not allowed to 
select the Create Table option in the Import dialog box. For more 
information, please refer to the 4th Dimension Design Reference manual. 

■ Import data using a form: This option is discussed in detail in the 
“Importing Data Using a Form” section on page 370. 

The Preview Area displays the contents of the import file as columns of 
data. If you import data using a form, all the fields of the form are 
displayed. You can resize each column by selecting and dragging the 
boundaries of the title bar with the mouse. 

6 If necessary, in the Preview Area, use the pop-up menus in the header 
area to select the fields into which each column in the import file will 
be imported.

Note This feature is not available if you checked the Create Table option or 
import data using a form. 

Resizing a column affects the number of characters allocated to the 
column if you are using the Fixed Length Text format. Otherwise, it 
only affects your view of the columns.

The title bar for each column indicates the name of the field into 
which the column will be imported and its data type. If necessary, use 
the pop-up menu to select a different field: 
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You can also select the Not imported option. In this case, the column 
of data is not imported. 

■ Value to Field  This button allows you to “intelligently” assign col-
umns from the import file to the fields in the table according to 
their type and not according to the order in which they appear. The 
data type of each column is estimated and it is assigned to a com-
patible field. The interpretation is done in the following manner: 

If no compatible field is found, the column is not imported. If you 
want to import the column, you must assign a field to it manually 
in the Preview Area using the column’s pop-up menu in the header 
area. 

Note This option is not available if you use a form for the import or if you 
check the Create Table box. 

■ Number of characters for the Fixed Length Text file format: When 
importing a Fixed Length Text file, the Preview Area displays the 
number of characters for each column below the field’s data type 
icon. The number of characters assigned to each column is based on 
the first row of data. You can change the distribution of characters 
among the columns by dragging the column dividers in the header 
area or entering values in the field length areas, but you can’t add 
characters to the row.

7 In the Records area, indicate if the imported records should replace 
the current selection (the Replace option), or if they are to be added 
to the existing data (the Append option). 

Estimated Field Type 4D Type
All numbers Real (Number)
True/False Boolean
Date in one of 4D formats Date 
Time Time
Other Alpha

Value to Field 
button
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8 Choose any other import options using the Header, Delimiters, Fill, 
XML and/or Format pages (optional).
These options are discussed in the “Import Options” section on 
page 371.

9 If you want to save your settings, click the Save Settings button. 
This option is discussed in the “Saving and Loading Import and Export 
Settings” section on page 390.

10 Click the Import button to begin importing the text file.
4th Dimension displays a progress indicator as it imports the data into 
your database. 

Importing Data 
Using a Form

If you want to import a text file into a form, click the Form tab located 
at the top of the Table and Field Selection Area. The advantage of using 
a form is that the form and object methods associated with it are 
executed as each record is imported. This allows you to process data 
while importing data from the User environment (i.e., without writing 
a custom import routine).

The list of forms in the selected table is displayed, so that you can 
choose a form for the import. The data will be imported into the fields 
on the form using the entry order of the form.

You can use forms that contain enterable variables and fields, but not 
buttons. The form method and the methods associated with variables 
and fields will be executed when each record is imported. Note, 
however, that the effects of these methods are not shown in the 
Preview area.

If you use a form for the import, please keep the following consider-
ations in mind:

■ The entry order of the form determines the order in which the col-
umns of data are imported. You should make sure that the entry order 
of the form matches the order of the columns in the text file. 

■ If there are fewer fields and variables on the form than columns in the 
text file, the extra columns will be ignored. 

■ A form used for import should not contain buttons. Also, subform 
objects are ignored.
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Import Options 4th Dimension offers you various import options that are accessible 
through tabs in the Options area. The number of tabs (between 1 and 
5) as well as their contents vary and depend on the type of file used 
and the options selected.

Header Page This page is available only for imports from Text and Fixed Length Text 
files. Two options are available:

■ Import from line #: This option allows you to specify the first line in 
the text file that will be imported. Use this feature to tell 
4th Dimension to skip over header information — such as titles or field 
names — in the import file. It is particularly useful when the import 
file starts with unformatted lines (title, date, etc.) because the import 
columns are calculated according to the format of the first line. 

■ Column Titles as Field Name: This option tells 4th Dimension to use 
the column titles as field names if you have selected the Create Table 
option.

Use these two options together, if needed. For example, if the import 
file starts with a title, followed by field names, followed by the first row 
of data, set the Import from Line # parameter to 2 and then check the 
Column Titles as Field Names check box.

Delimiters Page This page allows you to specify the field, record, and file delimiters 
used in Text and Fixed Length Text files.
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Delimiters are discussed in detail in the “Field, Record, and File 
Delimiters” section on page 363. To change the default delimiters, use 
the drop-down lists to the left of each area. These menus contain the 
values most frequently used for each delimiter. 

You can also enter a delimiter into the entry areas on the right. 

The drop-down list at the top of the page allows you to view the 
delimiters in different formats: Character, Decimal (default format), 
and Hexadecimal. Please note that, if you use unprintable characters as 
delimiters (such as Tab, Linefeed, and Return), the Character option 
will not show anything. 

Note The delimiters are reset to their default values if you click the Default 
button or if the type of the document is modified on the File page. 

XML Page This page is available for XML files only. It allows you to configure the 
parsing mode of the imported XML contents. 

At the time of data import, 4th Dimension interprets the contents of 
the XML document in order to extract the information. By default, this 
operation is carried out without any specific validation. The XML 
document is assumed to be “well-formed,” meaning that its structure is 
correct and its interpretation is unambiguous. 

You can, however, request “validation” of the document at the time of 
import: to do this, check the Validation option. In this case, 
4th Dimension parses the contents of the document based on its DTD 
(Document Type Definition) and checks that it corresponds to this 
definition. Import is only carried out if the document is validated. 

Note For more information on the DTD, refer to the “XML Page” paragraph 
on page 380. 
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If the DTD of the imported document is not included in the document 
itself, but is in a separate file, or if you want to use another DTD to 
validate the document, check the Use alternate DTD option and 
indicate the file containing the DTD using the Browse button.

Once the import is completed, the dialog box is closed and the table 
into which the data were imported becomes the current table. 

Format Page This page is available for Text, Fixed Length Text and XML files. It 
allows you to set the formats for imported Boolean fields. 

The syntax to use is True_Value;False_Value. For example, if you import 
a column into a Boolean field whose values are “Black” (for true) and 
“White” (for false), you can enter Black;White. 
The combo-box displays the most commonly used Boolean formats. 
You can enter any format that is not in the combo-box.

Filling Page This page appears only for Fixed Length Text files. It allows you to 
define the fill characters to use for each data type. The default fill 
character is the space:

For more information about the Fixed Length Text file format, please 
refer to the “File Formats” section on page 362. 

Different fill characters can be used for three data types: 
Alpha/Boolean (Boolean fields are imported as alphas), Numeric 
(Integer, Longint, and Real) and Date/Time. 
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Normally, the space is used to pad fixed format fields. The drop-down 
lists contain other choices. The entry areas to the right display the 
selected fill character. If you wish to use other characters, enter them 
directly in the entry areas.

The menu at the top of the page allows you to view the fill characters 
in different formats: Character, Decimal (default format), and 
Hexadecimal. An unprintable fill character will not appear if you use 
the Character format.

Exporting Data to Files
When you export data, you create a 4th Dimension, XML, SYLK, DIFF, 
DBF, Text, or Fixed Length Text file that can be opened by or imported 
by other applications. If you are exporting data for use with another 
application, see that application’s documentation for information 
about importing data. Choose a file format and delimiters compatible 
with the other application. 

In some cases, you need to use one or more export options to structure 
the export file correctly for the target application. For example, some 
programs accept the Text file format but require that the first record 
consist of the field names. You can add this record using a Header 
option that is available in the Options Area. See the “Header Page” 
section on page 379 for more information.

4th Dimension exports the records in the current sort order. You can 
choose to export all the records of a table or the current selection only. 

You have the option of selecting the fields to be exported in the Export 
Data dialog box or specifying a form. If you use a form, the fields on 
the form will be exported. 
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❿❿❿❿ To export data:

1 Choose Export > To File... from the File menu of 4th Dimension.

The Export Data dialog box appears.

2 Choose the export format from the Format drop-down list— Text, 
Fixed Length Text, DIFF, DBF, SYLK, XML, or 4IE.

For more information, please refer to the “File Formats” section on 
page 362. 

3 Choose the file type — Macintosh or Windows.
This option sets the record delimiters and ASCII map that will be used 
in the export file. For more information, see the “Macintosh and Win-
dows Files” section on page 363.

Table and Field 
Selection Area 

Command Area

Preview Area

Options Area

Export format
3754th Dimension User Reference



Chapter 14  Importing and Exporting Data
4 Click the Browse button, enter a name and a location for the export 
file and click Save (optional). 
The Export Data dialog box reappears, with the export file’s pathname 
shown in the File area. This step does not start the export.

Note If you skip these steps, you can also specify the name and location of 
the export file when you click the Export button. 

5 In the Table and Field Selection Area, select the table and the fields 
that you want to export. 
You can choose either of the following options:

■ Select the fields to export in the Export Data dialog box
If you use this option, choose a table from the Export From Table 
drop-down list to populate the Fields list with the eligible fields for 
the export. You then choose fields using the two blue buttons just 
above the Preview area. You can remove fields from the Preview area 
using the red buttons:

■ Export the data using a form
This option exports the fields on the form. This option is discussed 
in detail in the “Exporting Data Using a Form” section on page 378. 

6 In the Preview Area, modify the fields from which the data will be 
exported (optional).

Note This feature is not available if you export data using a form.

Several modifications can be made using the Preview Area:

■ Choosing other fields: The Preview area displays the contents of the 
export file as columns of data. The Header area for each column is a 
pop-up menu that you can use to change the field assigned to that 
column. 

Inserts the selected field in the Preview Area 
Inserts all the fields in the table in the Preview Area
Removes the selected field from the Preview Area
Removes all the fields from the Preview Area 
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■ Specifying the export format: The icon to the left of the field name 
indicates its data type. You can right-click to display a contextual 
menu of formats that are appropriate for the column’s data type. If 
desired, choose a format from the contextual menu.

If you do not assign a format, the Default Format is used. A format can 
also be selected on the Format options page. For more information, see 
the “Format Page” section on page 383.

■ Changing the lengths of Fixed Length Text fields: If you choose the 
Fixed Length text format, the Preview Area indicates the number of 
characters for each column. You can resize each column by drag-
ging the column divider in the title bar with the mouse. If you are 
using the Fixed Length Text format, this changes the number of 
characters allocated to the column in the export file. You can set the 
exact number of characters by entering a value in the entry area 
below the field’s data type icon. The default number of characters is 
as follows: Text fields have a length of 80 characters, Alpha fields 
have the maximum length assigned in the Design environment, 
and numeric fields have a length of 10 characters.

The fill characters are added at the end of alphanumeric fields and 
at the beginning of numeric fields.

■ Removing fields from the export file: You can remove a column 
from the export file and the Preview Area. To do so, click the col-
umn’s header and click the Delete button in the button panel . To 
delete all the fields, click the Delete All button in the button panel 

 .

7 In the Records area, indicate if you want to export all the records of 
the selected table (the Export all Records option), or only the current 
selection (the Export Selection option).

Number of characters for 
the column
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In both cases, the number of records to be exported is displayed in this 
area. 

8 Specify any other export options using the Header, Delimiters, 
Format, XML, and Filling pages (optional).
These options are discussed in the “Export Options” section on 
page 379.

9 If you want to save your settings, click the Save Settings button. 
This feature is discussed in the “Saving and Loading Import and Export 
Settings” section on page 390. 

10 Click Export to begin exporting to the disk file.
If you have not specified the pathname for the export file (as described 
in step 4 on page 376), a standard save file dialog appears. 

4th Dimension displays a progress indicator while the data is being 
exported.

Exporting Data 
Using a Form

If you want to use a form for the export, click on the Form tab, located 
at the top of the Export dialog box. You can then choose a form from 
the list of forms for the selected table. 

The main advantage of using a form is that the form method and the 
object methods associated with fields and variables are executed when 
each record is exported. This allows you to process the data during the 
export. Fields and variables will be exported in the order specified by 
the entry order of the form. Note, however, that the effects of these 
methods are not shown in the Preview Area.

Number of records 
to be exported
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Do not place buttons on the form. Subform objects are ignored.

4D Server It is not possible to export data using a form that includes methods in 
a stored procedure on the server. In fact, since form events are not 
managed by the server, the associated methods will not be called. 

Export Options 4th Dimension offers you various export options that are accessible 
using tabs in the Options area. The number of tabs as well as their 
contents depends on the type of export file and the selected options.

This section describes all the Export options pages; some may only be 
available for certain export file types.

Header Page This page is only available for Text and Fixed Length Text exports.

It allows you to add a title, row of field names, and/or a record number 
to the export file: 

■ Title: This option allows you to enter a title for the export docu-
ment. Enter the title in the area below the check box. 

■ Column Titles: This option exports the field names as the first 
‘record’ in the export file. 

■ Line numbering: This option numbers each line, which is each 
exported record. The numbering starts at 1 and increments by 1.

If Title is selected, it is the first row in the export file even if Column 
Titles is also selected. If Column Titles is selected, the field names fol-
low the title (if also present) and precede the first row of data; for Text 
files, the field names are separated by the field delimiter.

If Line Numbering is selected, the line number precedes the first field 
in each row, i.e., the first field as specified in the Preview Area becomes 
the second field, and so on.
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Delimiters Page This page allows you to specify the delimiters used in Text and Fixed 
Length Text files. It is not relevant for other types of export files.

Delimiters are discussed in detail in the “Field, Record, and File 
Delimiters” section on page 363. To modify the delimiters, you can use 
the drop-down menus to the left of each area. These menus contain 
the values most frequently used for each type of delimiter. 

You can also enter a delimiter directly in the area on the right. 

The menu at the top of the page allows you to modify or view the 
delimiters in different formats: Character, Decimal (default format), 
and Hexadecimal. Please note that if you use an unprintable character 
as a delimiter (such as a tab, linefeed, or return), the Character option 
will not show anything. The Decimal and Hexadecimal formats can 
display any character’s ASCII code.

Note The delimiters are reinitialized to their default value if you click the 
Default button or if the type of the document is modified on the File 
page. 

XML Page This page of parameters is only available for XML exports. It enables 
the configuration of the exported XML file contents:
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■ Encoding
This pop-up menu is used to select the encoding (i.e. the set of charac-
ters) to be used for the XML document. The choice of encoding 
depends on the contents of the data to be exported and the application 
that will be using them. By default, ISO-8859-1 (ISO Latin 1, West Euro-
pean) coding is selected. 

■ DTD options
When exporting in XML format, 4th Dimension allows you the choice 
of whether or not to generate a DTD (Document Type Declaration). A 
DTD records the set of specific rules and properties that the XML must 
follow. These rules define, more particularly, the name and contents of 
each tag, as well as its context. 

This formalization of elements enables you to check an XML 
document to make sure it is “valid” and is particularly useful in the 
case of recurrent tags in an XML document. Note that a DTD is not 
mandatory. 

To define the handling of the DTD, you must select one of the three 
following options:

■ No DTD (default option): When this option is selected, a DTD is not 
generated during export. 

■ Generate DTD: generates a DTD during export. When this option is 
checked, the following subset of radio buttons enables you to spec-
ify the location of the DTD to be generated:
- Inside the XML Export: A DTD will be included in the XML file itself 
(internal DTD). The generated XML file is thus independent. 
- As specific document: A DTD will be generated in a separate file 
(external DTD). An external DTD can be shared between several 
users and thus enables the harmonization of XML document struc-
tures generated from different sources. 

Note 4th Dimension allows a table and a field to have the same name. 
However, the XML language prohibits the use of different elements 
having the same name. Consequently, when the “Generate DTD” 
option is used, the exported 4D data must not include a table and field 
having the same name; otherwise, the XML file generated is invalid 
and cannot be opened by an XML parser. 

■  Refer to existing DTD: Using the associated Browse button, this 
option allows you to designate an existing external DTD file. 
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4th Dimension will include a reference to this DTD in the exported 
file. 

■ Replacing spaces
The Replace spaces option causes “space” characters to be replaced by 
underlines (“_”) in value name fields of the XML file generated. This 
option is checked by default since spaces are not allowed in XML value 
name fields. 

However, it is possible to uncheck the option when necessary for 
specific purposes. In this case, of course, the generated file will not be 
in conformity with the general syntax rules defined by the W3C for 
XML.

■ Refer to existing XSL
XSL (eXtensible Stylesheet Language) enables visual representation of 
the elements defined in an XML document. This language is used to 
schematically define the style sheets that can be used to process and 
display the contents of an XSL document. Using the Browse button, 
the Refer to existing XSL option allows you to associate an XSL file for 
the exported data.

Note For more information about the support of XSL, refer to the 
4th Dimension Language Reference manual.

When an XSL file has been selected, you must set up how it will be 
used with exported data using two options:

■ Apply the XSL transformation: When this option is checked, 
4th Dimension performs the transformation of XSL data directly on 
the set XSL document at the moment of export. 

■ Insert a link to the XSL file: When this option is checked, 
4th Dimension only inserts the reference to the designated XSL in 
the exported document (the transformation is not carried out). 
The exported XML file will therefore contain references to this XSL 
file.
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Format Page This page allows you to set the export formats for Alpha, Numeric, 
Date, Time, and Boolean fields. This option is available for Text and 
Fixed Length Text exports. By default, 4th Dimension’s standard 
formats are used. 

❿❿❿❿ To assign an export format:

1 Select a column in the Preview Area.
The combo-box corresponding to its data type becomes enabled. 

2 Choose a format from the combo box or (for Alpha, Numeric, or 
Boolean data types) enter a custom format.

Note You can also set a column’s export format using the contextual menu 
in the column’s header area (see the “Exporting Data to Files” section 
on page 374). 

■ About DateTime Format

The DateTime display format is available for exporting date or time 
data. This format corresponds to the XML date and time 
representation standard (ISO8601 format). For example, in this format 
the date/time May 31, 2003 at 1:20 p.m. is noted 2003-05-31T13:20:00.
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4th Dimension does not allow both a date and time to be stored in a 
single field. However, you can export data in this format so that the 
dates or times are recorded in conformity with the XML standard. If 
you export dates, the exported values will be of the style: 2003-05-
31T00:00:00; whereas if you export times, they will be of the style: 
0000-00-00T13:20:55. 

Note You can import XML data recorded in this format. They can be stored 
either in a date or time field, depending on the information that you 
want to keep. 

Filling Page This page is only relevant for Fixed Length Text exports. It allows you 
to define the fill character to use for each data type. You can specify a 
different fill character for Alpha/Boolean (Boolean fields are exported 
as Alpha fields), Numeric (Integer, Longint, and Real), and Date/Time 
values.

For a description of the Fixed Length Text file format, please refer to 
the “File Formats” section on page 362. 

Most often, the Space character is used. The drop-down lists contain 
other possible values. The entry areas to the right display the charac-
ters selected. If you wish to use other characters, enter them directly in 
these areas. 

The drop-down list at the top of the page allows you to view the fill 
characters in different formats: Character, Decimal (default format), 
and Hexadecimal. Please note that an unprintable character will be 
invisible if you select the Character format. The Decimal and 
Hexadecimal formats can display any character’s ASCII code.
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Importing and Exporting Data via an ODBC Data Source
4th Dimension lets you import and export data from or to an ODBC 
data source. 

What is an ODBC 
Source?

The ODBC protocol (Open DataBase Connectivity) is an interface 
allowing different applications to communicate between each other 
using SQL language. An ODBC data source is a permanently open 
“window” to a document belonging to an application, even when this 
application is not open. Many applications (databases, spreadsheets, 
data managers, etc.) allow publishing data as an ODBC source using a 
specific ODBC driver.

Any application supporting the ODBC protocol can read or write data 
in an ODBC source. The 4th Dimension import function allows getting 
data from an ODBC source while the export function allows inserting 
data into the ODBC source.

Defining an ODBC 
Source

■ Under Windows, the definition of an ODBC source is carried out using 
the Administrative Tools then Data Sources (ODBC) configuration 
panel:
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■ Under Mac OS X, the definition of an ODBC source is carried out using 
the ODBC Administrator program located in the Utilities folder:

Note For more information on these dialog boxes, please refer to the 
operating system documentation.

Importing Data 
from an ODBC 
Source

The concept of importing data from an ODBC source is the same as 
when importing other types of data, with the exception that an 
intermediary dialog box allowing you to select an ODBC source is 
used.

❿❿❿❿ To import data from an ODBC source: 

1 Choose the Import > From ODBC Source... command in the 
4th Dimension File menu:
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The select ODBC data source dialog box appears:

2 Select the data source to use and click OK (Windows) or Login 
(Mac OS). 
The standard 4th Dimension import data dialog box appears:

3 On the right side of the dialog box, set (using the table selection 
menu) the SQL table from which you wish to import data. 

Windows Mac OS

Selection of SQL 
table
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4 Select the table and 4D fields into which the data must be imported or 
check the “Create a table” option (this option is not available for 
compiled databases).
Like all other kinds of imports, the preview area displays matches 
between imported data and fields. You can also click the Form tab and 
import data using a form. For more information about these functions, 
refer to steps 5 and 6 in the “Importing Data from Files” paragraph on 
page 365, as well as the “Importing Data Using a Form” paragraph on 
page 370. 

5 Choose import options on the right side of the dialog box:

■ Data Source: This area describes the data source to which the data-
base is connected. You can display the select data source dialog box 
again by clicking Browse....

■ Records: You can add or replace the records of the import table with 
data coming from the source.

6 Click Import to import the data.
Once the data is imported, the connection between 4th Dimension and 
the data source is automatically closed.

Exporting Data to 
an ODBC Source

The concept of exporting data to an ODBC source is the same as when 
exporting other types of data, with the exception that an intermediary 
dialog box allowing you to select an ODBC source is used. Also, 
exported data is not stored in a disk file but directly in the published 
ODBC data source.

❿❿❿❿ To export data toward an ODBC source:

1 Choose the Export > To ODBC Source command in the 4th Dimension 
File menu:
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The select ODBC data source dialog box appears:

2 Select the data source to use and click OK (Windows) or Login 
(Mac OS). 
The standard 4th Dimension export data dialog box appears.

3 On the right side of the dialog box, set (using the table selection 
menu) the SQL table into which you wish to export data.

4 Select the table and 4D fields from which the data must be exported.
Like all other kinds of exports, the preview area displays matches 
between exported data and fields. You can modify these matches. 

Windows Mac OS

Selection of 
SQL table

Matches
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You can also click the Form tab and export data using a form. For more 
information about these functions, refer to steps 4 and 5 in the 
“Exporting Data to Files” paragraph on page 374, as well as the 
“Exporting Data Using a Form” paragraph on page 378.

5 Choose export options on the right side of the dialog box:
■ Data Source: This area describes the data source to which the data-

base is connected. You can display the select data source dialog box 
again by clicking Browse...

■ Records: You can only export the current selection or all records of 
the table.

6 Click Export... to export data toward the ODBC source.
Once the data is exported, the connection between 4th Dimension and 
the data source is automatically closed.

Saving and Loading Import and Export Settings
The import and export dialog boxes allow you to save and load your 
settings to and from disk. A settings file stores all the settings specified 
in the Import or Export editor: 
■ Name and access path of file or ODBC source,
■ Tables and fields selected and the name of the form, the export uses 

a form,
■ Import and export options (file type, delimiters, etc.).

You can carry out this operation using the import-export dialog boxes 
of files and ODBC sources. However, projects saved in the ODBC 
import-export dialog box are not compatible with the standard 
import-export dialog box and vice versa. 

■ To save or load the import or export settings, click the corresponding 
button in the Command area: 

Import and export settings files have the extension “.4SI” on Windows 
(they are of “4DSI” type on Mac OS).This feature allows you to 
automate the import or export process. Using a settings file is 
particularly useful in conjunction with the IMPORT DATA and EXPORT 
DATA commands. For more information, please refer to the 
4th Dimension Language Reference manual. 

Note An import/export settings file does not store filters because they are 
also related to the serial communication. If necessary, you will need to 
load an import or export filter before the operation. 

Save Settings Load Settings
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4th Dimension, as well as 4D Server and 4D Client have the ability to 
publish databases on the World Wide Web. When a database is 
published on the Web, a user can access it using a Web browser such as 
Netscape or Microsoft Internet Explorer. A Web user can perform all 
the standard data management tasks, such as viewing, adding, 
modifying, and deleting records. You can design a Web site using 
4th Dimension by creating forms that function as Web “pages” and 
using the 4th Dimension engine as the Web server. 

A 4D database can be published “as-is”, so that Web browsers connect 
in the same manner as the 4D Client in Custom Menus environment. 
The 4th Dimension Web server automatically manages the conversion 
of forms into HTML (HyperText Markup Language) format — the data 
format used by Web browsers — and data integrity. 

You can also define custom methods and static or semi-dynamic HTML 
pages and manage all the data sent and received by the Web server by 
programming.

Regardless of the Web server operating mode, you can continue to use 
your database in User or Custom Menus mode, for example entering or 
sorting records, even though the database is published. You can decide 
at any time to start or stop Web publication of your database. 

When 4th Dimension publishes a database on the Web “as-is”, it 
transparently translates the database’s forms and design components 
into HTML pages. A Web user accesses the database through HTML 
versions of your custom menus and forms. You can also use 
4th Dimension to publish static HTML pages, prepared, for example, 
using a WYSIWYG HTML generator. You can also encapsulate HTML 
on a 4th Dimension form. Within the encapsulated HTML, you can 
then implement JavaScript code that performs actions and data control 
on the user’s Web browser, without requiring a request to be sent back 
to 4th Dimension.
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When they become 4D clients, Web browsers are treated as “normal” 
database clients. For example, if a Web user modifies a record, 
4th Dimension automatically locks the record, preventing any other 
concurrent user (4th Dimension/4D Client or Web browser) from 
modifying it. After the user validates or cancels the data entry, 
4th Dimension automatically unlocks the record. 

For a complete description of the process of setting up and managing a 
database as a Web site, see the “Web Server” section in the 
4th Dimension Language Reference manual.

The following subjects will be addressed in this chapter:

■ Conditions for publishing the database as a Web server

■ Publishing and stopping publication of a database from the User envi-
ronment

■ Testing the Web server.

Database Publishing Conditions
In order for a database to be published as a Web server, the following 
conditions must be met:

■ You must have a “Web Server” expansion license. For more informa-
tion on this, please contact 4D or refer to the 4th Dimension Installation 
Manual. If you do not have such a license, the Web server will function 
as a demo for one hour.

■ Your computer must be connected to a network (Internet or Intranet) 
and the TCP/IP protocol must be installed on your operating system.

■ Under Mac OS X, you must have set up the access to the TCP port for 
Web server publishing. For more information, refer to the “Web server 
configuration and connection management” section in the 
4th Dimension Language Reference manual. 
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Starting and Stopping the Web Server
The 4D Web server is not completely automatic; it must be started and 
stopped by a database administrator. This can be carried out from 
4th Dimension, 4D Client or 4D Server.

Note The Web server can also be started and stopped by programming 
(using the START WEB SERVER and STOP WEB SERVER commands). For 
more information, please refer to the 4th Dimension Language Reference 
manual.

Starting the Web 
Server

❿❿❿❿ To start the Web server:

1 Check that the publishing conditions are met. 
These conditions are described in the “Database Publishing Condi-
tions” paragraph on page 392. 

2 Choose Start Web Server from the Run menu (4th Dimension and 4D 
Client). 
OR
Choose Start Web Server from the Web menu (4D Server). 
The command is dimmed when the Web Server is already running. If 
the network is not available, a warning dialog box will inform you of 
the fact.

The “Web Server” process, intended to manage Internet and/or 
Intranet access to the database, is then opened and the database is 
accessible to browsers.

When a database is published on the Web, the access rights defined for 
the User and/or Custom Menus environments are preserved in their 
entirety. 
In the case of simultaneous and multiple accesses to the database (for 
example, when several different browsers connect to it), 
4th Dimension automatically ensures the control of data integrity and 
the locking of records if necessary. In this case, the control of data 
integrity is identical to that carried out during 4D Client connections.

While your database is published on the Web, you can continue to 
work in the User environment, or continue to develop the database 
using the Design environment.
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Stopping the Web 
Server

❿❿❿❿ To stop the Web server:

1 Choose Stop Web Server from the Run menu (4th Dimension and 4D 
Client). 
OR
Choose Stop Web Server from the Web menu (4D Server). 
The command is dimmed when the Web Server is not currently run-
ning. 

Choosing this command immediately stops the database publication 
on the Web.

4D Server Of course, this menu command does not stop database publication for 
4D Client machines.

Automatic 
Publication

All databases created using 4th Dimension or 4D Server can be 
published as a Web server by default once it has been executed.

You can configure these settings in the Design environment, in the 
Preferences dialog box, Web/Configuration page: select Publish 
Database at Startup. For more information on this dialog box, please 
refer to the 4th Dimension Design Reference manual.

Testing the Web Server
You can check the operation of the 4th Dimension or 4D Client Web 
server at any time from the machine containing the 4D application. 

To do so, you just need to select the Test Web Server... command in 
the Run menu of 4th Dimension or 4D Client — when the Web server 
is launched: 
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When you select this command, the home page of the Web site 
published by the 4D application is displayed in a window of your 
default web browser:

This command allows verifying that the Web server, home page 
display, etc. are working correctly.

The page is called using the URL Localhost, which is the standard 
shortcut designating the IP address of the machine on which the Web 
browser is executed. The command takes into account the TCP 
publication port number specified in the application Preferences.
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current selection in   .  .  .  .  .  .  .  .  .  .  .   122
record locking .  .  .  .  .  .  .  .  .  .   59, 111, 122
sorting records .  .  .  .  .  .  .  .  .  .  .  .  .  .   129

4D Chart
areas  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   233
clearing documents   .  .  .  .  .  .  .  .  .  .  .   235
closing plug-in windows  .  .  .  .  .  .  .  .  .   233
creating areas in forms  .  .  .  .  .  .  .  .  .  .   233
creating documents   .  .  .  .  .  .  .  .  .  .  .   235
displaying/hiding menu bar   .  .  .  .  .  .  .   235
exporting a PICT document.  .  .  .  .  .  .  .   240
for graphing data   .  .  .  .  .  .  .  .  .  .  .  .   255

importing a PICT document .  .  .  .  .  .  .  .  239
menu bar   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  234
menu command  .  .  .  .  .  .  .  .  .  .  .  .  .  .  39
minimum area size .  .  .  .  .  .  .  .  .  .  .  .  235
opening documents   .  .  .  .  .  .  .  .  .  .  .  236
opening plug-in windows .  .  .  .  .  .  .  .  .  233
printing documents.  .  .  .  .  .  .  .  .  .  .  .  311
Properties menu item .  .  .  .  .  .  .  .  .  240, 311
saving documents   .  .  .  .  .  .  .  .  .  .  237–239
saving documents as templates   .  .  .  .  238–239
setting size of documents  .  .  .  .  .  .  .  .  .  240
using field references in plug-in windows .  .  299
using in forms  .  .  .  .  .  .  .  .  .  .  .  .  233–234
using in plug-in windows .  .  .  .  .  .  .  232–233

4D Draw. . . . . . . . . . . . . . . . . . . . . . . . . . . .  19
4D View . . . . . . . . . . . . . . . . . . . . . . . . . . . .  19
4D Write  . . . . . . . . . . . . . . . . . . . . . . . . . . .  19
4th Dimension

application.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  40
as single-user database   .  .  .  .  .  .  .  .  .  .  .  20
fields. See fields
Format (Import-Export) .  .  .  .  .  .  .  .  .  .  362
multi-tasking in   .  .  .  .  .  .  .  .  .  .  .  .  .  .  24

4th Dimension expressions. See expressions
4th Dimension forms. See forms
4th Dimension functions. See functions

A
Abort backup after waiting (min) 

(Backup Preferences)  . . . . . . . . . . . .  334
About 4th Dimension  . . . . . . . . . . . . . . . . . .  40
Accept button

accepting records .  .  .  .  .  .  .  .  .  .  .   57, 102
saving new records  .  .  .  .  .  .  .  .  .  .  .  .  .  54

access privileges for databases . . . . . . . . . . . 26–29
Accessing the database during backup  . . . . . .  323
active objects

changing appearance of .  .  .  .  .  .  .  .  220–221
duplicating   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  219

Add button (Backup Configuration Preferences)  327
Add command (Quick reports)  . . . . . . . . . . .  167
Add Folder button (Backup Configuration 

Preferences)  . . . . . . . . . . . . . . . . . .  327
3974th Dimension User Reference



Index
Add Formula button
in Formula editor .  .  .  .  .  .  .  .  .  .  .  .  .  126
in Order By editor   .  .  .  .  .  .  .  .  .  .  .  .  127

aligning objects . . . . . . . . . . . . . . . . . . .  216, 309
using alignment tools .  .  .  .  .  .  .  .  .  216–217
using Text menu  .  .  .  .  .  .  .  .  .  .  .  .  .  298

Alignment button (user forms)  . . . . . . . . . . .  134
alignment tools . . . . . . . . . . . . . . . . . . . . . .  217
Alpha field formats  . . . . . . . . . . . . . . . . . . . .  61

in quick reports   .  .  .  .  .  .  .  .  .  .  .  .  .  193
Always wait for the end of operations 

(Backup Preferences)  . . . . . . . . . . . .  333
And conjunction . . . . . . . . . . . . . . .  88, 101, 102
Append button (for choice lists). . . . . . . . . . . .  74
Apply Formula menu command  . . . . . . . . . . .  38
Apply the XSL transformation (Export). . . . . .  382
Applying a formula  . . . . . . . . . . . . . . . . . . .  119
Arrange in Front menu command  . . . . . . . . . .  39
Arrow tool  . . . . . . . . . . . . . . . . . . . . . . . . .  294
As specific document (DTD)  . . . . . . . . . . . . .  381
ascending sorts . . . . . . . . . . . . . . . . . . . . . .  124
ASCII codes. . . . . . . . . . . . . . . . . . . . . . . . .  363
at sign (@). . . . . . . . . . . . . . . . . . . . . . . . . . .  87
Attached file not found  . . . . . . . . . . . . . . . .  324
Attachments (Backup Configuration 

Preferences)  . . . . . . . . . . . . . . . . . .  327
attributes

of axis labels, setting  .  .  .  .  .  .  .  .  .  289, 290
of axis titles, setting.  .  .  .  .  .  .  .  .  .  289, 290
of chart lines, setting  .  .  .  .  .  .  .  .  .  .  .  289
of chart objects, setting .  .  .  .  .  .  .  .  289, 290
of chart text, setting   .  .  .  .  .  .  .  .  .  .  .  290
of lines, setting .  .  .  .  .  .  .  .  .  .  .  .  .  .  296
of objects, setting .  .  .  .  .  .  .  .  .  .  .  .  .  296
of text, setting  .  .  .  .  .  .  .  .  .  .  .  .  .  .  298

Auto option  . . . . . . . . . . . . . . . . . . . . . . . .  275
Automatic backups  . . . . . . . . . . . . . . . . . . .  338
Automatic restore  . . . . . . . . . . . . . . . . . . . .  350

Integrate last log file if database is incomplete 352
Restore last backup if database is damaged  .  351
Start database after automatic restore .  .  .  .  352

Automatic Size  . . . . . . . . . . . . . . . . . . . . . .  139
Automatic Width check box 

(Quick Report editor) . . . . . . . . . . . .  173
Automatic Width command (Quick reports) . .  168
Average (Quick Reports) . . . . . . . . . . . . . . . .  190
axes

attributes of, setting   .  .  .  .  .  .  .  .  .  289, 290
customizing  .  .  .  .  .  .  .  .  .  .  .  .  .  271–278

positioning origins of  .  .  .  .  .  .  .  .  .  .  .  276
reversing data order of .  .  .  .  .  .  .  .  .  .  .  276

axis labels
adding .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  273
display formats for   .  .  .  .  .  .  .  .  .  .  .  .  274
displaying   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  273
for Boolean fields  .  .  .  .  .  .  .  .  .  .  .  .  .  274
graphic attributes of, setting  .  .  .  .  .  .  .  .  289
hiding  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  273
orientations for .  .  .  .  .  .  .  .  .  .  .  .  .  .  274
positions for  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  273
text attributes of, setting .  .  .  .  .  .  .  .  .  .  290

Axis submenu  . . . . . . . . . . . . . . . . . . . . . . .  272
axis titles

adding .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   277–278
graphic attributes of, setting  .  .  .  .  .  .  .  .  290
orientations for .  .  .  .  .  .  .  .  .  .  .  .  .  .  278
positions for  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  278
text attributes of, setting .  .  .  .  .  .  .  .  .  .  290

B
Backup . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  33
Backup file integrity . . . . . . . . . . . . . . . . . . .  336
Backup file name (Backup Configuration 

Preferences) . . . . . . . . . . . . . . . . . . .  329
Backup impossible  . . . . . . . . . . . . . . . . . . . .  325
Backup journal. . . . . . . . . . . . . . . . . . . . . . .  358
Backup menu command . . . . . . . . . . . . . . . . .  33
Backup module (Description) . . . . . . . . . . . . .  319
Backup only if data file is modified 

(Backup Preferences) . . . . . . . . . . . . .  332
Backup parameters . . . . . . . . . . . . . . . . . . . .  325

Backup contents   .  .  .  .  .  .  .  .  .  .  .  .  .  326
Backup file names .  .  .  .  .  .  .  .  .  .  .  .  .  328
Last Backup Information.  .  .  .  .  .  .  .  .  .  329

Backup segmentation  . . . . . . . . . . . . . . . . . .  335
Backup settings

Backup only if data file is modified .  .  .  .  .  332
Deleting oldest backup file before/after 
backup .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  333
If active transactions or index operations  .  .  333
If backup fails .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  334
Keep only the last X backup files .  .  .  .  .  .  331
Time limit before aborting .  .  .  .  .  .  .  .  .  334

Backups
Accessing database during backup   .  .  .  .  .  323
Automatic  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  338
Automatic restore .  .  .  .  .  .  .  .  .  .  .  .  .  350
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Index
Calculating available space (for files).  .  .  .   332
Compression Rate  .  .  .  .  .  .  .  .  .  .  .  .   335
Encountering problems.  .  .  .  .  .  .  .  .  .   324
Executing .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   323
File names.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   328
Incidents  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   349
Information on Last Backup   .  .  .  .  .  .  .   329
Interlacing Rate  .  .  .  .  .  .  .  .  .  .  .  .  .   336
Journal  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   358
Managing .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   320
Manual  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   321
Manually integrating log .  .  .  .  .  .  .  .  .   356
Manually restoring .  .  .  .  .  .  .  .  .  .  .  .   353
Numbering ranges (files)  .  .  .  .  .  .  .  .  .   329
Parameters   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   325
Preferences   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   320
Redundancy Rate   .  .  .  .  .  .  .  .  .  .  .  .   336
Restoring data .  .  .  .  .  .  .  .  .  .  .  .  .  .   349
Scheduled .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   323
Scheduled backup settings  .  .  .  .  .  .  .  .   336
Segment size.  .  .  .  .  .  .  .  .  .  .  .  .  .  .   335
Starting .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   321
Undoing operations  .  .  .  .  .  .  .  .  .  .  .   357

Boolean fields
as check boxes .  .  .  .  .  .  .  .  .  .  .  .  .   64–65
as radio buttons  .  .  .  .  .  .  .  .  .  .  .  .   64–65
default value   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  64
labelling   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   274
See also fields

Border Line Style  . . . . . . . . . . . . . . . . . . . . .  139
borders

dialog box (Quick Report editor)   .  .  .  .  .   168
Quick Report editor   .  .  .  .  .  .  .  .  .  .  .   207
See also lines
setting   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   179
setting patterns of  .  .  .  .  .  .  .  .  .  .  .  .   221

Break columns (description of) . . . . . . . . . . . .  192
break fields  . . . . . . . . . . . . . . . . . . . . . . . . .  148

labeling break rows.  .  .  .  .  .  .  .  .  .  .  .   187
BREAK LEVEL command . . . . . . . . . . . . . . . .  149
break levels

description of  .  .  .  .  .  .  .  .  .  .  .  .  .  .   148
printing reports with .  .  .  .  .  .  .  .  .  .  .   148
using in a report .  .  .  .  .  .  .  .  .  .  .  .  .   187

break processing . . . . . . . . . . . . . . . . . . . . . .  148
Bring All To Front menu command . . . . . . . . . .  39
Build code button (Quick Report editor)  . . . . .  207

buttons
page navigation   .  .  .  .  .  .  .  .  .  .  .  .  .  .  59
record navigation.  .  .  .  .  .  .  .  .  .  .  .  .  .  58
types   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  55

C
C1...Cn (report variables) . . . . . . . . . . . . . . .  175
calculations

adding to reports .  .  .  .  .  .  .  .  .  .  .  190–191
in quick reports   .  .  .  .  .  .  .  .  .  .  .  .  .  190
performed by methods  .  .  .  .  .  .  .  .  .  .  317

Cancel button
canceling data entries .  .  .  .  .  .  .  .  .  .  .  .  58
canceling searches  .  .  .  .  .  .  .  .  .  .  .  .  .  96
discarding record changes .  .  .  .  .  .  .  .  .  .  54
for choice lists  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  75

Cancel the operation after X attempts  . . . . . .  334
case sensitivity, in passwords. . . . . . . . . . . . . .  28
categories

displaying in a graph  .  .  .  .  .  .  .  .  .  279–281
grouping.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  266
see also Category axis
sorting in reports .  .  .  .  .  .  .  .  .  .  .  .  .  186

Category axis (for a 2D graph), definition of . .  242
Category axis (for a 3D graph)

definition of .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  250
selecting a field for  .  .  .  .  .  .  .  .  .  .  .  .  261

Changing passwords  . . . . . . . . . . . . . . . . . . .  29
Chart menu command . . . . . . . . . . . . . . . . . .  38
chart objects

attributes of, setting   .  .  .  .  .  .  .  .  .  .  .  289
definition of .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  289
selecting .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  289

chart text (attributes of, setting)  . . . . . . . . . .  290
Chart tips . . . . . . . . . . . . . . . . . . . . . . . . . .  287
Chart Tool palette (displaying/hiding) . . . . . .  235
Check Log File menu command  . . . . . . . . . . .  33
choice lists . . . . . . . . . . . . . . . . . . . . . . . . 72–75

modifying .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  73–75
using   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  72–73

Choice of Mode palette  . . . . . . . . . . . . . . . . .  67
Choose Print Form dialog box . . . . . . . . . . . . .  33
circles (drawing)  . . . . . . . . . . . . . . . . . .  294–295
Clear menu command . . . . . . . . . . . . . . . . .  121
Clipboard

copying graphs to   .  .  .  .  .  .  .  .  .  .  .  .  231
graphing data from .  .  .  .  .  .  .  .  .  .  263–265
graphing dates from   .  .  .  .  .  .  .  .  .  .  .  263
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Index
closing plug-in windows . . . . . . . . . . . . . . . .  233
color

in labels  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  221
of chart lines, setting  .  .  .  .  .  .  .  .  .  .  .  290
of chart object borders, setting.  .  .  .  .  .  .  290
of chart objects, setting .  .  .  .  .  .  .  .  289, 290
of chart text, setting   .  .  .  .  .  .  .  .  .  .  .  290
of lines, setting .  .  .  .  .  .  .  .  .  .  .  .  .  .  296
of objects, setting .  .  .  .  .  .  .  .  .  .  .  .  .  296
of text objects, setting.  .  .  .  .  .  .  .  .  .  .  298

column indicators (Quick Report editor) . . . . .  161
Column Titles as Field Name . . . . . . . . . . . . .  371
Commands list (Formula editor)  . . . . . . . . . .  116
comparison operators. . . . . . . . . . . . . . . . . . .  86
Compiled / Interpreted menu command. . . . . .  35
Compression Rate (Backup Preferences)  . . . . .  335
conjunction operators

And  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  87
Except  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  88
in searches .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  94
Or .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  88

constraining graphic objects . . . . . . . . . . . . .  295
Control click . . . . . . . . . . . . . . . . . . . . . . . . .  12
Copy menu command . . . . . . . . . . . . . . . . . .  60
Count (Quick Reports) . . . . . . . . . . . . . . . . .  190
Create Merge Selection dialog box . . . . . . . . .  313
Create Table (Importing data) . . . . . . . . . . . .  367
create-file dialog box (saving quick report 

designs) . . . . . . . . . . . . . . . . . . . . .  156
creating

data files .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  32
formulas .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  115
labels  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  212–215
new databases  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  32
new documents   .  .  .  .  .  .  .  .  .  .  .  .  .  236
quick reports .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  155
the log file .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  341

crosshair/crossbar pointer (for creating objects)  216
CT SET ENTERABLE . . . . . . . . . . . . . . . . . . .  235
Ctrl+clicking to select records . . . . . . . . . . . . .  53
current selection

changing   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  23, 82
description of   .  .  .  .  .  .  .  .  .  .  .  22–23, 81
modifying records   .  .  .  .  .  .  .  .  .  .  .  .  110
multiple .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  82
printing records in  .  .  .  .  .  .  .  .  .  .  .  .  146
sorting.  .  .  .  .  .  .  .  .  .  .  .  .   125, 126–127

custom menus. . . . . . . . . . . . . . . . . . . . . . . .  40

Custom Menus menu command. . . . . . . . . . . .  35
Cut menu command. . . . . . . . . . . . . . . . . . . .  60

D
data

editing .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   60
entering using choice lists  .  .  .  .  .  .  .  . 72–73
exporting.  .  .  .  .  .  .  .  .  .  .  .  361, 374–378
graphing from a database   .  .  .  .  .  .   254–262
graphing from other applications .  .  .  .  .  .  262
graphing from the Clipboard .  .  .  .  .   262–263
importing   .  .  .  .  .  .  .  .  .  .  .  361, 365–370
in fields with attributes  .  .  .  .  .  .  .  .  . 69–75
reversing the order of  .  .  .  .  .  .  .  .  .  .  .  276
updating in graphs  .  .  .  .  .  .  .  .  .  .  .  .  262

data entry
changing order  .  .  .  .  .  .  .  .  .  .  .  .  .  .   56
default order  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  139
interrupting   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   60

data entry order
grouping objects   .  .  .  .  .  .  .  .  .  .  .  .  .  141
restoring standard order .  .  .  .  .  .  .  .  .  .  141
setting first object .  .  .  .  .  .  .  .  .  .  .  .  .  140

Data file (Backup Configuration Preferences) . .  326
data files . . . . . . . . . . . . . . . . . . . . . .  24, 41–46

creating new  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   32
opening  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   32
segmenting .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   47

data resource files . . . . . . . . . . . . . . . .  25, 41, 42
Data Segments menu command . . . . . . . . . . . .  33
data series. See series
Data source (ODBC) . . . . . . . . . . . . . . . . . . .  385
databases

creating   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   32
data files in .  .  .  .  .  .  .  .  .  .  .  25, 41, 44–46
data resource files in.  .  .  .  .  .  .  .  .  .  . 25, 41
entering password-protected .  .  .  .  .  .  . 26–29
exiting .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   33
graphing data from  .  .  .  .  .  .  .  .  .   254–262
opening  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 32, 44
pasting information from  .  .  .  .  .  .   298–302
publishing conditions .  .  .  .  .  .  .  .  .  .  .  392
searching .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 84–89
structure files in.  .  .  .  .  .  .  .  .  .  .  24, 41–46
structure resource files in   .  .  .  .  .  .  .  . 25, 41

Date fields (display formats for)  . . . . . . . . . . . .  63
dates, graphing from the Clipboard. . . . . . . . .  263
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DateTime Format . . . . . . . . . . . . . . . . . . . . .  383
dBase format  . . . . . . . . . . . . . . . . . . . . . . . .  362
DBF format  . . . . . . . . . . . . . . . . . . . . . . . . .  362
Debug button. . . . . . . . . . . . . . . . . . . . . . . .  317
default look (restoring in Label Wizard) . . . . . .  222
Default User Mode  . . . . . . . . . . . . . . . . . . . . .  26
Delete button

deleting records  .  .  .  .  .  .  .  .  .  .  55, 59, 120
for choice lists .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  74

Delete command (Quick reports)  . . . . . . . . . .  167
deleting objects (Label Wizard) . . . . . . . . . . . .  222
Deleting oldest backup file before/after backup 

(Backup Preferences) . . . . . . . . . . . . .  333
delimiters

embedded characters in   .  .  .  .  .  .  .  .  .   364
specifying .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   371

depth (setting for graphs)  . . . . . . . . . . . . . . .  284
Depth menu item . . . . . . . . . . . . . . . . . . . . .  285
descending sorts . . . . . . . . . . . . . . . . . . . . . .  124
Design environment

access to   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   26–29
designing reports in  .  .  .  .  .  .  .  .  .  .  .   151
specifying default forms   .  .  .  .  .  .  .  .  .  .  78
writing methods .  .  .  .  .  .  .  .  .  .  .  .  .  .  24

Design menu command  . . . . . . . . . . . . . . . . .  35
Detail row in quick reports. . . . . . . . . . . . . . .  175
Detection of URLs. . . . . . . . . . . . . . . . . . . . . .  61
DIF format . . . . . . . . . . . . . . . . . . . . . . . . . .  362
directories, naming . . . . . . . . . . . . . . . . . . . . .  42
display formats

Alpha field formats.  .  .  .  .  .  .  .  .  .  .  .  .  61
assigning  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   194
Date field formats  .  .  .  .  .  .  .  .  .  .  .  .  .  63
for axis labels  .  .  .  .  .  .  .  .  .  .  .  .  .  .   274
for expressions.  .  .  .  .  .  .  .  .  .  .  .  304–305
for field references .  .  .  .  .  .  .  .  .  .  304–305
for fields   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  60
for series values  .  .  .  .  .  .  .  .  .  .  .  .  .   280
in quick reports  .  .  .  .  .  .  .  .  .  .  .  193–195
Number field formats   .  .  .  .  .  .  .  .  .  .  .  61
Text field formats  .  .  .  .  .  .  .  .  .  .  .  .  .  62
Time field formats  .  .  .  .  .  .  .  .  .  .  .  .  .  64

Display of pages (user forms)  . . . . . . . . . . . . .  134
Display Record . . . . . . . . . . . . . . . . . . . . . . . .  77
displaying

4D Chart features   .  .  .  .  .  .  .  .  .  .  .  .   235
borders (user forms)  .  .  .  .  .  .  .  .  .  .  .   133
form limits (user forms)   .  .  .  .  .  .  .  .  .   133
markers (user forms)  .  .  .  .  .  .  .  .  .  .  .   133

page 0 (user forms) .  .  .  .  .  .  .  .  .  .  .  .  133
repeated values for break columns .  .  .  .  .  192
rulers (user forms)   .  .  .  .  .  .  .  .  .  .  .  .  133
series values for graphs  .  .  .  .  .  .  .  .  .  .  279

Displaying lines and/or points option 
(Line and Scatter graphs)  . . . . . . . . .  246

Distribution button (User forms) . . . . . . . . . .  134
Do nothing option (subforms). . . . . . . . . . . . .  77
Do nothing option (subtotals) . . . . . . . . . . . .  189
documents

clearing  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  235
creating  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  235
expressions in  .  .  .  .  .  .  .  .  .  .  .  .  .  .  302
field references in.  .  .  .  .  .  .  .  .  .  .  299–301
opening .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  236
printing  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  310–312
saving .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  237–239
saving as files (4D Chart)  .  .  .  .  .  .  .  .  .  237
saving as templates .  .  .  .  .  .  .  .  .  .  238–239
setting size .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  240

drawing graphic objects . . . . . . . . . . . . .  294–295
drawing tools. See tools

E
Edit Column menu command . . . . . . . . . . . .  174
Edit command (Quick reports)  . . . . . . . . . . .  167
Edit menu  . . . . . . . . . . . . . . . . . . . . . . . . . .  34
Edit Record (Standard action)  . . . . . . . . . . . . .  77
Editable by user . . . . . . . . . . . . . . . . . . . . . .  131
editing legend text. . . . . . . . . . . . . . . . . . . .  283
elevation of 3D graphs, setting  . . . . . . . . . . .  285
Encoding (Exporting) . . . . . . . . . . . . . . . . . .  381
Enter key  . . . . . . . . . . . . . . . . . . . . . . . . . . .  57
enterable objects (in data entry order)  . . . . . .  140
entry filters . . . . . . . . . . . . . . . . . . . . . . . . 71–72
Entry order (user forms) . . . . . . . . . . . . . . . .  133
Every X day(s) at x (Backup Scheduler 

Preferences)  . . . . . . . . . . . . . . . . . .  337
Every X hour(s) (Backup Scheduler Preferences)  337
Every X month(s), Xth Day at x 

(Backup Scheduler Preferences) . . . . .  338
Every X week(s) day at x (Backup Scheduler 

Preferences)  . . . . . . . . . . . . . . . . . .  338
Except conjunction. . . . . . . . . . . . . . . . . . . . .  88
Execute button . . . . . . . . . . . . . . . . . . . . . .  317
Execute Method dialog box. . . . . . . . . . . . . . .  36
Executing a backup  . . . . . . . . . . . . . . . . . . .  323
Exit menu command . . . . . . . . . . . . . . . . . . .  33
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Export
4D Chart document in PICT form  .  .  .  .  .  240
Delimiters Page .  .  .  .  .  .  .  .  .  .  .  .  .  .  380
Filling Page   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  384
Format page  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  383
Header Page  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  379
XML page  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  380

Export all Records option . . . . . . . . . . . . . . .  377
Export Data dialog box . . . . . . . . . . . . . . . . .  375
Export Selection as (File menu) . . . . . . . . . . .  240
Export Selection option  . . . . . . . . . . . . . . . .  377
Export To File menu command . . . . . . . . . . . .  33
Export To ODBC Source menu command . . . . .  33
Exporting data

to an ODBC source .  .  .  .  .  .  .  .  .  .  .  .  388
to files .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   33, 374
using a form  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  378

expressions
changing to text  .  .  .  .  .  .  .  .  .  .  .  .  .  304
changing values to text  .  .  .  .  .  .  .  .  .  .  303
evaluating  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  302
formatting .  .  .  .  .  .  .  .  .  .  .  .  .  .  304–305
referencing.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  302
showing as references .  .  .  .  .  .  .  .  .  .  .  303
showing as values   .  .  .  .  .  .  .  .  .  .  .  .  303
unreferencing   .  .  .  .  .  .  .  .  .  .  .  .  .  .  304
using in documents.  .  .  .  .  .  .  .  .  .  .  .  302

F
field attributes. . . . . . . . . . . . . . . . . . . . . . 69–75
field display formats. . . . . . . . . . . . . . . . . . . .  60

Alpha fields   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  61
Date fields .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  63
Number fields  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  61
Picture fields .  .  .  .  .  .  .  .  .  .  .  .  .  .  65–67
Text fields  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  62
Time fields .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  64

Field Format dialog box  . . . . . . . . . . . . . . . .  305
field references

changing to text  .  .  .  .  .  .  .  .  .  .  .  .  .  304
changing values to text  .  .  .  .  .  .  .  .  .  .  303
in plug-in windows .  .  .  .  .  .  .  .  .  .  .  .  299
inserting .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  299–301
showing as references .  .  .  .  .  .  .  .  .  .  .  303
showing as values   .  .  .  .  .  .  .  .  .  .  .  .  303
unreferencing   .  .  .  .  .  .  .  .  .  .  .  .  .  .  304

field types
Alpha   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   61
Boolean   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 64–65
Date  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   63
Integer .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   61
Long Integer  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   61
Picture .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 65–67
Real  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   61
Text  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   62
Time .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   64

fields
blank in label reports  .  .  .  .  .  .  .  .  .  .  .  214
Boolean, labelling .  .  .  .  .  .  .  .  .  .  .  .  .  274
entry filters for  .  .  .  .  .  .  .  .  .  .  .  .  . 71–72
graphing data from  .  .  .  .  .  .  .  .  .   254–262
inserting in 4D Chart documents .  .  .   299–301
invisible  .  .  .  .  .  .  .  .  85, 115, 125, 160, 211
mandatory  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   70
see also field references
sorting indexed .  .  .  .  .  .  .  .  .  .  .  .  .  .  129
unique .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   70
updating graphs from  .  .  .  .  .  .  .  .  .  .  .  262
using pop-up menu of .  .  .  .  .  .  .  .  .  .  .  301

Fields list
in Order By editor .  .  .  .  .  .  .  .  .  .  .  .  .  125
in Quick Report editor .  .  .  .  .  .  .  .  .  .  .  160

file formats supported by 4th Dimension . . . . .  362
File menu  . . . . . . . . . . . . . . . . . . . . . . . .  32–33
files

data  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 24–45
data resource  .  .  .  .  .  .  .  .  .  .  .  .  25, 41, 42
exporting to   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   33
importing (File menu) .  .  .  .  .  .  .  .  .  .  .   32
naming   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   42
structure  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 24–45
structure resource .  .  .  .  .  .  .  .  .  .  .  . 25, 41

fill patterns, setting. . . . . . . . . . . . . . . . . . . .  221
Filling Page (Export dialog box)  . . . . . . . . . . .  384
First Page button  . . . . . . . . . . . . . . . . . . . . . .  59
First Record button . . . . . . . . . . . . . . . . . . . . .  58
Fixed Length text format (Import-Export)  . . . .  362
Flipped option for 3D Triangle graphs . . . . . . .  253
Flush Data Buffers menu command  . . . . . . . . .  33
folders, naming of  . . . . . . . . . . . . . . . . . . . . .  42
font/font size

of chart text, setting .  .  .  .  .  .  .  .  .  .  .  .  290
of text objects, setting .  .  .  .  .  .  .  .  .  .  .  298
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Form editor
changing data entry order   .  .  .  .  .  .  .  .  .  56
creating labels with   .  .  .  .  .  .  .  .  .  .  .   209
Object bar .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   135
reports in  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   151

Format menu item  . . . . . . . . . . . . . . . . . . . .  304
Format page

Export   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   383
Import  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   373

formatting
axis labels .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   274
data for the Clipboard  .  .  .  .  .  .  .  .  .  .   262
references .  .  .  .  .  .  .  .  .  .  .  .  .  .  304–305
series values .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   280

forms
4D Chart areas in   .  .  .  .  .  .  .  .  .  .  .  .   233
changing between  .  .  .  .  .  .  .  .  .  .  .  .  .  79
custom menus .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  40
graphing in  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   255
parent   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  75
printing 4D Chart areas with  .  .  .  .  .  .  .   312
role of   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  22
templates  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  55
using 4D Chart in  .  .  .  .  .  .  .  .  .  .  233–234

Formula dialog box . . . . . . . . . . . . . . . . . . . .  267
Formula editor . . . . . . . . . . . . .  38, 105, 115–120

Commands  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   116
constructing searches.  .  .  .  .  .  .  .  .  .  .  .  90
constructing sorts  .  .  .  .  .  .  .  .  .  .  .  .   127
constructing sorts using   .  .  .  .  .  .  .  .  .   128
formulas in quick reports .  .  .  .  .  .  .  .  .   174
invisible tables and fields in.  .  .  .  .  .  .  .   115
Operators  .  .  .  .  .  .  .  .  .  .  .  .  .  .  115, 116
performing global updates  .  .  .  .  .  .  .  .   114
writing formulas .  .  .  .  .  .  .  .  .  .  .  .  .   103

formulas
adding   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   267
adding to quick reports .  .  .  .  .  .  .  .  .  .   174
applying   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   119
building.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   119
sorting on .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   128
using with graphs  .  .  .  .  .  .  .  .  .  .  .  .   267

functions
graphing   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   267
See also expressions
Subtotal .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   149

G
Generate a page break option  . . . . . . . . . . . .  189
Generate DTD option. . . . . . . . . . . . . . . . . .  381
Generate extra space option  . . . . . . . . . . . . .  189
Generating 4D code (Quick Reports)  . . . . . . .  206
global updates. . . . . . . . . . . . . . . . . . . .  113–114

of records  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  107
Go to Full Window menu item  . . . . . . . . . . .  234
graph options

changing   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  269
descriptions of  .  .  .  .  .  .  .  .  .  .  .  .  244–254

graph types
2D XY .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  248
3D Area  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  252
3D Column   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  250
3D Line  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  251
3D Spike .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  254
3D Triangle   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  253
Area .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  243
Bar   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  244
changing   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  268
Column .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  244
Line .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  245
options for .  .  .  .  .  .  .  .  .  .  .  .  .  .  244–254
Picture.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  247
Pie   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  246
Polar   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  248
Scatter .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  245
Surface   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  252

graphic objects
changing appearance of .  .  .  .  .  .  .  .  220–221
See also objects
specifying fill patterns   .  .  .  .  .  .  .  .  .  .  221

graphing
4th Dimension functions  .  .  .  .  .  .  .  .  .  267
data from other applications   .  .  .  .  .  .  .  262
data from the Clipboard.  .  .  .  .  .  .  .  262–265
data from the database  .  .  .  .  .  .  .  .  255–262
dates from the Clipboard  .  .  .  .  .  .  .  .  .  263
in forms .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  255
in plug-in windows .  .  .  .  .  .  .  .  .  .  .  .  255

graphs
Auto option  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  275
creating from data in the database .  .  .  254–262
creating from data on the Clipboard .  .  262–265
modifying .  .  .  .  .  .  .  .  .  .  .  .  .  .  270–293
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grid lines
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Grid Lines submenu. . . . . . . . . . . . . . . . . . .  278
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I
If active transactions or index operations 
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Import From File menu command . . . . . . . . . .  32
Import from line # . . . . . . . . . . . . . . . . . . . .  371
Import From ODBC Source menu command . . .  32

Import-Export
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Save Settings  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  390
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Importing and exporting (ODBC) . . . . . . . . . .  385
Importing data
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from files .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   32
from ODBC sources .  .  .  .  .  .  .  .  .  .  .  .   32
using a form  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  370

indexed fields, sorting on  . . . . . . . . . . . . . . .  129
indexed searches  . . . . . . . . . . . . . . . . . . . . . .  86
input forms

adding new records  .  .  .  .  .  .  .  .  .   108–109
deleting records .  .  .  .  .  .  .  .  .  .  .  .  .  .  120
help tips  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   56
modifying records in   .  .  .  .  .  .  .  .  .  .  .  111
role of  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   22
searching in   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   85
templates .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   55
using.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 54–60

Insert a link to the XSL file  . . . . . . . . . . . . . .  382
Insert button (for choice lists)  . . . . . . . . . . . . .  74
Insert Column menu command . . . . . . . . . . .  171
Insert command (Quick reports) . . . . . . . . . . .  167
Inside the XML Export (DTD). . . . . . . . . . . . .  381
Integrate last log file if database is incomplete 

(Backup Restore Preferences)  . . . . . . .  352
Integrated object and tool bars (Object bar) . . .  135
Interlacing rate (Backup Preferences) . . . . . . . .  336
ISO-8859-1  . . . . . . . . . . . . . . . . . . . . . . . . .  381
Items in List dialog box . . . . . . . . . . . . . . . . . .  73

J
justification of text objects, setting . . . . . . . . .  298

K
Keep only the last X backup files 

(Backup Preferences) . . . . . . . . . . . . .  331

L
Label Wizard

concatenating data  .  .  .  .  .  .  .  .  .  .  .  .  214
deleting objects .  .  .  .  .  .  .  .  .  .  .  .  .  .  222
description of .  .  .  .  .  .  .  .  .  .  209, 209–210
invisible tables and fields in  .  .  .  .  .  .  .  .  211
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labels
creating .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  212–215
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printing .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   229
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Labels menu command . . . . . . . . . . . . . . . . . .  38
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Last Record button . . . . . . . . . . . . . . . . . . . . .  58
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Legend menu item . . . . . . . . . . . . .  281, 282, 283
legends
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graphic attributes of, setting   .  .  .  .  .  .  .   290
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text attributes of, setting  .  .  .  .  .  .  .  .  .   290
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line width (Label Wizard)  . . . . . . . . . . . . . . .  222
lines

attributes of, setting  .  .  .  .  .  .  .  .  .  289, 296
drawing .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  294–295

Lines appearance option (2D XY graph types). .  248
List of Tables window . . . . . . . . . . . . . . . . . . .  78
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choice   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   72–75
excluded   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  72

Localhost. . . . . . . . . . . . . . . . . . . . . . . . . . .  395
locked records  . . . . . . . . . . . . . . . . . . . . . . .  111

deleting .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   122
locking, tools (graphs) . . . . . . . . . . . . . . . . . .  294
Log backup file name (Backup Configuration 

Preferences) . . . . . . . . . . . . . . . . . . .  329

Log files
Assigning field values .  .  .  .  .  .  .  .  .  .  .  348
Checking   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  33
Creating .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  341
Customizing operations display window  .  .  347
Illustration of operation.  .  .  .  .  .  .  .  .  .  340
Managing  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  339
Manually integrating  .  .  .  .  .  .  .  .  .  .  .  356
Names .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  328
Numbering ranges  .  .  .  .  .  .  .  .  .  .  .  .  329
Operations .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  339
Parsing   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  345
Stopping .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  344
Undoing operations   .  .  .  .  .  .  .  .  .  .  .  357
Viewing panes  .  .  .  .  .  .  .  .  .  .  .  .  .  .  349

M
Mandatory attribute. . . . . . . . . . . . . . . . . . . .  70
Manually integrating the log . . . . . . . . . . . . .  356
Manually restoring a backup . . . . . . . . . . . . .  353

via the open data file dialog box .  .  .  .  .  .  356
Many table . . . . . . . . . . . . . . . . . . . . . . . . . .  91
markers (displaying). . . . . . . . . . . . . . . . . . .  133
marquee (data entry order) . . . . . . . . . . . . . .  141
Maximum (Quick Reports) . . . . . . . . . . . . . .  190
maximum and minimum values . . . . . . . . . . .  71
menu bar . . . . . . . . . . . . . . . . . . . . . . . . . .  234

custom   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  40
displaying  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  235
hiding .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  235

Method menu command  . . . . . . . . . . . . . . . .  36
methods (executing)  . . . . . . . . . . . . . . . .  36, 315
Minimize All Windows menu command. . . . . .  39
Minimize Window menu command. . . . . . . . .  39
Minimum (Quick Reports)  . . . . . . . . . . . . . .  190
Minimum Size of the 4D Chart Area. . . . . . . .  235
Mode menu  . . . . . . . . . . . . . . . . . . . . . . . . .  35
Modify button, for choice lists. . . . . . . . . . . . .  73
Modify Record menu command  . . . . . . . . . . .  37
Modifying passwords . . . . . . . . . . . . . . . . . . .  29
Move to Back menu item  . . . . . . . . . . . .  218–219
Move to Front menu item. . . . . . . . . . . .  218–219
Moving (user forms). . . . . . . . . . . . . . . . . . .  133
multi-tasking  . . . . . . . . . . . . . . . . . . . . . . . .  21

using processes .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  24
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N
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New Data File menu command . . . . . . . . . . . .  32
New Database menu command . . . . . . . . . . . .  32
New menu item. . . . . . . . . . . . . . . . . . . . . .  236
New Process check box . . . . . . . . . . . . . . . . .  316
New Record in List menu command. . . . . . . . .  37
New Record menu command  . . . . . . . . . . . . .  37
Next Page button. . . . . . . . . . . . . . . . . . .  59, 147
Next Record button . . . . . . . . . . . . . . . . . . . .  58
Next scheduled backup (Backup Configuration 

Preferences)  . . . . . . . . . . . . . . . . . .  329
No automatic backup (Backup Scheduler 

Preferences)  . . . . . . . . . . . . . . . . . .  337
No DTD . . . . . . . . . . . . . . . . . . . . . . . . . . .  381
Number field formats . . . . . . . . . . . . . . . . . . .  61

O
Object library  . . . . . . . . . . . . . . . . . . . . . . .  142
Object menu

Move to Back menu item  .  .  .  .  .  .  .  .  .  218
Move to Front menu item .  .  .  .  .  .  .  .  .  218

Object Tool palette
displaying/hiding.  .  .  .  .  .  .  .  .  .  .  .  .  235
using to draw objects .  .  .  .  .  .  .  .  .  .  .  294

objects
aligning  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  216–217
arranging   .  .  .  .  .  .  .  .  .  .  .  .  .  .  306–310
attributes of, setting   .  .  .  .  .  .  .  .  .  .  .  296
border patterns .  .  .  .  .  .  .  .  .  .  .  .  .  .  221
borders of, setting   .  .  .  .  .  .  .  .  .  .  .  .  296
constraining  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  295
drawing  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  294–295
duplicating.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  219
fill attributes of, setting .  .  .  .  .  .  .  .  .  .  296
fill patterns for .  .  .  .  .  .  .  .  .  .  .  .  .  .  221
grouping.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  309–310
layering  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  218
line attributes of, setting   .  .  .  .  .  .  .  .  .  296
resizing with the mouse .  .  .  .  .  .  .  .  .  .  305
setting color of .  .  .  .  .  .  .  .  .  .  .  .  .  .  221
stacking order of, setting   .  .  .  .  .  .  .  .  .  307
ungrouping   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  310

ODBC (Importing and exporting)  . . . . . . . . .  385
ODBC sources

Definition  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  385
Exporting data to .  .  .  .  .  .  .  .  .  .  .  .  .  388

Exporting to  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   33
Importing   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   32
Importing data from.  .  .  .  .  .  .  .  .  .  .  .  386

OLE objects . . . . . . . . . . . . . . . . . . . . . . . . . .  39
OLE tools menu command  . . . . . . . . . . . . . . .  39
One table  . . . . . . . . . . . . . . . . . . . . . . . . . . .  91
Open Data File dialog box . . . . . . . . . . . . . . . .  43
Open Data File menu command . . . . . . . . . . . .  32
Open Database menu command. . . . . . . . . . . .  32
Open menu item  . . . . . . . . . . . . . . . . . . . . .  236
open-file dialog box (choosing label design files) 229
opening

data files  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   32
databases .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   32
documents  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  236
new documents .  .  .  .  .  .  .  .  .  .  .  .  .  .  236
plug-in windows   .  .  .  .  .  .  .  .  .  .  .  .  .  233

Operators (Formulas)  . . . . . . . . . . . . . .  115, 116
Operators list . . . . . . . . . . . . . . . . . . . . . . . .  115
Options (DTD) . . . . . . . . . . . . . . . . . . . . . . .  381
options for graphs, changing . . . . . . . . . . . . .  269
Options menu item (Chart menu)  . . . . . . . . .  269
Or conjunction. . . . . . . . . . . . . . . . . . . . . . . .  88
Order By button . . . . . . . . . . . . . . . . . . . . . .  128
Order By editor  . . . . . . . . . . . . . . . . . . .  38, 125
Order By menu command . . . . . . . . .  38, 126–128
origins of axes, positioning  . . . . . . . . . . . . . .  276
output forms

adding records  .  .  .  .  .  .  .  .  .  .  .  .  53, 109
deleting records .  .  .  .  .  .  .  .  .  .  .  .  .  .  121
modifying records .  .  .  .  .  .  .  .  .  .  .  53, 112
resizing columns  .  .  .  .  .  .  .  .  .  .  .  .  .   52
role of  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 22, 50
searching in   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   85
selecting records in  .  .  .  .  .  .  .  .  .  .  .  .   52
using.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   51

Oval tool . . . . . . . . . . . . . . . . . . . . . . . . . . .  294
ovals (drawing)  . . . . . . . . . . . . . . . . . .  294–295

P
Page 0 (user forms) . . . . . . . . . . . . . . . . . . . .  133
Page Setup dialog box . . . . . . . . . . . . . .  146, 149
Page Setup menu command . . . . . . . . . . . . . . .  33
Palettes visibility (Quick Report editor)  . . . . . .  207
Paper (displaying borders in Form editor). . . . .  133
parent forms  . . . . . . . . . . . . . . . . . . . . . . . . .  75
Parsing a log file . . . . . . . . . . . . . . . . . . . . . .  345
password access system . . . . . . . . . . . . . . .  26–29
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Passwords (Web server) . . . . . . . . . . . . . . . . . .  29
Paste Field menu item . . . . . . . . . . . . . . . . . .  300
Paste in Clipboard button (Quick Report editor)  208
Paste menu command . . . . . . . . . . . . . . . . . . .  60
pattern

of chart objects, setting .  .  .  .  .  .  .  .  .  .   289
of lines, setting   .  .  .  .  .  .  .  .  .  .  .  .  .   296
of objects, setting   .  .  .  .  .  .  .  .  .  .  .  .   296

percentages
displaying in a graph .  .  .  .  .  .  .  .  .  279–281
graphing   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   247

Performing a backup . . . . . . . . . . . . . . . . . . .  320
perspective (of 3D graphs, setting)  . . . . . . . . .  285
PICT . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  240
picture charts

See also two-dimensional graphs
Picture fields  . . . . . . . . . . . . . . . . . . . . . .  65–67

entering pictures in   .  .  .  .  .  .  .  .  .  .  .  .  65
on background   .  .  .  .  .  .  .  .  .  .  .  .   66–67
Replicated format  .  .  .  .  .  .  .  .  .  .  .  .  .  67
scaling to fit .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  66
truncating .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   65–66

pictures
adjusting in Picture graphs  .  .  .  .  .  .  .  .   292
contrast (background pictures)  .  .  .  .  .  .  .  67
picture charts  .  .  .  .  .  .  .  .  .  .  .  .  .  .   291

pie charts
exploding .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   291
rotating .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   247
See also two-dimenional graphs

Plots shapes option (2D XY graph type) . . . . . .  248
plug-in areas. See 4D Chart areas
plug-in windows

closing  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   233
graphing in  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   255
opening .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   232
using 4D Chart in  .  .  .  .  .  .  .  .  .  .  232–233
using field references in   .  .  .  .  .  .  .  .  .   299

pointers
crosshair/crossbar  .  .  .  .  .  .  .  .  .  .  .  .   216
multi-directional arrow .  .  .  .  .  .  .  .  .  .   220

Polygon tool  . . . . . . . . . . . . . . . . . . . . . . . .  294
polygons (drawing) . . . . . . . . . . . . . . . .  294–295
Preferences (folder) . . . . . . . . . . . . . . . . . . . . .  24
preferences, setting . . . . . . . . . . . . . . . . . . . .  241
Preferences... (Edit menu)  . . . . . . . . . . . . . . . .  34
Preview on Screen check box . . . . . . . . .  147, 149
Previous Page button. . . . . . . . . . . . . . . . . . . .  59
Previous Record button . . . . . . . . . . . . . . . . . .  58

Print dialog box. . . . . . . . . . . . . . . . . . .  147, 149
Print Form dialog box  . . . . . . . . . . . . . .  146, 149
Print menu command  . . . . . . . . . . . . . . . . . .  33
Print menu item  . . . . . . . . . . . . . . . . . . . . .  311
Print Merge menu item  . . . . . . . . . . . . . . . .  313
print merges, creating  . . . . . . . . . . . . . . . . .  312
print order, setting in 4D Chart . . . . . . . . . . .  310
Print with Variable Frame check box  . . . . . . . .  66
Printing

4D Chart Documents .  .  .  .  .  .  .  .  .  .  .  310
File menu command  .  .  .  .  .  .  .  .  .  .  .  .  33
Labels .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  229
Page Setup .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  33
Reports with Break Levels .  .  .  .  .  .  .  .  .  148
Standard Reports .  .  .  .  .  .  .  .  .  .  .  .  .  146
to a 4D View Document.  .  .  .  .  .  .  .  .  .  205
to an HTML Document .  .  .  .  .  .  .  .  .  .  205
to graphs   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  202

printing documents . . . . . . . . . . . . . . . .  310–312
as part of a record   .  .  .  .  .  .  .  .  .  .  .  .  312
in a print merge  .  .  .  .  .  .  .  .  .  .  .  312–314
to a graph  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  203

Problems during backup . . . . . . . . . . . . . . . .  324
processes

current selections with  .  .  .  .  .  .  .  .  .  .  .  82
deleting records   .  .  .  .  .  .  .  .  .  .  .  .  .  122
for multi-tasking  .  .  .  .  .  .  .  .  .  .  .  .  .  .  24
locked records  .  .  .  .  .  .  .  .  .  .  .  .  .  .  111

Properties menu item (4D Chart) . . . . . . .  240, 311

Q
Query and Modify command  . . . . . .  89, 101, 102
Query by Example menu command . . . . . .  89, 101
Query by Example searches . . . . . . . . . . . .  99–101
Query by Formula editor  . . . . . . . . . . . .  103–105
Query by Formula menu command . . . . . .  90, 104
Query editor . . . . . . . . . . . . . . . . .  37, 88, 90–98

description of   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  91
invisible tables and fields in .  .  .  .  .  .  .  .  .  85

Query Editor menu command . . . . . . . . . . . . .  92
Query in Selection button. . . . . . . . . . . . . . . .  92
Query menu command  . . . . . . . . . . . . . . . . .  89
Query menu commands . . . . . . . . . . . . . . . . .  37
Quick Report editor . . . . . . . . . . . . . . . . . . .  145

Borders option .  .  .  .  .  .  .  .  .  .  .  .  .  .  207
cells .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  161
description of   .  .  .  .  .  .  .  .  .   151, 159–161
invisible files and fields in .  .  .  .  .  .  .  .  .  160
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Index
Palettes visibility option.  .  .  .  .  .  .  .  .  .  207
sizing columns .  .  .  .  .  .  .  .  .  .  .  .  .  .  173
sorting records .  .  .  .  .  .  .  .  .  .  .  .  126, 183
Text properties option   .  .  .  .  .  .  .  .  .  .  207

Quick Report menu command. . . . . . . . . . . . .  38
quick reports

adding columns to  .  .  .  .  .  .  .  .  .  .  .  .  170
adding text to  .  .  .  .  .  .  .  .  .  .  .  .  .  .  169
Average calculation .  .  .  .  .  .  .  .  .  .  .  .  190
break levels in  .  .  .  .  .  .  .  .  .  .  .  .  .  .  187
C1...Cn (report variables)  .  .  .  .  .  .  .  .  .  175
calculations in  .  .  .  .  .  .  .  .  .  .  .  .  .  .  189
contextual menus   .  .  .  .  .  .  .  .  .  .  .  .  164
Count calculation   .  .  .  .  .  .  .  .  .  .  .  .  190
creating  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  155
formulas in   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  174
hiding columns and rows .  .  .  .  .  .  .  .  .  195
loading designs.  .  .  .  .  .  .  .  .  .  .  .  .  .  157
Maximum calculation.  .  .  .  .  .  .  .  .  .  .  190
Minimum calculation .  .  .  .  .  .  .  .  .  .  .  190
printing  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  197
printing options  .  .  .  .  .  .  .  .  .  .  .  .  .  200
printing to disk.  .  .  .  .  .  .  .  .  .  .  .  .  .  202
saving .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  156
sizing columns in.  .  .  .  .  .  .  .  .  .  .  .  .  173
specifying font size .  .  .  .  .  .  .  .  .  .  .  .  175
specifying fonts   .  .  .  .  .  .  .  .  .  .  .  .  .  175
specifying justification  .  .  .  .  .  .  .  .  .  .  175
specifying style .  .  .  .  .  .  .  .  .  .  .  .  .  .  175
Standard deviation calculation.  .  .  .  .  .  .  190
Sum calculation   .  .  .  .  .  .  .  .  .  .  .  .  .  190
using display formats in .  .  .  .  .  .  .  .  193–195

QuickTime Compression  . . . . . . . . . . . . . . . .  68

R
radio buttons (formatting Boolean fields as)  . . .  64
records

adding.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  108
deleting  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  120–122
deleting locked .  .  .  .  .  .  .  .  .  .  .  .  .  .  122
entering in input forms .  .  .  .  .  .  .  .  .  .  .  54
entering in output forms  .  .  .  .  .  .  .  .  .  .  53
graphing .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  254–262
locked .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  111
modifying  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  110
modifying in output forms   .  .  .  .  .  .  .  .  .  53
navigation buttons for   .  .  .  .  .  .  .  .  .  .  .  58
saving 4D Chart areas with  .  .  .  .  .  .  .  .  238

selecting  .  .  .  .  .  .  .  .  .  .  .  .  .  .  22–23, 83
selecting in output forms   .  .  .  .  .  .  .  .  .   52
sorting .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   123–129
sorting for reports .  .  .  .  .  .  .  .  .  .  .  .  .  148
updating globally .  .  .  .  .  .  .  .  .  .  .  .  .  113

Records menu  . . . . . . . . . . . . . . . . . . . . . . . .  37
Rectangle tool  . . . . . . . . . . . . . . . . . . . . . . .  294
rectangles (drawing) . . . . . . . . . . . . . . .  294–295
Redundancy rate (Backup Preferences). . . . . . .  336
Refer to existing DTD option . . . . . . . . . . . . .  381
Refer to existing XSL option. . . . . . . . . . . . . .  382
Reference menu item  . . . . . . . . . . . . . . . . . .  302
references

changing to text   .  .  .  .  .  .  .  .  .  .  .  .  .  303
displaying   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  303
formatting  .  .  .  .  .  .  .  .  .  .  .  .  .   304–305
see also field references

related tables . . . . . . . . . . . . . . . . . . . . . . . . .  75
searches on .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   91
searching on fields in  .  .  .  .  .  .  .  .  .  .  .   97

Remove button (Backup Configuration 
Preferences) . . . . . . . . . . . . . . . . . . .  327

Replace spaces (XML)  . . . . . . . . . . . . . . . . . .  382
Replicated (display format)  . . . . . . . . . . . . . . .  67
reports

creating with forms  .  .  .  .  .  .  .  .  .  .  .  .  145
printing standard  .  .  .  .  .  .  .  .  .  .   146–147
printing with break levels  .  .  .  .  .  .   148–149

resizing
automatic for labels .  .  .  .  .  .  .  .  .  .  .  .  224
columns (output forms)  .  .  .  .  .  .  .  .  .  .   52
graphs with the mouse   .  .  .  .  .  .  .  .  .  .  271
handles   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  220
objects (graphs) .  .  .  .  .  .  .  .  .  .  .  .  .  .  305
objects (labels)  .  .  .  .  .  .  .  .  .  .  .  .  .  .  220
objects with the mouse   .  .  .  .  .  .  .  .  .  .  305

Restore last backup if database is damaged 
(Backup Restore Preferences)  . . . . . . .  351

Restoring data  . . . . . . . . . . . . . . . . . . . . . . .  349
Automatic restore .  .  .  .  .  .  .  .  .  .  .  .  .  350
Incidents and diagnostic .  .  .  .  .  .  .  .  .  .  349

Retry after X hour(s) or minute(s) 
(Backup Preferences) . . . . . . . . . . . . .  334

Retry at the next scheduled date and time 
(Backup Preferences) . . . . . . . . . . . . .  334

Return to Form menu item  . . . . . . . . . . . . . .  234
Revert to factory settings (user forms) . . . . . . .  132
Right click under Mac OS X . . . . . . . . . . . . . . .  12
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Index
rotation
of 3D graphs, setting .  .  .  .  .  .  .  .  .  .  .   285
of axis labels, setting .  .  .  .  .  .  .  .  .  .  .   274
of axis titles, setting  .  .  .  .  .  .  .  .  .  .  .   278
of pie charts .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   247

Rounded rectangle tool . . . . . . . . . . . . . . . . .  294
rounding rectangle corners  . . . . . . . . . . . . . .  296
rulers

displaying .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   133
displaying/hiding  .  .  .  .  .  .  .  .  .  .  .  .   235

Run menu . . . . . . . . . . . . . . . . . . . . . . . . . . .  35
Runtime Explorer menu command . . . . . . . . . .  36

S
Save access to the database (4D Server)  . . . . . . .  29
Save as menu item  . . . . . . . . . . . . . . . . . . . .  237
Save as Template menu item  . . . . . . . . . . . . .  239
saving documents . . . . . . . . . . . . . . . . .  237–239

as desktop files.  .  .  .  .  .  .  .  .  .  .  .  .  .   237
as templates .  .  .  .  .  .  .  .  .  .  .  .  .  238–239
with 4th Dimension records.  .  .  .  .  .  .  .   238

Scheduled backup settings . . . . . . . . . . . . . . .  336
scroll bars, displaying/hiding . . . . . . . . . . . . .  235
scrolling

in quick reports  .  .  .  .  .  .  .  .  .  .  .  .  .   161
in text fields .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  62

search conditions
combining   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  87
elements of  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  84
modifying .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  96
removing  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  96
saving to disk  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  90

searches. . . . . . . . . . . . . . . . . . . . . . . . . .  84–85
comparison operators   .  .  .  .  .  .  .  .  .   86–87
compound   .  .  .  .  .  .  .  .  .  .  .  .  .  .   87–89
indexed .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  86
sequential .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  86
simple   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   87–89

Segment Size (Backup Preferences)  . . . . . . . . .  335
Segments

Numbering ranges .  .  .  .  .  .  .  .  .  .  .  .   329
Size of   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   335

Select All menu command . . . . . . . . . . . . . . . .  53
Select Similar Objects  . . . . . . . . . . . . . . . . . .  139
Selecting subrecords  . . . . . . . . . . . . . . . . . . . .  76
series (graphic attributes of, setting)  . . . . . . . .  289

Series axis
definition of .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  250
selecting a field for  .  .  .  .  .  .  .  .  .  .  .  .  260

series values
display formats for  .  .  .  .  .  .  .  .  .  .  .  .  280
displaying in a graph  .  .  .  .  .  .  .  .  .  279–281
graphic attributes of, setting .  .  .  .  .  .  .  .  290
see also values
text attributes of, setting   .  .  .  .  .  .  .  .  .  290

Shift key to constrain object shape. . . . . . . . .  216
Shift+clicking for selecting records . . . . . . . . . .  52
Show All menu command  . . . . . . . . . . . . . 37, 83
Show Both Points option (Line and/or 

Stacked graphs) . . . . . . . . . . . . . . . .  246
Show Clipboard (Edit menu) . . . . . . . . . . . . . .  34
Show Lines option (Line and/or Stacked graphs)  246
Show Points option 

(Line and/or Stacked graphs) . . . . . . .  246
Show References menu item . . . . . . . . . . . . .  303
Show Regression Line option 

(2D XY graph types). . . . . . . . . . . . .  248
Show Subset menu command . . . . . . . . . . . 37, 83
Show Values menu item . . . . . . . . . . . . . . . .  303
Showing One Label out of (graph option) . . . .  275
Single button mouse  . . . . . . . . . . . . . . . . . . .  12
size

font attribute.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  165
of columns (automatic) .  .  .  .  .  .  .  .  .  .  173
of labels (radio button)  .  .  .  .  .  .  .  .  .  .  224
of objects (labels) .  .  .  .  .  .  .  .  .  .  .  .  .  220
of objects, changing   .  .  .  .  .  .  .  .  .  220, 305
of page (radio button in Label editor)   .  .  .  224
See also resizing
setting for 4D Chart document   .  .  .  .  .  .  240

Sort area (Order By editor)  . . . . . . . . . . . . . .  128
Sort button for choice lists  . . . . . . . . . . . . . . .  75
Sort list (Quick Report editor)  . . . . . . . . . . . .  161
sorts

ascending  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  124
descending.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  124
levels  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  124
on modified records   .  .  .  .  .  .  .  .  .  .  .  128

squares (drawing)  . . . . . . . . . . . . . . . . .  294–295
Stacked option

for Area graphs .  .  .  .  .  .  .  .  .  .  .  .  .  .  244
for Bar graphs   .  .  .  .  .  .  .  .  .  .  .  .  .  .  245
for Column graphs .  .  .  .  .  .  .  .  .  .  .  .  245
for Line graphs .  .  .  .  .  .  .  .  .  .  .  .  .  .  246
for Picture graphs.  .  .  .  .  .  .  .  .  .  .  .  .  247
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Stacked Proportional option
for Area graphs .  .  .  .  .  .  .  .  .  .  .  .  .  .  244
for Bar graphs   .  .  .  .  .  .  .  .  .  .  .  .  .  .  245
for Column graphs  .  .  .  .  .  .  .  .  .  .  .  .  245
for Picture graphs.  .  .  .  .  .  .  .  .  .  .  .  .  247

stacking order (setting) . . . . . . . . . . . . . . . . .  307
Standard deviation (Quick Reports)  . . . . . . . .  190
Start Angle option, for Pie charts . . . . . . . . . .  247
Start database after automatic restore 

(Backup Restore Preferences) . . . . . . .  352
Start Web Server command . . . . . . . . . . . .  36, 393
Starting a backup . . . . . . . . . . . . . . . . . . . . .  321
Status (Backup Configuration Preferences)  . . .  329
Stop Web Server command . . . . . . . . . . . .  36, 394
Stopping a log file . . . . . . . . . . . . . . . . . . . .  344
Structure file (Backup Configuration 

Preferences)  . . . . . . . . . . . . . . . . . .  326
structure files  . . . . . . . . . . . . . . . . . . .  24, 41–46
structure resource files  . . . . . . . . . . . . . . . . 25, 41
style

of chart text, setting   .  .  .  .  .  .  .  .  .  .  .  290
of text objects, setting.  .  .  .  .  .  .  .  .  .  .  298

subfields (in search conditions) . . . . . . . . . . . .  90
subforms

adding subrecords   .  .  .  .  .  .  .  .  .  .  .  .  .  76
creating subrecords .  .  .  .  .  .  .  .  .  .  .  .  .  76
entering data in   .  .  .  .  .  .  .  .  .  .  .  .  .  .  76
setting double-click behavior   .  .  .  .  .  .  .  .  77
use   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  75

subrecords
creating  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  76
modifying  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  76
queries on  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  90
selecting .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  76

subtables
entering data in   .  .  .  .  .  .  .  .  .  .  .  .  .  .  75
searching on .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  90

Subtotal function. . . . . . . . . . . . . . . . . . . . .  149
Subtotal rows

hiding .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  195
labeling  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  187

Sum (Quick Reports)  . . . . . . . . . . . . . . . . . .  190
SYLK format . . . . . . . . . . . . . . . . . . . . . . . .  362
System configuration (information about)  . . . .  40

T
tables

creating for importing data   .  .  .  .  .  .  .  .  367
current selection in  .  .  .  .  .  .  .  .  .  .  .  .   82
invisible  .  .  .  .  .  .  .  .  85, 115, 125, 160, 211
related  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   75
role of  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   22
updating contents of   .  .  .  .  .  .  .  .  .  .  .  107

Tables List menu command . . . . . . . . . . . . . . .  38
Tab-Tab-Return (TTR) format . . . . . . . . . . . . .  262
templates

creating   .  .  .  .  .  .  .  .  .  .  .  .  .  .   238–239
definition of  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  238
forms   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   55

Test Web Server menu command . . . . . . . . . . .  36
Testing the Web Server . . . . . . . . . . . . . . . . .  394
text attributes, setting . . . . . . . . . . . . . . . . . .  298
Text fields . . . . . . . . . . . . . . . . . . . . . . . . . . .  62
Text format . . . . . . . . . . . . . . . . . . . . . . . . .  362

using delimiters .  .  .  .  .  .  .  .  .  .  .  .  .  .  363
text objects

adding to labels .  .  .  .  .  .  .  .  .  .  .  .  .  .  214
changing attributes (for charts) .  .  .  .  .  .  .  298
creating   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  297
creating for charts .  .  .  .  .  .  .  .  .  .  .  .  .  297
See also objects
setting fill patterns for .  .  .  .  .  .  .  .  .  .  .  221

Text properties (Quick Report editor)  . . . . . . .  207
Text tool . . . . . . . . . . . . . . . . . . . . . . . . . . .  297
text. See chart text, text attributes, text objects
three-dimensional graphs

3D Area graph type  .  .  .  .  .  .  .  .  .  .  .  .  252
3D Column graph type   .  .  .  .  .  .  .  .  .  .  250
3D Line graph type  .  .  .  .  .  .  .  .  .  .  .  .  251
3D Spike graph type .  .  .  .  .  .  .  .  .  .  .  .  254
3D Surface graph  .  .  .  .  .  .  .  .  .  .  .  .  .  252
3D Triangle graph type   .  .  .  .  .  .  .  .  .  .  253
from data in the database  .  .  .  .  .  .   256–262
parts of .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  249
perspective of, setting  .  .  .  .  .  .  .  .  .  .  .  285
see also graphs and 3D graphs

tick marks, customizing. . . . . . . . . . . . . . . . .  275
Time fields (display formats for) . . . . . . . . . . . .  64
Tips in 4D Chart. . . . . . . . . . . . . . . . . . . . . .  287
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Titles submenu. . . . . . . . . . . . . . . . . . . . . . .  277
titles, axis. See axis titles
titles, graph. See text objects
toolbar (Label Wizard) . . . . . . . . . . . . . . . . . .  212
toolbars (hiding). . . . . . . . . . . . . . . . . . . . . . .  31
tools

4D Chart  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  39
Line   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   294
locking  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   294
Oval   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   294
Polygon .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   294
Rectangle  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   294
Rounded Rectangle.  .  .  .  .  .  .  .  .  .  .  .   294
see also Chart Tool palette, Object Tool palette
selecting   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   294
Text   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   297

Tools menu . . . . . . . . . . . . . . . . . . . . . . . . . .  38
Tops Only option

for 3D Column graphs  .  .  .  .  .  .  .  .  .  .   251
for 3D Surface graphs.  .  .  .  .  .  .  .  .  .  .   253

Totals row
calculations in .  .  .  .  .  .  .  .  .  .  .  .  .  .   190
hiding   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   195

Totals Spacing command (Quick reports) . . . . .  167
Transactions (Definition) . . . . . . . . . . . . . . . .  340
two-dimensional graphs

adding depth to  .  .  .  .  .  .  .  .  .  .  .  .  .   284
Area graph type  .  .  .  .  .  .  .  .  .  .  .  .  .   243
from data in the database .  .  .  .  .  .  .  256–262
from data on the Clipboard .  .  .  .  .  .  263–265
Line graph type  .  .  .  .  .  .  .  .  .  .  .  .  .   245
parts of  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   242
Picture graph type  .  .  .  .  .  .  .  .  .  .  .  .   247
Pie graph type .  .  .  .  .  .  .  .  .  .  .  .  .  .   246
Polar graph type .  .  .  .  .  .  .  .  .  .  .  .  .   248
Scatter graph type  .  .  .  .  .  .  .  .  .  .  .  .   245
see also graphs

U
Undo menu command  . . . . . . . . . . . . . . . . . .  60
Undoing operation on log file  . . . . . . . . . . . .  357
Ungroup menu item . . . . . . . . . . . . . . . . . . .  310
Unique attribute . . . . . . . . . . . . . . . . . . . . . . .  70
Unreference menu item . . . . . . . . . . . . .  303, 304
unreferencing

expressions  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   304
fields  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   304

Update License (Help menu)  . . . . . . . . . . . . . .  39

Update menu item. . . . . . . . . . . . . . . . . . . .  262
URL

in a Text field   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  63
in an Alpha field  .  .  .  .  .  .  .  .  .  .  .  .  .  .  61

Use alternate DTD . . . . . . . . . . . . . . . . . . . .  373
Use Log File (Backup Configuration 

Preferences)  . . . . . . . . . . . . . . .  341, 344
User environment . . . . . . . . . . . . . . . . . . . 17–40

changing between tables   .  .  .  .  .  .  .  .  .  .  77
creating quick reports in   .  .  .  .  .  .  .  .  .  155
custom menus in .  .  .  .  .  .  .  .  .  .  .  .  .  .  40
Edit menu  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  34
File menu  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  32–33
Help menu.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  39
menus in   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  30–40
Mode menu  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  35
Records menu  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  37
role of .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  21
Run Menu .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  35
Tools menu   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  38
Window menu .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  39

User form editor
Contextual menu.  .  .  .  .  .  .  .  .  .  .  .  .  137
Toolbar  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  132

User forms
Access to object library  .  .  .  .  .  .  .  .  .  .  142
Align   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  139
Automatic size  .  .  .  .  .  .  .  .  .  .  .  .  .  .  139
Border line style  .  .  .  .  .  .  .  .  .  .  .  .  .  139
Color  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  138
Level   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  139
Selecting similar objects .  .  .  .  .  .  .  .  .  .  139

User Identification dialog box . . . . . . . . . . . . .  27
User interruption. . . . . . . . . . . . . . . . . . . . .  324
User menu command. . . . . . . . . . . . . . . . . . .  35
User structure file (Backup Configuration 

Preferences)  . . . . . . . . . . . . . . . . . .  326

V
Validation option (Import dialog)  . . . . . . . . .  372
Value to Field (Import Editor) . . . . . . . . . . . .  369
values

changing references to  .  .  .  .  .  .  .  .  .  .  303
displaying in Break columns.  .  .  .  .  .  .  .  192
displaying references to .  .  .  .  .  .  .  .  .  .  303
for series, displaying   .  .  .  .  .  .  .  .  .  .  .  279
maximum and minimum .  .  .  .  .  .  .  .  .  .  71
see also series values
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Values axis (for a 2D graph)  . . . . . . . . . . . . .  242
Values axis (for a 3D graph)

definition of  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  250
selecting a field for  .  .  .  .  .  .  .  .  .  .  .  .  261

Values menu item (Chart menu) . . . . . . . . . .  279
View menu item  . . . . . . . . . . . . . . . . . . . . .  285
Viewing panes. . . . . . . . . . . . . . . . . . . . . . .  349

W
Web Server

automatic publication   .  .  .  .  .  .  .  .  .  .  394
passwords  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  29
Starting/Stopping .  .  .  .  .  .  .  .  .  .  .  .  .  .  36
starting/stopping .  .  .  .  .  .  .  .  .  .  .   36, 393
Testing   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  36
testing .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  394

WEDD resource . . . . . . . . . . . . . . . . . . . . . . .  42
wildcard (@) character (in searches)  . . .  87, 94, 100
Window menu  . . . . . . . . . . . . . . . . . . . . . . .  39
windows

opening 4D Chart in plug-in   .  .  .  .  .  232–233
opening multiple 4D Chart  .  .  .  .  .  .  .  .  233

X
X-axis. See Category axis (for a 2D graph), 

Category axis (for a 3D graph) . . . . . .  242
XML format  . . . . . . . . . . . . . . . . . . . . . . . .  362
XML Keys-Backup manual  . . . . . . . . . . . . . .  360
XML page

Export .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  380
Import.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  372

XSL
exporting   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  382
transformation .  .  .  .  .  .  .  .  .  .  .  .  .  .  382

Databasename. . . . . . . . . . . . . . . . . . . . . . .  328
Logname  . . . . . . . . . . . . . . . . . . . . . . . . . .  328

Y
Y-axis. See Series axis, Values axis (for a 2D graph)

Z
Zoom button

in previewed report .  .  .  .  .  .  .  .  .  .  .  .  147
user forms  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  134
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